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This document describes the software options for satellite navigation: GPS, Assisted GPS, GPS P-Code,
Galileo, Assisted Galileo, GLONASS, Assisted GLONASS, COMPASS/BeiDou, Enh. GNSS and GNSS
Extensions, incl. Extension to 12 and 24 Satellites, Obscuration Simulation and Automatic Multipath,
Antenna Pattern, Spinning and Attitude Simulation
Described are the following software options:

● R&S®SMBV-K44/K244/K65/K266/K66/K67/K91/K92/K93/K94/K294/K95/K96/K101/K102/K103/K107
1415.8060.xx, 1415.8260.02, 1415.8560.xx, 1415.8590.02, 1415.8683.xx, 1419.2509.xx,
1415.8577.xx, 1415.8583.xx, 1415.8660.xx, 1415.8677.xx, 1415.8690.02, 1419.2521.xx,
1415.8790.xx, 1415.8802.xx, 1415.8819.xx, 1415.8825.xx, 1419.2709.xx

● R&S®AMU-K244/K266/K294
1402.7902.02, 1403.0976.02, 1403.0953.02

● R&S®AFQ-K244/K266/K294
1401.6454.02, 1415.0330.02, 1415.0318.02

● R&S®SMJ-K244/K266/K294
1409.0810.02, 1409.3502.02, 1409.3483.02

● R&S®SMU-K244/K266/K294
1408.5818.02, 1408.8630.02, 1408.8617.02

● R&S®SMW-K244/K266/K294
1413.4880.02, 1413.7015.02, 1413.7067.02

● R&S®SFU-K244
2115.2250.02
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1 Preface

1.1 Documentation Overview

The user documentation for the R&S SMBV consists of the following parts:

● Online Help system on the instrument,
● "Quick Start Guide" printed manual,
● Documentation CD-ROM with:

– Online help system (*.chm) as a standalone help,
– Operating Manuals for base unit and options,
– Service Manual,
– Data sheet and specifications,
– Links to useful sites on the R&S internet.

Online Help

The Online Help is embedded in the instrument's firmware. It offers quick, context-sen-
sitive access to the complete information needed for operation and programming. The
online help contains help on operating the R&S SMBV and all available options.

Quick Start Guide

The Quick Start Guide is delivered with the instrument in printed form and in PDF for-
mat on the Documentation CD-ROM. It provides the information needed to set up and
start working with the instrument. Basic operations and an example of setup are descri-
bed. The manual includes also general information, e.g., Safety Instructions.

Operating Manuals

The Operating Manuals are a supplement to the Quick Start Guide. Operating Manuals
are provided for the base unit and each additional (software) option.

These manuals are available in PDF format - in printable form - on the Documentation
CD-ROM delivered with the instrument. In the Operating Manual for the base unit, all
instrument functions are described in detail. Furthermore, it provides an introduction to
remote control and a complete description of the remote control commands with pro-
gramming examples. Information on maintenance, instrument interfaces and error
messages is also given.

In the individual option manuals, the specific instrument functions of the option are
described in detail. For additional information on default settings and parameters, refer
to the data sheets. Basic information on operating the R&S SMBV is not included in the
option manuals.

 

 

Documentation Overview
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Service Manual

The Service Manual is available in PDF format - in printable form - on the Documenta-
tion CD-ROM delivered with the instrument. It describes how to check compliance with
rated specifications, on instrument function, repair, troubleshooting and fault elimina-
tion. It contains all information required for repairing the instrument by the replacement
of modules.

This manual can also be orderd in printed form (see ordering information in the data
sheet).

Release Notes

The release notes describe new and modified functions, eliminated problems, and last
minute changes to the documentation. The corresponding firmware version is indicated
on the title page of the release notes. The current release notes are provided in the
Internet.

Web Helps

Web helps are provided for the base unit and each additional (software) option. The
content of the web helps correspond to the user manuals for the latest product ver-
sions.

The web help is an additional file format that offers quick online access. They are not
intended to be downloaded but rather to access the required information directly form
the R&S website.

Web helps are available at the R&S website, on the R&S SMBV product page at the
"Downloads > Web Help" area.

1.2 Typographical Conventions

The following text markers are used throughout this documentation:

Convention Description

"Graphical user interface ele-
ments"

All names of graphical user interface elements on the screen, such as
dialog boxes, menus, options, buttons, and softkeys are enclosed by
quotation marks.

KEYS Key names are written in capital letters.

File names, commands,
program code

File names, commands, coding samples and screen output are distin-
guished by their font.

Input Input to be entered by the user is displayed in italics.

Links Links that you can click are displayed in blue font.

"References" References to other parts of the documentation are enclosed by quota-
tion marks.
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2 General Description
The global navigation satellite system (GNSS) employs the radio signals of several
navigation standards, like GPS, Galileo, GLONASS, BeiDou etc. For several years,
GPS used to be the only standard available for civilian navigation through its C/A civil-
ian code. Nowadays, the GNSS signals and systems are undergoing fast development,
some systems are getting modernized and some are completely new. In the foreseea-
ble future, several more GNSS satellites utilizing more and new frequency will be avail-
able.

Differences between the GNSS implementation in R&S SMBV and R&S WinIQ-
SIM2

The GNSS implementation in the R&S SMBV provides you with the ability to generate
the signal of up to 6, 12 or 24 GNSS satellites, depending on the installed options. Sig-
nal generation is done in real-time and thus it is not limited to a certain time period.

The GNSS implementation in the R&S WinIQSIM2 allows you to generate waveform
files that can be loaded to an Rohde&Schwarz vector signal generator, e.g. the R&S
SMU200A. It provides you the ability to generate the signal of one GPS, Galileo or Glo-
nass satellite on either an R&S SMU200A, R&S SMJ100A, R&S AMU200A,
R&S AFQ100A, R&S SMW200A or R&S SMBV100A. Depending on the availability of
the respective options, e.g. R&S SMU-K244/-K266/-K294 you can simulate one GPS,
Galileo, GLONASS satellite respectively on the generator.

As a major difference to the real-time solution, the satellite signal is limited to a certain
time period depending on the ARB capacity of the vector signal generator and the user
configurable sample rate of the satellite signal.

This description follows the GNSS implementation in the R&S SMBV.
For information on the GNSS implementation in the R&S WinIQSIM2, see chap-
ter 2.12, "Functional Overview of the Basic Offline GNSS ", on page 53.

Brief introduction to the GNSS standards

● GPS
The Global Positioning System (GPS) consists of several satellites circling the
earth in low orbits. The satellites transmit permanently information that can be used
by the receivers to calculate their current position (ephemeris) and about the orbits
of all satellites (almanac). The 3D position of a receiver on the earth can be deter-
mined by carrying out delay measurements of at least four signals emitted by differ-
ent satellites.
Being transmitted on a single carrier frequency, the signals of the individual satel-
lites can be distinguished by means of correlation (Gold) codes. These ranging
codes are used as spreading code for the navigation message which is transmitted
at a rate of 50 baud.

● Galileo
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Galileo is the European global navigation satellite system that provides global posi-
tioning service under civilian control. It is planed to be inter-operable with GPS and
GLONASS and other global satellite navigation systems.
The fully deployed Galileo system consists of 30 satellites (27 operational and 3
spares). Three independent CDMA signals, named E5, E6 and E1, are perma-
nently transmitted by all Galileo satellites. The E5 signal is further sub-divided into
two signals denoted E5a and E5b (see figure 2-1).

● GLONASS
Glonass is the russian global navigation satellite system. It is expected to be fully
operational before the end of 2011 with 24 Modernized Glonass Satellites touring
the globe. Together with GPS, up to 54 GNSS Satellites are provided, which will
improve the availability and consequently the navigation performance in high urban
areas.

Fig. 2-1: GNSS frequency bands

● COMPASS/BeiDou
The fully deployed BeiDou Navigation Satellite System (BDS) is a Chinese satellite
navigation system. This navigation system is also know as BeiDou-2 and is expec-
ted in 2020. The BDS is a global satellite navigation systems that uses a constella-
tion of 35 satellites to cover the globe. This constellation includes 5 geostationary
orbit satellites (GEO) and 30 non-geostationary satellites; 27 in medium earth orbit
(MEO) and 3 in inclined geosynchronous orbit (IGSO).
The BDS uses frequency allocated in the E1, E2, E5B, and E6 bands.

● Assisted GNSS (A-GNSS)
Assisted GNSS (A-GNSS) was introduced to different mobile communication
standards to significantly reduce the Time To First Fix (TTFF) of a user equipment
(UE) containing a GNSS receiver. This is achieved by transmitting information
(assistance data) mainly about the satellites directly from a base station to the UE.
For example, a stand-alone GPS receiver needs about 30-60 seconds for a first fix
and up to 12.5 minutes to get all information (almanac).
In A-GNSS "UE based mode", the base station assists the UE by providing the
complete navigation message along with a list of visible satellites and ephemeris
data. In addition to this information, the UE gets the location and the current time at
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the Base Station and that speeds up both acquisition and navigation processes of
the GPS receiver and hence reduces TTFF to a few seconds.
In A-GNSS "UE assisted mode", the base station is even responsible for the calcu-
lation of the UE's exact location, i.e. the base station performs the navigation
based on the raw measurements provided by the UE. Since the Acquisition Assis-
tance Data provided by the Base Station already serves speeding up the acquisi-
tion process, the UE only has to track the code and carrier phase.

2.1 Functional Overview of the Basic Realtime GNSS
Options GPS, Galileo, GLONASS and BeiDou

This section gives an overview of the options GPS (R&S SMBV-K44), Galileo
(R&S SMBV-K66), GLONASS (R&S SMBV-K94) and BeiDou (R&S SMBV-K107).

Throughout this description, these options are denoted as basic GNSS options.

2.1.1 Real-time generation

With the option R&S SMBV-K44, up to six GPS satellites transmitting L1 or L2 signals
with C/A-code can be simulated in real-time.

With the option R&S SMBV-K66, up to six Galileo satellites transmitting E1 signal can
be simulated in real-time.

With the option R&S SMBV-K94, up to six GLONASS satellites transmitting L1 or L2
signal can be simulated in real-time.

With the option R&S SMBV-K107, up to six BeiDou satellites transmitting L1 or L2 sig-
nal can be simulated in real-time.

2.1.2 Multi-satellite GNSS signal

The instrument calculates a multi-satellite GNSS signal in three different simulation
modes, the static mode, the auto localization mode and the user localization mode.

In "Static mode", static satellites with constant Doppler shifts are provided for simple
receiver test, like receiver sensitivity, acquisition and tracking test, etc. production
tests. Selection and configuration of any localization data, such as receiver location for
instance, is not enabled.

The generic workflow is described in chapter 2.10.2, "Generating GNSS Signal for
Simple Receiver Tests (Static Mode)", on page 36.

The superposition signal of up to 6 dynamic satellites at a specific receiver location is
generated in one of the localization modes. The major difference to the static mode
implies the possibility to specify the receiver's location. Although, both the localization
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modes are provided for the generation of a realistic GNSS signal, there are some dif-
ferences between them.
● The "Auto Localization" mode is provided for the generation of a GNSS signal with

automatic exchange of satellite whenever needed to improve the position dilution
of precision and to ensure satellite visibility at the simulated receiver location. This
mode ensures an optimal satellite constellation, automatic dynamic calculation of
the satellite power at any moment and ephemeris projection from the selected
almanac.
In this simulation mode, the connected GNSS receiver can be forced to obtain a
3D fix at a predefined or user-defined static geographical location. Instrument
equipped with the option GNSS enhanced R&S SMBV-K92 can also simulate mov-
ing receivers (see chapter 2.5.1, "Moving Scenarios", on page 26).

● The "User Localization" mode provides flexible configuration of the satellite constel-
lation, the power settings and the individual satellites parameters. For instruments
equipped with assistance option R&S SMBV-K65, this mode also enables the
extraction of the navigation message from RINEX files. Dynamic exchange of satel-
lites can be performed by means of deactivation and activation of the individual
satellites. The power settings are enabled for configuration but the automatic
dynamic calculation function of the instrument may also be utilized.
This mode is required for the generation of user defined assisted GPS test scenar-
ios.

The table 2-1 gives an overview of the supported functionality per simulation mode.
Some functionality require additional options.

Table 2-1: Cross-reference between the simulation mode, supported functionality and the required options

Simulation Mode /

Function

Static Auto Localization User Localization Required Options

Configuration of static receiver location no yes yes R&S SMBV-K44/K66/K94/
K107

GNSS System Configuration yes yes yes R&S SMBV-K44 and
R&S SMBV-K66 and
R&S SMBV-K94 and
R&S SMBV-K107

Almanac/RINEX almanac almanac Almanac and
RINEX file suppor-
ted

R&S SMBV-K44/K66/K94/
K107

R&S SMBV-K65/K67/K95/
K107 for RINEX files

Projection of Navigation Message no yes yes R&S SMBV-K44/K66/K94/
K107

S.P.O.T. Display no yes yes R&S SMBV-K44/K66/K94/
K107

Assistance GNSS Data Generation no no yes R&S SMBV-K44/K66/K94/
K107 and

R&S SMBV-K65/K67/K95

Configuration of Satellite Constellation yes no yes R&S SMBV-K44/K66/K94/
K107

Functional Overview of the Basic Realtime GNSS Options GPS, Galileo, GLONASS and BeiDou
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Simulation Mode /

Function

Static Auto Localization User Localization Required Options

Power Mode User Auto Auto and User R&S SMBV-K44/K66/K94/
K107

Exchange of Satellites no automatic manual R&S SMBV-K44/K66/K94/
K107

Maximum Number of Satellites up to 12/24 up to 12/24 up to 12/24 R&S SMBV-K91/-K96

Motion Files

Motion Smoothening

Extract attitude from motion file

no yes yes R&S SMBV-K92

Time Conversion Configuration yes no yes R&S SMBV-K92

Navigation Message Configuration configurable read-only configurable R&S SMBV-K92

Atmospheric Configuration yes yes yes R&S SMBV-K92

Static Multipath Configuration no no yes R&S SMBV-K92

Automatic Multipath&Osculation sce-
narios

no yes yes R&S SMBV-K92 and
R&S SMBV-K102

Antenna Pattern/Body mask entry no yes yes R&S SMBV-K102

Attitude/Body rotation angle files

User defined vehicle spinning

no yes yes R&S SMBV-K92 and
R&S SMBV-K103

Hardware in the loop (HIL) no yes yes R&S SMBV-K92 (motion
only)

and R&S SMBV-K103
(motion and attitude)

2.1.3 GNSS System Configurations

Instrument equipped with the GNSS basic options GPS, Galileo, GLONASS and Bei-
Dou can be configured to generate the signal of hybrid GNSS satellite constellation
with radio signals of all navigation standards. Mixed configurations are enabled only in
the common or close-range frequency bands, e.g. L1/E1.

GNSS system configurations can be also used to configure general purpose global
parameters for the simulation.

2.1.4 Multiple almanacs

The instrument supports the configuration of the almanac files used. One almanac file
per GNSS navigation standard can be selected.

The Galileo satellite constellation is not yet in orbit. Hence, no almanac files for Galileo
are available. In this implementation, Galileo almanac files are provided for test purpo-
ses. The almanac files for GPS and Galileo use the same format.
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Current GNSS almanac data can be downloaded via the Internet and stored on the
hard disk of the instrument:
● U.S.Coast Guard Navigation Center GPS Homepage http://

www.navcen.uscg.gov/?pageName=gpsAlmanacs
The almanac files are named xxx.alm (for YUMA files) or xxx.al3 (for SEM
files) whereas xxx denotes the day of a year.

● http://www.celestrak.com/GPS/almanac/
The naming convention of the almanac file is: almanac.sem/
yuma.weekXXXX.YYYYYY.txt
whereas xxxx denotes the GPS week and yyyyyy the time of almanac (TOA).

● ftp://ftp.glonass-iac.ru/MCC/ALMANAC/
The file extension of the Glonass almanac file is: xxx.agl

For detailed information on the content and frame structure of navigation data, refer to
the specifications.

2.1.5 On-the-fly configuration of the satellites constellation

The simulation mode "User Localization" makes the satellite constellation user-defina-
ble. Not only the individual satellite parameters and the navigation message parame-
ters are enabled for configuration, but active satellites can be turned off or the satellite
constellation can be extended with new satellites at any time and on-the-fly, without
causing an interruption of the currently running signal calculation. Changes in ephem-
eris of an active satellite and the power settings are performed without signal calcula-
tion restart, too. Hence, satellites ephemeris adjustment can be performed during the
time the satellite is disabled and the updated parameters will be used from the moment
this satellite is active again. This functionality can be used to perform manual
exchange of satellite's at user defined moment of time.

This on-the-fly re-configuration during signal generation is especially beneficial by time
consuming measurements or test.

2.1.6 Signal generation with projection of the ephemeris navigation data

The instrument employs a special algorithm for projecting the ephemeris navigation
data that allows the generation of a navigation message without limitation in the simu-
lation time. The ephemeris are updated and there is no limitation problem of maximum
allowed time span of two hours (GPS) or half an hour (Glonass) between the simula-
tion time and the reference time of the current satellite ephemeris page.

2.1.7 Dynamic exchange of satellites

In this implementation, the exchange of satellites can be performed automatically or be
configured and triggered by the user.

● To enable the instrument to perform automatic exchange of satellites, select the
"Auto Localization" mode.
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In this mode, the instrument constantly monitors and updates the simulated satel-
lite's constellation based on two criteria, the optimal satellite constellation with mini-
mum PDOP and the satellite's visibility respecting the Elevation Mask. While the
PDOP is a constellation parameter that is calculated by the instrument and dis-
played in real-time, the satellite's visibility is a satellite parameter which indicates
that the satellite elevation at a specific user location is above a configurable eleva-
tion mask.
Depending on the current satellite's conditions and the used number of satellites, a
sophisticated algorithm decides how often the PDOP and the satellite's visibility
have to be proved and at which moment of time the satellite's constellation has to
be changed. Satellites that do not fulfill the criteria for minimum PDOP and suffi-
cient visibility are exchanged dynamically and on-the-fly. Information about the
expected time of the next upcoming exchange is provided by the parameter Next
Constellation Change.
The generic workflow is described in chapter 2.10.3, "Generating GNSS Signal
with Automatic Dynamic Exchange of the Satellites (Auto Localization Mode)",
on page 36.

● In "User Localization" mode the exchange of the satellites is not performed auto-
matically, but the satellite's constellation is fully configurable. Satellites can be
turned off, reconfigured and turned on again, the existing satellite constellation can
be extended with new satellites. Hence, an exchange of the satellites can be con-
figured and performed at any moment of time, as defined by the user.
The generic workflow is described in chapter 2.10.4, "Generating GNSS Signal
with Manual Exchange of the Satellites (User Localization Mode)", on page 36.

2.1.8 Flexible power configuration and automatic dynamic power control

The instrument employs a dynamic power control concept. To provide better flexibility,
two power modes are provided, the "Auto" and the "User" power modes.

● "User" power mode is intended for dynamical configuration of the power of each
satellite separately and manually.

● "Auto" power mode enables an internal dynamical automatic power control. The
power is calculated automatically based on the satellite-to-receiver distance which
varies with the time.

Refer to chapter 3.6.1, "Power Configuration", on page 92 for examples and informa-
tion about the power calculation.

The generic workflow is described in chapter 2.10.12, "Adjusting the Power Settings",
on page 42.

2.1.9 Simulation of uninterrupted location fix

The simulation of uninterrupted location fix requires a GNSS signal that fulfills the fol-
lowing conditions:
● An optimal satellite's constellation is selected and monitored constantly, i.e. the

exchange of the satellites is performed automatically
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● The power of the satellites is monitored and updated constantly depending on the
satellite-to-receiver distance and some channel parameters, e.g. atmospheric
effects.

● The age of the ephemeris (t - toe) is respected, for example the simulation time is
always within the allowed time span of 2h around the GPS reference time of the
current ephemeris page. For GLONASS, this time is usually 30 minutes.

The table 2-2 gives an overview how these criteria are fulfilled by the provided localiza-
tion modes.

Table 2-2: Criteria for the generation of GNSS signal for simulation of uninterrupted location fix

Criteria

Simulation
Mode

Optimal Satellite's Constella-
tion

Power Monitoring and
Update

Age of Ephemeris

"Auto Localiza-
tion"

selected and updated automati-
cally

automatic dynamic exchange
of the satellites

performed automatically projection of the ephem-
eris from the almanac

"User Localiza-
tion"

initial optimal satellite's constel-
lation

manual user-defined exchange
of the satellites

performed automatically projection of the ephem-
eris or many ephemeris
pages are made available

Hence, both localization modes provide a realistic signal; the decision which localiza-
tion mode will be used is a trade-off between the much better accuracy of the ephem-
eris retrieved from a RINEX file or a manual ephemeris configuration and the automatic
selection of the optimal satellite's constellation with automatic exchange of the satel-
lites.

The generic workflow is described in chapter 2.10.3, "Generating GNSS Signal with
Automatic Dynamic Exchange of the Satellites (Auto Localization Mode)", on page 36
and chapter 2.10.4, "Generating GNSS Signal with Manual Exchange of the Satellites
(User Localization Mode)", on page 36.

2.1.10 Real-Time S.P.O.T. display

The real-word situation of disappearance and re-appearance of satellites, as well as
the dynamic display of several parameters like HDOP, PDOP, receiver's location,
elapsed time and the trajectory of a moving receiver can be observed in real-time in
the special "Real-Time S.P.O.T." (Satellites and Position Online Tracker) display.

The Real-Time S.P.O.T. display is enabled for "Auto Localization" and "User Localiza-
tion" modes.

2.2 Realtime Option GPS P-Code (R&S SMBV-K93)

The option GPS P-Code (R&S SMBV-K93) is only available for instruments equipped
with option GPS (R&S SMBV-K44). It enhances the option GPS with the functionality
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to generate a position accuracy (P-Code) signal and allows the configuration of P or
C/A+P satellite signals in addition to the civilian C/A signal enabled by the basic GPS
option (R&S SMBV-K44).

P-Codes are one week long codes with a high chip rate 10.23 MHz. The higher chip
rate significantly increases the performance compared to the civilian C/A codes used
by commercial receivers, i.e. P-Code signal provide better Carrier to Noise sensitivity.
Another difference compared to the C/A signals is that P-Code signals are only sensi-
ble to less than 30 m multipath delay whereas C/A signals are sensible to 300 m.

The generic workflow is described in chapter 2.10.10, "Generating GPS Signal Modula-
ted with P Code", on page 40.

2.3 Enhancements of Realtime Assisted GNSS Options
GPS, Galileo and GLONASS

This section gives an overview of the options Assisted GPS (R&S SMBV-K65), Assis-
ted Galileo (R&S SMBV-K67) and Assisted GLONASS (R&S SMBV-K95).

● The option Assisted GPS (R&S SMBV-K65) is only available for instruments equip-
ped with option GPS (R&S SMBV-K44). It enhances the basic option with function-
ality required for A-GPS/A-GNSS test scenarios for 3GPP FDD, GSM and EUTRA/
LTE.

● The option Assisted Galileo (R&S SMBV-K67) is only available for instruments
equipped with option Galileo (R&S SMBV-K66). It enhances the basic option with
functionality to generate user defined test scenarios.

● The option Assisted GLONASS (R&S SMBV-K95) is only available for instruments
equipped with option GLONASS (R&S SMBV-K94). It enhances the basic option
with functionality required for A-GLONASS/A-GNSS test scenarios for 3GPP FDD
and EUTRA/LTE.

2.3.1 Support of RINEX files

Additionally to the almanac files, a Receiver Independent Exchange Format RINEX
files are supported. RINEX files are very well known and are standard formats gener-
ated by Control Stations (CS) and many commercial receivers. RINEX Navigation Files
usually comprise the ephemeris sets for several satellites with different TOE and TOC.
Hence, only one RINEX File is enough to describe satellite orbits for a period longer
than 2 hours and sometimes up to 1 day.

Current RINEX files can be downloaded via the Internet and stored on the hard disk of
the instrument, e.g. http://cddis.gsfc.nasa.gov/gnss_datasum.html#brdc or ftp://
ftp.glonass-iac.ru/MCC/BRDC
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2.3.2 Full Set of Pre-defined Test Scenarios as Basis for A-GPS/A-GLO-
NASS/A-GNSS Protocol and Conformance Test Cases

An instrument equipped with the assisted options supports test scenarios as basis for
A-GPS/A-GLONASS/A-GNSS Protocol and Conformance Test cases. Some of the test
cases may require additional options.

Test scenario vs. test case
An instrument equipped with the required options provides predefined test scenarios,
not the standard conform test cases!
The provided test scenarios are suitable basis for the test cases. However, to perform
a particular test case as specified by the 3GPP test specification, you have to subse-
quently configure several settings. You may have to adjust the receiver location, the
simulation time, active satellites in the pre-selected satellite constellation, power set-
ting, etc.
Refer to the corresponding 3GPP test specification for the required values.
See also chapter 2.10.7, "Generating A-GNSS Test Signal", on page 39.

The table 2-3 lists the currently supported predefined A-GPS test scenarios.

Table 2-3: A-GPS test scenarios overview

Test Scenario Required for Test Case Required SW Option

 GSM  

3GPP TS 51.010: 10.9 Signaling 3GPP TS 51.010-1 v.7.7.0 10.9: A-GPS Signaling sce-
nario

R&S SMBV-K44/-K65

3GPP TS 51.010: 10.10 Performance 1 3GPP TS 51.010-1 v.7.7.0 10.10: A-GPS Performance
Test Scenario 1

R&S SMBV-K44/-K65

3GPP TS 51.010: 10.10 Performance 2 3GPP TS 51.010-1 v.7.7.0 10.10: A-GPS Performance
Test Scenario 2

R&S SMBV-K44/-K65

3GPP TS 51.010: 10.10 Performance 3 3GPP TS 51.010-1 v.7.7.0 10.10: A-GPS Performance
Test Scenario 3

R&S SMBV-K44/-K65/-K92

 3GPP FDD  

3GPP TS 34.108: 10.7 Signaling 3GPP TS 34.108 v.8.0.0 10.7: A-GPS Signaling scenario R&S SMBV-K44/-K65

3GPP TS 34.108: 10.1.2 Performance 1 3GPP TS 34.108 v.8.0.0 10.1.2: A-GPS Performance
scenario 1

R&S SMBV-K44/-K65

3GPP TS 34.108: 10.1.2 Performance 2 3GPP TS 34.108 v.8.0.0 10.1.2: A-GPS Performance
scenario 2

R&S SMBV-K44/-K65

3GPP TS 34.108: 10.1.2 Performance 3 3GPP TS 34.108 v.8.0.0 10.1.2: A-GPS Performance
scenario 3

R&S SMBV-K44/-K65/-K92

 3GPP2  

3GPP2 C.S0036: 2.1.1 Stationary 3GPP2 C.S0036-0 V1.0 2.1.1: A-GPS Stationary R&S SMBV-K44/-K65

3GPP2 C.S0036: 2.1.2 Moving 3GPP2 C.S0036-0 V1.0 2.1.2: A-GPS Moving R&S SMBV-K44/-K65/-
K91/-K92
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Test Scenario Required for Test Case Required SW Option

 EUTRA/LTE  

3GPP TS 37.571-2: S7 Signaling ST1 3GPP TS 37.571-2 v.10.0.0 subclause 7: A-GPS Signal-
ing scenario, Subtest 1

R&S SMBV-K44/-K65

3GPP TS 37.571-1: S7 Performance 1
ST1

3GPP TS 37.571-1 v.10.0.0 subclause 7: A-GPS Per-
formance scenario 1, Subtest 1

R&S SMBV-K44/-K65

3GPP TS 37.571-1: S7 Performance 2
ST1

3GPP TS 37.571-1 v.10.0.0 subclause 7: A-GPS Per-
formance scenario 2, Subtest 1

R&S SMBV-K44/-K65

3GPP TS 37.571-1: S7 Performance 5
ST1

3GPP TS 37.571-1 v.10.0.0 subclause 7: A-GPS Per-
formance scenario 5, Subtest 1

R&S SMBV-K44/-K65/-K92

The table 2-4 lists the currently supported predefined A-GLONASS test scenarios.

Table 2-4: A-GLONASS test scenarios overview

Test Scenario Required for Test Case Required SW Option

 3GPP FDD  

3GPP TS 37.571-2: S6 Signaling ST1 3GPP TS 37.571-2 v.10.0.0 subclause 6: A-Glonass Sig-
naling scenario, Subtest 1

R&S SMBV-K94/-K95

3GPP TS 37.571-1: S6 Performance 1 3GPP TS 37.571-1 v.10.0.0 subclause 6: A-Glonass
Performance scenario 1, Subtest 1

R&S SMBV-K94/-K95

3GPP TS 37.571-1: S6 Performance 2 3GPP TS 37.571-1 v.10.0.0 subclause 6: A-Glonass
Performance scenario 2, Subtest 1

R&S SMBV-K94/-K95

3GPP TS 37.571-1: S6 Performance 5 3GPP TS 37.571-1 v.10.0.0 subclause 6: A-Glonass
Performance scenario 5, Subtest 1

R&S SMBV-K94/-K95/-K92

 EUTRA/LTE  

3GPP TS 37.571-2: S7 Signaling ST2 3GPP TS 37.571-2 v.10.0.0 subclause 7: A-Glonass Sig-
naling scenario, Subtest 2

R&S SMBV-K44/-K95

3GPP TS 37.571-1: S7 Performance 1
ST2

3GPP TS 37.571-1 v.10.0.0 subclause 7: A-Glonass
Performance scenario 1, Subtest 2

R&S SMBV-K44/-K95

3GPP TS 37.571-1: S7 Performance 2
ST2

3GPP TS 37.571-1 v.10.0.0 subclause 7: A-Glonass
Performance scenario 2, Subtest 2

R&S SMBV-K44/-K95

3GPP TS 37.571-1: S7 Performance 5
ST2

3GPP TS 37.571-1 v.10.0.0 subclause 7: A-Glonass
Performance scenario 5, Subtest 2

R&S SMBV-K44/-K95/-K92

The table 2-5 lists the currently supported predefined A-GNSS test scenarios.

Table 2-5: A-GNSS test scenarios overview

Test Scenario Required for Test Case Required SW Option

 3GPP FDD  

3GPP TS 37.571-2: S6 Signaling ST4 3GPP TS 37.571-2 v.10.0.0 subclause 6: A-GNSS Sig-
naling scenario, Subtest 4

R&S SMBV-K44/-K65/-K95

3GPP TS 37.571-1: S6 Performance 1
ST4

3GPP TS 37.571-1 v.10.0.0 subclause 6: A-GNSS Per-
formance scenario 1, Subtest 4

R&S SMBV-K44/-K65/-K95

Enhancements of Realtime Assisted GNSS Options GPS, Galileo and GLONASS



General DescriptionSatellite Navigation

22Operating Manual 1173.1427.12 ─ 08

Test Scenario Required for Test Case Required SW Option

3GPP TS 37.571-1: S6 Performance 2
ST4

3GPP TS 37.571-1 v.10.0.0 subclause 6: A-GNSS Per-
formance scenario 2, Subtest 4

R&S SMBV-K44/-K65/-K95

3GPP TS 37.571-1: S6 Performance 5
ST4

3GPP TS 37.571-1 v.10.0.0 subclause 6: A-GNSS Per-
formance scenario 5, Subtest 4

R&S SMBV-K44/-K65/-
K92/-K95

 EUTRA/LTE  

3GPP TS 37.571-2: S7 Signaling ST4 3GPP TS 37.571-2 v.10.0.0 subclause 7: A-GNSS Sig-
naling scenario, Subtest 4

R&S SMBV-K44/-K65/-K95

3GPP TS 37.571-1: S7 Performance 1
ST5

3GPP TS 37.571-1 v.10.0.0 subclause 7: A-GNSS Per-
formance scenario 1, Subtest 5

R&S SMBV-K44/-K65/-K95

3GPP TS 37.571-1: S7 Performance 2
ST5

3GPP TS 37.571-1 v.10.0.0 subclause 7: A-GNSS Per-
formance scenario 2, Subtest 5

R&S SMBV-K44/-K65/-K95

3GPP TS 37.571-1: S7 Performance 5
ST5

3GPP TS 37.571-1 v.10.0.0 subclause 7: A-GNSS Per-
formance scenario 5, Subtest 5

R&S SMBV-K44/-K65/-
K92/-K95

The generic workflow is described in chapter 2.10.7, "Generating A-GNSS Test Sig-
nal", on page 39.

2.3.3 Custom build scenarios

The assisted options (R&S SMBV-K65/-K67/-K95) and are not limited to be used for A-
GNSS testing exclusively. Despite the predefined scenarios, it is also possible to
define any user-specific test scenario.

For testing of stand-alone GNSS receivers, the assisted options offer full flexibility on
the simulated satellites including definition of the complete navigation message. The
simulation mode "User Localization" can be used to get an optimal satellite's constella-
tion and to adjust the navigation message to the exact requirements.

The basic BeiDou option (R&S SMBV-K107) is sufficient for this kind of tests. Addi-
tional assisted option is not required.

The generic workflow is described in chapter 2.10.5, "Generating A-GPS Custom Build
Scenarios (User Localization Mode)", on page 37.

2.3.4 Generation of assistance data

Besides generating the satellite signals for predefined test scenario, the assisted
options (R&S SMBV-K65/-K67/-K95) are also able to provide all kinds of assistance
data in line with the simulated scenario which can be provided to the UE by a protocol
tester.

Certainly, this also applies to user-defined test scenarios.

For the generation of A-BeiDou user-defined test signals, the basic BeiDou option
(R&S SMBV-K107) is sufficient. Additional assisted option is not required.
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Refer to chapter 2.9.1, "Example of A-GPS Test Setup", on page 34 for an example
of the A-GPS setup. The generic workflow is described in chapter 2.10.8, "Generating
GNSS Assistance Data", on page 39.

2.4 Realtime Option Extension to 12 / 24 Satellites
(R&S SMBV-K91/-K96)

These options extend the maximum number of simulated satellites.
● Instrument equipped with the option R&S SMBV-K91 is enabled to generate the

signal of up to 12 configurable satellites.
Any hybrid 12-satellite configuration is possible, for example a combination like 10
C/A GPS + 1 Galileo E1 + 1 GLONASS R-C/A. The available satellites depend on
the availability of the basic options, respectively on the enabled standards in the
"GNSS System Configurations" and the selected "RF Band"

● The R&S SMBV-K96 requires the option R&S SMBV-K91 and further extends the
maximum number of simulated satellites.
Instruments equipped with this combination are enabled to generate the signal of
up to 24 GPS C/A, Galileo E1, Glonass R-C/A and BeiDou B1-C/A satellites if the
respecitvely GNSS basic option or a combination there of is available.
The option R&S SMBV-K96 does not enhance the number of P-code satellites/
taps.

2.4.1 Channel Budget

There is a limitation of the maximum number of simulated satellites, depending on
whether P code signal and BeiDou satellites are enabled in the GNSS system configu-
ration or not.

Without satellites using position accuracy (P-Code) signals

The generation of up to 24-GPS C/A, Galileo E1 and/or GLONASS satellites hybrid
signal is possible when no P-Code signals are activated. For the Use Position Accu-
racy (P-Code) GPS= Off case the following rules apply:
● The total number of available resource units depends on the "Activate GNSS

Standards > BeidDou" state as follows:
– 14a + 10 b, if "BeidDou = Off"
– 24a, if "BeidDou = On"

● Any of the GPS C/A, Glonass R-C/A and BeiDou B-C/A satellite/multipath tap
channel consumes 1a or 1b resource units

● A Galileo E1 satellite/multipath tap consumes 1a or 2b
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Example: 
The table 2-6 lists some of the GNSS constellations with 24 satellites that can be ach-
ieved.
Table 2-6: Possible GNSS hybrid configurations with 24 satellites

GPS C/A signal Galileo E1 signal GLONASS R-C/A sig-
nal

BeiDou B-C/A

24 0 0 0

12 0 12 0

8 8 8 0

12 0 0 12

0 0 0 24

8 0 8 8

5 2 5 10

etc.    

With activated P-code in the GNSS system configuration

For enabled Use Position Accuracy (P-Code) GPS or Maximum Number of Satellites is
less or equal to 24, only a subset of hybrid GNSS configurations are possible (see
table 2-8).

The table 2-7 describes the number of C/A and P-Code resource units needed per sig-
nal when both the C/A GPS and position accuracy P-Code GPS signals are activated
in GNSS system configuration.

Table 2-7: Number of resource units required per signal

Standard Required option "Signal" c

C/A resource units

p

P-code resource
units

GPS R&S SMBV-K44 C/A 1 0

   0 1

 R&S SMBV-K44 and

R&S SMBV-K93

P 0 1

  (C/A+P)Q 1 1

   0 2

Galileo R&S SMBV-K66 E1 2 0

   1 1

   0 2

GLONASS R&S SMBV-K94 R-C/A 1 0

   0 1
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Standard Required option "Signal" c

C/A resource units

p

P-code resource
units

BeiDou R&S SMBV-K107 B-C/A 1 0

   0 1

Example: 
According to the table, the GPS (C/A+P)Q signal requires 1c + 1p or 2p units.
The total available budget when GPS and P-code signals are activated in a hybrid
GNSS system configuration is 12c + 12p.

Instruments equipped with R&S SMBV-K92 can generate multipath signal. The gener-
ation of multipath satellite signal with n taps requires n times more resource units.

Example: 
The table 2-8 lists some of the GNSS constellations that can be achieved based on the
table 2-7.
Table 2-8: Possible GNSS hybrid configurations

GPS (C/A +P)Q
signal

GPS P signal GPS C/A signal Galileo E1 signal GLONASS R-C/A
signal

12 0 0 0 0

11 0 0 0 2

10 0 0 1 2

9 0 0 2 2

8 4 4 0 0

8 4 2 0 2

8 0 8 0 0

8 0 4 0 4

8 0 0 0 8

8 0 0 4 0

8 0 3 2 1

8 0 0 3 2

8 0 0 2 4

8 0 0 1 6

7 0 0 3 4

6 0 0 4 4

5 0 0 3 8
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2.5 Functional Overview of Realtime Option GNSS
Enhanced (R&S SMBV-K92)

This option enhances the basic options R&S SMBV-K44/K66/K94/K107 with the follow-
ing functionality:
● support of motion files
● smoothening of the used defined trajectories
● real time motion vectors or hardware in the loop (HIL)
● modeling static multipath profiles
● configuration of atmospheric effects
● system time conversion
● leap second simulation parameters.

For detailed description see:

● Moving Scenarios....................................................................................................26
● Static Multipath Signal Generation..........................................................................27
● Configuration of the Atmospheric Parameters........................................................ 27
● Time Conversion Configuration...............................................................................27
● Leap Second Simulation......................................................................................... 28
● Internal Waypoint Resampling................................................................................ 28
● Motion Smoothening Using Vehicle Description File.............................................. 28
● Hardware in the Loop (HIL).....................................................................................29

2.5.1 Moving Scenarios

The option GNSS enhanced (R&S SMBV-K92) enhances the basic GNSS options by
user-definable moving scenarios.

The following test scenario require moving scenario:
● A-GPS test scenarios for 3GPP FDD and GSM (Performance Test Scenario#3)
● CDMA test case "3GPP2 Moving Test Scenario"
● A-GNSS Scenario 5 for EUTRA/LTE

Another application field of the moving scenarios is the testing of stand-alone GNSS
receivers.

In the R&S SMBV, a movement, i.e. a moving receiver is defined in one of the follow-
ing ways:
● by a waypoint file that simulates a "moving" of the connected GNSS receiver

A waypoint can be defined with:
– the WGS 84 geodetic coordinates, see chapter A.1.1.1, "Waypoint File For-

mat", on page 293
– the East-North-Upper (ENU) 2D vector trajectoryparameters (line, arc), see

chapter A.1.1.2, "Vector Trajectory File Format", on page 294
● by extracting of the the location data from the NMEA files, see chapter A.3, "NMEA

Scenarios", on page 306
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● by configurable locations in Cartesian or geodetic coordinates with potentially
defined velocity vector or velocity magnitude parameters in the *.xtd file, see
chapter A.1.1.4, "Trajectory Description Files", on page 296

● by the provided predefined waypoint files for the land, ship, aircraft and spacecraft
vehicles

● by the KML file format of third-party software, like the Google Earth, Google Maps
etc. For description of the file format, refer to the Google Earth documentation.

Moving vs. motion
All these file formats describe a moving receiver and are suitable for the simulation of a
movement from one waypoint to the next.
Howerver, only the more extensive file format *.xtd is suitable to describe a motion
including high dynamics e.g. velocity and attitude. In instruments equipped with the
R&S SMBV-K103 option, this file format simulates additionally a body rotation and atti-
tude profile of the receiver’s vehicle.
See also chapter 2.8, "Realtime Option GNSS Extension for Spinning and Attitude
Simulation (R&S SMBV-K103)", on page 33.

2.5.2 Static Multipath Signal Generation

The instrument provides the possibility to simulate the GNSS signal of one or more sat-
ellites that undergoes static multipath propagation effects.

The generic workflow is described in chapter 2.10.9, "Generating Multipath Scenarios",
on page 40.

2.5.3 Configuration of the Atmospheric Parameters

In instruments equipped with the option GNSS enhanced (R&S SMBV-K92), the iono-
spheric navigation parameters and both ionospheric and tropospheric models of the
installed GNSS standards are enabled for configuration.

A possible application of the activation and deactivation of the ionospheric and tropo-
spheric models is to simulate the variation in the pseudorange of the corresponding
GNSS satellites. The ionospheric navigation parameters only define what the satellites
are transmitting as ionospheric correction parameters whereas the model configuration
describes the actual ionospheric and tropospheric models used in the satellite-receiver
channel simulation.

2.5.4 Time Conversion Configuration

The instrument supports an advanced function for transformation of the GNSS time to
the universal time coordinate basis (UTC) and vice versa. The provided GNSS system
time conversion parameters are zero-order and first order system clock drift parame-
ters in addition to the current leap second. The leap second describes the difference
between the GPS, Galileo, GLONASS or BeiDou system time and UTC system time. It
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is for example possible to simulate a system time drift between GPS and Galileo by
configuring different time conversion sets for both UTC-GPS and UTC-Galileo conver-
sion parameters.

The time conversion parameters can be either manually configured or fetched from the
RINEX header. It is recommenced to keep the default configurations without system
time offset and/or drift.

2.5.5 Leap Second Simulation

The instrument enables the simulation of leap second in a straightforward way. The
simulation requires only the date and sign of the next leap second, further calculations
are performed automatically.

2.5.6 Internal Waypoint Resampling

For the simulation of motion and body rotation, the R&S SMBV uses a 100 Hz internal
resolution. The motion files you load into the instrument may contain waypoint and/or
attitude coordinates with a resolution that is either not constant or different than the
internally used one. The R&S SMBV interpolates (resamples) externally supplied files
and transform the user-defined rates to the internal resolution.

The internal resampling algorithm is based on the great circle approximation. The
instrument resamples the vehicle attitude (yaw/heading, pitch/elevation, roll/bank)
parameters linearly in a common reference basis. Depending on the contents of the
motion file, in particular on the way the velocity is defined, the resampling is performed
accordingly.

2.5.7 Motion Smoothening Using Vehicle Description File

The selected motion file (e.g. waypoint file) may contain a set of random waypoints,
without knowledge about the realistic dynamic. Smoothening is a function that regener-
ates the motion file based on the specified maximum dynamics (speed, acceleration
and jerk) and sampling rate, as they are defined in the vehicle description file *.xvd.

This approach ensures smoothening of the abrupt changes in the direction or in the
velocity of a moving object.

Main characteristics of the smoothening algorithm:
● modified version of linear segment parabolic blend algorithm (LSPB)
● guaranteed continuity in acceleration (limited Jerk) between the waypoints

The smoothening algorithm uses a user-defined proximity parameter to determine:
● the maximum deviation from the user’s input waypoints
● the number of inserted waypoints along the great circle

With a proximity value of zero, the motion is formed entirely of straight segments. At
any of the specified waypoints, each direction change causes a motion stop.
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For more information, refer to chapter A.4.1, "Detailes on the Smoothening Algorithm",
on page 307.

For description of the file formats, refer to chapter A.1.1, "Movement or Motion Files",
on page 293 and chapter A.1.2, "Vehicle Description Files (Used for Smoothening)",
on page 300.

2.5.8 Hardware in the Loop (HIL)

The term Hardware in the Loop (HIL) describes the mode in which the R&S SMBV acts
as a slave and is remotely controlled by master application software (see figure 2-2).
The application software sends remote control commands in real time, possibly from a
flight simulator. The R&S SMBV processes the received position, motion and attitude
information and generates the required signal. The output GNSS signal is provided
back to the application or to the flight simulator.

Fig. 2-2: Example of HIL test setup

To compensate for system latency, the R&S SMBV applies a prediction algorithm. The
instrument uses the high order dynamics of the master application software and pre-
dicts the user’s position at the subsequent GNSS signal update time.

The R&S SMBV accepts the real time HIL commands with a varying time resolution up
to 100 Hz. If you enable the R&S SMBV to generate a 1PPS marker signal and syn-
chronize the flight simulator to it, the flight simulator sends the real time commands
right after 1PPS. This ensures a prediction latency of 10 ms.
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See also chapter 4.7, "Hardware in the Loop (HIL)", on page 190.

2.6 Realtime Option GNSS Extension for Obscuration
Simulation and Automatic Multipath (R&S SMBV-
K101)

This option requires one of the basic realtime GNSS options R&S SMBV-K44,
R&S SMBV-K66, R&S SMBV-K94 or R&S SMBV-K107. The automatic multipath func-
tionality additionally requires the option R&S SMBV-K92.

In a real-word scenario, a static or a moving receiver may not always receive the signal
of all theoretically visible satellites for its current position. In rural or suburban areas, in
tunnels or in car parking places, some or more satellites may be partly or completely
obscured by a wall or other vertical plane. Receivers experience additionally effects of
signal reflection caused by a water surfaces (e.g. the sea) or the ground. This option
enhances the basic GNSS options to automatically simulate different obscuration and
multipath effects caused for example from surrounding buildings in static or moving
scenarios, e.g. urban canyon.

The figure 2-3 is an example of a receiver placed in a car driving on a street. The com-
bination option R&S SMBV-K101/-K92, allows you to define any test scenario, includ-
ing the particular moving behavior and surrounding buildings with their height and the
distance to the receiver, as well as the material they are built from.

Fig. 2-3: Example: Vertical obstacles for simulation of obscuration and multipath from surrounding
buildings

Approaches in the different simulation modes

In "User Localization" mode, the simulated user's environment conditions and effects
are applied on the user defined subset of satellites.
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In "Auto Localization" mode, the optimal satellites constellation is selected based on
the enabled "Maximum Number of Satellites" and configured "Evaluation Mask". A line-
of-sight propagation (LOS view) is assumed in the first stage and the satellites constel-
lation is selected to minimize the HDOP/PDOP. Only now, the selected constellation is
filtered by simulating the “user environment” model’s obscuration and multipath effects
on the satellite constellation. The satellite constellation is constantly proved and a sat-
ellite handover is performed automatically, whenever a new satellite appears or
because of the receiver's movement profile, a satellite is not any more obscured.

To simulate a real-life scenario, it is recommended that you enable a hybrid GNSS
simulation with 24 satellites. Refer to the corresponding description for an overview of
all required options.

Internal sampling rate

The R&S SMBV samples the user's environment different, depending whether only
obscuration or the combination of obscuration and automatic multipath is simulated.
For example, the sampling rate of the model "Urban canyon" is 10 Hz if only obscura-
tion is enabled and 5 Hz in the other case.

Error Message: Cut in the scenario dynamics
If a multipath scenario requires more than the maximum available channel budget, the
instrument cuts the scenario dynamics.
See also chapter 2.4.1, "Channel Budget", on page 23.

2.7 Realtime Option GNSS Extension for Antenna Pattern
(R&S SMBV-K102)

This option requires one of the basic realtime GNSS options R&S SMBV-K44,
R&S SMBV-K66, R&S SMBV-K94 or R&S SMBV-K107.

This option enhances the basic options with the definition of different antenna patterns,
body masks and the simulation of real-life scenarios, like a GNSS antenna placed in a
car (see table 2-9). The instrument provides an interface for loading user-defined
antenna patterns. The antenna patterns have to be defined in files with predefined file
format and file extension *.ant_pat (seechapter A.1.3, "Antenna Pattern / Body
Mask Files", on page 301 ).

Possible application fields

This option enables you to automatically simulate satellite power and carrier phase
depending on the antenna pattern and the attitude parameters.
● Automotive applications

The provided attitude parameters can forced to the motion direction, i.e. they are
automatically extracted from the user-defined motion vector.

● Body mask applications
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Two files describe an antenna, the antenna pattern *.ant_pat file and the phase
response *.phase file.
Both files must have the same file name and must be stored in the same directory.
The *.ant_pat file describes the power response matrix of each antenna. The
instrument retrieves the phase response matrix from the *.phase file.
If the required *.phase file does not exist, the instrument sets the carrier phase
matrix to zero.

● Outdoor scenarios
If the instrument is equipped with both options R&S SMBV-K101/-K102, the
antenna pattern is applied on reflections from the defined user environment, e.g
roadside plane.

● Indoor absorption scenarios
The provided antenna pattern can be used to simulate the signal absorption as well
as the carrier phase bias from every angle around a GNSS receiver.

The provided *.ant_pat file format enables you to define up to four antennas per
vehicle and to perform antenna switching trough real time scheduling (see
<subsystem>: APATtern: ANTenna: ID). The resolution of the antenna pattern
power response and carrier phase offsets can go to 1° for both, the elevation and azi-
muth.

Table 2-9: Example: Power response matrix due to a car's body mask

Power and phase
profile of an
antenna

Car body mask Power response matrix of the antenna
(*.ant_pat file)

You can also load antenna patterns measured by some over-the-air (OTA) measure-
ments, e.g the R&S®DST200 RF Diagnostic Chamber.
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2.8 Realtime Option GNSS Extension for Spinning and
Attitude Simulation (R&S SMBV-K103)

This option requires the GNSS option R&S SMBV-K102.

This option allows you to configure a vehicle attitude or the body rotation parameters
yaw, pitch, and roll. The R&S SMBV calculates the power and the carrier phase
response of a specific satellite or a multipath reflection at a specific angle of arrival
(AoA). The calculation is based on the defined attitude profile and the selected antenna
pattern. The firmware updates the powers and carrier phase offsets of all satellite sig-
nals in real time and with an update rate of 800 Hz.

In a real-word scenario, a receiver placed in an airplane may not always receive the
signal of all theoretically visible satellites at its current position. Depending on the ori-
entation of the vehicle, several satellites may be partly or completely obscured. The
orientation of the vehicle is described with the three flight dynamics parameters, the
yaw (heading), pitch (elevation) and roll (bank), see figure 2-4. With enabled spinning,
the instrument additionally simulates a constant rate of change of the roll.

Fig. 2-4: Flight dynamics parameters: yaw/heading, pitch/elevation and roll/bank
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2.9 Realtime Test Setups

2.9.1 Example of A-GPS Test Setup

Fig. 2-5: Example of A-GPS Test Setup

2.10 Typical Realtime Workflow

The workflow examples provided in this section assume an instrument, fully equipped
with all available GNSS options.

2.10.1 General Workflow

This section introduces the general workflow for configuring the primary settings, that
are common for almost all further configurations workflow. The block diagram on the
figure 2-6 shows an overview of the common configuration steps.
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Fig. 2-6: General workflow

Typical Realtime Workflow
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2.10.2 Generating GNSS Signal for Simple Receiver Tests (Static Mode)

1. Perform steps 1 to 3 according to General Workflow.

2. If required, select "GNSS System Configuration" and enable a hybrid GNSS satel-
lite constellation.

3. Select "GNSS Main Dialog > Simulation Mode > Static".

4. Perform relevant steps 9 to 17 from General Workflow.

5. Select "GNSS Main Dialog > State > ON".

The generated GNSS signal is calculated according to the satellite configuration
settings, the selected almanac file and selected moment of time (date and time).

2.10.3 Generating GNSS Signal with Automatic Dynamic Exchange of the
Satellites (Auto Localization Mode)

1. Perform steps 1 to 3 according to General Workflow.

2. Select "GNSS Main Dialog > Simulation Mode > Auto Localization".

3. Perform relevant steps 6 to 17 from General Workflow.

4. Select "GNSS Main Dialog > State > On".

The instrument generates the GNSS signal for the selected satellites' constellation,
calculated to fulfill the minimum PDOP and satellite visibility criteria. The selected
satellites are dynamically and on-the-fly exchanged as soon as an exchange of
satellites is necessary. The satellites parameters displayed in the "Satellite Config-
urations" dialog and the "Navigation Message" parameters are read-only.
Open the Real-Time S.P.O.T. display to show the position of the active and inac-
tive satellites. The current values of the parameters "PDOP/HDOP", "Receiver
Location" and simulation "Time" are also displayed. If a moving receiver has been
configured, the "Real-Time S.P.O.T. > Map View" displays the trajectory the
receiver should have.

2.10.4 Generating GNSS Signal with Manual Exchange of the Satellites
(User Localization Mode)

1. Perform steps 1 to 3 according to General Workflow.

2. Select "GNSS Main Dialog > Simulation Mode > User Localization".

3. Perform steps 6 to 18 from General Workflow.
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a) To reproduce the exact satellite navigation message, it is recommended to
select a RINEX file, if one exists.
For more information, see chapter 2.10.11, "Configuring the Navigation Param-
eters", on page 41.

b) If required, select "GNSS Main Dialog > Satellite Configuration > Atmospheric
Configuration" and adjust the settings.

c) If required, select "GNSS Main Dialog > Satellite Configuration > Time Conver-
sion Configuration" and adjust the settings.

d) Select "GNSS Main Dialog > Satellite Configuration > Power Mode > Auto" to
enable the dynamic automatic calculation of the power level and adjust the
required power settings.
For more information, see chapter 2.10.12, "Adjusting the Power Settings",
on page 42.

4. Select "GNSS Main Dialog > State > On".

The instrument generates the GNSS signal for the selected satellites' constellation.
The satellite parameters can be additionally reconfigured to simulate multipath
effects for instance (see also chapter 2.10.9, "Generating Multipath Scenarios",
on page 40).
Open the Real-Time S.P.O.T. display to show the position of the active and inac-
tive satellites. The current values of the parameters "PDOP/HDOP", "Receiver
Location" and simulation "Time" are also displayed. If a moving receiver has been
configured, the "Real-Time S.P.O.T. > Map View" displays the trajectory the
receiver should have.

5. To trigger a manual satellite's exchange for Sat#3 for instance, select "GNSS Main
Dialog > Satellite Configuration > Sat#3 > State > Off".

6. Select "Satellite Configuration > Sat#3 > Navigation Message" and adjust the
parameters as required.

7. Enable the satellite again or add a new satellite to the satellite's constellation.

The Real-Time S.P.O.T. displays the updated position of the active and inactive
satellites.

2.10.5 Generating A-GPS Custom Build Scenarios (User Localization
Mode)

This description lists the steps necessary to configure an A-GPS custom build scenario
and explains the configuration in principle. The required steps for the other assisted
scenarios are analogical.

1. Perform steps 1 to 3 according to General Workflow.

2. Select "GNSS Main Dialog > Simulation Mode > User Localization".

3. Perform steps 6 to 19 from from General Workflow.
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a) It is recommended to select a RINEX file, if one exists.
For more information, see chapter 2.10.11, "Configuring the Navigation Param-
eters", on page 41.

b) Select a start simulation time around to beginning of the ephemeris span.
For GPS, the age of ephemeris is 2 hours and the selectd simulation time is
aligned to the even hours of the day, for example, 00:00, 02:00, 04:00 etc.
See also chapter 2.1.9, "Simulation of uninterrupted location fix", on page 17.

c) Disable "Satellite Configuration > Global Ephemeris Real-Time Projection".
d) Select "Satellite Configuration > Sat# > Navigation Message" and adjust the

parameters as required.
Note: The parameters "Satellite Configuration > Global Ephemeris Real-Time
Projection" and "Satellite Configuration > Sat# > Navigation Message > Real-
Time Projection" must be disabled!

e) Select "GNSS Main Dialog > Satellite Configuration > Power Mode > User" and
adjust the required power settings.
For more information, see chapter 2.10.12, "Adjusting the Power Settings",
on page 42.

4. Select "GNSS Main Dialog > State > On".

5. Generate the required "Assistance Data" (see also chapter 2.10.8, "Generating
GNSS Assistance Data", on page 39).

The instrument generates an A-GPS signal according to the settings made.

2.10.6 Generating A-GPS Test Signal

The generic workflow for generation of A-GPS test scenarios in conformance to A-GPS
2G/3G Protocol and Conformance Test Cases is as follow:

1. Execute "GPS Main Dialog > Set To Default" to adjust the instrument's settings to a
standard set of operating conditions.

2. Select "GPS Main Dialog > Test Scenario > A-GNSS" and select a predefined
GSM, 3GPP FDD, 3GPP2 (CDMA2000) or EUTRA/LTE test scenario.
See also chapter 2.3.2, "Full Set of Pre-defined Test Scenarios as Basis for A-
GPS/A-GLONASS/A-GNSS Protocol and Conformance Test Cases", on page 20.

3. Select "GNSS Main Dialog > State > ON".

The instrument generates an A-GPS signal according to the selected test scenario.
Refer to the corresponding specification and customize the test scenario signal for
the predefined specific test case, i.e. perform the necessary changes on the satel-
lite constellation, receiver location, simulation time and power settings.
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2.10.7 Generating A-GNSS Test Signal

The generic workflow for generation of A-GNSS test scenarios in conformance to Pro-
tocol and Conformance Test Cases is as follow:

1. Select "GNSS Main Dialog > Set To Default" to adjust the instrument's settings to a
standard set of operating conditions.

2. Select "GNSS Main Dialog > Test Scenario > A-GNSS" and select a predefined
3GPP FDD or EUTRA/LTE test scenario, e.g. "3GPP TS 37.571-2: S7 Signaling
ST4".

3. Select "GNSS Main Dialog > State > ON".

The instrument generates an A-GNSS signal according to the selected test sce-
nario.
Refer to the corresponding specification and customize the test scenario signal for
the predefined specific test case, i.e. perform the necessary changes on the satel-
lite constellation, receiver location, simulation time and power settings.

2.10.8 Generating GNSS Assistance Data

This step-by-step description explains the configuration in principle.

In hybrid A-GNSS scenario, generate the assistance data of the GNSS standards sep-
arately in different files.

1. Select "GNSS Main Dialog > Simulation Mode > User Localization" and perform
the required settings (see e.g. chapter 2.10.5, "Generating A-GPS Custom Build
Scenarios (User Localization Mode)", on page 37).

2. Execute "GNSS Main Dialog > Assistance Data" and select the "Assistance Mode
> A-GPS/A-Galileo/A-GLONASS".

3. Select "Synchronize All" to align the assistance data settings with the settings that
have been already made for the satellites of the selected standard.

4. If required, reselect the space vehicles for which assistance data is to be gener-
ated.

5. Reconfigure the reference location (i.e. enter the coordinates of the BS location
instead of receiver location).

6. Adjust the "Duration" and the "Resolution" of assistance data.

7. Select the "Assistance Data generation > Acquisition Data Format".
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8. Generate the required assistance data (almanac file, ionospheric file, etc.).

The generated assistance data files are stored in the selected folder. Refer to the
description of the corresponding file for description of the file format used.

2.10.9 Generating Multipath Scenarios

1. Perform steps 1 to 3 according to General Workflow.

2. Select "GNSS Main Dialog > Simulation Mode > User Localization".

3. Select "Satellite Configuration > Sat# > Multipath".

4. Select the "Number of Taps" and configure the additional "Time Shift", "Power",
"Doppler Shift" and "Carrier Phase" per tap.

5. Select "Multipath Configuration > State > On".

The graph displays the selected propagation conditions.

Fig. 2-7: Example of "Multipath Configuration"

6. Select "GNSS Main Dialog > State > On".

The instrument will generate the GNSS signal of satellites that experience static
multipath propagation.

2.10.10 Generating GPS Signal Modulated with P Code

1. Perform steps 1 to 3 according to General Workflow.

2. In the "GNSS System Configuration" dialog enable "Activate GNSS Standards >
GPS".
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3. Enable "GNSS System Configuration > Use Position Accuracy (P-Code)".

4. In "Simulation Mode > User Localization", select "Satellite Configurations > Sat# >
Standard > GPS" and enable "Signals > P" or "C/A+P" for this GPS satellite as
required.

Tip: Not enough hardware resources. This warning message appears and the sat-
ellite is disabled if the available hardware resources are not enough to generate
the desired signal.
Hybrid GNSS constellations, multipath configurations, signals modulated by P code
and activated satellites consume hardware resources. Refer to chapter 2.4.1,
"Channel Budget", on page 23 for description on the how the available hardware
resources are distributed.

5. In "Simulation Mode > Auto Localization", select "Satellite Configurations > Global
Signal Config" and adjust the signals of the GPS satellites.

6. Perform relevant steps 5 to 19 from General Workflow.

7. Select "GNSS Main Dialog > State > ON".

The instrument generates the GNSS signal for the selected satellites' constellation.

2.10.11 Configuring the Navigation Parameters

Extracting the navigation message from the almanac file

► Select "GNSS Main Dialog > Almanac" and select an almanac file.

The almanac file is used to extract all navigation parameters. These parameters
are transmitted as part of the navigation message.

Manual configuration of the navigation parameters

1. Select "GNSS Main Dialog > Simulation Mode > User Localization".

2. Select "GNSS Main Dialog > Satellite Configuration > Sat# > Navigation".

3. Adjust the "Navigation Message Configuration > Number of Pages"

4. Select "Navigation Message Configuration > Page Number" and configure the con-
tent of the selected ephemeris page(s).

5. Repeat steps 2 to 4 for all GNSS satellites

Extracting the ephemeris, the satellite clock correction parameters and the GLO-
NASS frequency numbers from RINEX file

1. Select "GNSS Main Dialog > Simulation Mode > User Localization".

2. Select "GNSS Main Dialog > RINEX" and select RINEX file.

3. Select "GNSS System Configuration > RINEX Configuration > Import RINEX Files".
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4. Enable "GNSS System Configuration > RINEX Configuration > Update Frequency
Number (GLONASS) > On".

5. Select "GNSS System Configuration > RINEX Configuration > State On".

The ephemeris and satellite clock correction part of the navigation message are
extracted from the selected RINEX file for a GNSS system and used to simulate
the position of the satellites of this particular GNSS system. If a GLONASS file is
used, the frequency number allocations are also extracted.
The ephemeris and the clock correction parameters and, for GLONASS satellites,
the frequency number allocation of all satellites that are not available in the RINEX
files or had not been configured manually are extracted from the selected almanac
of the corresponding GNSS system.

Extracting the ionospheric and time conversion parameters from RINEX file

1. Select "GNSS Main Dialog > Simulation Mode > User Localization".

2. Select "GNSS Main Dialog > RINEX" and select RINEX file.

3. Perform "GNSS System Configuration > RINEX Configuration > Import RINEX
Files".

4. Enable "GNSS System Configuration > RINEX Configuration > Update UTC and
Atmospheric Parameters".

5. Select "GNSS System Configuration > RINEX Configuration > State On".

The ionospheric and time conversion parameters are extracted from the header of
the selected RINEX file.
If required, adjust the extracted ionospheric and time conversion parameters.

2.10.12 Adjusting the Power Settings

Refer to chapter 3.6.1, "Power Configuration", on page 92 for explanation and exam-
ple on the power level calculation.

Power settings in "Auto" power mode

We assume, that the reference power is specified by a reference satellite.

1. Select "GNSS Main Dialog > Satellite Configuration > Power Mode > Auto".

2. Set the "Satellite Configuration > Reference Power".

3. Set the "Satellite Configuration > Reference Satellite".

4. If a hybrid "GNSS System Configuration" is activated, select "Satellite Power Tun-
ing > Inter-Standard Tuning > Set to Standard" to simulate the nominal power dif-
ference between the GNSS standard as defined in the standard.

5. For the satellites undergoing static multipath effects:
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a) Select "Sat# > Multipath Configuration > Power" and adjust the power level of
the corresponding fading tap.

b) Enable "Multipath Configuration > State > On".

6. Set "GNSS Main Dialog > State > On".

The power level of the generated GNSS signal is displayed with the parameter
"Total Power".

The power levels displayed in the "Satellite Configuration > Constellation Table" are
the power level at the simulation's start moment.
Select "Real-Time SPOT > Display Type > Power View" to display the current power
levels.

Power settings in "User" power mode

This power mode is enabled in both "Auto Localization" and "User Localization" simula-
tion modes.

1. Select "GNSS Main Dialog > Satellite Configuration > Power Mode > User".

2. Set the "Satellite Configuration > Reference Power".

3. Set the "Satellite Configuration > Constellation Table > Sat# > Power" level of the
individual satellites.

4. For the satellites undergoing static multipath effects:

a) Select "Sat# > Multipath Configuration > Power" and adjust the power level of
the corresponding fading tap.

b) Enable "Multipath Configuration > State > On".

5. If you work in "Auto Localization" mode, select "Satellite Configuration > Global
Signal and Relative Power Configuration" and allocate the signals and the power
values for the satellites that are not simulated yet.

6. If not already enabled, set "GNSS Main Dialog > State > On".

The power level of the generated GNSS signal is displayed with the parameter
"Total Power".

2.10.13 Handling NMEA Files

1. On your receiver, record the NMEA messages to a log file with an extension
*.nmea.

2. Use an external hard disk, USB stick or a LAN connection and transfer this NMEA
log file to a network directory or the instrument.

3. Select the "GNSS main dialog > Geographic Location > Waypoints".
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4. Select the "GNSS main dialog > Select Waypoint File", navigate to the directory the
loaded NMEA file is stored and select the file.

The instrument decodes the logged NMEA file (*.nmea) and automatically config-
ures the user location to the values retrieved from the logged file. The information
about possible receiver's moving is considered too.
If required, re-configure the automatically applied settings.

The instrument decodes the complete NMEA file but settings related to deactivated or
not installed navigation standards are ignored.

Refer to chapter A.3, "NMEA Scenarios", on page 306 for detailed description of the
NMEA file format.

2.10.14 Creating GNSS Scenarios in a User Environment

The R&S SMBV provides predefined files and settings to simplify the configuration of
common scenarios. If you relay on the predefined files, it is recommended that you use
the combinations listed in table 2-10.

Table 2-10: Suitable configurations

Scenario "Vehicle
Type"

Predefined Vehicle
Description File

Waypoint File "Obscura-
tion&Auto Multi-
path > Type"

"Antenna Pattern/Body
Mask File"

Urban Canyon Pedestrian

Land Vehicle

Pedestrian1.xvd

Land Vehicle1.xvd

Scen_Urban_Can-
yon_1.txt

Urban Canyon Car_Medium

Car_Medium_OpenRoof

SUV

VAN

City Block Pedestrian

Land Vehicle

Pedestrian1.xvd

Land Vehicle1.xvd

Scen_City_Block.txt City Block Car_Medium

Car_Medium_OpenRoof

SUV

VAN

Suburban Pedestrian

Land Vehicle

Pedestrian1.xvd

Land Vehicle1.xvd

Scen_Circle_5km.txt Suburban Area Car_Medium

Car_Medium_OpenRoof

SUV

VAN

Highway/Cutting Land Vehicle Land Vehicle1.xvd Scen_Circle_5km.txt Highway

Cutting

Car_Medium

Car_Medium_OpenRoof

SUV

VAN
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Scenario "Vehicle
Type"

Predefined Vehicle
Description File

Waypoint File "Obscura-
tion&Auto Multi-
path > Type"

"Antenna Pattern/Body
Mask File"

Parking Land Vehicle Land Vehicle1.xvd Scen_Park-
ing_1min.txt

Scen_Park-
ing_10min.txt

Scen_Parking_1h.txt

Parking - 1min

Parking -10 min

Parking -1 h

Car_Medium

Car_Medium_OpenRoof

SUV

VAN

Bridge/Tunnels Land Vehicle Land Vehicle1.xvd Scen_Circle_5km.txt Bridge 1

Bridge 2

Long Tunnel

Multiple Tunnels

Car_Medium

Car_Medium_OpenRoof

SUV

VAN

To configure a city block scenario

This step-by-step description is based on the scenario City Block (see table 2-10) and
explains the configuration steps in principle. The main goal is to demonstrate the
impact of enabled obstacles and multipath effects on the simulated signal.

1. Execute "GNSS Main Dialog > Set To Default" to adjust the instrument's settings to
a standard set of operating conditions.

2. Select "GNSS Main Dialog > GNSS System Configuration" and enable the required
navigation systems, e.g. a hybrid GPS, Galileo and GLONASS configuration.

3. Enable "GNSS Main Dialog > Simulation Mode > Auto Localization".

4. Select "GNSS Main Dialog > Satellite Configuration > Maximum Number of Satel-
lites > 24".

5. Select "GNSS Main Dialog > User Environment > Vehicle Type > Land Vehicle"

6. Select "GNSS Main Dialog > User Environment > Vehicle Description File" and
select LandVehicle1.

7. Select "GNSS Main Dialog > Localization Data" and select "Geographic Location/
Attitude > Waypoints" to enable a moving receiver.

8. In the "Localization Data" dialog:

a) select "Waypoints File > Select Predefined Waypoints", navigate to a prede-
fined moving scenario, e.g. Scen_City_Block.txt and execute "Select"

b) select "Read Out Mode > Round Trip"

Tip: In automotive applications and if the instrument is not equipped with option
R&S SMBV-K103, force the attitude to the motion direction of the vehicle. The atti-
tude parameters are extracted from the selected waypoint file.

9. Select "GNSS Main Dialog > State > On" to enable signal generation.

10. Select "GNSS Main Dialog > Real-Time S.P.O.T > Display Type > Sky View" to
visualize the automatically selected satellite constellation.

Typical Realtime Workflow
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The "Sky View" displays the satellite constellation with the active GNSS satellites.
To observe the movement trajectory, use the "Display Type > Map View".

11. Select "GPS Main Dialog > Obscuration&Auto Multipath > Type > City Block" and
enable "Physical Model > Obscuration Only".

The instrument applies automatically the predefined "Obstacles File > City_Block"
to simulate a real word environment conditions

12. In the "GPS Main Dialog > Real-Time S.P.O.T > Display Type > Sky View", com-
pare the displayed satellite constellation.

Typical Realtime Workflow
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Grey color = invisible satellites, i.e. satellites that are obscured for example by buildings

For the current receiver's position in the selected environment, some of the satel-
lites are not visible.

13. Select "GPS Main Dialog > Obscuration&Auto Multipath" and enable "Physical
Model > Obscuration & Multipath".

14. In the "GPS Main Dialog > Real-Time S.P.O.T > Display Type > Sky View", com-
pare the displayed satellite constellation.

Blue border = satellites receiving an echo signal, for example from multipath

For the current receiver's position in the selected environment, the receiver
receives the reflected signal from several of the invisible satellites.

15. To observe how the signal received by a receiver placed for example in a car
changes:

Typical Realtime Workflow
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a) select "GNSS Main Dialog > Antenna Pattern/Body Mask File > Select Prede-
fined Antenna Pattern"

b) navigate to a predefined antenna pattern file, e.g. Car_Small and execute
"Select"

Green color = visible satellite with antenna power loss

Possible further configurations
● If your goal is to reproduce the exact satellite navigation message as in the reality,

load a RINEX file.
● Adjust the start simulation time. The RINEX file should be around the same day of

the start simulation time.
● Adjust the atmospheric parameters

2.10.15 Simulating the Effect of an Antenna Pattern

1. Execute "GNSS Main Dialog > Set To Default" to adjust the instrument's settings to
a standard set of operating conditions.

2. Select "GNSS Main Dialog > GNSS System Configuration" and enable the required
navigation systems, e.g. a hybrid GPS, Galileo and GLONASS configuration.

3. Enable "GNSS Main Dialog > Simulation Mode > Auto Localization".

4. Select "GNSS Main Dialog > Satellite Configuration > Maximum Number of Satel-
lites > 24".

5. Select "GNSS Main Dialog > User Environment > Vehicle Type > Aircraft"

6. Select "GNSS Main Dialog > User Environment > Vehicle Description File > Select
Predefined Vehicle Description > Aircraft1".
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7. Select "GNSS Main Dialog > Localization Data" and select "Geographic Location/
Attitude > Waypoints" to enable a moving receiver.

8. In the "Localization Data" dialog:

a) select "Waypoints File > Select Predefined Waypoints", navigate to a prede-
fined moving scenario and execute "Select"

b) select "Read Out Mode > Round Trip"
c) set "Yaw/Pitch > From Motion > On"
d) set "Roll > From Spinning > On"
e) set "Spinning Rate > 0.25 Hz"

9. Select "GNSS Main Dialog > User Environment > Obscuration & Auto Multipath"
and configure the settings as displayed on die figure.

10. Select "GNSS Main Dialog > User Environment > Antenna Pattern/Body Mask File
> Predefined/User Defined Files" and navigate to the *.ant_pat file.
In this example, we use an user defined antenna pattern file that describes an
antenna with four sectors, see example "Antenna with four sectors" on page 302.

11. Select "GNSS Main Dialog > State > On" to enable signal generation.

12. Select "GPS Main Dialog > Real-Time S.P.O.T > Display Type > Sky View".

Typical Realtime Workflow
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The display is updated in real time and you can observe how depending on the
current GNSS receiver position, the spinning rate and the current active antenna
sector the received GNSS signal changes.

13. Select "Display Type > Power View".

The power levels of the space vehicles are updated in real time.

Typical Realtime Workflow
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2.11 Generating GNSS Signal with Several Instruments

This section provides example on connection and configuration of two R&S SMBV
instruments for generating common GNSS signal.

Overview of required relevant options

Instrument#1
● option GPS (R&S SMBV-K44)
● GNSS global option R&S SMBV-K91 (Extension to 12 Satellites)
● generation of more than 12 satellites requires additionally GNSS global option

R&S SMBV-K96 (Extension to 24 Satellites)
● option Phase Coherence (R&S SMBV-B90)

Instrument#2
● option GLONASS (R&S SMBV-K94)
● GNSS global option R&S SMBV-K91 (Extension to 12 Satellites)
● generation of more than 12 satellites requires additionally GNSS global option

R&S SMBV-K96 (Extension to 24 Satellites)
● option Phase Coherence (R&S SMBV-B90)

In this description, only the GNSS related settings are discussed. For detailed informa-
tion on cabling and required configuration, refer to:
● R&S SMBV Operating Manual, section "Synchronous Signal Generation"
● Application Note 1GP67 "Phase Adjustment"
● Application Note 1GP84 "Time Synchronous Signals with Multiple R&S SMBV100A

Vector Signal Generators "

The figure 2-8 provides an example of test setup. The two instruments are connected
to work in master-slave mode and the local oscillators (LO) are coupled. The first
instrument provides the second one with its system clock, trigger, reference and LO
signals.
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Fig. 2-8: Example: Connecting two R&S SMBV to generate GNSS signal using common RF frequency

The following lists only the required task related settings.
We assume that the instruments are configured to ensure a carrier phase coherence.

1. In the Instrument#1, perform the required steps according to General Workflow and
configure the instrument to generate GPS signal with 12 or more satellites and "RF
Band > L1/E1" (see also figure 2-1).

a) Select "GPS > GNSS System Configuration > Use Common RF Frequency >
ON".

b) Execute "GPS > Update RF Frequency".

The value in the "Frequency" display in the header of the instrument is set to
1.58565 GHz. The GPS signal is however modulated on the GPS frequency L1 =
1.57542 GHz.

2. In the Instrument#2, perform the required steps according to General Workflow and
configure the instrument to generate GLONASS signal with 12 more satellites and
"RF Band > L1/E1".

a) Select "GLONASS > GNSS System Configuration > Use Common RF Fre-
quency > ON".

b) Execute "GLONASS > Update RF Frequency".

Generating GNSS Signal with Several Instruments
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The value in the "Frequency" display in the header of the instrument is set to
1.58565 GHz. The GLONASS signal is however modulated on the GLONASS fre-
quency L1 = 1.602 GHz.

3. In both instruments, in the "GNSS > Satellite Configuration" dialog, enable:

a) "Reference Satellite > N.A."
b) select the same "Reference Standard"
c) set the same "Reference Power"

2.12 Functional Overview of the Basic Offline GNSS

This section gives an overview of the basic offline options GPS (R&S SMx/AMU-K244),
Galileo (R&S SMx/AMU-K266), GLONASS (R&S SMx/AMU-K294).

2.12.1 Single-satellite GNSS signal

R&S WinIQSIM2 calculates a single satellite GNSS signal, where static satellites with
constant Doppler shifts are provided for simple receiver test, like receiver sensitivity,
acquisition and tracking test, etc. production tests. Selection and configuration of any
localization data, such as receiver location for instance, is not enabled.

A generic workflow is described in chapter 2.12.2.1, "Generating an one-satellite static
generic GNSS signal with R&S WinIQSIM2", on page 53.

2.12.2 Typical Offline Workflow

This section provides some examples of typical workflow by working with one of the
baseic offline options.

2.12.2.1 Generating an one-satellite static generic GNSS signal with R&S WinIQSIM2

The generic workflow for generating a GNSS Satellite (GPS, Galileo, GLONASS or
BeiDou) signal with R&S WinIQSIM2 and saving it as a waveform is as follow:

1. Execute "Set To Default" to adjust the instrument's settings to a standard set of
operating conditions.

2. Select the required "RF Band".

3. Select an arbitrary data or "Real Navigation Data" as "Data Source".

4. When using "Real Navigation Data", use the "Almanac > Almanac File" function
and choose an almanac file.
The navigation message will be automatically formed to be conforming to this
almanac file.
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5. Adjust the "Oversampling" parameter to increase or decrease the sample rate used
to generate the GNSS Satellite Signal

6. Adjust the "Duration of Satellites Simulation".

7. Adjust the date and the simulation time (GNSS Mean Time).

8. Select "Satellite Configurations" and configure the satellite as required, e.g. "Space
Vehicle ID (SV-ID)" and "Doppler Shift".
For disabled "Real Time Navigation Message", the "Initial Code Phase" and the
"Frequency Number" of the GLONASS satellites can be configured.

Tip: For Galileo satellites, enable "BOC(1,1)" modulation instead of "CBOC(6,1)" to
reduce the sample rate required to simulate a certain period of time.

9. Set "State > ON" to enable the GNSS Satellite signal generation.

10. Select the "Generate Waveform File" to save the GNSS Satellite signal to a wave-
form file.

2.12.2.2 Loading and Processing a GNSS Waveform in the ARB of the Rohde&Schwarz
Signal Generator

To load and process a GNSS waveform proceed as follow:

1. Enable the R&S WinIQSIM2 to generate a one-satellite static generic GNSS signal
with constant Doppler shift and generate a waveform file.

2. Connect the R&S WinIQSIM2 to the R&S SMBV.

3. Transfer the waveform file. For detailed description, refer to the R&S WinIQSIM2
Software Manual.

4. In the R&S SMBV, select "Baseband > ARB" and load the waveform.

The instrument loads the waveform in the ARB generator and displays a message,
that states the frequency used during signal generation ("Resulting Frequency").

Tip: Another possibility is to find out the carrier frequency is to use "ARB Wave-
form Info".
Note: The carrier frequency of a R&S SMBV that processes a waveform generated
with the R&S WinIQSIM2 has to match the value of the parameter "Resulting Fre-
quency".

5. Select the FREQ key to set the frequency in the header of the instrument to the
resulting frequency of the generated waveform.

6. Set the "ARB State > On" to enable signal processing.

The R&S SMBV processes the GNSS signal generated by the R&S WinIQSIM2.
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3 User Interface
● The instrument may be equipped with different satellite navigation options. To

access the available satellite standards, select "Baseband block > Satellite Naviga-
tion" and select the desired satellite standard, e.g. GPS.
To simplify the description, the selected satellite standard is referred as an "entry
standard".

● Since most of the parameters provided for configuration are similar and do not
depend on the entry standard, this description uses the SW option GPS/A-GPS
(R&S SMBV-K44/-K65) and the GNSS global options R&S SMBV-K91/-K92/-K96
(Extension to 12 and 24 Satellites/GNSS Enhancements) as a reference.
Satellite standard dependent settings are described separately or the differences
are explicitly stated.

● The GNSS implementation in the R&S WinIQSIM2 is a simplified offline version of
the real-time one and provides the capability to generate an one-satellite generic
signal. Therefore the relevant parameters are adjusted accordingly in R&S WinIQ-
SIM2. You find the differences explicitly stated in the description.

3.1 GNSS Main Dialog

To access the available satellite standards:

► Select "Baseband > Satellite Navigation" and select the desired satellite standard,
e.g. GPS.

The dialog is split into several sections.

The upper section of the dialog is where you enbale the GNSS digital standard, call the
default settings and select the simulation mode.

In the real-time solution, the "User Environment" section comprises the settings of the
satellite signals, the vehicle type and the obscurtion and enabled antenna.
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The "Navigation Data" section comprises the navigation data source settings.

Additionally, you can access settings for configuring the satellite signals, generating
assistance data and displaying the "Real-Time S.P.O.T.".

The screenshots provided in this description show parameter values that have been
selected to illustrate as much as possible of the provided functions and possible inter-
dependencies between them.
These values are not necessarily representative of realistic test situations.

The remote commands required to define these settings are described in chapter 4,
"Remote-Control Commands", on page 155.

3.1.1 General Settings for GNSS Simulation

To access this settings:

► Select "Baseband > Satellite Navigation > GPS".

The provided settings enable you to perform general configurations, like to set the
default settings or access further dialogs.

State
Enables/disables the GNSS signal simulation.

Enabling this standard disables all the other digital standards and digital modulation
modes.
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For R&S SMBV instruments, a continuous GNSS signal is generated for up to 24 satel-
lites in real time mode. The maximum number is determined by the parameter Maxi-
mum Number of Satellites and the maximum value depends on the installed SW
options.

For R&S WinIQSIM2, a time limited GNSS signal is generated for one satellite in offline
mode. The time limited GNSS Signal is continuously played and repeated in the ARB
of the vector signal generator. In this case, the "Restart" marker may be helpful to trig-
ger a GNSS receiver module when simulating an offline generated GNSS Signal.

Note: Enabling the standard sets automatically the "Frequency" and "Level" displayed
in the header of the instrument according to the selected settings, e.g. "RF Band" and
"Total Power" at the simulation start time!

Remote command: 
<subsystem>: STATe on page 159

Set to default
Calls the default settings. The following table gives an overview of the settings. Refer
to the remote-control commands description for the preset value for each parameter.

Note: Use Update RF Frequency function to preset the RF Frequency and level.

Parameter Value

State Not affected by Set to default

RF Band L1/E1

Simulation Mode Static

Almanac GPS_SEM678.txt/GAL_Yuma678.txt/GLO_678.agl/
Beidou_Yuma678.txt

(R&S WinIQSIM2)

Oversampling

Duration of Satellite Simulation

(R&S WinIQSIM2)

2

1s

Data Source PRBS9

System Time Time basis of the entry standard

GNSS System Configuration GPS only, Galileo only, GLONASS only or BeiDou
only (depending on the entry standard)

Satellite configuration  

Maximum Number of Satellites 1

State satellite 1 On

Standard GPS, Galileo, GLONASS or BeiDou (depending on
the entry standard)

Signal C/A, E1-DEF, R-C/A or B1-C/A (depending on the
entry standard)

Remote command: 
<subsystem>: PRESet  on page 159
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Save/Recall
Accesses the "Save/Recall" dialog, i.e. the standard instrument function for storing and
recalling the complete dialog related settings in a file. The provided navigation possibil-
ities in the dialog are self-explanatory.

The file name and the directory it is stored in are user-definable; the file extension is
however predefined.

The follwoing file extension are used: *.gps, *.galileo, *.glonass respectively.

Determines whether the instrument performs an absolute or a differential storing of the
settings.

Enable this function to accelerate the saving process by saving only the settings with
values different to the default ones.

Note: This function is not affected by the "Preset" function.

Remote command: 
[:SOURce<hw>]: BB: GPS:SETTing: CATalog?  on page 162
[:SOURce<hw>]: BB: GALileo:SETTing: CATalog?  on page 162
<subsystem>: SETTing: STORe on page 162
<subsystem>: SETTing: STORe:FAST  on page 163
<subsystem>: SETTing: LOAD on page 163
<subsystem>: SETTing: DELete on page 163

Data List Management
Accesses the "Data List Management" dialog used to create and edit data lists.

All data lists are stored as files with the predefined file extension *.dm_iqd. The file
name and the directory they are stored in are user-definable.

Note: All data lists are generated and edited by means of the SOURce:BB:DM subsys-
tem commands. Files containing data lists usually end with *.dm_iqd. The data lists
are selected as a data source for a specific function in the individual subsystems of the
digital standard.

Generate Waveform File
(R&S WinIQSIM2 only)

With enabled signal generation, triggers the instrument to store the current settings as
an ARB signal in a waveform file. Waveform files can be further processed by the ARB
and/or as a multi carrier or a multi segment signal.

The file name and the directory it is stored in are user-definable; the predefined file
extension for waveform files is *.wv.

See also:
● chapter 2.12.2.1, "Generating an one-satellite static generic GNSS signal with R&S

WinIQSIM2", on page 53
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● chapter 2.12.2.2, "Loading and Processing a GNSS Waveform in the ARB of the
Rohde&Schwarz Signal Generator", on page 54.

Remote command: 
<subsystem>: WAVeform: CREate  on page 164

Update RF Frequency
(R&S SMBV only)

Sets the "Status Bar > Frequency" display to the resulting frequency. The RF Fre-
quency is calculated automatically depending on the selected RF Band, on the entry
standard and on the enabled navigation standards.

Note: RF Frequency vs RF Band.
● For navigation standards with overlapping carrier frequencies, e.g. GPS and Gali-

leo in the L1/E1 upper RNSS band (see figure 2-1), the RF frequency is the carrier
frequency L1 = E1 = 1.57542 GHz.

● For navigation standards with different RF Frequencies, e.g. GPS and GLONASS
in the L1/E1 upper RNSS band, the resulting RF frequency is located between the
GPS L1 and the GLONASS L1 frequency.

Remote command: 
<subsystem>: PRFFrequency  on page 160

RF Band
Determines the RF band, i.e. the upper or lower RNSS band (see figure 2-1).

The different satellites will be modulated on their corresponding standard carrier fre-
quencies (see table 3-1).
Table 3-1: Carrier frequencies

Navigation Stand-
ard

"RF Band" Carrier Frequency, GHz Required SW Option

GPS L1

L2

1.57542

1.2276

R&S SMBV-K44/-K244

GALILEO E1 1.57542 R&S SMBV-K66/-K266

GLONASS L1

L2

1.602

1.246

R&S SMBV-K94/-K294

BeiDou L1 1.561098 R&S SMBV-K107

Remote command: 
<subsystem>: RFBand  on page 159

Test Scenario
(R&S SMBV only)

Selects a predefined A-GPS/A-GLONASS/A-GNSS test scenario (see chapter 2.3.2,
"Full Set of Pre-defined Test Scenarios as Basis for A-GPS/A-GLONASS/A-GNSS Pro-
tocol and Conformance Test Cases", on page 20 for an overview).

The available test scenarios depend on the installed SW options. The A-GNSS test
cases require hybrid GNSS configuration (see "Activate GNSS Standards"
on page 86).
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All parameters (simulated position, satellite configuration, Almanac, navigation data,
etc.) will be set according to the selected test scenario.

The selection "User Defined" enables the configuration of all parameters.

Remote command: 
[:SOURce<hw>]: BB:GPS: ATSCenario  on page 160
[: SOURce<hw>]: BB:GLONass: ATSCenario  on page 161

Simulation Mode
Sets the simulation mode.

Note: Refer to table 2-1 for an overview of the supported functionality per simulation
mode. Some functionality require additional options.

"Static" The satellite signals are configured by the user.
See also chapter 2.10.2, "Generating GNSS Signal for Simple
Receiver Tests (Static Mode)", on page 36 for R&S SMBV instru-
ments.
For WinIQSIM2, see chapter 2.12.2.1, "Generating an one-satellite
static generic GNSS signal with R&S WinIQSIM2", on page 53.

"Auto Localization"
(R&S SMBV only)
The satellite signals are configured corresponding to a 'real' user
defined location.
Four satellites will be selected depending on the selected almanac.
For instruments equipped with option R&S SMBV-K91/-K96, the num-
ber of configurable satellites is extended to 12 resp. 24. The number
of configurable satellites is adjusted with the parameter Maximum
Number of Satellites.
In this localization mode, a new satellite will be exchanged in real-
time with a current one as soon as the elevation of the latter is less
than the selected Elevation Mask or a new satellite constellation with
better PDOP is found.
The ephemeris are extracted from the almanac and displayed in the
Navigation Message Configuration dialog. The ephemeris data of all
satellites are updated automatically and projected automatically to
ensure that the age of the ephemeris is within the allowed time span.
Whenever a new almanac is selected, the start time of the simulation
will be set to the almanac's TOA (Time of Application).
See also chapter 2.10.3, "Generating GNSS Signal with Automatic
Dynamic Exchange of the Satellites (Auto Localization Mode)",
on page 36.
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"User Localization"
(R&S SMBV only)
User localization mode enables the configuration of the satellites con-
stellation at the beginning of the simulation and editing it in real-time,
i.e. satellites can be enabled or disabled in real-time and without
interruption of the signal generation.
For instruments equipped with assistance option (e.g. R&S SMBV-
K65/-K95/-K67), this mode additionally enables the configuration of
all parameter of the Navigation Message, the generation of assis-
tance data and the loading of RINEX files.
This mode is useful for the generation of A-GNSS test signals differ-
ent than the standardized ones (see chapter 2.10.5, "Generating A-
GPS Custom Build Scenarios (User Localization Mode)",
on page 37).

Remote command: 
<subsystem>: SMODe  on page 160

Oversampling
(R&S WinIQSIM2 only)

Determines the upsampling factor.

A higher upsampling factor improves the filtering but increases the waveform size pro-
portionally. This leads to limitation for the maximum Duration Of Satellite Simulation.

Remote command: 
<subsystem>: FILTer: OSAMpling  on page 164

Duration Of Satellite Simulation
(R&S WinIQSIM2 only)

Determines the duration of the satellite simulation.

The resulting duration of the simulation is calculated as follow:

CarrierF
Shift Doppler1

Simulation Satellite of Duration  Simulation of Duration




where FCarrier is the frequency selected with the parameter "RF Band" on page 59.

The maximum duration of satellite simulation depends on the "Oversampling"
on page 61 and the ARB memory size of the connected instrument.

Remote command: 
<subsystem>: DURation  on page 163

GNSS System Configuration
(R&S SMBV only)

Opens the GNSS System/Almanac Configuration Settings dialog for defining the
GNSS system configuration and selecting the almanac/RINEX files per navigation
standards.

If a hybrid GNSS configuration is enabled, the name of the selected GNSS navigation
standard is displayed next to the button.
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Trigger/Marker, Marker
Calls the menu for selecting the trigger source, for setting the time delay of an external
trigger signal and for configuring the marker signals (see chapter 3.14, "Trigger/Marker/
Clock Settings", on page 145). For R&S SMBV instruments, the currently selected trig-
ger source is displayed to the right of the button.

Note: The trigger and clock functions are available for R&S SMBV instruments only.

Remote command: 
n.a.

Arm
(R&S SMBV only)

Stops signal generation. This button appears only with "Running" signal generation in
the "Armed_Auto" and "Armed_Retrigger" trigger modes.

Signal generation can be restarted by a new trigger (internally with "Execute Trigger"
or externally).

Remote command: 
<subsystem>: TRIGger: ARM: EXECute on page 283

Execute Trigger
(R&S SMBV only)

Executes trigger manually. A manual trigger can be executed only when an internal
trigger source and a trigger mode other than "Auto" have been selected.

Remote command: 
<subsystem>: TRIGger: EXECute  on page 284

Clock
(R&S SMBV only)

Calls the menu for selecting the clock source and for setting a delay (see chapter 3.14,
"Trigger/Marker/Clock Settings", on page 145).

Remote command: 
n.a.

3.1.2 User Environment

The propagation channel between a GNSS satellite and an user is split into three envi-
ronment characteristics:
● Satellite Configuration (orbit and satellite clock errors)
● Atmospheric Configuration (Ionosphere, troposphere)
● User Environment or near user environment (Environment model e.g. Urban can-

yon, vehicle type, vehicle’s aerodynamics, vehicle’s motion and attitude as well as
antenna pattern)

With the "User Environment" parameters you can configure the near field parameters.
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To access this settings:

1. Select "Baseband > Satellite Navigation > GPS".

2. Select "Simulation Mode > Auto Localization/User Localization".

3. Navigate to "User Environment".

Vehicle Type
Sets the vehicle type, e.g "Pedestrian", "Land Vehicle", "Ship", "Aircraft", "Spacecraft",
"HIL (Hardware in the Loop)".

The selected vehicle type determines:
● the GNSS application e.g. automotive with "Pedestrian" and "Land Vehicle"
● the main elements of the vehicle as vehicle description file, localization data,

Obscuration and Multipath models and antenna pattern/body mask.
When changing the selected vehicle type, a corresponding predefined vehicle descrip-
tion files as well as motion files (if necessary) are selected in order to ensure that the
simulated receiver motion maps to the vehicle type and the particular application, e.g.
aeronautics with "Aircraft".

"Aircraft/Spacecraft"
A vehicle motion profile is pre-selected. Simulation with a static loca-
tion simulation is not possible.

"HIL (Hardware in the Loop)"
There are no predefined files available.
The instrument expects the vehicle’s motion and attitude coordinates
in real time from for example an external application software (see
figure 2-2).
Smoothening is not possible.

Remote command: 
<subsystem>: VEHicle: TYPE on page 166

Vehicle Description File
Provides an access to the standard "File Select" dialog to select a user defined vehicle
description file. The vehicle description files are files with extension *.xvd and prede-
fined file format, see chapter A.1.2, "Vehicle Description Files (Used for Smoothen-
ing)", on page 300. The *.xvd files include the limits on the vehicle's dynamics.

The firmware provides some predefined vehicle description files. These files are stored
at a predefined system directory.

If a file is selected, the name of the selected file is displayed.

Remote command: 
<subsystem>: VEHicle: CATalog:USER?  on page 166
<subsystem>: VEHicle: CATalog:PREDefined?  on page 166
<subsystem>: VEHicle: FILE  on page 166

Localization Data
Access to the dialog with setting to configure a 'real' static or moving geographic loca-
tion, see chapter 3.2, "Localization Data", on page 68.

A summary information on the selected location is displayed.
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(Start) Geographic Location
Displays the coordinates of the static geographic location or the coordinates of the start
geographic location as defined in the selected waypoint/attitude file.

See also "Location Coordinates" on page 71 and "Waypoint/Attitude File …"
on page 70.

Obscuration and Auto Multipath
Available in instruments equipped with option R&S SMBV-K101 and enabled "Auto
Localization" or "User Localization" mode, provides an access to the dialog to define
the near environmental model, see chapter 3.3, "Obscuration and Auto Multipath Set-
tings", on page 73.

A summary information on the enabled settings is displayed.

Antenna Pattern/Body Mask File
For instruments equipped with R&S SMBV-K102, provides an access to the standard
"File Select" dialog to select a file, describing the antenna pattern or the body mask.
Several predefined antenna patterns are provided.

If a file is selected, the file name is displayed.

Two files describe an antenna, the antenna pattern *.ant_pat file and the phase
response *.phase file. Both files must have the same file name and must be stored in
the same directory. The *.ant_pat file describes the power response matrix of each
antenna. The instrument retrieves the phase response matrix from the *.phase file. If
the required *.phase file does not exist, the instrument sets the carrier phase matrix
to zero.

With a selected antenna pattern, the instrument simulates the satellite power and car-
rier phase depending on the antenna pattern and attitude parameters. For automotive
applications, enable the parameter "Localization Data > From Motion" to extract the
attitude parameters from the waypoint file.
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For more information, see chapter 2.7, "Realtime Option GNSS Extension for Antenna
Pattern (R&S SMBV-K102)", on page 31 and chapter A.1.3, "Antenna Pattern / Body
Mask Files", on page 301

Remote command: 
<subsystem>: APATtern: CATalog: PREDefined?  on page 167
<subsystem>: APATtern: CATalog: USER? on page 167
<subsystem>: APATtern: FILE on page 167
see also:
<subsystem>: APATtern: ANTenna: LIST? on page 167
<subsystem>: APATtern: ANTenna: ID on page 168
<subsystem>: RT:UPDate: ANTenna  on page 168

3.1.3 Navigation Data

► To access this settings, select "main Dialog > Navigation Data"

With the provided settings you can define the data source for navigation informa-
tion.

Data Source
Selects data source for the navigation information.

Navigation data plays an extremely important role, since they are essential for calculat-
ing the positions of the satellites. It also contains the information about the currently
valid space vehicle IDs.

Arbitrary data is supported only in "Static" mode. In "Auto Localization" and "User
Localization" mode, "Real Navigation Data" is pre-selected and no other data source
can be selected.

"Real Navigation Data"
"Real Navigation Data" (almanac/RINEX) can be downloaded from
the internet and stored on the hard disk of the generator. If required,
re-configure manually the downloaded files.
Hence, neither almanac nor RINEX files for Galileo are available. In
the R&S SMBV, some predicted almanacs and Rinexes are provided
to simulate the movement of Galileo satellites on their designed
orbits.
Use the chapter 3.4, "GNSS System/Almanac Configuration Set-
tings", on page 86 dialog to select the almanac file per navigation
standard.
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"PRBSxx/Data List/Pattern"
Arbitrary data can be used for basic tests on the GNSS signals.
Signals generated in this way can be recognized by a GPS receiver.
However, since there is no real navigation data modulated with the
GNSS spreading code, only the signal level of the simulated satel-
lite(s) as carrier to noise ratio can be measured and displayed by the
receiver (sensitivity test).
A signal of this type is usually sufficient for performing simple function
tests.

The following standard data sources are available:
● "All 0, All 1"

An internally generated sequence containing 0 data or 1 data.
● "PNxx"

An internally generated pseudo-random noise sequence.
● "Pattern"

An internally generated sequence according to a bit pattern.
Use the "Pattern" box to define the bit pattern.

● "Data List/Select DList"
A binary data from a data list, internally or externally generated.
Select "Select DList" to access the standard "Select List" dialog.
– Select the "Select Data List > navigate to the list file *.dm_iqd

> Select" to select an existing data list.
– Use the "New" and "Edit" functions to create internally new

data list or to edit an existing one.
– Use the standard "File Manager" function to transfer external

data lists to the instrument.
See also "Main Dialog > Data List Management".

Remote command: 
<subsystem>: NAVigation: DATA  on page 175
<subsystem>: NAVigation: DATA: DSELect on page 176
<subsystem>: NAVigation: DATA: PATTern on page 176

Almanac/RINEX
Opens the GNSS System/Almanac Configuration Settings dialog.

One almanac file and one RINEX file per navigation standard can be selected. The
available navigation standards depend on the installed options.

Selection of RINEX files is enabled for "User Localization" mode and requires installed
assistance option of the navigation standard used as an entry standard.

For description of the RINEX file format, see chapter A.2, "RINEX Files", on page 303.

Time Conversion Configuration
Opens the Time Conversion Configuration dialog.
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System Time
Determines the time basis used to enter the simulation start time. Per default, the time
basis of the entry standard is used but the user may choose or switch to a different
time basis at any time. The time is then automatically recalculated and displayed in the
selected time format.

Note: Use the Time Conversion Configuration dialog to configure the parameters, nec-
essary for time conversion between the navigation's standard proprietary time and the
UTC.

Remote command: 
<subsystem>: NAVigation: SIMulation: TBASis on page 176

Date [dd.mm.yyyy]
(enabled for "Data Source > Real Navigation Data" and "System Time > UTC/GLO")

Enters the date for the simulation in DD.MM.YYYY format of the Gregorian calendar.
The simulation time is not limited to the almanac week.

In "Auto Localization" mode, the default value of this parameter depend on the
selected almanac file. The retrieved value is the week day corresponding to the TOA of
the entry standard.

Remote command: 
<subsystem>: NAVigation: SIMulation: DATE on page 176

Time [hh:mm:ss:xxx]
(enabled for "Data Source > Real Navigation Data" and "System Time > UTC/GLO")

Enters the exact simulation start time in UTC time format.

In "Auto Localization" mode, the default value of this parameter is equal to the TOA of
the almanac that corresponds to the navigation standard used as an entry standard.

Remote command: 
<subsystem>: NAVigation: SIMulation: TIME  on page 177

Week Number
(enabled for "System Time > GPS/GST/BDT")

Enters the week number (WN) the navigation signal is generated for.

The satellite clocks in the GPS and Galileo navigation systems are not synchronized to
the UTC one but use a proprietary time, e.g. the GPS/Galileo System Time. The format
used for these system time basis is week number and Time of Week (TOW).

The weeks are numbered starting form a reference point of time (WN_REF=0), that
depends on the navigation standard:
● GPS reference point: January 6, 1980 (00:00:00 UTC)
● GALILEO reference point: August 22, 1999
● BeiDou reference point: Januar 01, 2006
The default value of this parameter is equal to the Week of the almanac that corre-
sponds to the navigation standard used as an entry standard.

The parameter is only available if data source "Real Navigation Data" is selected.

Remote command: 
<subsystem>: NAVigation: SIMulation: WNUMber  on page 177
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Time of Week (TOW)
(enabled for "System Time > GPS/GST/BDT")

Define the simulation start time within the Week Number.

The Time of Week (TOW) is expressed in number of seconds and covers an entire
week. The value is reset to zero at the end of each week.

Remote command: 
<subsystem>: NAVigation: SIMulation: TOWeek on page 178

3.1.4 Advanced Configuration

Satellite Configurations
Access the dialog for configuring the satellite data (see chapter 3.6, "Satellite Configu-
ration", on page 91).

Real-Time S.P.O.T.
(enabled for "Localization" mode)

Access the dialog for real-time display of the current PDOP and HDOP values, display
of the satellites states and position, display of the receiver position and display of the
received satellite power (see chapter 3.13, "Real-Time S.P.O.T.", on page 139).

Assistance Data Generation
(enabled for "User Localization" mode and requires the basic BeiDou option
R&S SMBV-K107 or installed assisted option, e.g. Assisted GPS R&S SMBV-K65.

Access the dialog Assistance Data Generation for generation of assistance data corre-
sponding to the selected "Assistance Mode".

3.2 Localization Data

(R&S SMBV only)

To access this settings:

1. Select "Baseband > Satellite Navigation > GPS".

2. Select "Simulation Mode > Auto Localization/User Localization".

3. Select "User Environment > Localization Data".

In the "Localization Data" dialog you can configure the satellites signal correspond-
ing to a 'real' static or moving geographic location.
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Geographic Location/Attitude
Selects the geographic location of the GNSS receiver.

"User Defined" This mode enables the definition of the vehicle’s body rotation param-
eters of the GNSS receiver when a static location in the WGS84 coor-
dinate system is defined:
● "Latitude", "Longitude" and "Altitude"
● in istrument equipped with R&S SMBV-K103, also the attitude

(yaw, pitch and roll)
The simulated altitude is the height above the ellipsoid (HAE) altitude.

"Waypoints" (requires option GNSS Enhancements R&S SMBV-K92)
Enables the selection of a moving scenario, i.e. the simulation of
moving receiver. Predefined or user waypoint files can be loaded.
The parameters "Latitude", "Longitude" and "Altitude" are set accord-
ing to the first simulated position defined in the file describing the
movement, i.e. the raw waypoint, NMEA, KML, *.xtd or trajectory
description file.
For more information, see chapter 2.5.1, "Moving Scenarios",
on page 26 and chapter A.1, "User Environment Files", on page 293.
For information about the current position of the receiver, open the
Real-Time S.P.O.T. display and check the parameter "Receiver Loca-
tion" or the displayed receiver trajectory ("Map View").
Option R&S SMBV-K103 is required to simulate the attitude informa-
tion retieved from the waypoint/attitude file.
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"City" Selects one of the predefined fixed geographic locations (see
table 3-2).
The parameters "Latitude", "Longitude" and "Altitude" are set accord-
ing to the selected position.
Table 3-2: Coordinates of the Simulated Predefined Positions

Continent City Latitude Longitude Altitude

America New York 40.7142 -74.0064 1 m

 San Fran-
cisco

37.8194388888 -122.4784944 35 m

Asia Beijing 39.905555555555 116.391388888888 60 m

 Seoul 37.5515 126.987794444444 265 m

 Singapore 1.3113111111111 103.826852777777 110 m

 Taipei 25.022344444444 121.514758333333 10 m

 Tokyo 35.683861111111 139.745058333333 45 m

Australia Sydney -33.8833 151.2167 3 m

Europe London 51.500625 -0.1246222 22 m

 Moscow 55.752222 37.615556 200 m

 Munich 48,150 11,5833 508 m

 Paris 48.8584 2.29462777777777 66 m

Remote command: 
<subsystem>: LOCation: CATalog?  on page 170
<subsystem>: LOCation[: SELect]  on page 170

Waypoint/Attitude File …
For selected "Geographic Location > Waypoints", access to the "Select Waypoint/Atti-
tude File" dialog to select predefined waypoint files.

A waypoint file is description of a moving scenario with possibly attitude coordinates
that may have different forms, like for example a sequence of positions or vector arc
movement. A waypoint file must have the extension *.txt, *.nmea, *.kml or *.xtd.

See also chapter A.1.1, "Movement or Motion Files", on page 293 for detailed descrip-
tion of the file formats.

Remote command: 
<subsystem>: LOCation: WAYPoints: FILE on page 170

Smooth Movement
The location of the waypoints defined in the waypoints file may cause sharp changes in
the movement direction. In instruments equipped with R&S SMBV-K92, this parameter
uses an internal algorithm to smooth the trajectory to simulate more realistic move-
ment.

Remote command: 
<subsystem>: LOCation: SMOVement  on page 174
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Read Out Mode
For selected "Geographic Location > Waypoints", defines the way the waypoint/attitude
file is to be read.

The receiver trajectory can be observed in the "Map View" on the Real-Time S.P.O.T.
display.

"Cyclic" The waypoint file is read out cyclic.
Using this read out mode is only recommended for waypoint files that
describe a circle moving scenario or moving scenario in which the
start and the end point are close to each other.

"One Way" The file is read out only once.
By reaching the end of the file, the last described position is assumed
to be a static one.

"Round Trip" By reaching the end of the file, the file is read out backwards.

Remote command: 
<subsystem>: LOCation: WAYPoints: ROMode  on page 171

Location Coordinates
In the ECEF WGS84 coordinate system, a geographic location is identified by three
coordinates, the altitude, latitude and longitude. The last two can be displayed in deci-
mal or DMS format. The display format is determined by the parameter "Position For-
mat".

Parameter Description

"Position Format" Sets the format in which the Latitude and Longitude are displayed.
● "DEG:MIN:SEC"

The display format is Degree:Minute:Second and Direction, i.e.
XX°XX'XX.XX" Direction, where direction can be North/South and
East/West.

● "Decimal Degree"
The display format is decimal degree, i.e. +/-XX.XXXXX°, where "+"
indicates North and East and "-" indicates South and West.

"Altitude" Sets the geographic altitude of the reference location in meters above sea
level.

The simulated altitude is the height above the ellipsoid (HAE) altitude.

"Latitude" Sets the latitude of the reference location.

"Longitude" Sets the longitude of the reference location.

The altitude, latitude and longitude are only configurable for user defined geographic
locations. If a value other than "User Defined" is selected in the "Geographic Location"
field, these fields are read only.

Remote command: 
to enter the coordinates in Degree:Minute:Second format
<subsystem>: LOCation: COORdinates: DMS  on page 172
to enter the coordinates in decimal degree format
<subsystem>: LOCation: COORdinates: DECimal  on page 171
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Yaw/Heading, Pitch/Elevation, Roll/Bank
For instruments equipped with R&S SMBV-K103, sets the angles of rotation in the cor-
responding direction, i.e. the rotation around the respective yaw, pitch and roll axes.
"Yaw/Heading, Pitch/Elevation, Roll/Bank" are defined relative to the local horizon.

See also figure 2-4.

Remote command: 
<subsystem>: LOCation: YAW on page 173
<subsystem>: LOCation: PITCh on page 173
<subsystem>: LOCation: ROLL  on page 173
see also <subsystem>: RT:RATTitude?  on page 280

From Motion/From Spinning
Enable "From Motion/From Spinning" to extract the attitude parameters from the way-
point file. For scenarios with defined waypoints/attitude file this forces the attitude
parameters to motion direction even if the Waypoint / Attitude has attitude information,
like for example in a *.xtd file with <property
waypointformat="position_attitude">.

For specific applications like automotive, it is realistic to set the yaw and pitch to vehi-
cle’s motion direction, because the usual body axes angles of a car are in the direction
of the velocity vector. For other applications, however, like for example aeronautics
with a landing plane, this parameter is not usefull (the nose of the plane is in an
upward direction at the time when the plane is moving downwards).

Tip: Enable the parameter "From Motion" if you simulate an automotive scenario with
instrument without the option R&S SMBV-K103.

Remote command: 
<subsystem>: LOCation: YAW: FMOTion on page 173
<subsystem>: LOCation: PITCh: FMOTion  on page 173
<subsystem>: LOCation: ROLL: FSPinning  on page 173

Spinning Rate
For instruments equipped with R&S SMBV-K103, simulates a constant rate of change
of the roll, defined with Vehicle Body Start Roll.

Remote command: 
<subsystem>: LOCation: SPIN: RATE on page 174

Vehicle Body Start Roll
For instruments equipped with R&S SMBV-K103, defines the start angles of rotation of
the vehicle.

Remote command: 
<subsystem>: LOCation: SPIN:SRoll  on page 174

Localization Data



User InterfaceSatellite Navigation

73Operating Manual 1173.1427.12 ─ 08

3.3 Obscuration and Auto Multipath Settings

The "Obscuration and Auto Multipath" dialog is available for instrument equipped with
the additional option R&S SMBV-K101.

To access this settings:

1. Select "Baseband > Satellite Navigation > GPS".

2. Select "Simulation Mode > Auto Localization/User Localization".

3. Select "User Environment > Obscuration and Auto Multipath".

The provided settings enables you to select a predefined near environmental
model or to customize the model as required. Most oft the user defined models are
created in table form, where each row corresponds to a object that causes obscu-
ration, reflection of the signal and/or multipath effects. The configured objects are
displayed on a graphical view with selectable orientation. Each object is identified
on the graphical view with its row index.

To simplify and accelerate the configuration, the instrument provides:
● a subset of predefined but customizable user environment models, like suburban

area, urban canyon, tunnel, bridge, highway, etc. that can be used directly or as
basis for further configurations.

● an interface for loading of generated files or storing current configurations into files
(see "Obstacles File" on page 78 or "Planes File" on page 81).

● as well as setting for joint obstacle's configuration, like defining of a subset of
obstacles and automatically repeating the configured subset (see "Repetition Win-
dow" on page 80).

Visualizing the obscured satellites
The defined user environment model is applied on the current satellite's constellation.
For the current receiver's location, some satellites are not simulated, others are simula-
ted but are obscured or not, have echos or with attenuated power due to antenna pat-
tern response. To visualize the satellite's constellation state currently used by the
receiver, use the "Sky View" in the Real-Time S.P.O.T. display.

3.3.1 Common Settings

This section describes the parameters that are common for all near environmental
models.

Type
Selects a predefined obscuration&auto multipath model or enables the configuration of
the near environment and physical model.

● Customizable Type
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– User Defined: the parameters "Near Environment" and "Physical Model" are
configurable

● Predefined Types
– City Block

The model assumes: average building height 20m
– Urban Canyon

Correspond to an urban canyonas in commercial city places.
The model assumes: street width 30m, average building height 30m, gap
between the buildings along a street 10m, street length 1200m

– Suburban Area
The model assumes: relatively high distance between the GNSS receiver and
the main reflecting obstacles

– Cutting
The model assumes: obscuration effects from side barriers on the left and right
of a vehicle moving on a highway

– Highway
The model assumes: effects of the barriers as well as cars moving in the oppo-
site lines and subsequently interrupting the GNSS signal for a short time in a
periodic way

– Bridge
– Parking

The model assumes: a full signal obscuration in a parking for 1 min, 10 min or
1 hour.
This model is useful by measuring the time a GNSS receiver needs to reac-
quire the GNSS satellites after leaving the obscured area.

– Tunnel
To store a user-defined configuration, use the "Save As" function. User defined obscu-
rations can be loaded at a latter time to repeat test with the same user environment.

Remote command: 
<subsystem>: OBSCuration: TYPE on page 181

Near Environment
Determines the kind and nature of the obstacles.
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Table 3-3: Available customizable near environment models in depending on the vehicle type and the geographic location

Near Environment Vehicle Type Mov-
ing
loca-
tion

Static
loca-
tion

Short Description

Vertical Obstacles Pedestrian

Land Vehicle

x x The model simulates the whole fix geometry of many objects (loca-
tions) to the left, right, front and back of the user's static location and is
suitable for city block simulation

The objects are defined relative to the map orientation, i.e to the street
orientation. The map is built on the OX and OY axes and any point on
the map can be defined as a reference point. Each object is defined
with its length and its distance to this reference point.

The receiver's position is configurable and defined as an offset to the
reference point.

See chapter 3.3.2, "Vertical Obstacles Settings", on page 76.

Roadside Planes Pedestrian

Land Vehicle

x  This model describes an environment where the user defined obsta-
cles representing roadside planes or surfaces built from different
materials are located to the left and/or to the right side of the receiver/
vehicle. In this mode the roadside planes are assumed parallel to the
motion of the vehicle

The model is enabled in instrument equipped with option R&S SMBV-
K92.

See chapter 3.3.3, "Roadside Planes Settings", on page 79.

Full Obscuration Pedestrian

Land Vehicle

Ship

x  This model defines areas with configurable size in that the satellite sig-
nals are completely obscured.

The model is enabled in instrument equipped with option R&S SMBV-
K92.

See chapter 3.3.4, "Full Obscuration Settings", on page 82

Ground/Sea Reflec-
tion

Ship

Aircraft

Spacecraft

x x (Ship
only)

Simulated is ground/sea reflection as well as obscuration of satellites
due to modeled canyon obstacles (left and right) with configurable dis-
tance to vehicle, height and surface type with different properties.

Use this model to simulate flights over sea/lakes with surrounding can-
yon or for ships crossing sea straits.

See chapter 3.3.5, "Ground/Sea Reflection", on page 84

Line of Sight (LOS) all x x No near field environment is defined

The environment view displays the currently configured model.

Remote command: 
<subsystem>: OBSCuration: ENVironment  on page 181

Physical Model
For "Near Environment" different than "LOS", the physical model determines whether
the satellite signals are obscured and/or multipath echoes are simulated.

The simulation of multipath effects in "Physical Model > Obscuration&Multipath"
requires additionally the option R&S SMBV-K92.

Remote command: 
<subsystem>: OBSCuration: PMODel on page 181
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Viewport from/to, Zoom Out
Zooms in the displayed model to the selected range. To display the full model again,
use the"Zoom Out" function.

3.3.2 Vertical Obstacles Settings

This section comprises the parameters, necessary to configure a "near environmental"
model for simulation of obscurations and multipath effects expected in a city environ-
ment. The vertical obstacles are defined in a static (OX, OY) coordinate system and
are either parallel to OX or OY axis following axis direction.

Examples of predefined environment based on the vertical obstacles are "City Block"
and "Urban Canyon".

Fig. 3-1: Vertical obstacles settings on the basis of a predefined city block
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Fig. 3-2: Vertical obstacles settings on the basis of a predefined urban canyon

Receiver Offset
Determines the start position of a receiver/vehicle in terms of height and left/front offset
relative to the reference point (i.e. the (0,0,0) coordinate). The reference point is the
reference for the definition of the vertical obstacles.

Tip: Use this parameters to redefine the receiver's start location relative to the config-
ured obstacles geometry without changing the obstacles definition in the table (Obsta-
cles Configuration Table).

Note: Simulation of vehicle. If a vehicle is simulated, the position describes a vehicle
geometric reference. The offset between antenna and the vehicle’s reference is descri-
bed in the antenna pattern (*.ant_pat). The simulated GNSS signal refers to the
antenna and not the vehicle geometric reference.

"Start Receiver X Offset"
X offset of the first simulated receiver location in the (OX, OY) coordi-
nate system

"Start Receiver Y Offset"
Y offset of the first simulated receiver location in the (OX, OY) coordi-
nate system
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"Start Receiver Height Offset"
Height offset

Remote command: 
<subsystem>: OBSCuration: VOBS: ROFFset: X on page 182
<subsystem>: OBSCuration: VOBS: ROFFset: Y on page 182
<subsystem>: OBSCuration: VOBS: ROFFset: HEIGht on page 182

Map Orientation
The map is aligned to the points of the compass. The value represents the angle
between East direction and 0X axis. A value of 0° means that OX axis is to the east
and OY to North; a value of 90° corresponds to OX orientation to the north and OY to
West.

A compass sign shows the current direction to the north.

Remote command: 
<subsystem>: OBSCuration: VOBS: ROFFset:MORientation  on page 182

Obstacles File
Provides an access to the standard "File Select" dialog to select a user defined obsta-
cles description file (*.rs_obst).

Remote command: 
<subsystem>: OBSCuration: VOBS: CATalog: PREDefined?  on page 183
<subsystem>: OBSCuration: VOBS: CATalog: USER? on page 183
<subsystem>: OBSCuration: VOBS: FILE on page 183

View Type
Change the display orientation of the model. The available view types depend on the
current near environmental model.

Table 3-4: Graphical representation of the urban canyon

"Side View (OX)" "Side View (OY)"

Obstacles Configuration Table
Each vertical obstacle is defined in one table row. The row index indicates the obstacle
on the display view.
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Direction axis ← Obstacles Configuration Table
Determines the alignment of the vertical obstacle, parallel to OX or to the OY axis.

First Edge X/Y Coordinates, m ← Obstacles Configuration Table
For vertical obstacles, sets the coordinate of the start point (first edge) of the obstacle
in meters. First edge has the lowest coordinate value on its direction axis. The coordi-
nate is interpreted on the OX or OY axis.

Length/Height ← Obstacles Configuration Table
Defines the obstacles' length and height in meters. The obstacle is parallel to the
Direction axis

Material ← Obstacles Configuration Table
Defines the material the obstacle is build from. Available are "Glass", "Concrete",
"Wood", "Gypsum", "Formica", "Marble", "Dry Wall", "Brick".

Permittivity/Power Loss ← Obstacles Configuration Table
Displays/defines the material property, permittivity or power loss, for the selected mate-
rial. This value is a measure for the reflection caused by the obstacle.

Alignment Filter ← Obstacles Configuration Table
Filters the display of all obstacles for that the selected criteria is fulfilled.

Material Property ← Obstacles Configuration Table
Define whether the material is defined by its permittivity/conductivity or power loss
characteristic.

Insert Left/Right, Delete, Undo All, Save ← Obstacles Configuration Table
Standard functions for adding/appending and removing table rows, undo and save
changes.

3.3.3 Roadside Planes Settings

This model is enabled in instrument equipped with option R&S SMBV-K92.

This section comprises the parameters, necessary to configure a near environmental
model for simulation of obscurations and multipath effects that a moving receiver expe-
riences while moving on a road surrounded by buildings or other objects.
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The vertical roadside planes are defined alongside the road and parallel to the motion
direction of the moving receiver. A maximum of two vertical planes at max (left and
right) are considered based on current user mileage. Examples of predefined environ-
ment based on roadside planes are "Suburban Area", "Highway" and "Cutting".

Fig. 3-3: Roadside planes settings on the basis of a predefined suburban area

Receiver Height Offset
Determines the start position of a receiver in terms of height offset relative to the refer-
ence point used to define the roadside planes.

Tip: Use this parameters to redefine thethe vehicle's height relative to the configured
obstacles geometry without changing the obstacles definition in the table (Obstacles
Configuration Table).

Remote command: 
<subsystem>: OBSCuration: RPL:ROFFset: HEIGht  on page 184

Repetition Window
Enables the repetition of the defined objects and determines the repeating period (in
km).

Remote command: 
<subsystem>: OBSCuration: RPL:RWINdow: STATe on page 184
<subsystem>: OBSCuration: RPL:RWINdow  on page 184

Set Length to Infinite
If enabled, assumes planes with infinite width. Enable this parameter if a cutting sce-
nario is simulated.

Remote command: 
<subsystem>: OBSCuration: RPL: ILENgth on page 184
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Planes File
Provides an access to the standard "File Select" dialog to select a user defined
description file (*.rs_buil).

Remote command: 
<subsystem>: OBSCuration: RPL: CATalog: PREDefined?  on page 183
<subsystem>: OBSCuration: RPL: CATalog: USER? on page 183
<subsystem>: OBSCuration: RPL: FILE on page 183

View Type
Change the display orientation of the model. The available view types depend on the
current near environmental model.

Table 3-5: Graphical representation of a highway model

"View Type = Distance vs. Position" "View Type = Height vs. Position"

Obstacles Configuration Table
Each roadside plane is defined in one table row. The row index indicates the obstacle
on the display view. The left and right planes are color-coded.

Alignment ← Obstacles Configuration Table
For roadsides planes, determines according to which axis (left or right) the location is
aligned. The available values depend on the selected Alignment Filter.

Reference Receiver Position ← Obstacles Configuration Table
Distance (mileage) starting from which the corresponding roadside plane is considered
for user obscuration and multipath simulation.
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Distance ← Obstacles Configuration Table
Defines the distance of the vertical obstacle to the OX or OY axis. The distance is
expressed in meters.

Height ← Obstacles Configuration Table
Defines the obstacles' height in meters.

Material ← Obstacles Configuration Table
Defines the material the obstacle is build from. Available are "Glass", "Concrete",
"Wood", "Gypsum", "Formica", "Marble", "Dry Wall", "Brick".

Permittivity/Power Loss ← Obstacles Configuration Table
Displays/defines the material property, permittivity or power loss, for the selected mate-
rial. This value is a measure for the reflection caused by the obstacle.

Material Property ← Obstacles Configuration Table
Define whether the material is defined by its permittivity/conductivity or power loss
characteristic.

Alignment Filter ← Obstacles Configuration Table
Filters the display of all obstacles for that the selected criteria is fulfilled.

Insert Left/Right, Delete, Undo All, Save ← Obstacles Configuration Table
Standard functions for adding/appending and removing table rows, undo and save
changes.

3.3.4 Full Obscuration Settings

This model is enabled in instrument equipped with option R&S SMBV-K92.

This section comprises the parameters, necessary to configure areas in that the satel-
lite signal is fully obscured, like in tunnels. Examples of predefined environments
based on full obscuration are "Bridge", "Parking" and "Tunnel".

 

Obscuration and Auto Multipath Settings



User InterfaceSatellite Navigation

83Operating Manual 1173.1427.12 ─ 08

Reference Scale
Defines whether the obstacles' positions are defined as distance (in km) or as time (in
s).

Note: Changing between the two scale without saving the configuration leads to data
loss.

Remote command: 
<subsystem>: OBSCuration: FULL: SCALe on page 185

Repetition Window
Enables the repetition of the defined objects and determines the repetition period (in
km).

Remote command: 
<subsystem>: OBSCuration: FULL:RWINdow: STATe  on page 185
<subsystem>: OBSCuration: FULL:RWINdow  on page 185

Full Obscuration Configuration Table
Defines the full obscured areas as a sequence of zones at defined position and with
defined "Width". Each zone is defined in one table row.

Tip: To enable an area pattern, define the subset of areas and enable a "Repetition
Window" with suitable repetition period. Adjust the displayed window size (Viewport
from/to, Zoom Out), to visualize all configured full obscuration areas.

"Reference" Defines the reference starting position or time stamp at which a spe-
cific obscured zone is applied.

Remote command: 
<subsystem>: OBSCuration: FULL: AREA<ch>: REFerence  on page 186
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"Length" Length of the obscured zone, defined in km or sec.

Remote command: 
<subsystem>: OBSCuration: FULL: AREA<ch>: LENGth on page 187

Remote command: 
<subsystem>: OBSCuration: FULL: AREA:COUNt?  on page 186
<subsystem>: OBSCuration: FULL: AREA:APPend  on page 186
<subsystem>: OBSCuration: FULL: AREA<ch>: INSert on page 186
<subsystem>: OBSCuration: FULL: AREA<ch>: DELete  on page 186

3.3.5 Ground/Sea Reflection

This section comprises the parameters, necessary to configure a near environmental
model for simulation of obscurations and multipath effects caused by ground and sea
reflections.

The ground/sea reflections model is available for ship, aircraft and spacecraft vehicles
and describes canyon vertical obstacles parallel to the motion direction of the user
(direction axis).

Material Property
Define whether the material is defined by its permittivity/conductivity or power loss
characteristic.

The material properties depend on the selected surface type.

Remote command: 
<subsystem>: OBSCuration: GSR:MPRoperty  on page 187
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Surface Type
Describes the surface. Available are "Dry Ground", "Medium Dry Ground", "Wet
Ground", "Fresh Water" and "Sea Water". The different surfaces feature different
reflection characteristics.

Remote command: 
<subsystem>: OBSCuration: GSR:STYPe  on page 187

Ground Permittivity/Conductivity, Power Loss
Displays/defines the surface property, permittivity, conductivity or power loss, for the
selected surface type. This value is a measure for the reflection caused by the surface.

Remote command: 
<subsystem>: OBSCuration: GSR: PERMittivity  on page 187
<subsystem>: OBSCuration: GSR: CONDuctivity  on page 188
<subsystem>: OBSCuration: GSR: PLOSs on page 188

h1/h2, d1/d2
Determines the height of the right/left obstacle and the distance between the receiver
and the obstacles.

Remote command: 
<subsystem>: OBSCuration: GSR:O1Distance  on page 188
<subsystem>: OBSCuration: GSR:O2Distance  on page 188
<subsystem>: OBSCuration: GSR:O1Height  on page 189
<subsystem>: OBSCuration: GSR:O2Height  on page 189

Ground Altitude
Sets the altitude of the ground level relative to the WGS84 ellipsoid, i.e. the terrain
ground level is set relative to WGS84 zero level or sea level.

Remote command: 
<subsystem>: OBSCuration: GSR: GALTitude on page 189

Obstacle Orientation
For "Geographic Location/Attitude" different than waypoint and "Vehicle Type = Air-
craft/Ship/Spacecraft", defines the direction of the obstacles. If the vehicle is moving,
the obstacles are assumed to be parallel to the motion.

The value zero means that the obstacles are parallel to the east direction.

Remote command: 
<subsystem>: OBSCuration: GSR:OORientation  on page 189
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3.4 GNSS System/Almanac Configuration Settings

► To access this dialog, select "Main Dialog > GNSS System Configuration"

The dialog comprises the general settings for GNSS system configuration, such as
selecting the GNSS standards, and configuring the almanac and RINEX files.

Activate GNSS Standards
Defines the navigation standards that will be part of the GNSS system configuration.
Only the satellites of an enabled standard are configurable in the Satellite Configura-
tion dialog.

The navigation standard of the entry point is always enabled. The further available nav-
igation standards depend on the installed options.

Note: Throughout this description, the term hybrid cinfiguration denotes a GNSS sys-
tem configuration comprising the satellites of two or more navigation standards.

Remote command: 
<subsystem>: HYBRid:<GNSS>[: STATe]  on page 193

Use Common RF Frequency
Enable this parameter if several R&S SMBV instruments are connected to generate
GNSS signal in the same GNSS band (see figure 2-1) and phase coherent signal is
required, e.g. two instruments generating respectively up to 24 GPS, 24 GLONASS
and 24 BeiDou satellites in the L1/E1 RF band.
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This feature triggers the instruments to shift the baseband signal in the frequency
domain so that both instruments can use the same RF frequency. The effect is compa-
rable with enabled hybrid GNSS configuration. With correct configured settings, instru-
ments equipped with hardware option R&S SMBV-B90 generate phase coherent RF
signals.

For more information on the required options, connection and configuration steps, refer
to chapter 2.11, "Generating GNSS Signal with Several Instruments", on page 51.

Remote command: 
<subsystem>: UCRF on page 193

Use Position Accuracy (P-Code) GPS
The generation of GPS signal modulated by P-code requires the additional software
option R&S SMBV-K93.

This parameter is enabled only if GPS standard is activated in the GNSS system con-
figuration. Activate "Use Position Accuracy" to enable the selection of P and C/A+P
signals in the Satellite Configuration dialog.

Remote command: 
<subsystem>: UMGPs on page 193

GPS Anti-Spoofing
Enables Anti Spoofing flag in the GPS navigation message.

Remote command: 
<subsystem>: SATellite: ASPoofing  on page 193

Almanac Configuration
Displays the settings of the selected almanac files per navigation standard. One alma-
nac file can be selected per navigation standard. Predefined or user almanac files can
be loaded.

The following almanac files are supported:
● GPS and Galileo

– SEM-files with data extension xxx.al3
– YUMA almanac files with data extension xxx.alm
These files describe GPS and Galileo almanacs, whereas xxx denotes the day of a
year.
Note: Current GPS almanac data can be downloaded via the Internet and stored
on the hard disk of the instrument:
U.S.Coast Guard Navigation Center GPS Homepage http://
www.navcen.uscg.gov/?pageName=gpsAlmanacs

● Glonass
Almanac files with data extension xxx.agl
Refer also to the download ftp site for Glonass almanacs: ftp://ftp.glonass-
iac.ru/MCC/ALMANAC/

When an almanac file is selected, the time information of the file (Week, SEM and
TOA) is indicated in the table. If RINEX file is not enabled, the satellite specific informa-
tion (ephemeris) is also taken from the almanac.

The SEM and TOA are indicated in Greenwich Mean Time.
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Parameter SCPI command

"Almanac File" <subsystem>: NAVigation: ALManac: <GNSS>: FILE on page 195

<subsystem>: SVID: <GNSS>:LIST  on page 200

"Week Number"1) <subsystem>: NAVigation: ALManac: <GNSS>: WNUMber on page 199

"Week Span"1) <subsystem>: NAVigation: ALManac: <GNSS>: DATE:BEGIn  on page 196

<subsystem>: NAVigation: ALManac: <GNSS>: DATE:END on page 196

"Time of Applicability
(TOA)"2)

<subsystem>: NAVigation: ALManac: <GNSS>: TOAPplicability: 
TOWeek  on page 198

<subsystem>: NAVigation: ALManac: <GNSS>: TOAPplicability: 
WNUMber  on page 198

"Time of Applicability
(TOA)"

<subsystem>: NAVigation: ALManac: GLONass: TOAPplicability: 
DATE? on page 197

<subsystem>: NAVigation: ALManac: GLONass: TOAPplicability: 
TIME? on page 197

1) "Week Number" and "Week Span": no SCPI command for Glonass
2) TOA format for GPS: (WN, TOW) WN_REF (6 Jan 1980 00:00:00 UTC)

  TOA format for Galileo: (WN, TOW) WN_REF (22 August 1999 00:00:00 UTC)

RINEX Configuration
Selects and activates one "RINEX File" per navigation standard. Predefined or user
RINEX files can be loaded.

Perform "Import RINEX Files" to upload the selected file. The ephemeris and satellite
clock parameters of the SV IDs included in the selected RINEX file are retrieved from
this file. However, the parameters of SV IDs that are not included in the RINEX file are
retrieved from the almanac of the corresponding GNSS.

Enable the "Update UTC and Atmospheric Parameters" to synchronize the time con-
version parameters and the atmospheric parameters to the corresponding values
retrieved from the RINEX file.

Enable the "Update Frequency Number (GLONASS)" to extract the frequency number
allocations from the RINEX file.

See also
● chapter A.2, "RINEX Files", on page 303 for description of the RINEX file format
● chapter 2.10.11, "Configuring the Navigation Parameters", on page 41

Remote command: 
<subsystem>: NAVigation: RINex:GPS: FILE on page 199
<subsystem>: NAVigation: RINex:GPS: STATe on page 200
<subsystem>: NAVigation: RINex:IMPort  on page 200
<subsystem>: NAVigation: RINex:UUAState  on page 200
<subsystem>: NAVigation: RINex:UFNState  on page 200
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3.5 Time Conversion Configuration

To access this settings:

1. Select "Baseband > Satellite Navigation > GPS".

2. Select "Localization Data > Time Convertion Configuration".

This dialog provides the settings necessary to configure the time conversion from a
navigation standard (GPS, Galileo, GLONASS or BeiDou) to UTC. The conversion
settings are necessary for switching from one time basis to another.

The time conversion is performed according to the following formula:

tUTC = (tE - delta_tUTC) modulo 86400, where delta_tUTC and tE are as follows:

delta_tUTC = delta_tLS+A0+A1 (tE-Tot+604800(WN-WNot)) and

tE = tGPS or tGalileo

The GNSS implementation in the R&S WinIQSIM2 is a simplified offline version of the
real-time one and provides the capability to generate an one-satellite generic signal.
Therefore the time conversion parameters table is adjusted accordingly to one satellite
in R&S WinIQSIM2. You find the differences explicitly stated in the description.

 

Time Conversion Configuration



User InterfaceSatellite Navigation

90Operating Manual 1173.1427.12 ─ 08

Time Conversion Parameters
Configuration of the time conversion parameters require software option R&S SMBV-
K92. The time conversion parameters are enabled only in "User Localization" and
"Static" modes.

The basis for the time conversion is the UTC. The parameters of each of the navigation
standards are set as an offset to the UTC.

To retrieve the time configuration parameters from an imported RINEX file, enable the
parameter Update UTC and Atmospheric Parameters.

For better readability, the values of the time correction parameters are input as integer
in the same way as they are included in the satellite's navigation message but the cor-
responding "Scale Factor" and the "Scaled Value" are displayed too.

Parameter Description SCPI Command

"A_0" Constant term of polynomial, A0 <subsystem>: NAVigation: TCONversion: 
GPS:AZERo  on page 202

"A_1" 1st order term of polynomial, A1 <subsystem>: NAVigation: TCONversion: 
GPS:AONE  on page 202

"t_ot" UTC data reference Time of Week,
tot

<subsystem>: NAVigation: TCONversion: 
GPS:TOT  on page 203

"WN_t" UTC data reference Week Number,
WNt

<subsystem>: NAVigation: TCONversion: 
GPS:WNOT  on page 203

Leap Second Configuration
The GPS time is not corrected to match the Earth's rotation and does not consider time
corrections that are typical for the UTC, such as the leap second for instance. The UTC
time corrections are performed periodically, the date of the next expected correction is
determined by the parameter "Next Leap Second Date".

As of June 30, 2012, the value of the "Current Leap Second", is 16 seconds.

Parameter Description SCPI Command

"Synchronize" Synchronizes the leap sec-
ond according to the simula-
tion time.

<subsystem>: NAVigation: TCONversion: 
LEAP:SYNC  on page 206

"Current Leap Seconds
(Ref. 1980)"

Displays the currently used
leap second.

<subsystem>: NAVigation: TCONversion: 
LEAP:SEConds  on page 205

"Simulate Leap Second
Transition"

(R&S SMBV only)

Enables/disables the simula-
tion of the leap second tran-
sition.

<subsystem>: NAVigation: TCONversion: 
LEAP:SLSTransition[: STATe]  on page 205

Time Conversion Configuration
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Parameter Description SCPI Command

"Next Leap Second
Date"

(R&S SMBV only)

Determines the date of the
next UTC time correction.

<subsystem>: NAVigation: TCONversion: 
LEAP:DATE  on page 205

"Leap Sign"

(R&S SMBV only)

The time correction is per-
formed in steps of one sec-
ond. One second may be
added to or subtracted from
the current leap second
value.

<subsystem>: NAVigation: TCONversion: 
LEAP:SIGN  on page 205

UTC-UTC(SU)
(for GLONASS satellites)

The Universal Time Coordinate (UTC) as used for GPS and Galileo can have a phase
shift and a frequency drift compared to the Russian UTC basis (UTC(SU)). These set-
tings are provided for configuration of the UTC differences UTC - UTC(SU) as transmit-
ted by GLONASS satellites.

Parameter Description SCPI Command

"UTC(SU) Ref-
erence Date"

Indicates the UTC-UTC (SU) time
conversion reference date.

<subsystem>: NAVigation: TCONversion: 
UTCSu: DATE? on page 204

"A_0" Constant term of polynomial A0 (vir-
tual)

<subsystem>: NAVigation: TCONversion: 
UTCSu: AZERo on page 204

"A_1" 1st order term of polynomial, A1 (vir-
tual)

<subsystem>: NAVigation: TCONversion: 
UTCSu: AONE on page 204

The Glonass satellites transmit the offset between GPS and GLONASS system time as
part of their navigation message. They assume only a delay and no frequency drift.
The time offset is calculated as following:
GPS – GLONASS = "GPS – UTC" + "UTC – UTC(SU)" – "GLONASS -
(UTC(SU) + 3h)" – 3h
For hybrid GNSS configuration with activated GLONASS satellites, this GPS – GLO-
NASS time offset is maintained constant by automatically adjusting the "GPS-UTC"
drift parameters ("A_1","T_ot" and "WN_ot") while changing the "UTC – UTC(SU)"
parameters.

3.6 Satellite Configuration

To access this settings:

1. Select "Baseband > Satellite Navigation > GPS".
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2. Select "Satellite Configuration".

In the "Satellite Configuration" dialog, you can activate and confuigure the signal
simulation of up to 24 satellites. The maximum number of the configurable satel-
lites depends on the installed options.
The GNSS implementation in R&S WinIQSIM2 is a simplified offline version of the
realtime option. The offline version provides the possibility to generate an one-sat-
ellite generic signal, i.e. only 1 satellite can be activated and configured.
In the following description, the relevant parameters are adjusted accordingly in
R&S WinIQSIM2. You find the differences explicitly stated in the description.

3.6.1 Power Configuration

The power settings in the upper part of the dialog are relevant only for R&S SMBV
instruments. Section "Satellites" applies also to WinIWQSIM, however, only one satel-
lite can be configured.

This section comprises the power settings. The dynamic power control concept is
based on two power modes, the "Auto" and the "User" mode. Use the auto mode if a
dynamic automatic power calculation is preferred. For flexible real time configuration of
the power settings per satellite, enable the user mode.

The table 3-6 gives an overview of the parameters that are considered by the calcula-
tion of the satellites' power levels.
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Table 3-6: Overview of the parameters affecting the power level of the GNSS signal

Power Mode Reference
Power

Reference
Satellite

Pseudorange Inter-Stand-
ard Tuning

Additional
Power per
Tap

Relative/Displayed Power of
the individual satellites sig-
nal component

Auto yes yes yes yes yes displays the power level at the
simulation start time

User yes - - - yes yes

The table 3-7 shows how the power levels are calculated depending on the "Simulation
Mode", the "Power Mode" and whether a signal component undergoes static multipath
or not.

Table 3-7: Calculating the power levels of the satellite as a function of the "Power Mode" and the "Simulation Mode".

Power Mode/

Simulation
Mode

Auto User

"Static" - Absolute PowerSat#_Signal = Ref. Power + Relative
PowerSat#_Signal

"Auto Localiza-
tion"

Absolute PowerSat#_Signal = Ref. Power +
Power*Sat#_Signal

1)

Absolute PowerSat#_Signal,Tap# = Ref. Power +
PowerSat#_Signal + Additional Powertap#

"User Localiza-
tion"

Absolute PowerSat#_Signal,Tap# = Ref. Power +
Power*Sat#_Signal

1) + Additional Powertap#

 

1) For a satellite in the satellite list with pseudorange at time t = Pseudoranget and "Ref.
Standard = Std"

Power*Sat#_Signal_t = 20log10(Ref. Orbital Dist/NDRef.Std) + 20log10(NDStd/Pseudoranget)
+Inter-Standard PowerSat#_Ref.Signal, where ND is the nominal orbital distance (see Ref-
erence Signal/ Reference Orbital Distance).

Example: Calculation of the Power* if "Ref. Sattellite" is different than N.A.
Power*Sat#_Signal_t = 20log10(PseudorangeRef.Sat_t0/PseudorangeSat#Signal_t) + Inter-Stand-
ard PowerSat#_Ref.Sat, where t0 represents the start moment of the simulation.

If "Ref. Satellite" different than N.A. , the power level displayed in the user inerface
(Power) represents the power level at the start moment of the simulation (t0) and is
calculated as follow:
Displayed PowerSat#_Signal_t0 = 20log10(PseudorangeRef.Sat_t0/PseudorangeSat#Signal_t0) +
Inter-Standard PowerSat#_Ref.Sat

The total power of the generated GNSS signal is displayed with the parameter Total
Power.
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Example: Power calculation in "User" power mode for GNSS signal undergoing
static multipath propagation
Power calculation for the power settings and satellite constellation as shown on fig-
ure 3-4.

Fig. 3-4: Example: Power Configuration in User Power Mode

● Number of Satellites = 4
● Sat#1: PowerSat#1_C/A = -1 dB; static Multipath = Off

● Sat#2: PowerSat#2_C/A = 0 dB; static Multipath = Off

● Sat#3: PowerSat#3_E1-DEF = -5 dB; static Multipath = On (Additional PowerTap#1 = -5
dB, Additional PowerTap#2 = -3 dB)

● Sat#4: PowerSat#4_E1-DEF = -10 dB; static Multipath = Off

● Reference Power = -115 dBm

Calculation of the absolute power levels
● Absolute PowerSat#1_C/A = Ref. Power + PowerSat#1_C/A + Additional Powertap# = -115

dBm + -1 dB = -116 dBm
● Absolute PowerSat#2_C/A = Ref. Power + PowerSat#2_E1-DEF + Additional Powertap# =

-115 dBm + 0 dB = -115 dBm
● Absolute PowerSat#3_E1-DEF,Tap#1 = Ref. Power + PowerSat#3_E1-DEF + Additional

PowerTap#1 = -115 dBm + -5 dB + -5 dB = -125 dBm
Absolute PowerSat#3_E1-DEF,Tap#2 = Ref. Power + PowerSat#3_E1-DEF + Additional
PowerTap#2 = -115 dBm + -5 dB + -3 dB = -123 dBm

● Absolute PowerSat#4_E1-DEF = Ref. Power + PowerSat#4_C/A + Additional Powertap# =
-115 dBm + -10 dB = -125 dBm

Satellite Configuration
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Open the "Real-Time SPOT" dialog, set the "Display Type" to "Power View" and com-
pare the displayed power levels.

The power level are displayed sorted per navigation standard and in ascending order
of the SV-ID.

Example: Power calculation in "Auto" power mode
Power calculation for the power settings and satellite constellation at the simulation
start time as shown on figure 3-5.

Fig. 3-5: Example: Power Configuration in Auto Power Mode

Note: The power values displayed in "Auto" power mode correspond to the start of the
simulation (t0). The power levels change automatically as function of the satellite-
receiver distance but the display is not updated.
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Tip: Select "GNSS General Settings > Real-Time SPOT" and select "Display Type >
Power View". The displayed power levels are updated in real-time.

Power levels at the beginning of the simulation (t=t0):
● Reference Power = -115 dBm

The reference power is the nominal power of the reference satellite at the start time
and location; the power of all other satellites are simulated as relative power to the
power of the reference one.

● Reference Satellite = Sat#4
● Number of Satellites = 4
● for all satellites static Multipath = Off
● Sat#1: Displayed PowerSat#1_C/A = 1.58 dB

● Sat#2: Displayed PowerSat#2_E1-DEF = 1.46 dB

● Sat#3: Displayed PowerSat#2_E1-DEF = 1.49 dB

● Sat#4: Displayed PowerSat#4_C/A = 0 dB

● Inter-Standard Power TuningGPS C/A-GAL E1-DEF = -1.5 dB , i.e. the displayed power
levels of the Galileo satellites are internally boosted with 1.5 dB.

Calculation of the absolute power levels at the beginning of the simulation (t=t0):
● Absolute PowerSat#1_C/A = Ref. Power + Displayed PowerSat#1_C/A = -115 dBm + 1.58

dB = -113.42 dBm
● Absolute PowerSat#2_E1-DEF = Ref. Power + Displayed PowerSat#2_E1-DEF = -115 dB +

1.46 dB = -113.54 dB
● Absolute PowerSat#3_E1-DEF = Ref. Power + Displayed PowerSat#3_E1-DEF = -115 dBm

+ 1.49 dB = -113.51 dB
● Absolute PowerSat#4_C/A = Ref. Power = -115 dBm
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Select "GNSS General Settings > Real-Time SPOT" and select "Display Type > Power
View" and compare the displayed power levels.

Fig. 3-6: Example: Power levels at the beginning of the simulation

Another way to query the current power levels is by using the corresponding SCPI
command, e.g. see <subsystem>: RT: <GNSS>:SVID<ch>: TAP<us>: POWer: 
ABSolute  on page 272.

The total power of the generated GNSS signal is displayed with the parameter "Total
Power".

Example: Power calculation for mixed signals
Power calculation for the power settings and satellite constellation at the simulation
start time as shown on figure 3-7.

Fig. 3-7: Example: Power Configuration with Mixed Signal

This example focus only on the power calculation of the mixed signal.

● Power Mode = User
Number of Satellites = 4
for all satellites Multipath = Off
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● Sat#1: PowerSat#1_C/A+P = -1.31 dB; Power Reference = C/A; Intra-Standard
PowerSat#_PowRef = 3 dB, i.e the C/A signal is boosted with 3 dB compared to the P-
code signal.

● Sat#2: PowerSat#2_E1-DEF = 0 dB; PseudorangeRef.Sat_t0 = 23384433.474 m

● Sat#3: PowerSat#3_R-C/A = -5.39 dB;

● Sat#4: PowerSat#4_C/A = -2.14 dB;

● Reference Power = -115 dBm

Calculation of the absolute power levels
● Absolute PowerSat#1_C/A = Ref. Power + PowerSat#1_C/A+P + Additional Powertap# =

-115 dBm + -1.31 dB = -116.31 dBm
Absolute PowerSat#1_P = Ref. Power + PowerSat#1_C/A+P + Additional Powertap# +
Intra-Standard PowerSat#_PowRef = -115 dBm + -1.31 dB + -3 dB = -119.31 dBm

● Absolute PowerSat#2_E1-DEF = Ref. Power + PowerSat#2_E1-DEF + Additional Powertap#

= -115 dBm + 0 dB = -115 dBm
● Absolute PowerSat#3_R-C/A = Ref. Power + PowerSat#3_R-C/A + Additional Powertap# =

-115 dBm + -5.39 dB = -120.39 dBm
● Absolute PowerSat#4_C/A = Ref. Power + PowerSat#4_C/A + Additional Powertap# = -115

dBm + -2.14 dB = -117.14 dBm

Open the "Real-Time SPOT" dialog, set the "Display Type" to "Power View" and com-
pare the displayed power levels.

The power level are displayed sorted per navigation standard and in ascending order
of the SV-ID.

Power Mode
Determines whether the power is calculated automatically or is based on user defined
settings.
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● "User" power mode is intended for dynamical configuration of the power of each
satellite separately and manually.

● "Auto" power mode enables an internal dynamical automatic power control. The
power of all satellites is calculated automatically based on the satellite-to-receiver
distance and relative to the relative power of the reference satellite. The Reference
Satellite is simulated as relative 0 dB at the start reference receiver location and at
the simulation start time.
The "Auto" power mode is enabled in "Auto Localization" and "User Localization"
modes.

Remote command: 
<subsystem>: POWer:MODE  on page 222

Reference Power
Sets the power level that is used as a reference for the calculation of the power level of
the satellites.

● In "Auto" power mode, the "Reference Power" is the power level of the reference
signal component Reference Satellite at the reference orbital distance.
Example:

"Ref. Orbital Dist" = 20300 km
"Ref. Standard" = GPS
"Ref. Signal" = C/A

The "Inter-Standard Power Tuning" settings are applied automatically. The power
levels of all satellites are calculated automatically based on this reference power
level for each moment of time depending on the ratio of their dynamic satellite-
receiver distance.

● In "User" power mode, the "Reference Power" represents the power level based on
which all initial satellite power levels are calculated.

Remote command: 
<subsystem>: POWer:REFerence[: POWer]  on page 222

Reference Satellite
Determines the satellite used as a reference for the calculation of the power levels of
the satellites in "Power Mode > Auto".
● For "Reference Satellite" different than "N.A."

The values of Reference Standard and Reference Signal/ Reference Orbital Dis-
tance are updated for the selected "Reference Satellite" and the satellite to user
distance at the start simulation time.

● For "Reference Satellite = N.A."
"Reference Standard" is configurable and "Ref. Distance" is set to the nominal orbi-
tal distance ND of the selected "Reference Standard". See also Reference Signal/
Reference Orbital Distance.

Remote command: 
<subsystem>: POWer:REFerence: SATellite  on page 223
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Total Power
By enabled signal generation, displays the total power of the generated GNSS signal
at a moment of time. The total power is a real time parameter that follows the real time
changes in the absolute power levels of all active satellites.

Remote command: 
<subsystem>: POWer: TOTal? on page 225

Reference Standard
In "Power Mode > Auto", determines the reference standard.

Note: In a test setup involving two instruments, in both instruments, set the "Reference
Satellite > N.A." and enable equal "Reference Power" and the same "Reference Stand-
ard".

Remote command: 
<subsystem>: POWer: REFerence: STANdard  on page 223

Reference Signal/ Reference Orbital Distance
("Power Mode > Auto" only)

● For "Reference Satellite" different than "N.A."
displays the signal component of the current reference satellite used as reference
for the power calculation and the pseudorange of the reference satellite at the
beginning of the simulation (t=t0).

● For "Reference Satellite = N.A.", the following nominal orbit distances (ND) are
used:
– NDGPS = 20300 km
– NDGLONASS = 19100 km
– NDGalileo= 23222 km
– NDBeiDou_MEO = 21528 km and NDBeiDou_IGSO/GEO = 35786 km

Remote command: 
<subsystem>: POWer: REFerence: SIGNal?  on page 223
<subsystem>: POWer: REFerence: DISTance?  on page 224

3.6.2 General Satellites Settings

Use Spreading
(enabled in "Static" mode only)

Activates/deactivates spreading. When spreading is deactivated the pure navigation
data is modulated onto the RF carrier.

Remote command: 
<subsystem>: SPReading[: STATe] on page 212

Galileo Sat. Modulation
(Galileo in WinIQSIM2 only)

Selects the modulation mode used for modulating the Galileo carrier signal.
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Tip: Select BOC(1,1) modulation to reduce the sample rate required to simulate a cer-
tain period of time.

Remote command: 
<subsystem>: GALModulation  on page 213

Elevation Mask
(R&S SMBV instruments only)

(enabled for "Auto Localization" and "User Localization"mode)

Sets the satellite's elevation mask, i.e. determines the elevation filter applied during the
"Get Optimal Constellation" process or, while using the Auto Localization mode, used
to filter all low-elevation satellites which are closer to the horizon and may witness in
reality more unwanted multipath effects.

When the elevation decreases below the selected elevation mask, the GPS satellite is
considered as invisible by the receiver and hence the GPS receiver can not use this
satellite for determining its position. The GPS receiver has to search for another satel-
lite with better visibility.

Automatic dynamic exchange of the satellites is performed in "Auto Localization" only.
The expected time of the next upcoming satellites handover is displayed in the "Real-
Time S.P.O.T." view with the parameter Next Constellation Change.

While analyzing the generated signal, make sure that the "Satellite Elevation Mask"
used by the signal generation is set to the elevation mask of the GNSS receiver.

Remote command: 
<subsystem>: SEMask  on page 212

Initial HDOP/PDOP
(R&S SMBV only)

Displays the HDOP (Horizontal Dilution of Precision) / PDOP (Position Dilution of Pre-
cision) of the selected satellite constellation at the beginning of the simulation.

The displayed HDOP/PDOP value is not updated. The dynamic "HDOP" and "PDOP"
calculated on the current satellite constellation is displayed in the Real-Time S.P.O.T.
dialog.

The HDOP can be used as an indication of 2D positioning quality; the PDOP is an indi-
cation of 3D positioning quality. The general rule here is that the smaller the HDOP/
PDOP the better the precision of the position fix will be.

At least four different satellites have to be configured to get a reasonable value; other-
wise -1 will be displayed.

This parameter is enabled only for "Auto Localization" and "User Localization"mode.

Remote command: 
<subsystem>: HDOP? on page 213
<subsystem>: PDOP? on page 213

Atmospheric Configuration
(R&S SMBV only)

Access the Atmospheric Configuration dialog for configuring:
● the ionospheric tropospheric models used for the satellite channel’s simulation
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● the atmospheric parameters as transmitted in the corresponding GNSS navigation
message.

Get Optimal Constellation
(R&S SMBV only)

In "User Localization" mode, the satellites are fully configurable. Use this function prior
to and as basis for further configurations and retrieve an optimal satellites constellation
for the selected Almanac/RINEX file, Elevation Mask and the selected Maximum Num-
ber of Satellites.

Note: The retrieved satellite's constellation includes satellites with "State Off", if the
number of satellites with elevation higher than the selected "Elevation Mask" is less
than the selected "Maximum Number of Satellites".

Remote command: 
<subsystem>: GOConstellation  on page 213
<subsystem>: RT:OCONstellation?  on page 279

Satellites Power Tuning
(R&S SMBV only)

Opens the Satellites Power Tuning dialog for setting the power relation between the
signals of different GNSS standards.

Global Signal (and Relative Power) Configuration
Enabled in "Auto Localization" mode. "Relative Power Configuration" is enabled in
"Power Mode > User".

Opens the Global Signal Configuration dialog to determine:
● the type of signal a SV ID will use in the moment the corresponding satellite

becomes visible
● in "Power Mode > User", the relative power per SV ID.

3.6.3 Configuration of the Satellite Constellation

This section comprises the setting of the satellites constellation and the individual set-
tings of each enabled satellite. The satellite constellation is enabled for configuration in
"Static" and "User Localization" mode.

Global Ephemeris Real-Time Projection
(R&S SMBV only)

Forces ephemeris projection for all satellites, i.e. enables the parameter "Sat# > Navi-
gation Message Configuration > Real-Time Projection" for all satellites.

Note: "Global Ephemeris Real-Time Projection" has to be disabled, if assistance data
will be generated.

Remote command: 
<subsystem>: SATellite: GRTProjection  on page 214

 

Satellite Configuration



User InterfaceSatellite Navigation

103Operating Manual 1173.1427.12 ─ 08

Maximum Number of Satellites
Determines the maximum number of satellites that can be simulated. The minimum
allowed values depends on the selected Simulation Mode. Configurations with one sat-
ellite are allowed only in "Static" mode; "Auto Localization" and "User Localization"
modes require four satellites or more.

Generating the navigation signal with more than 6 satellites is enabled only for instru-
ments, equipped with option R&S SMBV-K91/-K96. The maximum number of satellites
is additionaly limitted by the available hardware resources of the instrument, espessialy
if P-Code modulated signals are enabled in the GNSS system configuration. Refer to
chapter 2.4.1, "Channel Budget", on page 23 for detailed description.

The GNSS implementation in the R&S WinIQSIM2 provides one satellite signal.

The number of satellites selected determines the number of rows in the Constellation
Table.

Remote command: 
<subsystem>: SATellite: COUNt on page 214

Constellation Table
Comprises the setting of the satellites constellation. These settings are enabled for
configuration in "Static" and "User Localization" mode.

Satellite State ← Constellation Table
Activates/deactivates the satellite.

Note:
In "User Localization" mode, changing the satellites state is performed on-the-fly and
without interruption of the signal generation, unless:
● "Obscuration & Auto Multipath > Near Environment" is different than LOS or
● "Antenna Pattern / Body Mask File" is different than "Isotropic"
Note: Not enough hardware resources. This error message appears and the satellite is
disabled if the available hardware resources are not enough to generate the desired
signal.
Hybrid GNSS configurations, multipath configurations, signals modulated by P code
and activated satellites consume hardware resources. Refer to chapter 2.4.1, "Channel
Budget", on page 23 for description on how the available hardware resources are dis-
tributed.

Remote command: 
<subsystem>: SATellite<st>: STATe on page 219

Standard ← Constellation Table
Selects the navigation standard the corresponding satellite belongs to. The available
GNSS standards depend on the entry standard, the selected GNSS System/Almanac
Configuration Settings and the installed options.

Remote command: 
<subsystem>: SATellite<st>: STANdard  on page 218

Signal(s) ← Constellation Table
Selects the type of signal the corresponding satellite is using.
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According to the GPS specifications, the C/A code (f_ca = 1.023 MHz) is provided for
civilian purposes. They are used as spreading codes for the navigation data which is
transmitted at a rate of 50 baud. The carrier L1 or L2 signal can be modulated by C/A
code only, P code only or by both (C/A+P). The modulation used is displayed with the
parameter Modulation.

Note: The generation of GPS signal modulated by P code requires the additional soft-
ware option R&S SMBV-K93. The configuration of "P" and "C/A+P" signals is enabled
only in a hybrid GNSS configuration with GPS navigation standard and enabled para-
metr "GNSS System Configuration > Use Position Accuracy (P-Code) > On".
Table 3-8: Overview of the supported signals

Band Entry Point Standard Signal minimum Required Option

L1/E1 GPS GPS C/A

P

(C/A+P)Q1)

(C/A+P)I1)

R&S SMBV-K44, R&S SMx/
AMU-K244

R&S SMBV-K93

 Galileo Galileo E1-DEF R&S SMBV-K66, R&S SMx/
AMU-K266

 GLONASS GLONASS R-C/A R&S SMBV-K94, R&S SMx/
AMU-K294

 BeiDou BeiDou B1-C/A R&S SMBV-K107

L2 GPS GPS C/A

P

(C/A+P)Q1)

(C/A+P)I1)

R&S SMBV-K44, R&S
SMBV-K244

R&S SMBV-K93

 GLONASS GLONASS R-C/A R&S SMBV-K94, R&S
SMBV-K294

1)(C/A + P)Q is the standard transmitted signal on L1 and P is the standard transmitted
signal on L2; old generation IIA satellites did not transmit P on L2. The standard men-
tions some cases where C/A and P are in-phase on L2 and hence the availability of the
configuration (C/A+P)I.

Note: Not enough hardware resources. This error message appears and the satellite is
disabled if the available hardware resources are not enough to generate the desired
signal.
Hybrid GNSS configurations, multipath configurations, signals modulated by P code
and activated satellites consume hardware resources. Refer to chapter 2.4.1, "Channel
Budget", on page 23 for description on the how the available hardware resources are
distributed.

Remote command: 
<subsystem>: SATellite<st>: SIGNal on page 218

SV-ID ← Constellation Table
Enters the Space Vehicle ID of the satellite to be simulated. This value is used to gen-
erate the corresponding spreading code.
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Note: The SV ID of the GLONASS satellites are with 64 smaller than their PRN num-
ber, e.g to GLONASS satellite R5 corresponds PRN=69.
If "Real Navigation Data" is used, only the valid IDs which are listed in the almanac are
selectable; for arbitrary data, any ID can be selected.

SV ID set to "N.A." indicates a not assigned satellite.

The SV-ID field is highlighted in dark blue color if a static multipath is activated.

Remote command: 
<subsystem>: SATellite<st>: SVID on page 219

Power ← Constellation Table
(R&S SMBV instruments only)

The meaning of this parameter depends on the selected "Power Mode":
● In "User" power mode, this parameters sets the power offset of the satellite in dB.

The offset determines the power ratio of the activated satellites.
Configuration of satellites power is performed on-the-fly and without interruption of
the signal generation, unless:
– "Obscuration & Auto Multipath > Near Environment" is different than LOS or
– "Antenna Pattern / Body Mask File" is different than "Isotropic"

● In "Auto" power mode, the displayed value is the power level of the satellite at the
start of the simulation (t0). A configured Inter-Standard Tuning is automatically
applied. The power level changes automatically as function of the satellite-receiver
distance (Pseudorange) but the display is not updated.

Refer to chapter 3.6.1, "Power Configuration", on page 92 for detailed information
about the power calculation.

Remote command: 
<subsystem>: SATellite<st>: POWer  on page 224
<subsystem>: RT:<GNSS>: SVID<ch>: TAP<us>:POWer: ABSolute  on page 272

3.6.4 Individual Satellite Settings

Comprises the settings of the selected satellite.

The values displayed in this section are the initial values of the parameters at the
beginning of the simulation or at the time the specific satellite is activated. These val-
ues will be updated internally to implement moving satellites and receivers. However
the displayed values are not updated.

Standard Chip Rate
Displays the chip rate.

Remote command: 
<subsystem>: SATellite<st>: SCRate? on page 218

Frequency Number
(enabled for GLONASS satellites only)

Frequency number indicates the sub-carrier used to modulate the GLONASS satellite.
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Depending on the selected Data Source, "Frequency Number" is either configurable or
read only. If the frequency number is read directly from the Almanac or the RINEX file,
i.e. if you use "Real Navigation Data" as data source, frequency number is read only.
With "Pattern", "PRBS" or "Data List", you can set the value.

Remote command: 
<subsystem>: SATellite<st>: FNUMber on page 215

Orbit Type
(R&S SMBV only)

(enabled for BeiDou satellites only)

Indicates the orbit type the BeiDou satellite is using. The BeidDu global satellite navi-
gation systems uses a constellation of 35 satellites with following orbits:

"GEO" 5 geostationary orbit satellites with "SV-ID = 1.. 5"

"MEO" 27 middle earth orbits global satellites

"IGSO" 3 Inclined Geosynchronous Satellite Orbit regional satellites, visible
only in China and Australia

Remote command: 
<subsystem>: SATellite<st>: ORBit on page 217

Modulation
Displays the modulation used for modulating the carrier signal.

Remote command: 
<subsystem>: SATellite<st>: MODulation on page 217

Power Reference
For mixed Signal(s) like "C/A+P", displays the signal used as a reference by power cal-
culation.

The power reference is fixed to "C/A" for mixed signals. For signals modulated only
with the P code, the power reference is "P".

Remote command: 
<subsystem>: SATellite<st>: POWer:RSIGnal?  on page 224

Navigation...
Opens the chapter 3.10, "Navigation Message Configuration", on page 116 dialog for
configuring the parameters of the navigation message.

Multipath...
(requires option R&S SMBV-K92)

Opens the Static Multipath Configuration dialog for configuring the static multipath
propagation per satellite.

Duration (Elev. > 2.5/5/7.5/10°)
(R&S SMBV only)

This parameter is enabled only for "Localization" mode.
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Displays the time the satellite's elevation will be higher than 2.5, 5, 7.5 or 10° starting
at the first simulation moment of the satellite of interest, as selected with the parameter
Elevation Mask. This parameter can be used to get an impression of how long the con-
nected GNSS receiver may use this certain satellite for its position fix.

The value is displayed in format hh:mm:ss.

The displayed value is not updated but the elevation of each satellite is constantly
monitored. Decreasing the satellite's elevation below the selected elevation mask value
is one of the reasons for the automatic dynamic exchange of satellites. Thus, a change
of the satellite constellation can occur before the initially calculated time elapses.

In "Auto Localization" mode, the expected time of each upcoming exchange is dis-
played in the "Real-Time S.P.O.T." view by the parameter Next Constellation Change.

Remote command: 
<subsystem>: SATellite<st>: DURation?  on page 215

Initial Code Phase
(enabled only in "Static" mode and for arbitary navigation data source)

Sets the initial code phase.

In R&S WinIQSIM2, the actual simulated resolution for initial code phase depends on
the sample rate. The selected Initial Carrier Phase is internally rounded to a sample.
To increase hte sample rate, use the Oversampling function.

Remote command: 
<subsystem>: SATellite<st>: CPHase on page 216

Pseudorange
Displays the propagation delay from satellite to receiver in meters and is calculated as
follow:

Pseudorange = Time Shift * c / Standard Chip Rate, where c is the
speed of light.

In "Auto" power mode, this parameter affects the calculation of the displayed power
level of the corresponding satellite.

The parameter is enabled for configuration in "Simulation Mode > Static".

In R&S WinIQSIM2, this parameter is fixed to 0.

Remote command: 
<subsystem>: SATellite<st>: PRANge on page 217

Pseudorange Bias
(R&S SMBV instruments only)

Sets a bias to the Pseudorange. The parameter is updated on -the-fly and can be used
to bias the pseudorange of a satellite.

The parameter is enabled for configuration in "Auto/User Localization" modes.

Remote command: 
<subsystem>: SATellite<st>: PRBias on page 218
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Time Shift/ chips
The parameter is enabled for configuration in "Static" mode. In R&S WinIQSIM2, it is
fixed to 0.

Displays the propagation delay from satellite to receiver. The time shift is displayed in
chips.

In "Localization" mode, this parameter is not configurable and is set automatically
depending on the simulated Geographic Location/Attitude and on the satellite's orbit.

Remote command: 
<subsystem>: SATellite<st>: TSHift  on page 219

Doppler Shift
The parameter is enabled for configuration in "Static" mode.

Enters the Doppler shift of the simulated signal of the satellite. The simulation of Dop-
pler-shifted signals can be used to check the receiver characteristics under more real-
istic conditions than with zero Doppler.

In "Localization" mode, this parameter is not configurable and is set automatically
depending on the simulated "Geographic Location" and on the satellite's orbit.

The relevant change to the chip rate of the code is carried out automatically. The cur-
rently valid values for Doppler-shifted carrier frequency and chip rate are displayed
under:
● Resulting Start Frequency
● Resulting Start Chip Rate
● Resulting P-Code Chip Rate

Remote command: 
<subsystem>: SATellite<st>: DSHift on page 215

Initial Carrier Phase
The parameter is enabled for configuration in "Simulation Mode > Static".

Sets the initial carrier phase. The parameter is updated automatically in "Auto/User
Localization" modes.

In R&S WinIQSIM2, it is forced to 0.

Remote command: 
<subsystem>: SATellite<st>: ICPHase on page 216

Resulting Start Frequency
Indicates the currently valid values for Doppler-shifted carrier frequency.

The resulting frequency is calculated according to the following:
● GPS, Galileo, BeiDou

fresulting = fband + fDoppler,
where fband is set with parameter RF Band.

● Glonass
fband_L1 = 1602 MHz, fband_L2 = 1247 MHz
k = frequency number
fGlo_L1_resulting, MHz = 1602 + ( k * 0.5625) + fDoppler
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fGlo_L2_resulting, MHz = 1247 + ( k * 0.4375) + fDoppler

Remote command: 
<subsystem>: SATellite<st>: FREQuency?  on page 216

Resulting Start Chip Rate
Indicates the currently valid values for the chip rate. The relevant change to the chip
rate is carried out automatically if the Doppler shift is changed.

The resulting chip rate is calculated according to the following:
● GPS, Galileo, BeiDou

fresulting = fcode * {1 + fDoppler / fband},
where fband is set with parameter RF Band,
fcode_GPS/Galileo = 1.023 MHz and fcode_BeiDou = 2.046 MHz

● Glonass on L1/E1 band
fresulting = fcode * {1 + fDoppler / [fband+ k * 562500 (Hz)]}

● Glonass on L2 band
fresulting = fcode * {1 + fDoppler /[ fband+ k * 437500 (Hz)]},

Remote command: 
<subsystem>: SATellite<st>: CACRate?  on page 214

Resulting P-Code Chip Rate
(R&S SMBV only)

Indicates the currently valid values for the chip rate of the P-code. The relevant change
to the chip rate of the P-code is carried out automatically if the Doppler shift is
changed.

The resulting P-chip rate is calculated according to the following:

fP-resulting = fP * {1 + fDoppler / fband}

where fband is as set with parameter RF Band and fP is fixed to 10.230 MHz.

Remote command: 
<subsystem>: SATellite<st>: PCRate? on page 216

3.7 Global Signal Configuration

To access this settings:

1. Select "Baseband > Satellite Navigation > GPS".

2. Select "Simulation Mode > Auto Localization".

3. Select "Satellite Configuration > Global Signal Configuration".

Use the provided settings to determine the type of signal a SV ID will use in the
moment the corresponding satellite becomes visible.
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The dialog displays all available SV ID of each of the enabled GNSS standards
according to the selected almanac. For each available SV ID a signal can be
assigned. Refer to table 3-8 for an overview of the supported signals pre GNSS
standard.

SV ID Signal Coupling
For quick configuration, enables the configuration of all SV IDs simultaneously, i.e. the
value set for the first available SV ID is used for all other. Current settings are overwrit-
ten.

Remote command: 
<subsystem>: SVID: SIGNal:COUPling  on page 220

GPS/Galileo/GLONASS/BeiDou Signals and Power
In "Auto Localization" mode, determine the type of signal and the power a SV ID will
use in the moment the corresponding satellite becomes visible.

Remote command: 
<subsystem>: SVID<ch>:<GNSS>: SIGNal  on page 220
<subsystem>: SVID<ch>:<GNSS>: POWer  on page 220
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3.8 Atmospheric Configuration

To access this dialog,

1. Select "Main Dialog > Satellite Configuration"

2. Select "Atmospheric Configuration".
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The atmospheric configuration comprises the parameters for adjusting the iono-
spheric and tropospheric models of the simulation as well as the corresponding
atmospheric navigation parameters transmitted by each GNSS if available. GPS
and Galileo assume specific ionospheric models and hence transmit different
atmospheric navigation parameters; the one for GLONASS is not yet specified by
the time this firmware had been developed and hence Glonass satellites transmit
no data on the atmosphere. The ionospheric navigation parameters only define
what the satellites are transmitting as ionospheric correction parameters whereas
the model configuration describes the actual ionospheric and tropospheric models
used in the satellite-receiver channel simulation.
The parameters in this dialog are enabled for configuration only for instruments
equipped with the option GNSS Enhanced (R&S SMBV-K92).

Tropospheric Model
Determines whether a STANAG tropospheric model is applied or not.

Remote command: 
<subsystem>: ATMospheric: TROPospheric: MODel on page 250

Ionospheric Model
Determines whether a Klobuchar ionospheric model is applied or the ionospheric
effects are not simulated.

Remote command: 
<subsystem>: ATMospheric: IONospheric: MODel on page 251

Klobuchar Parameters
Defines the ionospheric model used by the channel simulation. The ionospheric model
applies for all satellites, irrespectively to the navigation standards they belong to.

Parameter Description SCPI Command

"alpha_0 ..
alpha_3"

Sets the parameter alpha_0 .. alpha_3 of
the satellite's navigation message.

<subsystem>: ATMospheric: 
IONospheric: KLOBuchar: 
ALPHa<ch0>  on page 251

"beta_0 .. beta_3" Sets the parameter beta_0 .. beta_3 of
the satellite's navigation message.

<subsystem>: ATMospheric: 
IONospheric: KLOBuchar: 
BETA<ch0>  on page 251

GPS/BeiDou Ionospheric Parameters
Changing the ionospheric model has an impact on the satellite's parameters "Time
Shift", "Doppler Shift" and "Duration (Elevation>2.5/5/7.5/10°)".

Atmospheric Configuration
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Parameter Description SCPI Command

"alpha_0 ..
alpha_3"

Displays the parameter alpha_0 ..
alpha_3 of the satellite's navigation mes-
sage.

<subsystem>: ATMospheric: GPS: 
IONospheric: ALPHa<ch0> 
on page 251

<subsystem>: ATMospheric: 
BEIDou: IONospheric: ALPHa<ch0> 
on page 252

"beta_0 .. beta_3" Displays the parameter beta_0 .. beta_3
of the satellite's navigation message.

<subsystem>: ATMospheric: GPS: 
IONospheric: BETA<ch0> 
on page 252

<subsystem>: ATMospheric: 
BEIDou: IONospheric: BETA<ch0> 
on page 252

GALILEO Ionospheric Parameters
The GALILEO ionospheric model includes the broadcast coefficients ai0, ai1 and ai2

used to compute the Effective Ionization Level Az and the "Ionospheric Disturbance
Flag", given for five different regions.

Changing the ionospheric model has an impact on the satellite's parameters "Time
Shift", "Doppler Shift" and "Duration (Elevation>2.5/5/7.5/10°)".

Parameter Description SCPI Command

"a_i0 .. a_i2" Displays the parameters effective Ioniza-
tion level 1st .. 3rd order of the satellite's
navigation message.

<subsystem>: ATMospheric: 
GALileo: IONospheric: AI<ch0> 
on page 252

"SF_1 .. SF_5" Displays the parameters ionospheric dis-
turbance flag for region 1 to 5 of the sat-
ellite's navigation message.

<subsystem>: ATMospheric: 
GALileo: IONospheric: SF<ch> 
on page 253

3.9 Satellites Power Tuning

The parameters of "Power Tuning" are only configurable for R&S SMBV instruments.

To access this dialog:

1. Select "Baseband > Satellite Navigation > GPS".

 

Satellites Power Tuning
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2. Select "Satellite Configuration > Satellites Power Tuning".

The "Satellite Power Tuning" dialog comprises the setting for inter-standard power
relations and the power relation between the signals of a specific GNSS standard.
The inter-standard parameters are required for the configuration of the nominal
power difference between the different navigation standards. These parameters
are considered only in "Auto Power Mode".
See chapter 3.6.1, "Power Configuration", on page 92 for information about the
power calculation.

Intra-Standard Tuning
Intra-Standard power settings are provided for GPS mixed signals. The C/A signal is
allways used as "Power Reference".

Set to 0 ← Intra-Standard Tuning
Sets the power relations between the signal components to 0 dB.

Remote command: 
<subsystem>: POWer:INTRa: GPS:PZERo  on page 226

Set to Standard ← Intra-Standard Tuning
Sets the power relation between the signals belonging to the same navigation standard
according to the relation determined in the specifications.
Table 3-9: Intra-Standard Tuning

Parameter Value

C/A - P 3 dB

Remote command: 
<subsystem>: POWer: INTRa:GPS: PSTandard  on page 226

C/A-P ← Intra-Standard Tuning
Sets the power relation between the signals belonging to the same navigation stand-
ard. Use the Set to Standard function to preset the values.

Remote command: 
<subsystem>: POWer: INTRa: GPS:CAP on page 226

Satellites Power Tuning
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Inter-Standard Tuning
The inter-standard calculation is performed based on the GPS standard.

Set to 0 ← Inter-Standard Tuning
Sets the Inter-Standard Power relations to 0 dB.

Remote command: 
<subsystem>: POWer: INTer: PZERo on page 225

Set to Standard ← Inter-Standard Tuning
Sets the power relation between the signals belonging to the different navigation stand-
ard according to the relation determined in the specifications.
Table 3-10: Inter-Standard Tuning

Parameter Value

GPS C/A - CALILEO E1-DEF -1.25 dB

GPS C/A - GLONASS R-C/A 3.03 dB

GPS C/A - BeiDou (GEO) B-C/A 4.5 dB

GPS C/A - BeiDou (MEO) B-C/A 4.5 dB

GPS C/A - BeiDou (IGSO) B-C/A 4.5 dB

Remote command: 
<subsystem>: POWer: INTer:PSTandard  on page 225

GPS C/A-GALILEO E1-DEF, GPS C/A-GLONASS R-C/A, GPS C/A-BeiDou
(GEO/MEO/IGSO) B-C/A ← Inter-Standard Tuning
Sets the power relation between the signals belonging to the different navigation stand-
ards. Use the Set to Standard function to preset the values.

The power level of the GPS signal C/A is used as reference.

Remote command: 
<subsystem>: POWer:INTer: CAE1Def on page 225
<subsystem>: POWer:INTer: CARCA on page 225
<subsystem>: POWer:INTer: CABCAGeo  on page 225
<subsystem>: POWer:INTer: CABCAIgso  on page 225
<subsystem>: POWer:INTer: CABCAMeo  on page 225

Satellites Power Tuning
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3.10 Navigation Message Configuration

The parameters of the Navigation Message are only configurable for R&S SMBV
instruments equipped with one of the assisted options, e.g. Assisted GPS
(R&S SMBV-K65).
The parameters of the "Navigation Message Configuration" dialog are enabled for con-
figuration only in "User Localization" and "Static Mode" mode on the R&S SMBV; in
"Auto Localization" and R&S WinIQSIM2 "Static" modes, the parameters of the naviga-
tion message of each satellite are read only.

To access this dialog:

1. Select "Baseband > Satellite Navigation > GPS".

2. Select "Simulation Mode > User Localization".

3. Select "Satellite Configuration > Navigation Message Configuration".

Although the navigation messages are fully configurable, it is recommended to use
the almanac's parameter as basis for further configurations (see "Set To Almanac"
on page 119).
For better readability of the parameters in the "Navigation Message Configuration"
dialog, the corresponding values are input as integer in the same way as they are
included in the satellite's navigation message, but the scaled values and the scal-
ing factors are also displayed. Different scaling factors may apply for the same
parameters in the different GNSS standards.

  

(R&S SMBV instruments only)   

 

Navigation Message Configuration
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GPS Satellite Galileo Satellite BeiDou Satellite

  

 GLONASS Satellite  

GPS Satellite GLONASS Satellite BeiDou Satellite

Navigation Message Configuration
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Galileo Satellite Galileo Satellite  

SV-ID / Standard
Displays the SV ID and the navigation standard the navigation message is related to.

Remote command: 
n.a.

Number of Navigation Pages
(Requires installed assistance option, e.g. Assistance GPS R&S SMBV-K65)

Several navigation pages are available per satellite.

If RINEX file is used, the value of this parameter is retrieved from the file. A RINEX file
may contains ephemeris information for up to 24h. Since the ephemeris are update
every two hours, the RINEX file contains a maximum number of 12 navigation pages.

Remote command: 
<subsystem>: SVID<ch>:<GNSS>: NMESsage: PAGE:COUNt  on page 230

Current Page Index
(Requires installed assistance option, e.g. Assistance GPS R&S SMBV-K65)

Select a specific page from all available navigation pages (Number of Navigation
Pages) and enables the set of ephemeris parameters of this page for configuration.

Remote command: 
n.a.

Real-Time Projection
(enabled in "User Localization" mode and disabled "Satellite Configuration > Global
Ephemeris Real-Time Projection")

Enables the instrument to internally perform a projection of the navigation message
whenever this message is approaching its validity limit.

When using RINEX file containing information for up to 24 hours, the navigation page
to be used is selected in the way, that the simulation start time is within the time span
from TOE to TOE+2h, i.e. TOE <= Current Simulation Time <= TOE+2h.

It may however happen, that the required consecutive navigation page is missing in the
RINEX file. The enabled "Real-Time Projection" assures the automatic projection of the
navigation message, i.e. the ephemeris set will contain valid data again.

Note: "Real-Time Projection" have to be disabled, if assistance data will be generated.

Remote command: 
<subsystem>: SVID<ch>: <GNSS>:NMESsage: RTPRojection  on page 231

Navigation Message Configuration
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Set To Almanac
(enabled only in "User Localization" mode)

The navigation message's parameters will be calculated according to the selected
almanac.

Using this option as basis for further reconfiguration is recommended.

Remote command: 
<subsystem>: SVID<ch>: <GNSS>:NMESsage: PRESet  on page 230

Project Navigation Message
(enabled only in "User Localization" mode)

Triggers the projection of the parameters of the navigation message. The values of the
TOE and TOC are calculated according to the selected current simulation time (for
"System Time UTC", as selected with the parameters Date [dd.mm.yyyy] and Time
[hh:mm:ss:xxx]). The updated values of the ephemeris and clock correction are dis-
played.

Note: Use this function prior to the generation of assistance data, if RINEX files are not
used.
The projection affects the parameters of the signal at the exact moment the satelilite is
activated. Thus, if projection is required, trigger the projection at the beginning of the
satellite signal generation.

Remote command: 
<subsystem>: SVID<ch>:<GNSS>: NMESsage: PROJect  on page 230

GPS, Galileo and BeiDou Common Ephemeris Parameters
The ephemeris parameters correspond to the SV ID and navigation standard displayed
with the parameter SV-ID / Standard and to the navigation page determined by the
Current Page Index.
Table 3-11: Common Ephemeris Parameters

Parameter Description SCPI command

M_0 Mean Anomaly at Reference Time (1) <subsystem>: SVID<ch>: <GNSS>: 
NMESsage[: PAGE<us>]: EPHemeris: 
MZERo on page 238

Delta_N Mean Motion Difference From Computed
Value (1)

<subsystem>: SVID<ch>: <GNSS>: 
NMESsage[: PAGE<us>]: EPHemeris: 
NDELta  on page 238

e Eccentricity (1) <subsystem>: SVID<ch>: <GNSS>: 
NMESsage[: PAGE<us>]: EPHemeris: 
ECCentricity  on page 235

1) As this parameter affects the satellite's orbit,
the value selected here also has an impact
on the satellite's parameters "Time Shift",
"Doppler Shift" and "Duration (Eleva-
tion>2.5/5/7.5/10°)".

The value of these parameters will be upda-
ted automatically.

 

Navigation Message Configuration



User InterfaceSatellite Navigation

120Operating Manual 1173.1427.12 ─ 08

Parameter Description SCPI command

SQRT(A) Square Root of the Semi-Major Axis (1) <subsystem>: SVID<ch>: <GNSS>: 
NMESsage[: PAGE<us>]: EPHemeris: 
SQRA on page 240

OMEGA_0 Longitude of Ascending Node of Orbit Plane
at Weekly Epoch (1)

<subsystem>: SVID<ch>: <GNSS>: 
NMESsage[: PAGE<us>]: EPHemeris: 
OZERo on page 239

i_0 Inclination Angle at Reference Time (1) <subsystem>: SVID<ch>: <GNSS>: 
NMESsage[: PAGE<us>]: EPHemeris: 
IZERo on page 237

Omega Argument of Perigee (1) <subsystem>: SVID<ch>: <GNSS>: 
NMESsage[: PAGE<us>]: EPHemeris: 
OMEGa on page 239

OMEGA_DOT Rate of Right Ascension (1) <subsystem>: SVID<ch>: <GNSS>: 
NMESsage[: PAGE<us>]: EPHemeris: 
ODOT on page 238

IDOT Rate of Inclination Angle (1) <subsystem>: SVID<ch>: <GNSS>: 
NMESsage[: PAGE<us>]: EPHemeris: 
IDOT on page 236

C_uc Amplitude of the Cosine Harmonic Correc-
tion Term to the Argument of Latitude (1)

<subsystem>: SVID<ch>: <GNSS>: 
NMESsage[: PAGE<us>]: EPHemeris: 
CUC on page 234

C_us Amplitude of the Sine Harmonic Correction
Term to the Argument of Latitude (1)

<subsystem>: SVID<ch>: <GNSS>: 
NMESsage[: PAGE<us>]: EPHemeris: 
CUS on page 235

C_rc Amplitude of the Cosine Harmonic Correc-
tion Term to the Orbit Radius (1)

<subsystem>: SVID<ch>: <GNSS>: 
NMESsage[: PAGE<us>]: EPHemeris: 
CRC on page 234

C_rs Amplitude of the Sine Harmonic Correction
Term to the Orbit Radius (1)

<subsystem>: SVID<ch>: <GNSS>: 
NMESsage[: PAGE<us>]: EPHemeris: 
CRS on page 234

C_ic Amplitude of the Cosine Harmonic Correc-
tion Term to the Angle of Inclination (1)

<subsystem>: SVID<ch>: <GNSS>: 
NMESsage[: PAGE<us>]: EPHemeris: 
CIC on page 233

C_is Amplitude of the Sine Harmonic Correction
Term to the Angle of Inclination (1)

<subsystem>: SVID<ch>: <GNSS>: 
NMESsage[: PAGE<us>]: EPHemeris: 
CIS on page 233

TOE Time Of Ephemeris (1) <subsystem>: SVID<ch>: <GNSS>: 
NMESsage[: PAGE<us>]: EPHemeris: 
TOE on page 241

1) As this parameter affects the satellite's orbit,
the value selected here also has an impact
on the satellite's parameters "Time Shift",
"Doppler Shift" and "Duration (Eleva-
tion>2.5/5/7.5/10°)".

The value of these parameters will be upda-
ted automatically.
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GPS and BeiDou Ephemeris Parameters
The ephemeris parameters correspond to the SV ID and navigation standard displayed
with the parameter SV-ID / Standard and to the navigation page determined by the
Current Page Index.
Table 3-12: GPS and BeiDou Ephemeris Parameters

Parameter Description SCPI command

SV accuracy /
URA Index

 <subsystem>: SVID<ch>: <GNSS>: 
NMESsage[: PAGE<us>]: EPHemeris: 
URA on page 241

SV Health This value does not have an impact on the
actual health status of the generated satel-
lite.

<subsystem>: SVID<ch>: <GNSS>: 
NMESsage[: PAGE<us>]: EPHemeris: 
HEALth  on page 236

IODC Issue of Data, Clock <subsystem>: SVID<ch>: <GNSS>: 
NMESsage[: PAGE<us>]: EPHemeris: 
IDOC on page 236

IODE Issue of Data, Ephemeris <subsystem>: SVID<ch>: <GNSS>: 
NMESsage[: PAGE<us>]: EPHemeris: 
IDOE on page 237

1) As this parameter affects the satellite's orbit,
the value selected here also has an impact
on the satellite's parameters "Time Shift",
"Doppler Shift" and "Duration (Eleva-
tion>2.5/5/7.5/10°)".

The value of these parameters will be upda-
ted automatically.

 

GPS Ephemeris Parameters
The ephemeris parameters correspond to the SV ID and navigation standard displayed
with the parameter SV-ID / Standard and to the navigation page determined by the
Current Page Index.
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Table 3-13: GPS Ephemeris Parameters

Parameter Description SCPI command

Code on L2 Type of code for L2; This value does not
have any impact on the actual used ranging
code of the generated satellite.

The used "Ranging Code" is set in the "Sat-
ellite Configuration" menu.
● "Reserved"

Reserved for future use.
● "P Code ON"

Carrier L2 (f_L2= 1.2276 GHz) is modu-
lated by P-code (BPSK).

● "C/A Code ON"
Carrier L2 (f_L2= 1.2276 GHz) is modu-
lated by C/A-code (BPSK).

<subsystem>: SVID<ch>: GPS:
NMESsage[: PAGE<us>]: EPHemeris: 
CLTMode  on page 233

L2 P Data
Flag

Use of carrier L2 P data flag

This value does not have an impact on
whether really data is transmitted on the sat-
ellite's carrier L2 or not.

<subsystem>: SVID<ch>: GPS:
NMESsage[: PAGE<us>]: EPHemeris: 
LTPData  on page 238

Fit Interval
Flag

Indicates the curve-fit interval used by the
CS (Control Segment) in determining the
ephemeris parameters

<subsystem>: SVID<ch>: GPS:
NMESsage[: PAGE<us>]: EPHemeris: 
FIFLag  on page 235

SF1 Reserved
1/2/3/4

 <subsystem>: SVID<ch>: GPS:
NMESsage[: PAGE<us>]: EPHemeris: 
SF1Reserved<gr>  on page 239

AODO Age of Data Offset <subsystem>: SVID<ch>: GPS:
NMESsage[: PAGE<us>]: EPHemeris: 
AODO on page 233

SV Configura-
tions

 <subsystem>: SVID<ch>: GPS:
NMESsage[: PAGE<us>]: EPHemeris: 
SVConfig  on page 240

1) As this parameter affects the satellite's orbit,
the value selected here also has an impact
on the satellite's parameters "Time Shift",
"Doppler Shift" and "Duration (Eleva-
tion>2.5/5/7.5/10°)".

The value of these parameters will be upda-
ted automatically.

 

Galileo Ephemeris Parameters
Comprises the Galileo specific ephemeris parameters.
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Table 3-14: Galileo Specific Ephemeris Parameters

Parameter Description SCPI command

SISA Signal In Space Accuracy <subsystem>: SVID<ch>: GALileo: 
NMESsage[: PAGE<us>]: EPHemeris: 
SISA on page 240

IODnav Issue Of Data (Ephemeris and Clock correc-
tion)

<subsystem>: SVID<ch>: GALileo: 
NMESsage[: PAGE<us>]: EPHemeris: 
IODNav  on page 237

IODa Issue Of Data (Almanacs) <subsystem>: SVID<ch>: GALileo: 
NMESsage[: PAGE<us>]: EPHemeris: 
IODA on page 236

GPS and BeiDou Clock Correction Parameters
The ephemeris parameters correspond to the SV ID and navigation standard displayed
with the parameter SV-ID / Standard and to the navigation page determined by the
Current Page Index.
Table 3-15: GPS and BeiDou Clock Correction Parameters

Parameter Description SCPI command

T_GD L1-L2 Correction Term (1) <subsystem>: SVID<ch>: <GNSS>: 
NMESsage[: PAGE<us>]: CCORection: 
TGD on page 232

t_OC

a_f2

a_f1

a_f0

Clock Correction Parameter (1) <subsystem>: SVID<ch>: <GNSS>: 
NMESsage[: PAGE<us>]: CCORection: 
TOC on page 232

<subsystem>: SVID<ch>: <GNSS>: 
NMESsage[: PAGE<us>]: CCORection: 
AF<gr0>  on page 231

1: As this parameter affects the satellite's orbit, the value selected here also has an
impact on the satellite's parameters "Time Shift", "Doppler Shift" and "Duration (Eleva-
tion>2.5/5/7.5/10°)".

The value of these parameters will be updated automatically.

GLONASS Ephemeris Parameters
Comprises the GLONASS specific ephemeris parameters.
Table 3-16: GLONASS Specific Ephemeris Parameters

Parameter Description SCPI command

Satellite
Ephemeris
Type (M)

Satellite ephemeris types GLONASS, GLO-
NASS-M

<subsystem>: SVID<ch>: GLONass: 
NMESsage[: PAGE<us>]: EPHemeris: 
SEType  on page 247

SV accuracy /
URA Index
(F_T)

Provides the predicted satellite user range
accuracy (URA).

<subsystem>: SVID<ch>: GLONass: 
NMESsage[: PAGE<us>]: EPHemeris: 
URA on page 249
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Parameter Description SCPI command

SV Health
(B_n,1_n)

A health value. The user navigation equip-
ment analyzes only the MSB of this word.
● B_n[3] = 1_n = 1

Satellite not healthy
● B_n[3] = 1_n = 0

Satellite is healthy

<subsystem>: SVID<ch>: GLONass: 
NMESsage[: PAGE<us>]: EPHemeris: 
HEALth  on page 246

Age of
Ephemeris
Page (P1)

Time interval between 2 adjacent values of
TOE. It defines hence the age of the current
Glonass Ephemeris page.
This parameter maps to the P1 parameter in
the navigation message as follows:
● 01

Age of Ephemeris = 30 min
● 10

Age of Ephemeris = 45 min
● 11

Age of Ephemeris = 60 min

Note: Tb-Interval and TOE displays depend
on this value.

<subsystem>: SVID<ch>: GLONass: 
NMESsage[: PAGE<us>]: EPHemeris: 
AOEP on page 246

Tb-Index Index of the Tb-time interval. Time of
Ephemeris (TOE) corresponds to this value
multiplied by 15 minutes. This value is
actually a scaled TOE value with a unit of 15
minutes.

Note: Tb-Interval and TOE displays depend
on this value.
Condition to be always met:
● (Tb-Index – 1)

should be an integer multiple of (Age
of Ephemeris[min]/15)

● Case 1:
Age of Ephemeris = 30 min
Tb-Index = 1, 3, 5... 95

● Case 2:
Age of Ephemeris=45 min
Tb-Index = 1, 4, 7... 94

● Case 3:
Age of Ephemeris = 60 min
Tb-Index = 1, 5, 9... 93

<subsystem>: SVID<ch>: GLONass: 
NMESsage[: PAGE<us>]: EPHemeris: 
TINDex  on page 248

Tb-Alignment
(P2)

Configures TOE to be aligned to an even or
odd scale of 15 min for "Age of Ephemeris" =
30 or 60 min.

Forced to "1", hence odd in case of Age of
Ephemeris = 45 min

Note: All Ephemeris pages of an SVID have
the same Tb alignment (P2).

The Tb-Interval and TOE parameters
depend on this value.

<subsystem>: SVID<ch>: GLONass: 
NMESsage[: PAGE<us>]: EPHemeris: 
TALignment  on page 247
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Parameter Description SCPI command

Tb-Interval Displays the Tb-Interval in the current day
where the Ephemeris set page is valid.

Tb-Interval = [((Tb - 1 + P2) *
15 * 60) -AgeOfEphemeris / 2
Examples:
● tb = 45, P2 = 1 and Age of Eph = 30

Tb-Interval = [11:00:00 11:30:00]
● tb = 45, P2 = 1 and Age of Eph = 45

Tb-Interval = [10:52:30 11:37:30]
● tb = 45, P2 = 0 and Age of Eph = 60

Tb-Interval=[10:30:00 11:30:00]

<subsystem>: SVID<ch>: GLONass: 
NMESsage[: PAGE<us>]: EPHemeris: 
TINTerval?  on page 248

TOE (tb) Displays the time of Ephemeris in the current
day. Also referred to in the standard as the
middle of the Tb-Interval or tb. This parame-
ter is equivalent to DayTime[(Tb - 1 +
P2) * 15 * 60 seconds] and independ-
ent of "Age of Ephemeris".
Examples:
● tb = 45, P2 = 1
● tb = 45, P2 = 1
● tb = 45, P2 = 0

TOE = 11:00:00

<subsystem>: SVID<ch>: GLONass: 
NMESsage[: PAGE<us>]: EPHemeris: 
TOE? on page 248

p Reliability measure of system time conver-
sion parameters.
● 00

TAU_C and TAU_GPS relayed from
control segment.

● 01
TAU_C from control segment;
TAU_GPS calculated on board GLO-
NASS-M satellite.

● 10
TAU_C on board Glonass-M satellite
and TAU_GPS relayed from CS.

● 11
TAU_C and TAU_GPS calculated on
board Glonass-M satellites.

<subsystem>: SVID<ch>: GLONass: 
NMESsage[: PAGE<us>]: EPHemeris: P
on page 247

X_n The OX position coordinate of the current
satellite at TOE(tb), i.e. the middle of the Tb-
Interval(1).

<subsystem>: SVID<ch>: GLONass: 
NMESsage[: PAGE<us>]: EPHemeris: 
XN on page 249

Y_n The OY position coordinate of the current
satellite at TOE(tb), i.e. the middle of Tb-
Interval(1).

<subsystem>: SVID<ch>: GLONass: 
NMESsage[: PAGE<us>]: EPHemeris: 
YN on page 249

Z-n The OZ position coordinate of the current
satellite at TOE(tb), i.e. the middle of Tb-
Interval(1).

<subsystem>: SVID<ch>: GLONass: 
NMESsage[: PAGE<us>]: EPHemeris: 
ZN on page 249

XDOT_n The OX velocity coordinate of the current
satellite at TOE(tb), i.e. the middle of Tb-
Interval(1).

<subsystem>: SVID<ch>: GLONass: 
NMESsage[: PAGE<us>]: EPHemeris: 
XDN on page 250

YDOT_n The OY velocity coordinate of the current
satellite at TOE(tb), i.e. the middle of Tb-
Interval(1).

<subsystem>: SVID<ch>: GLONass: 
NMESsage[: PAGE<us>]: EPHemeris: 
YDN on page 250
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Parameter Description SCPI command

ZDOT_n The OZ velocity coordinate of the current
satellite at TOE(tb), i.e. the middle of Tb-
Interval(1).

<subsystem>: SVID<ch>: GLONass: 
NMESsage[: PAGE<us>]: EPHemeris: 
ZDN on page 250

XDDOT_n The OX acceleration coordinate of the cur-
rent satellite due to solar and lunar gravita-
tional effects at TOE(tb), i.e. the middle of
Tb-Interval(1).

<subsystem>: SVID<ch>: GLONass: 
NMESsage[: PAGE<us>]: EPHemeris: 
XDDN on page 249

YDDOT_n The OY acceleration coordinate of the cur-
rent satellite due to solar and lunar gravita-
tional effects at TOE(tb), i.e. the middle of
Tb-Interval(1).

<subsystem>: SVID<ch>: GLONass: 
NMESsage[: PAGE<us>]: EPHemeris: 
YDDN on page 249

ZDDOT_n The OZ acceleration coordinate of the cur-
rent satellite due to solar and lunar gravita-
tional effects at TOE(tb), i.e. the middle of
Tb-Interval(1).

<subsystem>: SVID<ch>: GLONass: 
NMESsage[: PAGE<us>]: EPHemeris: 
ZDDN on page 249

1: The coordinates correspond to the PZ-90 coordinate system.

GLONASS Clock Correction Parameters
Comprises the GLONASS specific parameters for clock correction.
Table 3-17: GLONASS Clock Correction Parameters

Parameter Description SCPI command

TAU_n (-a_f0) SV Clock bias correction coefficient <subsystem>: SVID<ch>: GLONass: 
NMESsage[: PAGE<us>]: 
CCORrection: TAUN  on page 246

GAMMA_n
(a_f1)

SV Clock drift correction coefficient <subsystem>: SVID<ch>: GLONass: 
NMESsage[: PAGE<us>]: 
CCORrection: GAMN  on page 245

Delta_TAU_n Time difference between navigation RF sig-
nal transmitted in L2 and navigation RF sig-
nal transmitted in L1 band

<subsystem>: SVID<ch>: GLONass: 
NMESsage[: PAGE<us>]: 
CCORrection: DTAU  on page 245

E_n Age of operation information <subsystem>: SVID<ch>: GLONass: 
NMESsage[: PAGE<us>]: 
CCORrection: EN on page 245

Galileo INAV Parameters
Comprises the parameters of the Integrity navigation message I/NAV, provided by E5b
and E1-B signals and supporting Safety of Life Service. The I/NAV message carries
extended system integrity information.
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Table 3-18: INAV Parameters

Parameter Description SCPI command

B_GD (E1-
E5B)

E1-E5b Broadcast Group Delay
BGD(E1,E5b)

<subsystem>: SVID<ch>: GALileo: 
NMESsage[: PAGE<us>]: INAV:BGD 
on page 243

T_OC (E1-
E5B)

Clock correction data reference Time of
Week toC(E1,E5b)

<subsystem>: SVID<ch>: GALileo: 
NMESsage[: PAGE<us>]: INAV:TOC 
on page 245

a_f2 (E1-E5B) SV clock drift rate correction coefficient
af2(E1,E5b)

<subsystem>: SVID<ch>: GALileo: 
NMESsage[: PAGE<us>]: INAV:
AF<gr0>  on page 243

a_f1 (E1-E5B) SV clock drift correction coefficient
af1(E1,E5b)

 

a_f0 (E1-E5B) SV clock bias correction coefficient
afo(E1,E5b)

 

E1B_DVS Data Validity Satellite Status, transmitted on
E1-B (E1-BDVS)

<subsystem>: SVID<ch>: GALileo: 
NMESsage[: PAGE<us>]: INAV:E1BDVS 
on page 243

E5B_DVS Data Validity Satellite Status, transmitted on
E5b (E5bDVS)

<subsystem>: SVID<ch>: GALileo: 
NMESsage[: PAGE<us>]: INAV:E5BDVS 
on page 244

E1B_HS Signal Health Status for E1 (E1-BHS) <subsystem>: SVID<ch>: GALileo: 
NMESsage[: PAGE<us>]: INAV:E1BHS 
on page 244

E5B_HS Signal Health Status for E5b (E5bHS) <subsystem>: SVID<ch>: GALileo: 
NMESsage[: PAGE<us>]: INAV:E5BHS 
on page 244

Galileo FNAV Parameters
Comprises the parameters of the freely accessible navigation message F/NAV, provi-
ded by the E5a signal for Open Service.
Table 3-19: FNAV Parameters

Parameter Description SCPI command

B_GD (E1-
E5A)

E1-E5a Broadcast Group Delay
BGD(E1,E5a)

<subsystem>: SVID<ch>: GALileo: 
NMESsage[: PAGE<us>]: FNAV:BGD 
on page 241

T_OC (E1-
E5A)

Clock correction data reference Time of
Week toC(E1,E5a)

<subsystem>: SVID<ch>: GALileo: 
NMESsage[: PAGE<us>]: FNAV:TOC 
on page 243

a_f2 (E1-E5A) SV clock drift rate correction coeffi cient
af2(E1,E5a)

<subsystem>: SVID<ch>: GALileo: 
NMESsage[: PAGE<us>]: FNAV:
AF<gr0>  on page 241

a_f1 (E1-E5A) SV clock drift correction coeffi cient
af1(E1,E5a)
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Parameter Description SCPI command

a_f0 (E1-E5A) SV clock bias correction coeffi cient
afo(E1,E5a)

 

E5A_DVS Data Validity Satellite Status, transmitted on
E5a (E5aDVS)

<subsystem>: SVID<ch>: GALileo: 
NMESsage[: PAGE<us>]: FNAV:E5ADVS 
on page 242

E5A_HS Signal Health Status for E5a (E5aHS) <subsystem>: SVID<ch>: GALileo: 
NMESsage[: PAGE<us>]: FNAV:E5AHS 
on page 242

K F-NAV Almanac Scheduling start index <subsystem>: SVID<ch>: GALileo: 
NMESsage[: PAGE<us>]: FNAV:K 
on page 242

3.11 Static Multipath Configuration

The parameters of the "Multipath Configuration" are only configurable for instruments
with equipped assisted option (R&S SMBV-K92).

To access this settings:

1. Select "Baseband > Satellite Navigation > GPS".

2. Select "Simulation Mode > User Localization".

3. Select "Satellite Configuration > Multipath".

The "Multipath Configuration" dialog enables you to configure the signal parame-
ters of the selected satellite, so that a signal undergoing multipath propagation is
simulated. The provided settings enable configuration of the number of fading taps
and individual configuration of the time and Doppler shift, power and carrier phase
per tap. The resulting propagation is displayed in the graph on the right side of the
dialog.
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State
Enables/disables the generation of multipath signal for the satellite with the displayed
SV ID belonging to the displayed GNSS standard. Settings made in the dialog are con-
sidered only if the multipath configuration is enabled.

Remote command: 
<subsystem>: SVID<ch>: <GNSS>:MPATh: STATe  on page 207

SV ID / Standard
Displays the SV ID and the GNSS standard the satellite is belonging to.

Remote command: 
n.a.

Number of Taps
Sets the paths number. The value determines the number of rows available for config-
uration.

The maximum value for this parameter is calculated dynamically, see chapter 2.4.1,
"Channel Budget", on page 23.

Remote command: 
<subsystem>: SVID<ch>: <GNSS>:MPATh: TAP:COUNt  on page 208

Multipath Taps Table
Comprises the settings of the taps. The number of taps, i.e. the table rows is deter-
mined by the parameter Number of Taps.

Time Shift / Chips ← Multipath Taps Table
Sets an additional delay of the selected satellite, used to simulate multipath conditions.

Remote command: 
<subsystem>: SVID<ch>: <GNSS>: MPATh: TAP<us>:TSHift  on page 209

Power ← Multipath Taps Table
Sets the additional power of the satellite in dB, used to simulate multipath conditions.
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See chapter 3.6.1, "Power Configuration", on page 92 for information about the power
calculation.

Remote command: 
<subsystem>: SVID<ch>: <GNSS>: MPATh:TAP<us>: POWer  on page 209

Doppler Shift /Hz ← Multipath Taps Table
Enters the additional Doppler shift of the simulated signal of the satellite, used to simu-
late multipath conditions.

Remote command: 
<subsystem>: SVID<ch>: <GNSS>: MPATh:TAP<us>: DSHift  on page 208

Carrier Phase /rad ← Multipath Taps Table
Sets the carrier phase, used in case of multipath simulation.

Remote command: 
<subsystem>: SVID<ch>: <GNSS>: MPATh:TAP<us>: CPHase on page 208

3.12 Assistance Data Generation

The "Assistance Data Generation" dialog is available for instrument equipped with the
basic BeiDou option (R&S SMBV-K107) or one of options for assisted satellite naviga-
tion, e.g. A-GPS (R&S SMBV-K65).

To access the "Assistance Data Generation" dialog:

1. Select "Main Dialog > Simulation Mode > User Localization"

2. Select "Assistance Data Generation".

The "Assistance Data Generation" dialog is used to generate assistance data files
for Assisted-GNSS testing. These files can be formatted into mobile communica-
tion's message formats and passed by the protocol tester to the DUT in order to
speed up Time To First Fix (TTFF). See also chapter 2.10.8, "Generating GNSS
Assistance Data", on page 39.
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The upper part of the "Assistance Data Generation" dialog is where the "Assis-
tance Mode" and the "Space Vehicle Selection" are set. The middle part of the dia-
log comprises the parameters of the "Reference Location" and "Time Configura-
tion". The lower part of the dialog offers assistance in the generation of the "Alma-
nac", "Ionospheric", "Navigation", "UTC" and "Acquisition" files.

The R&S SMBV provides a two-level synchronization concept. The "Synchronize All"
function enables you to perform a fast reload of all parameters in the dialog. Selective
settings alignment is enabled by means of the "Synchronize" functions in each of the
individual parameter groups. Although the selection of the satellite, the configuration of
the reference location and the time configuration parameters are fully user-definable, it
is recommended to use the synchronisation function to retrieve the values for the rele-
vant parameters from the GNSS main dialog as basis for further configuration.
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Assistance Mode
Defines the type of assistance data to be loaded.

Value Required Option

A-GPS R&S SMBV-K65

A-GALILEO R&S SMBV-K67

A-GLONASS R&S SMBV-K95

A-BeiDou R&S SMBV-K107

Remote command: 
<subsystem>: ADGeneration: MODE  on page 259

Synchronize All/Synchronize

Parameter Description SCPI command

"Synchronize
All"

Synchronizes the parameters of the
satellites configuration and of the refer-
ence location configuration blocks as
well as the time configuration parame-
ters with the settings made in the "Sat-
ellite Configuration" dialog and in the
"GNSS Main Dialog".

Note: Synchronized are only the satel-
lites of the corresponding entry stand-
ard; all other satellites, are disregarded.

<subsystem>: ADGeneration: GPS: 
SYNChronize  on page 259

"Synchronize" Synchronizes the settings of the corre-
sponding parameter group.

<subsystem>: ADGeneration: GPS: SVID:
SYNChronize  on page 259

<subsystem>: ADGeneration: GPS: 
LOCation: SYNChronize  on page 259

<subsystem>: ADGeneration: GPS: 
TOAData: SYNChronize  on page 259

Space Vehicle State
Enables/disables a space vehicle with the selected SV ID for generation of assistance
data.

Use the "Synchronize" function to retrieve the SV ID belonging to the selected naviga-
tion standard (Assistance Mode), as configured in the "Satellite Configuration" dialog.

Remote command: 
<subsystem>: ADGeneration: GPS: SVID<ch>:STATe  on page 259

Reference Location
The reference location section provides access to the parameters for setting the coor-
dinates of the reference location.
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Parameter Description

"Position Format" Sets the format in which the Latitude and Longitude are displayed.
● "DEG:MIN:SEC"

The display format is Degree:Minute:Second and Direction, i.e.
XX°XX'XX.XX" Direction, where direction can be North/South and
East/West.

● "Decimal Degree"
The display format is decimal degree, i.e. +/-XX.XXXXX°, where "+"
indicates North and East and "-" indicates South and West.

"Altitude" Sets the geographic altitude of the reference location in meters above sea
level.

"Latitude" Sets the latitude of the reference location.

"Longitude" Sets the longitude of the reference location.

"Uncertainty Radius" Sets the maximum radius of the area within which the two dimensional loca-
tion of the UE is bounded.

The uncertainty radius determines the required sensitivity of the DUT.

Remote command: 
<subsystem>: ADGeneration: GPS: LOCation: URADius on page 262
to enter the coordinates in Degree:Minute:Second format
<subsystem>: ADGeneration: GPS: LOCation: COORdinates: DMS on page 261
to enter the coordinates in decimal degree format
<subsystem>: ADGeneration: GPS: LOCation: COORdinates: DECimal 
on page 260

Uncertainty Radius
Sets the Uncertainty Radius, i.e. sets the maximum radius of the area within which the
two dimensional location of the UE is bounded.

The uncertainty radius determines the required sensitivity of the DUT.

Remote command: 
<subsystem>: ADGeneration: GPS: LOCation:URADius  on page 262

Time Basis
Determines the time basis used to enter the time of assistance data parameters.

Remote command: 
<subsystem>: ADGeneration: GPS:TOAData: TBASis  on page 262

Date [dd.mm.yyyy]
(enabled for "Time Basis" set to UTC or GLONASS)

Enters the date for the assistance data in DD.MM.YYYY format of the Gregorian calen-
dar.

Remote command: 
<subsystem>: ADGeneration: GPS: TOAData:DATE  on page 263

Time [hh:mm:ss]
(enabled for "Time Basis" set to UTC or GLONASS)
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Enters the exact start time for the assistance data in UTC time format.

Remote command: 
<subsystem>: ADGeneration: GPS:TOAData: TIME  on page 263

Week Number
(enabled for "Time Basis" set to GPS, GALILEO or BDT)

Enters week number (WN) the assistance data is generated for.

Remote command: 
<subsystem>: ADGeneration: GPS:TOAData: WNUMber on page 265

Time of Week
(enabled for "Time Basis" set to GPS, GALILEO or BDT)

Determines the Time of Week (TOW) the assistance data is generated for.

Remote command: 
<subsystem>: ADGeneration: GPS:TOAData: TOWeek on page 264

Duration
Sets the duration (in ms) of the assistance data.

Remote command: 
<subsystem>: ADGeneration: GPS:TOAData: DURation  on page 264

Resolution
Sets the resolution (in ms) of the assistance data.

Remote command: 
<subsystem>: ADGeneration: GPS: TOAData: RESolution  on page 264

Data Format
In "Assistance Mode > A-GPS", determines the data format, "GPS" or "GNSS", of the
generated acquisition files.

Affected are the Almanac file, the Navigation file and the acquisition file.

Remote command: 
<subsystem>: ADGeneration[: ACQuisition]: DFORmat  on page 265

Generate Almanac File …
Access the "Generate Almanac File" dialog for saving the generated almanac file. The
file name is user definable; the data format is defined with the parameter Data Format.

The almanac file is generated in one of the listed file formats:
● in a comma separated file format .rs_al (see table 3-20)
● as standard Yuma formatted file .rs_yuma

– This file format is not supported for A-GLONASS.
– In case of GPS, Galileo and BeiDou the .rs_yuma, the almanac file can be

used as the main almanac source for the specific GNSS standard.
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Table 3-20: Contents of the generated almanac file (GPS)

Parameter Unit

SatID -

e dimensionless

toa sec

delta_i semi-circles

OMEGADOT semi-circles/sec

SV Health boolean

SQRT(A) meters

OMEGA0 semi-circles

M0 semi-circles

w semi-circles

af0 seconds

af1 sec/sec

The generated almanac file is conformant to the format appended to standards 3GPP
34.108 v.8.0.0, 3GPP TS 51.010-1v.7.7.0 and 37.571 v10.0. The file lists all possible
satellites, available from the source almanac file.

See chapter 2.10.8, "Generating GNSS Assistance Data", on page 39 for description of
the workflow for generation of assistance data.

Remote command: 
<subsystem>: ADGeneration: ALManac: CREate  on page 266

Generate Ionospheric File …
Access the "Select Ionospheric File" dialog for storing the generated ionospheric
model.

The generated ionospheric file is file with extension .rs_ion and specified file name.

The parameters listed in this file (see the example in table 3-21) are according to the
parameters used for describing the near satellite ionospheric model.
● With GPS Klobuchar parameters are exported
● With Galileo, Galileo Ionosphere parameters are exported
● With GLONASS, file is empty since GLONASS satellites do not transmit any infor-

mation about the ionosphere
Table 3-21: Contents of the generated ionospheric file (GPS)

Parameter Unit

alpha_0 seconds

alpha_1 sec/semi-circles

alpha_2 sec/(semi-circles)2

alpha_3 sec/(semi-circles)3

beta_0 seconds
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Parameter Unit

beta_1 sec/semi-circles

beta_2 sec/(semi-circles)2

beta_3 sec/(semi-circles)3

See chapter 2.10.8, "Generating GNSS Assistance Data", on page 39 for description of
the workflow for generation of assistance data.

Remote command: 
<subsystem>: ADGeneration: IONospheric: CREate on page 267

Generate Navigation File …
Access the "Select Navigation File" dialog for saving the generated navigation model
(ephemeris). The generated navigation file is a file with extension .rs_nav, the
selected file name and data format as defined with the parameter Data Format.

Additionally, RINEX file can be also generated to export the ephemeris assistance
data. The reference for the generating of the ephemeris page of each satellite is the
"Time of Assistance Data". The generated RINEX file is a file with extension .<XX>n
for GPS and Galileo and .<XX>g for GLONASS, where <XX> stands for the year of
the recording, e.g. .12n for GPS ephemeris recording in 2012. The generated RINEX
file is conformed to the standard RINEX file format, as described in chapter A.2.1,
"RINEX Format Description", on page 304.

The generated navigation file comprises the GNSS standard ephemeris and clock cor-
rection parameters of the navigation model (see table 3-22).
Table 3-22: Contents of the generated navigation file (GPS)

Parameter Unit

SatID -

Sat Status -

C/A or P on L2 boolean

URA Index boolean

SV Health boolean

IODC -

L2 P Data Flag boolean

SF 1 Reserved -

TGD sec

toc sec

af2 sec/sec2

af1 sec/sec

af0 sec

Crs meters
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Parameter Unit

delta_n semi-circles/sec

M0 semi-circles

CUC radians

e -

CUS radians

(A)1/2 meters1/2

Toe sec

Fit Interval Flag boolean

AODO sec

CIs radians

I0 semi-circles

Crc meters

omega semi-circles

OMEGAdot semi-circles/sec

Idot semi-circles/sec

The generated .rs_nav comma separated format is conformant to the format appen-
ded to standards 3GPP 34.108 v.8.0.0, 3GPP TS 51.010-1v.7.7.0 and and
37.571v10.0. The file contains one row per satellite.

See section chapter 2.10.8, "Generating GNSS Assistance Data", on page 39 for
description of the workflow for generation of assistance data.

Remote command: 
<subsystem>: ADGeneration: NAVigation: CREate on page 266

Generate UTC File …
Access the "Select UTC File" dialog for saving the generated UTC file. The generated
UTC file is a file with extension .rs_utc and the selected file name.

The file contains all standard UTC parameters (SatID, A_0, A_1, delta_t_LS, t_ot,
WN_t, WN_LSF, DN, and Delta_t_LSF) that are necessary to transform GNSS time to
the normal UTC time.

The generated UTC file contains one entry per standard.

See chapter 2.10.8, "Generating GNSS Assistance Data", on page 39 for description of
the workflow for generation of assistance data.

Remote command: 
<subsystem>: ADGeneration: UTC:CREate  on page 266
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Generate Acquisition File …
Access the "Select Acquisition File" dilaog for saving the generated acquisition file. The
generated Acquisition file is a file with extension .rs_acq, the selected file name and
data format as defined with the parameter Data Format.

This file consists of:
● one or more rows, each corresponding to

– the Receiver Referenced GNSS Time of Week (GNSS TOW) for GPS, Galileo
and BeiDou satellites

– elapsed time, relative to GLONASS Time of Assistance data (Time of
Validity(ms)) for GLONASS satellites.

The number of generated rows is calculated as follow:
Number Of Generated Rows = "Duration Of Assistance Data" / "Resolution of
Assistance Data"

● one or more sequential acquisition blocks per row, where each block comprises the
parameters listed in table 3-23.
The number of the acquisition blocks depends on the number of enabled space
vehicles.

The generated acquisition file is conformed to the format appended to standards 3GPP
34.108 v.8.0.0, 3GPP TS 51.010-1v.7.7.0 and 37.571v10.0.
Table 3-23: Contents of the generated acquisition file (one acquisition block)

Parameter Description Unit

(GPS, BeiDou)

Unit

(GLOANSS, Galileo)

SVID/PRNID Satellite ID that corresponds to
the record

- -

Doppler (0th order
term)

Zero Order Doppler Term Hz Hz

Doppler (1st order
term)

1st order Doppler Term Hz/sec Hz/sec

Doppler Uncer-
tainty

Uncertainty Doppler Hz m/s

Code Phase Code Phase

or half-Chip index at epoch
Time of Transmission (GPS Sat
Time)

chips ms

Integer Code
Phase

Integer Code Phase

or ms unit index at epoch Time
of Transmission (GPS Sat
Time)

- ms

GPS Bit Number Corresponding Bit number
(modulo 4) at epoch Time of
Transmission (GPS Sat Time)

- NA

Code Phase
Search Window

Correlator Code phase Search
Radius

chips ms
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Parameter Description Unit

(GPS, BeiDou)

Unit

(GLOANSS, Galileo)

Azimuth Azimuth Angle of the Satellite in
ENU orthonormal coordinate
System centered at reference
point

deg deg

Elevation Elevation Angle of the Satellite
in ENU orthonormal coordinate
System centered at reference
point

deg deg

See chapter 2.10.8, "Generating GNSS Assistance Data", on page 39 for description of
the workflow for generation of assistance data.

Remote command: 
<subsystem>: ADGeneration: ACQuisition: CREate on page 265

3.13 Real-Time S.P.O.T.

The parameters of the "Real-Time S.P.O.T." are only configurable for R&S SMBV
instruments.

To access this settings:

1. Select "Baseband > Satellite Navigation > GPS".

2. Select "Simulation Mode > Auto Localization/User Localization".

The "Real-Time S.P.O.T." (Satellites and Position Online Tracker) view is a
dynamic display of the current satellite's constellation, receiver position, power lev-
els of the active satellites.
The "Real-Time S.P.O.T." view provides dynamic real-time information about sev-
eral parameters like HDOP, PDOP, receiver's location and current simulation time.

The displayed settings are grouped into different views, the "Sky View", the "Map
View", the "Power View", and the "Trajectory View".
● The "Sky View" displays the current position and state (active or inactive) of the

satellites in the current satellites constellation. Enable "Simulation Mode > Auto
Localization" to observe the situation of disappearance and re-appearance of satel-
lites.
For instruments equipped with option R&S SMBV-K101, the "Sky View" indicates
also the obscured satellites, the satellites with echoes, etc. For example, the satel-
lites which signal is not visible from the current receivers position because there is
a obstacle between the receiver and the satellite, are displayed in grey color.
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LOS = Line of Sight; visible satellite
LOS (A.P. loss) = Visible satellite with antenna pattern loss
LOS + Echoes = Visible satellite with echoes
LOS + Echoes (A. P. loss) = Visible satellite with antenna pattern loss and echoes
Echoes = Obscured satellite, only echoes available for example due to buildings
Obscured = Obscured satellite, for example due to buildings
Inactive = Satellite is not simulated

To query the satellite's constellation for the selected time, use the SCPI command:
<subsystem>: RT:SCONstellation?  on page 277

● The "Map View" display the trajectory of moving receiver or the position of a static
one.

If GNSS receiver software is used to analyze the generated GNSS signal, a slight
difference between the receiver position displayed on the "Map View" and the posi-
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tion displayed on the receiver software may be noticed at the beginning of a simu-
lation. This accuracy of the "Map View" display is progressively increasing with the
time elapsed and after the first satellite handover the deviation should completely
disappear.
To query the receiver location for the selected time, use the SCPI commands:
<subsystem>: RT: RLOCation: COORdinates: DECimal?  on page 274
<subsystem>: RT:RLOCation: COORdinates: DMS?  on page 275

● The "Power View" displays the current power levels of of the signals of the active
satellites and their echos. The displayed values are updated in real time.

To query the satellite's absolute power for the selected time, use the SCPI com-
mand:
<subsystem>: RT:<GNSS>: SVID<ch>: TAP<us>: POWer:ABSolute 
on page 272

● The "Trajectory View" displays the time variation of the azimuth and the satellite's
elevation in the selected time window.

To query the satellite's position for the selected time, use the SCPI commands:
<subsystem>: RT:<GNSS>: SVID<ch>: AZIMuth on page 269
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<subsystem>: RT:<GNSS>: SVID<ch>: ELEVation  on page 271

Example: 
The figures in this section show the "Real-Time S.P.O.T. > Sky View" display of the
same custom build GPS, Galileo and GLONASS hybrid GNSS scenario with automatic
exchange of the satellites but the second one is made around 15 min later (compare
the value of the parameter "Time" in both figures).

Sky View (Start moment) Sky View (15 min later)

The current position and state of the satellites is displayed on the "Sky View". This is a
hybrid GNSS scenario with 12 satellites. Compare the satellite constellations, the posi-
tion and number of active and inactive satellites; some satellites had disappeared
behind the horizon.

3.13.1 Display Type

Display Type
Switches between the available views. See chapter 3.13, "Real-Time S.P.O.T.",
on page 139.

Remote command: 
n.a

3.13.2 Real-Time Information

The "Real-Time Information" section is common for all views and provides dynamic
real-time information about several parameters like "HDOP", "PDOP", "Receiver Loca-
tion", "Elapsed Time" and "Time of Simulation".

Time (UTC)
Displays the current date and time of the simulation. The value is displayed in format
DD.MM.YYY HH:MM:SS and is updated every 5 sec.

Remote command: 
n.a
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Receiver Location
Displays the current location of the receiver in decimal format.

For static Geographic Location/Attitude, the "Receiver Location" is as selected in the
"Localization Data" dialog.

For moving receivers however, the receiver position specified in the "Localization Data"
section of the main dialog is the initial location of the receiver. The current receiver
location is retrieved from the waypoints file as function of the simulation "Time" and
displayed in the "Real-Time S.P.O.T. > Map View" display.

Remote command: 
n.a

Receiver Attitude
Displays the current receiver attitude parameters yaw/heading, pitch/elevation, roll/
bank in degrees.

The initial receiver attitude parameters are selected in the "Localization Data" dialog.

Remote command: 
<subsystem>: RT:RATTitude?  on page 280

HDOP / PDOP
Displays the current HDOP and PDOP value of the selected satellite constellation.

The HDOP (Horizontal Dilution of Precision) can be used as an indication of 2D posi-
tioning quality. The PDOP (Position Dilution of Precision) can be used as an indication
of 3D positioning quality.

The general rule here is that the smaller the HDOP and PDOP are, the better the preci-
sion of the position fix will be.

Remote command: 
n.a.

Next Constellation Change
(enabled for "Auto Localization" mode)

Displays the expected date and time of the upcoming satellites handover.

Remote command: 
<subsystem>: SPOT:NHOTime?  on page 269

3.13.3 Reference Location

The "Reference Location" section is enabled in "Map View" display and provides the
settings for configuration of the reference location.

Reference Location Coordinates
The reference location is identified by a latitude and a longitude. The values can be
displayed in decimal or DMS format. The display format is determined by the parame-
ter "Position Format".
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For static receivers, the initial values of the latitude and longitude are automatically set
to the values of the Geographic Location/Attitude selected in the Localization Data sec-
tion of the main dialog. When simulating moving receivers, the initial values are derived
from the waypoints file and set to the coordinates of the first receiver position.

Parameter Description

"Position Format" Sets the format in which the Latitude and Longitude are displayed.
● "DEG:MIN:SEC"

The display format is Degree:Minute:Second and Direction, i.e.
XX°XX'XX.XX" Direction, where direction can be North/South and
East/West.

● "Decimal Degree"
The display format is decimal degree, i.e. +/-XX.XXXXX°, where "+"
indicates North and East and "-" indicates South and West.

The Position Format selected heir changes the format the Receiver Location
is displayed.

"Latitude" Sets the latitude of the reference location.

"Longitude" Sets the longitude of the reference location.

Remote command: 
n.a

Deviation
Sets the deviation in terms of meters from the Reference Location and determines the
radius of the "Map View" display.

Remote command: 
n.a.

3.13.4 Trajectory View Settings

This settings section is available in the "Trajectory View" display and comprises the
settings for customization of the displayed Azimuth and Elevation trajectories.

Satellite Standard
Determines the navigation standard the Satellite SV-ID is belonging to.

Remote command: 
determined by the <GNSS> block of the SCPI command

Satellite SV-ID
Determines the SV-ID of the satellite for that the Azimuth and Elevation trajectories are
displayed.

Remote command: 
determined by the suffix in the SVID<ch> block of the SCPI command

Time Offset
Determines the time offset as number of days and number of hours.

Remote command: 
n.a.
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Time Window
Sets the time window the trajectories are displayed in, i.e. determines the resolution of
the x-axis of the Trajectory View.

Remote command: 
n.a.

3.14 Trigger/Marker/Clock Settings

To access this dialog, select "Main Dialog > Trigger/Marker".

The trigger and clock functions are available for R&S SMBV instruments only.

The "Trigger In" section is where the trigger for the signal is set. Various parameters
will be provided for the settings, depending on which trigger source - internal or exter-
nal - is selected. The current status of signal generation ("Running" or "Stopped") is
indicated for all trigger modes.

The "Marker Mode" section is where the marker signals at the MARKER output con-
nectors are configured.

The "Marker Delay" section is where a marker signal delay can be defined, either with-
out restriction or restricted to the dynamic section, i.e., the section in which it is possi-
ble to make settings without restarting signal and marker generation.
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The "Clock Settings" section is where the clock source is selected and - in the case of
an external source - the clock type.

The buttons in the last section lead to the submenu for general trigger, clock and map-
ping settings.

3.14.1 Trigger In

The "Trigger In" section is where the trigger for the signal is set. Various parameters
will be provided for the settings, depending on which trigger source - internal or exter-
nal - is selected. The current status of signal generation ("Running" or "Stopped") is
indicated for all trigger modes.

Trigger Mode
Selects trigger mode.

The trigger mode determines the effect of a trigger on the signal generation.

"Auto" The signal is generated continuously.

"Retrigger" The signal is generated continuously. A trigger event (internal or
external) causes a restart.
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"Armed_Auto" The signal is generated only when a trigger event occurs. Then the
signal is generated continuously.
Button "Arm" stops signal generation. A subsequent trigger event
(internal with "Execute Trigger" or external) causes a restart.

"Armed_Ret-
rigger"

The signal is generated only when a trigger event occurs. Then the
signal is generated continuously. Every subsequent trigger event cau-
ses a restart.
Button "Arm" stops signal generation. A subsequent trigger event
(internal with "Execute Trigger" or external) causes a restart.

"Single" The signal is generated only when a trigger event occurs. Then the
signal is generated once to the length specified at "Signal Duration".
Every subsequent trigger event (internal with "Execute Trigger" or
external) causes a restart.

Remote command: 
<subsystem>[: TRIGger]: SEQuence  on page 282

Signal Duration
Defines the length of the signal sequence to be output in the "Single" trigger mode.

It is possible to output deliberately just part of the signal, an exact sequence of the sig-
nal, or a defined number of repetitions of the signal.

Remote command: 
<subsystem>: TRIGger: SLENgth on page 282

Running/Stopped
Displays the status of signal generation for all trigger modes. This display appears only
when signal generation is enabled ("State" On).

"Running" The modulation signal is generated; a trigger was (internally or exter-
nally) initiated in triggered mode.
If "Armed_Auto" and "Armed_Retrigger" have been selected, genera-
tion of signals can be stopped with the "Arm" button. A new trigger
(internally with "Execute Trigger" or externally) causes a restart.

"Stopped" The signal is not generated, and the instrument waits for a trigger
event (internal or external).

Remote command: 
<subsystem>: TRIGger: RMODe?  on page 283

Arm
(R&S SMBV only)

Stops signal generation. This button appears only with "Running" signal generation in
the "Armed_Auto" and "Armed_Retrigger" trigger modes.

Signal generation can be restarted by a new trigger (internally with "Execute Trigger"
or externally).

Remote command: 
<subsystem>: TRIGger:ARM: EXECute  on page 283
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Execute Trigger
(R&S SMBV only)

Executes trigger manually. A manual trigger can be executed only when an internal
trigger source and a trigger mode other than "Auto" have been selected.

Remote command: 
<subsystem>: TRIGger:EXECute  on page 284

Trigger Source
Selects trigger source. This setting is effective only when a trigger mode other than
"Auto" has been selected.

"Internal" The trigger event is executed by "Execute Trigger".

"External" The trigger event is executed with the aid of the active edge of an
external trigger signal.
The trigger signal is supplied via the TRIGGER connector. The polar-
ity, the trigger threshold and the input impedance of the TRIGGER
input can be set in the "Global Trigger/Clock Settings" dialog.

Remote command: 
<subsystem>: TRIGger: SOURce  on page 284

Sync. Output to External Trigger
(enabled for Trigger Source External)

Enables/disables output of the signal synchronous to the external trigger event.

For or two or more R&S SMBVs configured to work in a master-slave mode for syn-
chronous signal generation, configure this parameter depending on the provided sys-
tem trigger event and the properties of the output signal. See the table below for an
overview of the required settings.
Table 3-24: Typical Applications

System Trigger Application "Sync. Output
to External
Trigger"

Common External Trigger event
for the master and the slave
instruments

All instruments are synchronous to the external trig-
ger event

ON

All instruments are synchronous among themselves
but starting the signal from first symbol is more
important than synchronicity with external trigger
event

OFF

Internal trigger signal of the mas-
ter R&S SMBV for the slave
instruments

All instruments are synchronous among themselves OFF
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"On" Corresponds to the default state of this parameter.
The signal calculation starts simultaneously with the external trigger
event but because of the instrument’s processing time the first sam-
ples are cut off and no signal is outputted. After elapsing of the inter-
nal processing time, the output signal is synchronous to the trigger
event.

"Off" The signal output begins after elapsing of the processing time and
starts with sample 0, i.e. the complete signal is outputted.
This mode is recommended for triggering of short signal sequences
with signal duration comparable with the processing time of the
instrument.

Remote command: 
<subsystem>: TRIGger: EXTernal: SYNChronize: OUTPut  on page 284

External Delay
Sets the trigger signal delay in chips on external triggering. This enables the instrument
to be synchronized with the device under test or other external devices.

Remote command: 
<subsystem>: TRIGger[:EXTernal<ch>]: DELay on page 286

External Inhibit
Sets the duration for inhibiting a new trigger event subsequent to triggering. The input
is to be expressed in chips.

Trigger/Marker/Clock Settings
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In the "Retrigger" mode, every trigger signal causes signal generation to restart. This
restart is inhibited for the specified number of chips.

Remote command: 
<subsystem>: TRIGger[: EXTernal<ch>]: INHibit  on page 286

3.14.2 Marker Mode

The marker output signal for synchronizing external instruments is configured in the
marker settings section "Marker Mode".

Marker Mode
Selects a marker signal for the associated "MARKER" output.

Note: One marker signal. In instruments equipped with option R&S SMBV-K96, disa-
bled parameter Use Position Accuracy (P-Code) GPS and enabled satellites constella-
tion with more than 12 satellites, only one marker signal is available!

"Restart" (R&S WinIQSIM2 only)
A marker signal is generated continuously. A trigger event causes a
restart.
This marker marks one repetition of the ARB and hence depends on
"Duration Of Satellite Simulation".

"1PPS" A marker signal is generated for every start of second. The used time
basis is displayed rigth to the field.
The "Pulse Width" is set in the corresponding field. The input is
expressed as a number of chips.

"10PPS" A marker signal is generated ten times per second hence once every
100 ms.

"1PP2S" A marker signal is generated for every second start of second. The
used time basis is displayed rigth to the field.
The "Pulse Width" is set in the corresponding field. The input is
expressed as a number of chips.

Remote command: 
<subsystem>: TRIGger: OUTPut<ch>: PULSe: WIDTh on page 289

"Pulse" A regular marker signal is generated. The clock frequency is defined
by entering a divider. The frequency is derived by dividing the chip
rate by the divider. The input box for the divider opens when "Pulse"
is selected, and the resulting pulse frequency is displayed.

Remote command: 
<subsystem>: TRIGger: OUTPut<ch>: PULSe: DIVider on page 288
<subsystem>: TRIGger: OUTPut<ch>: PULSe: FREQuency?  on page 289

"Pattern" A marker signal that is defined by a bit pattern is generated. The pat-
tern has a maximum length of 32 bits and is defined in an input field
which opens when pattern is selected.

Remote command: 
<subsystem>: TRIGger: OUTPut<ch>: PATTern  on page 288
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"ON/OFF
Ratio"

A regular marker signal that is defined by an ON/OFF ratio is gener-
ated. A period lasts one ON and OFF cycle.
The "ON Time" and "OFF Time" are each expressed as a number of
samples and are set in an input field which opens when ON/OFF ratio
is selected.

Remote command: 
<subsystem>: TRIGger: OUTPut<ch>: ONTime  on page 288
<subsystem>: TRIGger: OUTPut<ch>: OFFTime  on page 288

"Trigger" A marker signal is generated only when a trigger event occurs. Then
the signal is generated continuously. Every subsequent trigger event
causes a restart.

Remote command: 
<subsystem>: TRIGger: OUTPut<ch>: MODE on page 287

3.14.3 Marker Delay

The delay of the signals on the MARKER outputs is set in the"Marker Delay" section.

Marker x Delay
Enters the delay between the marker signal at the marker outputs and the start of the
frame or slot.

The input is expressed as a number of chips. If the setting "Fix marker delay to
dynamic range" is enabled, the setting range is restricted to the dynamic range. In this
range the delay of the marker signals can be set without restarting the marker and sig-
nal.

Remote command: 
<subsystem>: TRIGger:OUTPut<ch>: DELay on page 285

Current Range without Recalculation
Displays the dynamic range within which the delay of the marker signals can be set
without restarting the marker and signal.

The delay can be defined by moving the setting mark.

Remote command: 
<subsystem>: TRIGger:OUTPut<ch>: DELay: MINimum?  on page 285
<subsystem>: TRIGger:OUTPut<ch>: DELay: MAXimum?  on page 285

Fix marker delay to current range
Restricts the marker delay setting range to the dynamic range. In this range the delay
can be set without restarting the marker and signal.

Remote command: 
<subsystem>: TRIGger: OUTPut: DELay:FIXed  on page 286
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3.14.4 Clock Settings

The Clock Settings is used to set the clock source and a delay if required.

Sync. Mode
Selects the synchronization mode.

This parameter is used to enable generation of very precise synchronous signal of sev-
eral connected R&S SMBVs.

Note: If several instruments are connected, the connecting cables from the master
instrument to the slave one and between each two consecutive slave instruments must
have the same length and type.
Avoid unnecessary cable length and branching points.

"None" The instrument is working in stand-alone mode.

"Sync. Master" The instrument provides all connected instrument with its synchroni-
sation (including the trigger signal) and reference clock signal.

"Sync. Slave" The instrument receives the synchronisation and reference clock sig-
nal from another instrument working in a master mode.

Remote command: 
<subsystem>: CLOCk: SYNChronization: MODE  on page 291

Set Synchronization Settings
Performs automatically adjustment of the instrument's settings required for the syn-
chronization mode, selected with the parameter "Synchronization Mode".

Remote command: 
<subsystem>: CLOCk: SYNChronization: EXECute  on page 291

Clock Source
Selects the clock source.

"Internal" The internal clock reference is used to generate the symbol clock.

"External" The external clock reference is fed in as the symbol clock or multiple
thereof via the CLOCK connector. The symbol rate must be correctly
set to an accuracy of +/-2 % (see data sheet).
The polarity of the clock input can be changed with the aid of "Global
Trigger/Clock Settings".

Remote command: 
<subsystem>: CLOCk: SOURce on page 290

Clock Mode
Enters the type of externally supplied clock.

"Chip" A chip clock is supplied via the CLOCK connector.
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"Multichip" A multiple of the chip clock is supplied via the CLOCK connector; the
sample clock is derived internally from this.
The "Multiplier" window provided allows the multiplication factor to be
entered.

Remote command: 
<subsystem>: CLOCk: MODE on page 290

Clock Multiplier
Enters the multiplication factor for clock type "Multiple".

Remote command: 
<subsystem>: CLOCk:MULTiplier  on page 290

Measured External Clock
Provided for permanent monitoring of the enabled and externally supplied clock signal.

Remote command: 
CLOCk:INPut:FREQuency?

3.14.5 Global Settings

The buttons in this section lead to submenu for general trigger, clock and mapping set-
tings.

Global Trigger/Clock Settings
Calls the "Global Trigger/Clock/Input Settings" dialog.

This dialog is used among other things for setting the trigger threshold, the input impe-
dance and the polarity of the clock and trigger inputs.

The parameters in this menu affect all digital modulations and standards, and are
described in chapter "Global Trigger/Clock/Input Settings" in the Operating Manual.
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4 Remote-Control Commands
The following commands are required to perform signal generation with the satellite
navigation options in a remote environment. We assume that the R&S SMBV has
already been set up for remote operation in a network as described in the R&S SMBV
documentation. A knowlage about the remote control operation and the SCPI com-
mand syntax are assumed.

Conventions used in SCPI command descriptions
For a description of the conventions used in the remote command descriptions, see
section "Remote Control Commands" in the R&S SMBV operating manual.

The SOURce:BB:GPS|GALileo|GLONass|BEIDou subsystem contains commands
for configuring hte GNSS standards.

Placeholder <Subsystem>

To simplify the description of the remote control commands, the placeholder
<Subsystem> is introduced. Depending on the navigation standard used as an entry
standard, replace this placeholder <Subsystem> with SOURce:BB:GPS,
SOURce:BB:GALileo (for Galileo), SOURce:BB:GLONass (for GLONASS) or
SOURce:BB:BEIDou (for BeiDou).

The replacement of the place holder <Subsystem> is mandatory, i.e. remote control
commands containing this placeholder are not recognized and accepted by the instru-
ment.

Example: 
SCPI command: <subsystem>: STATe 
● Entry Standard = GPS

SOUR:BB:GPS:STAT
● Entry Standard = Galileo

SOUR:BB:GAL:STAT
● Entry Standard = GLONASS

SOUR:BB:GLON:STAT
● Entry Standard = BeiDou

SOUR:BB:BEID:STAT
● invalid command

<Subsystem>:STAT

Placeholder <GNSS>

The placeholder <GNSS> is introduced to simplify the description of group of com-
mands with similar syntax. Depending on the navigation standard to be controlled,
replace this placeholder <GNSS> with GPS, GALileo, GLONass or BEIDou.
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Example: 
SCPI command: <subsystem>: HYBRid:<GNSS>[: STATe] 
● Entry Standard = GPS

replace the placeholder<subsystem> with SOUR:BB:GPS
● In a hybrid GNSS configuration, the navigation standard of the entry point (GPS) is

always enabled. To enable the Galileo satellites, replace the placeholder <GNSS>
with GALileo
SOUR:BB:GPS:HYBR:GAL:STAT

● invalid commands
<Subsystem>:HYBR:GAL:STAT
SOUR:BB:GPS:HYBR:<GNSS>:STAT

Common Suffixes

The following common suffixes are used in remote commands:

Suffix Value range Description

SOURce<hw> [1] available baseband signals

OUTPut<ch> 1 .. 4

1 .. 2

available markers

R&S SMBV supports two markers

EXTernal<ch> 1 .. 2 external trigger connectors

SVID<ch> 1 .. 37 for GPS satel-
lites

1 .. 50 for Galileo sat-
ellite

distinguishes between the SV IDs

Note: The SV ID must correspond to a healthy satellie!

TAP<us> 1 .. 10 taps in the multipath configuration

Satellite<st> 1 .. 24 distinguishes between the satellites

PAGE<us> 1 .. 12 navigation page

Tasks (in manual or remote operation) that are also performed in the base unit in the
same way are not described here.
In particular, this includes:
● Managing settings and data lists, i.e. storing and loading settings, creating and

accessing data lists, accessing files in a particular directory, etc.
● Information on regular trigger, marker and clock signals as well as filter settings, if

appropriate.
● General instrument configuration, such as configuring networks and remote opera-

tion
● Using the common status registers

For a description of such tasks, see the R&S SMBV operating manual.

The following commands specific to the satellite standards are described here:
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● Programming Examples........................................................................................157
● Primary Settings....................................................................................................157
● User Environment, Antenna Pattern and Body Mask............................................165
● Localization Data...................................................................................................169
● Navigation Data.....................................................................................................175
● Obscuration and Auto Multipath............................................................................178
● Hardware in the Loop (HIL)...................................................................................190
● GNSS System Configuration.................................................................................192
● Almanac/RINEX Configuration..............................................................................194
● Time Conversion Configuration.............................................................................201
● Static Multipath Configuration............................................................................... 206
● Satellites Configuration and Satellites Signal Settings......................................... 210
● Global Signal Configuration.................................................................................. 220
● Power Tuning and Power Settings........................................................................221
● Navigation Message Configuration....................................................................... 227
● Atmospheric Configuration....................................................................................250
● Assistance Data Settings...................................................................................... 253
● S.P.O.T Configuration and Real-Time Commands...............................................267
● Trigger Settings.....................................................................................................282
● Marker Settings.....................................................................................................287
● Clock Settings....................................................................................................... 290

4.1 Programming Examples

The following sections provide simple programming examples for the R&S SMBV. The
purpose of the examples is to present all commands for a given task. In real applica-
tions, one would rather reduce the examples to an appropriate subset of commands.

The programming examples have been tested with a software tool which provides an
environment for the development and execution of remote tests. To keep the examples
as simple as possible, only the "clean" SCPI syntax elements are reported. Non-exe-
cutable command lines (e.g. comments) start with two // characters.

At the beginning of the most remote control program, an instrument (p)reset is recom-
mended to set the R&S SMBV to a definite state. The commands *RST and
SYSTem:PRESet are equivalent for this purpose. *CLS also resets the status registers
and clears the output buffer.

In all of the examples we assume that a remote PC is connected to the instrument, the
remote PC and the instrument are switched on and a connection between them is
established.

4.2 Primary Settings

The following examples use GPS entry standard.
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Example: Save/Recall Files with user settings
This example shows how to query and load settings files, stored with the save/recall
function.

********************************************
SOURce1:BB:GPS:SETTings:CATalog? '/var/user/settings'
// Response: gps_settings,settings
SOURce1:BB:GLONass:SETTings:CATalog? '/var/user/settings'
// Response: glo_settings,settings
SOURce1:BB:GALileo:SETTings:CATalog? '/var/user/settings'
// Response: gal_settings
// There are five files in the /var/user/settings directory: 
// gps_settings.gps, settings.gps, glo_settings.glonass, 
// settings.glonass and gal_settings.galileo
SOURce1:BB:GPS:SETTings:STORe '/var/user/settings/gps_settings_new'
SOURce1:BB:GPS:SETTings:LOADe '/var/user/settings/gps_settings'
SOURce1:BB:GPS:SETTings:DELete '/var/user/settings/settings'
// Deletes the file settings.gps
SOURce1:BB:GPS:SETTings:CATalog? '/var/user/settings'
// Response: gps_settings,gps_settings_new
SOURce1:BB:GLONass:SETTings:CATalog? '/var/user/settings'
// Response: glo_settings,settings

Example: Selecting a predefined test scenario
This example shows how to enable an A-GPS test scenario. The A-GNSS test scenar-
ios require a GPS/GLONASS hybrid GNSS configuration.

**********************************
// select and enable the predefined A-GNSS test scenario
// 3GPP FDD Performance Test Scenario 2
// ****************************************
SOURce1:BB:GPS:PRESet
SOURce1:BB:GPS:ATSCenario W3GPER2
SOURce1:BB:GPS:STATe ON

<subsystem>:PRESet.....................................................................................................159
<subsystem>:STATe......................................................................................................159
<subsystem>:RFBand.................................................................................................... 159
<subsystem>:PRFFrequency.......................................................................................... 160
<subsystem>:SMODe.....................................................................................................160
[:SOURce<hw>]:BB:GPS:ATSCenario............................................................................. 160
[:SOURce<hw>]:BB:GLONass:ATSCenario......................................................................161
<subsystem>:SETTing:CATalog......................................................................................162
[:SOURce<hw>]:BB:BEIDou:SETTing:CATalog?...............................................................162
[:SOURce<hw>]:BB:GALileo:SETTing:CATalog?.............................................................. 162
[:SOURce<hw>]:BB:GLONass:SETTing:CATalog?............................................................162
[:SOURce<hw>]:BB:GPS:SETTing:CATalog?................................................................... 162
<subsystem>:SETTing:STORe........................................................................................162
<subsystem>:SETTing:STORe:FAST...............................................................................163
<subsystem>:SETTing:LOAD..........................................................................................163

Primary Settings
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<subsystem>:SETTing:DELete........................................................................................163
<subsystem>:DURation.................................................................................................. 163
<subsystem>:FILTer:OSAMpling..................................................................................... 164
<subsystem>:WAVeform:CREate.................................................................................... 164

<subsystem>:PRESet

Restores the default settings. The default values correspond to the *RST values in the
descriptions of the SCPI commands.

Example: See example "Selecting a predefined test scenario"
on page 158.

Usage: Event

Manual operation: See "Set to default" on page 57

<subsystem>:STATe <State>

Enables/disables the GNSS signal simulation.

Enabling this standard disables all the other digital standards and digital modulation
modes.

A continuous GNSS signal is generated for up to 24 satellites in real time mode. The
number is determined by the command <subsystem>: SATellite: COUNt  and the
maximum value depends on the installed SW options.

Parameters:
<State> 0 | 1 | OFF | ON

*RST: 0

Example: See example "Selecting a predefined test scenario"
on page 158.

Manual operation: See "State" on page 56

<subsystem>:RFBand <RfBand>

Selects the center carrier frequency of the instrument.

Parameters:
<RfBand> L1 | L2

Available values depend on selected standard.
*RST: L1

Example: SOURce1:BB:GPS:RFBand L1
SOURce1:BB:GPS:PRFLevel
sets the RF level to 1.575420 GHz

Example: SOURce1:BB:GALileo:RFBand L1
selects the Galileo E1 RF band
SOURce1:BB:GALileo:PRFLevel
sets the RF level to 1.575420 GHz

Primary Settings
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Manual operation: See "RF Band" on page 59

<subsystem>:PRFFrequency

Sets the RF frequency in the "Frequency" display in the header of the instrument to the
carrier frequency.

Tip: The carrier frequency is calculated automaticaly and for hybrid signals may devi-
ate from the frequency set with the command <subsystem>: RFBand.

Example: BB:GPS:RFB L1
BB:GPS:PRFL
sets the RF level to 1.575420 GHz

Usage: Event

Manual operation: See "Update RF Frequency" on page 59

<subsystem>:SMODe <SMode>

Sets the simulation mode.

Parameters:
<SMode> STATic | AUTO | USER

Refer to "Simulation Mode" on page 60 for description of hte
simulation modes.
*RST: STATic

Manual operation: See "Simulation Mode" on page 60

[:SOURce<hw>]:BB:GPS:ATSCenario <Scenario>

Selects the file with the predefined A-GPS/A-GNSS test scenario.

Table 4-1: A-GPS test scenarios

Test Scenario SCPI

3GPP TS 51.010: 10.9 Signaling GSMSIG

3GPP TS 51.010: 10.10 Performance 1/2/3 GSMPER1|GSMPER2|GSMPER3

3GPP TS 34.108: 10.7 Signaling W3GSIG

3GPP TS 34.108: 10.1.2 Performance 1/2/3 W3GPER1|W3GPER2|W3GPER3

3GPP2 C.S0036: 2.1.1 Stationary W3G2M

3GPP2 C.S0036: 2.1.2 Moving W3G2S

3GPP TS 37.571-2: S7 Signaling ST1 LTESIGST1

3GPP TS 37.571-1: S7 Performance 1/2/5 ST1 LTEPER1ST1|LTEPER2ST1|LTEPER5ST1

Primary Settings
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Table 4-2: A-GNSS test scenarios

Test Scenario SCPI

3GPP TS 37.571-2: S6 Signaling ST4 W3GSIGST4

3GPP TS 37.571-1: S6 Performance 1/2/5 ST4 W3GPER1ST4|W3GPER2ST4|W3GPER5ST4

3GPP TS 37.571-2: S7 Signaling ST4 LTESIGST4

3GPP TS 37.571-1: S7 Performance 1/2/5 ST5 LTEPER1ST5|LTEPER2ST5|LTEPER5ST5

Parameters:
<Scenario> USER | GSMSIG | GSMPER1 | GSMPER2 | GSMPER3 |

W3GSIG | W3GPER1 | W3GPER2 | W3GPER3 | W3G2S |
W3G2M | W3GSIGST4 | W3GPER1ST4 | W3GPER2ST4 |
W3GPER5ST4 | LTESIGST1 | LTESIGST4 | LTEPER1ST1 |
LTEPER1ST5 | LTEPER2ST1 | LTEPER2ST5 | LTEPER5ST1 |
LTEPER5ST5
User
No predefined test scenario is selected.
*RST: USER

Example: See example "Selecting a predefined test scenario"
on page 158.

Manual operation: See "Test Scenario" on page 59

[:SOURce<hw>]:BB:GLONass:ATSCenario <Scenario>

Selects the file with the predefined A-GLONASS/A-GNSS test scenario.

Table 4-3: A-GLONASS test scenarios

Test Scenario SCPI

3GPP TS 37.571-2: S6 Signaling ST1 W3GSIGST1

3GPP TS 37.571-1: S6 Performance 1/2/5 W3GPER1ST1|W3GPER2ST1W3GPER5ST1

3GPP TS 37.571-2: S7 Signaling ST2 LTESIGST2

3GPP TS 37.571-1: S7 Performance 1/2/5 ST2 LTEPER1ST2|LTEPER2ST2|LTEPER5ST2

Table 4-4: A-GNSS test scenarios

Test Scenario SCPI

3GPP TS 37.571-2: S6 Signaling ST4 W3GSIGST4

3GPP TS 37.571-1: S6 Performance 1/2/5 ST4 W3GPER1ST4|W3GPER2ST4|W3GPER5ST4

3GPP TS 37.571-2: S7 Signaling ST4 LTESIGST4

3GPP TS 37.571-1: S7 Performance 1/2/5 ST5 LTEPER1ST5|LTEPER2ST5|LTEPER5ST5
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Parameters:
<Scenario> USER | W3GSIGST1 | W3GSIGST4 | W3GPER1ST1 |

W3GPER5ST4 | W3GPER5ST1 | W3GPER2ST4 |
W3GPER2ST1 | W3GPER1ST4 | LTESIGST2 | LTESIGST4 |
LTEPER1ST2 | LTEPER1ST5 | LTEPER2ST2 | LTEPER2ST5 |
LTEPER5ST2 | LTEPER5ST5
User
No predefined test scenario is selected.
*RST: USER

Manual operation: See "Test Scenario" on page 59

<subsystem>:SETTing:CATalog
[:SOURce<hw>]:BB:BEIDou:SETTing:CATalog?
[:SOURce<hw>]:BB:GALileo:SETTing:CATalog?
[:SOURce<hw>]:BB:GLONass:SETTing:CATalog?
[:SOURce<hw>]:BB:GPS:SETTing:CATalog?
Reads out the files with GPS/Galileo/GLONASS settings in the default directory. The
default directory is set using command MMEM:CDIRectory. Only files with the file
extension .gps, .galileo or respectively .glonass are listed.

Return values: 
<Catalog> string

Example: See example "Save/Recall Files with user settings"
on page 158.

Usage: Query only

Manual operation: See "Save/Recall" on page 57

<subsystem>:SETTing:STORe <Filename>

Stores the current settings of the specified GNSS standard into the selected file. The
directory is set using command MMEM:CDIRectory. A path can also be specified, in
which case the files in the specified directory are read. Only the file name has to be
entered. Configurations are stored with the predefined file extension *.gps (for GPS
settings) or *.galileo (for Galileo settings).

Setting parameters: 
<Filename> string

Example: See example "Save/Recall Files with user settings"
on page 158.

Usage: Setting only

Manual operation: See "Save/Recall" on page 57
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<subsystem>:SETTing:STORe:FAST <Fast>

Determines whether the instrument performs an absolute or a differential storing of the
settings.

Enable this function to accelerate the saving process by saving only the settings with
values different to the default ones.

Note: This function is not affected by the "Preset" function.

Parameters:
<Fast> 0 | 1 | OFF | ON

*RST: 1

Manual operation: See "Save/Recall" on page 57

<subsystem>:SETTing:LOAD <Filename>

Loads the selected file with GPS/Galileo/GLONASS settings. The directory is set using
command MMEM:CDIRectory. A path can also be specified, in which case files in the
specified directory are read. Only files with the file extension *.gps, *.galileo or
*.glonass can be loaded.

Setting parameters: 
<Filename> string

Example: See example "Save/Recall Files with user settings"
on page 158.

Usage: Setting only

Manual operation: See "Save/Recall" on page 57

<subsystem>:SETTing:DELete <Filename>

Deletes the selected file with GPS or Galileo settings. The directory is set using com-
mand MMEM:CDIRectory. A path can also be specified, in which case files in the
specified directory are deleted. Only files with the file extension .gps or .galileo are
deleted.

Setting parameters: 
<Filename> string

Example: See example "Save/Recall Files with user settings"
on page 158.

Usage: Setting only

Manual operation: See "Save/Recall" on page 57

<subsystem>:DURation <Duration>

Determines the duration of the satellite simulation.
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The resulting duration of the simulation is calculated as follow:

CarrierF
Shift Doppler1

Simulation Satellite of Duration  Simulation of Duration




where FCarrier is the frequency selected with the parameter RF Band.

The maximum duration of satellite simulation depends on the Oversampling factor and
the ARB memory size of the connected instrument.

Parameters:
<Duration> float

Range: 20.0e-3  to  64
Increment: 20.0e-3
*RST: 20.0e-3

Example: SOUR:BB:GPS:DUR 20
sets 20 ms for the satellite simulation.

Manual operation: See "Duration Of Satellite Simulation" on page 61

<subsystem>:FILTer:OSAMpling <OSampling>

Determines the upsampling factor.

A higher upsampling factor improves the filtering but increases the waveform size pro-
portionally. This leads to limitation for the maximum "Duration Of Satellite Simulation".

Parameters:
<OSampling> integer

Range: 2  to  32
*RST: 2

Manual operation: See "Oversampling" on page 61

<subsystem>:WAVeform:CREate <Filename>

(For R&S WinIQSIM2 only)

This command creates a waveform using the current settings of the GNSS dialog. The
file is stored with the predefined file extension *.wv. The file name and the directory it
is stored in are user-definable.

Setting parameters: 
<Filename> string

Example: MMEM:CDIR 'D:\user\waveform
sets the default directory.
BB:GPS:WAV:CRE 'gnss_1'
creates the waveform file gnss_1.wv in the default directory.

Usage: Setting only

Primary Settings



Remote-Control CommandsSatellite Navigation

165Operating Manual 1173.1427.12 ─ 08

Manual operation: See "Generate Waveform File" on page 58

4.3 User Environment, Antenna Pattern and Body Mask

Example: Defining the vehicle type and selectg a *.xvd file
The following example uses the GPS entry standard.

//Query the available vehicle description files and load one of them
SOURce1:BB:GPS:SMODe AUTO
SOURce1:BB:GPS:VEHicle:TYPE PEDestrian
SOURce1:BB:GPS:VEHicle:CATalog:PREDefined?
// Response: Aircraft,Ship,Pedestrian,...
MMEM:CDIR "/var/user/myXVDFiles"
SOURce1:BB:GPS:VEHicle:CATalog:USER? 
// Response: xvd_pedestrian
SOURce1:BB:GPS:VEHicle:FILE "/var/user/myXVDFiles/my_pedestrian"

Example: Selecting an antenna file
The following example uses the GPS entry standard. A user defined antenna pattern
file exist. The file contents are described in chapter A.1.3, "Antenna Pattern / Body
Mask Files", on page 301.

//Query the available antenna pattern files and loads one of them
SOURce1:BB:GPS:SMODe AUTO
SOURce1:BB:GPS:APATtern:CATalog:PREDefined?
// Response: Bus,Car_Small,Isotropic,...
MMEM:CDIR "/var/user/antenna_patterns"
SOURce1:BB:GPS:APATtern:CATalog:USER? 
// Response: ant_pat_3ant
SOURce1:BB:GPS:APATtern:FILE "/var/user/antenna_patterns/ant_pat_3ant"
SOURce1:BB:GPS:APATtern:LIST?
// Response: 1,2,3
// three antennas with antenna IDs 1, 2 and 3 are defined
// select the antenna with antenna ID=2
SOURce1:BB:GPS:APATtern:ID 2
// switch the antenna in real time after elapsing the specified time
SOURce1:BB:GPS:RT:UPDate:ANTenna 12500,1

<subsystem>:VEHicle:CATalog:PREDefined?...................................................................166
<subsystem>:VEHicle:CATalog:USER?........................................................................... 166
<subsystem>:VEHicle:FILE.............................................................................................166
<subsystem>:VEHicle:TYPE........................................................................................... 166
<subsystem>:APATtern:CATalog:PREDefined?................................................................ 167
<subsystem>:APATtern:CATalog:USER?.........................................................................167
<subsystem>:APATtern:FILE.......................................................................................... 167
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<subsystem>:APATtern:ANTenna:LIST?..........................................................................167
<subsystem>:APATtern:ANTenna:ID............................................................................... 168
<subsystem>:RT:UPDate:ANTenna.................................................................................168

<subsystem>:VEHicle:CATalog:PREDefined?

Queries the names of the predefined vehicle description files in the system directory.
Only files with the file extension *.xvd are listed.

Example: see example "Defining the vehicle type and selectg a *.xvd file"
on page 165

Usage: Query only

Manual operation: See "Vehicle Description File" on page 63

<subsystem>:VEHicle:CATalog:USER?

Queries the names of the user-defined vehicle description files in the default directory.
The default directory is set using command MMEM:CDIRectory. Only files with the file
extension *.xvd are listed.

Example: see example "Defining the vehicle type and selectg a *.xvd file"
on page 165

Usage: Query only

Manual operation: See "Vehicle Description File" on page 63

<subsystem>:VEHicle:FILE <Filename>

Loads the selected vehicle description file. Use the command MMEM:CDIRectory to
define the directory. Only files with the file extension *.xvd are loaded.

Parameters:
<Filename> string

Example: see example "Defining the vehicle type and selectg a *.xvd file"
on page 165

Manual operation: See "Vehicle Description File" on page 63

<subsystem>:VEHicle:TYPE <Type>

Sets the vehicle type.

Parameters:
<Type> HIL | SPACecraft | AIRCraft | SHIP | LVEHicle | PEDestrian

HIL, Spacecraft, Aircraft, Ship, Land Vehicle, Pedestrian

Example: see example "Defining the vehicle type and selectg a *.xvd file"
on page 165

Manual operation: See "Vehicle Type" on page 63
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<subsystem>:APATtern:CATalog:PREDefined?

Queries the names of the predefined antenna pattern files in the system directory. Only
files with the file extension *.ant_pat are listed.

Example: see example "Selecting an antenna file" on page 165

Usage: Query only

Options: R&S SMBV-K102

Manual operation: See "Antenna Pattern/Body Mask File" on page 64

<subsystem>:APATtern:CATalog:USER?

Queries the names of the user-defined antenna pattern files in the default directory.
The default directory is set using command MMEM:CDIRectory. Only files with the file
extension *.ant_pat are listed.

Example: see example "Selecting an antenna file" on page 165

Usage: Query only

Options: R&S SMBV-K102

Manual operation: See "Antenna Pattern/Body Mask File" on page 64

<subsystem>:APATtern:FILE <Filename>

Loads the selected antenna pattern file. Only files with the file extension *.ant_pat
are loaded, see chapter A.1.3, "Antenna Pattern / Body Mask Files", on page 301.

Parameters:
<Filename> string

Example: see example "Selecting an antenna file" on page 165

Options: R&S SMBV-K102

Manual operation: See "Antenna Pattern/Body Mask File" on page 64

<subsystem>:APATtern:ANTenna:LIST?

Queries the antenna identifiers <antenna id> specified in the selected *.ant_pat
file.

Return values: 
<List> <antenna id#1>,<antenna id#2>,<antenna id#2>,<antenna

id#4>
Returns a comma separated list of the used antenna identifiers
(ID).
A maximum of four antennas ca nbe specifed in one file, i.e. the
list contains maximum of four <antenna id>.

Example: see example "Selecting an antenna file" on page 165
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Usage: Query only

Options: R&S SMBV-K102

Manual operation: See "Antenna Pattern/Body Mask File" on page 64

<subsystem>:APATtern:ANTenna:ID <AntennaId>

Selects one particular antenna by its antenna ID. To query the list of all antenna IDs,
use the <subsystem>: APATtern: ANTenna: LIST?.

Parameters:
<AntennaId> integer

Range: 0  to  INT_MAX
*RST: 0

Example: see example "Selecting an antenna file" on page 165

Options: R&S SMBV-K102

Manual operation: See "Antenna Pattern/Body Mask File" on page 64

<subsystem>:RT:UPDate:ANTenna

Triggers the software to schedule a real time switch of the used antenna at a specific
future time, as specified in the antenna pattern (*.ant_pat) file.

For description of the file format, refer to chapter A.1.3, "Antenna Pattern / Body Mask
Files", on page 301.

The switching is scheduled only if the following rules are respected:
● the selected <AntennaId> is specified in the selected antenna pattern file

● the SCPI command is sent at least 5 seconds ahead of the execution time speci-
fied with the parameter <ElapsedTime>

● the execution of last successfully scheduled SCPI command
<subsystem>:RT:UPDate:ANTenna is completed

● the selected <AntennaId> is different than the currently active antenna:
– different from <AntennaId> specified in the last executed SCPI command

– different from the initially selected <AntennaId>, if this is the first command

Note: The listed prerequisites for correct real time antenna switching are mandatory. If
the SCPI command fails to abide by those rules, it will be ignored.

Parameters:
<ElapsedTime> float

Elapsed time from the simulation start time at which a switch to
the defined <AntennaId> is performed.

Range: 0  to  99999999
Increment: 0.01
Default unit: s
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<AntennaId> integer
Use the command <subsystem>: APATtern: ANTenna: 
LIST? to query the antenna IDs defined in the currently selected
antenna pattern file.
Range: 1  to  100
Increment: 1

Example: see example "Selecting an antenna file" on page 165

Usage: Event

Options: R&S SMBV-K102

Manual operation: See "Antenna Pattern/Body Mask File" on page 64

4.4 Localization Data

Example: Selecting a waypoint file
The following example uses GPS entry standard.

SOURce1:BB:GPS:LOCation:CATalog?
// Response: User Defined,Waypoints,New York,San Francisco,Beijing,Seoul,...
SOURce1:BB:GPS:LOCation:SELect "Waypoints"
SOURce1:MMEM:CAT?'/var/user/Lists/Gnss/Waypoints'
// Response: 583768,52428800000,".,DIR,0","..,DIR,0","3gpp2.txt,ASC,233703",
// "Melbourne.txt,ASC,238949","Melbourne_Movement.txt,ASC,2104
SOURce1:BB:GPS:LOCation:WAYPoints:FILE '/var/user/Lists/Gnss/Waypoints/Melbourne.txt'
SOURce1:BB:GPS:LOCation:WAYPoints:ROMode CYCLic
SOURce1:BB:GPS:LOCation:COORdinates:DECimal?
// Response: 144.966658,-37.816663,100
// Coordinates of the first simulation position defined in the selected file
SOURce1:BB:GPS:LOCation:COORdinates:DMS?
// Response: 44,57,59.970,EAST,37,48,59.987,SOUT,100 

<subsystem>:LOCation:CATalog?................................................................................... 170
<subsystem>:LOCation[:SELect]..................................................................................... 170
<subsystem>:LOCation:WAYPoints:FILE......................................................................... 170
<subsystem>:LOCation:WAYPoints:ROMode................................................................... 171
<subsystem>:LOCation:COORdinates:DECimal................................................................171
<subsystem>:LOCation:COORdinates:DMS..................................................................... 172
<subsystem>:LOCation:YAW.......................................................................................... 173
<subsystem>:LOCation:PITCh........................................................................................ 173
<subsystem>:LOCation:ROLL......................................................................................... 173
<subsystem>:LOCation:YAW:FMOTion............................................................................173
<subsystem>:LOCation:PITCh:FMOTion..........................................................................173
<subsystem>:LOCation:ROLL:FSPinning......................................................................... 173
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<subsystem>:LOCation:SPIN:RATE................................................................................ 174
<subsystem>:LOCation:SPIN:SRoll................................................................................. 174
<subsystem>:LOCation:SMOVement...............................................................................174

<subsystem>:LOCation:CATalog?

Queries the names of the predefined geographic locations.

Example: See example "Selecting a waypoint file" on page 169.

Usage: Query only

Manual operation: See "Geographic Location/Attitude" on page 69

<subsystem>:LOCation[:SELect] <Location>

Selects the geographic location of the GNSS receiver.

Parameters:
<Location> "User Defined" | "New York" | "San Francisco" | "Beijing" |

"Seoul" | "Singapore" | "Taipei" | "Tokyo" | "Sydney" | "London" |
"Moscow" | "Munich" | "Paris" | "Waypoints"
User Defined
Enables the definition of the "Latitude", "Longitude" and "Alti-
tude" of the GNSS receiver with fixed position in the ECEF
WGS84 coordinate system.
Waypoints
(requires option GNSS Enhancements R&S SMBV-K92)
Enables defining a moving scenario, i.e. the simulation of a mov-
ing receiver.
"New York" | "San Francisco" | "Beijing" | "Seoul" | "Singa-
pore" | "Taipei" | "Tokyo" | "Sydney" | "London" | "Moscow"
| "Munich" | "Paris"
Selects one of the predefined fixed geographic locations.
The parameters "Latitude", "Longitude" and "Altitude" are set
according to the selected position.

Example: See example "Selecting a waypoint file" on page 169.

Manual operation: See "Geographic Location/Attitude" on page 69

<subsystem>:LOCation:WAYPoints:FILE <WayPoints>

Selects a predefind waypoint file. A waypoint file must have the extension .txt,
.nmea or .xtd.

This setting is only available if <subsystem>: LOCation[: SELect]  is set to
Waypoints.

Parameters:
<WayPoints> string
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Example: See example "Selecting a waypoint file" on page 169.

Options: R&S SMBV-K92

Manual operation: See "Waypoint/Attitude File …" on page 70

<subsystem>:LOCation:WAYPoints:ROMode <RoMode>

Defines the way the waypoint file is to be read.

This setting is only available if <subsystem>: LOCation[: SELect]  is set to
Waypoints.

Parameters:
<RoMode> CYCLic | RTRip | OWAY

CYCLic
The waypoint file is read out cyclic.
Using this read out mode is only recommended for waypoint files
that describe a circle moving scenario or moving scenario in
which the start and the end point are close to each other.
OWAY (One Way)
The file is read out only once.
When the end of the file is reached, the last described position is
assumed to be a static one.
RTRip (Round Trip)
When the end of the file is reached, the file is read out back-
wards.
*RST: OWAY

Example: See example "Selecting a waypoint file" on page 169.

Options: R&S SMBV-K92

Manual operation: See "Read Out Mode" on page 71

<subsystem>:LOCation:COORdinates:DECimal <Longitude>, <Latitude>,
<Altitude>

Defines the coordinates of the geographic location of the GNSS receiver in decimal for-
mat.

Parameters:
<Longitude> float

Range: -180  to  180
Increment: 1E-6
*RST: 0

<Latitude> float
Range: -90  to  90
Increment: 1E-6
*RST: 0
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<Altitude> float
Altitude in meters above sea level.
Range: -10000  to  1600000
Increment: 0.1
*RST: 0

Example: See example "Selecting a waypoint file" on page 169.

Manual operation: See "Location Coordinates" on page 71

<subsystem>:LOCation:COORdinates:DMS <LongitudeDeg>, <LongitudeMin>,
<LongitudeSec>, <LongitudeDir>, <LatitudeDeg>, <LatitudeMin>,
<LatitudeSec>, <LatitudeDir>, <Altitude>

Defines the coordinates of the geographic location of the GNSS receiver in degrees,
minutes and seconds.

Parameters:
<LongitudeDeg> integer

Defines the longitude degrees.
Range: 0  to  180
Increment: 1
*RST: 0

<LongitudeMin> integer
Defines the longitude minutes.
Range: 0  to  59
Increment: 1
*RST: 0

<LongitudeSec> float
Defines the longitude seconds.
Range: 0  to  59.999
Increment: 0.001
*RST: 0

<LongitudeDir> EAST | WEST
Defines the longitude direction.
*RST: EAST

<LatitudeDeg> integer
Defines the latitude degrees.
Range: 0  to  90
Increment: 1
*RST: 0
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<LatitudeMin> integer
Defines the latitude minutes.
Range: 0  to  59
Increment: 1
*RST: 0

<LatitudeSec> float
Defines the latitude seconds.
Range: 0  to  59.999
Increment: 0.001
*RST: 0

<LatitudeDir> NORTh | SOUTh
Defines the latitude direction.
*RST: NORT

<Altitude> float
Defines the altitude in meters above sea level.
Range: -10000  to  1600000
Increment: 0.1
*RST: 0

Example: See example "Selecting a waypoint file" on page 169.

Manual operation: See "Location Coordinates" on page 71

<subsystem>:LOCation:YAW <Yaw>
<subsystem>:LOCation:PITCh <Pitch>
<subsystem>:LOCation:ROLL <Roll>

Sets the attitude parameters relative to the local horizon.

Parameters:
<Roll> float

Range: -180  to  180
Increment: 0.001
*RST: 0

Options: R&S SMBV-K103

Manual operation: See "Yaw/Heading, Pitch/Elevation, Roll/Bank" on page 72

<subsystem>:LOCation:YAW:FMOTion <State>
<subsystem>:LOCation:PITCh:FMOTion <State>
<subsystem>:LOCation:ROLL:FSPinning <FromSpinning>

Force the attitude parameters to motion direction. Usefull in automotive applications.

Parameters:
<FromSpinning> 0 | 1 | OFF | ON

*RST: OFF
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Options: R&S SMBV-K103 for <subsystem>:LOCation:ROLL:FSPinning

Manual operation: See "From Motion/From Spinning" on page 72

<subsystem>:LOCation:SPIN:RATE <Rate>

Simulates a constant rate of change of the roll.

Parameters:
<Rate> float

Range: -500  to  500
Increment: 0.01
*RST: 0

Options: R&S SMBV-K103

Manual operation: See "Spinning Rate" on page 72

<subsystem>:LOCation:SPIN:SRoll <StartRollAngle>

Defines the start angles of rotation of the vehicle.

Parameters:
<StartRollAngle> float

Range: -180  to  180
Increment: 0.001
*RST: 0

Example: SOURce1:BB:GPS:LOCation:ROLL:FSPinning ON
SOURce1:BB:GPS:LOCation:SPIN:RATE 0.25
SOURce1:BB:GPS:LOCation:SPIN:SRoll 90

Options: R&S SMBV-K103

Manual operation: See "Vehicle Body Start Roll" on page 72

<subsystem>:LOCation:SMOVement <SmoothMovement>

Enables an internal algorithm to smooth the trajectory, see also chapter 2.5.7, "Motion
Smoothening Using Vehicle Description File", on page 28.

Parameters:
<SmoothMovement> 0 | 1 | OFF | ON

*RST: OFF

Example: SOURce1:BB:GPS:LOCation:SMOVement
Options: R&S SMBV-K92

Manual operation: See "Smooth Movement" on page 70
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4.5 Navigation Data

Example: Selecting Real Navigation Data
The following example uses GPS entry standard.

SOURce1:BB:GPS:NAVigation:DATA RND
SOURce1:BB:GPS:NAVigation:ALManac:GPS:FILE "GPS_SEM585.txt"
SOURce1:BB:GPS:NAVigation:SIMulation:TBASis UTC
SOURce1:BB:GPS:NAVigation:SIMulation:DATE?
//Response: 2008,7,13
SOURce1:BB:GPS:NAVigation:SIMulation:TIME?
//Response: 17,4,0
SOURce1:BB:GPS:NAVigation:SIMulation:TBASis GPS
SOURce1:BB:GPS:NAVigation:SIMulation:WNUMber?
//Response: 1488
SOURce1:BB:GPS:NAVigation:SIMulation:TOWeek?
//Response: 61455 

<subsystem>:NAVigation:DATA...................................................................................... 175
<subsystem>:NAVigation:DATA:DSELect.........................................................................176
<subsystem>:NAVigation:DATA:PATTern........................................................................ 176
<subsystem>:NAVigation:SIMulation:TBASis....................................................................176
<subsystem>:NAVigation:SIMulation:DATE...................................................................... 176
<subsystem>:NAVigation:SIMulation:TIME....................................................................... 177
<subsystem>:NAVigation:SIMulation:WNUMber................................................................177
<subsystem>:NAVigation:SIMulation:TOWeek.................................................................. 178

<subsystem>:NAVigation:DATA <Data>

Determines the data source for the navigation information.

Parameters:
<Data> ZERO | ONE | PATTern | PN9 | PN11 | PN15 | PN16 | PN20 |

PN21 | PN23 | DLISt | RNData
RNData
Real navigation data provided by an almanac file.
Use the command <subsystem>: NAVigation: ALManac: 
<GNSS>: FILE to select the almanac file.

ZERO | ONE| PATTern | PNxx | DLISt
Standard data sources (a sequence of 0 or 1, a pseudo-random
sequence with different lenght, a pattern or a data list)
*RST: RNData

Example: See example "Selecting Real Navigation Data" on page 175.

Manual operation: See "Data Source" on page 65
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<subsystem>:NAVigation:DATA:DSELect <DSelect>

Selects a data list as data source.

Data lists are files with file extensions *.dm_iqd that are stored in a directory of the
user's choice.

To set the default directory, use the command MMEMory:CDIR. To access the files in
this directory, you only have to give the file name, without the path and the file exten-
sion.

Parameters:
<DSelect> string

Example: SOURce1:BB:GPS:NAVigation:DATA DLIS
SOURce1:BB:GPS:NAVigation:DATA:DLISt
"/var/user/temp/GNSS_list1"
selects file "GNSS_list1" as the data source.
This file must be in the directory /var/user/temp/ and have
the file extension *.dm_iqd.

Manual operation: See "Data Source" on page 65

<subsystem>:NAVigation:DATA:PATTern <Pattern>

Determines the bit pattern for <subsystem>: NAVigation: DATA  PATTern.

Parameters:
<Pattern> 64 bit pattern

Example: SOURce1:BB:GPS:NAVigation:DATA PATTern
SOURce1:BB:GPS:NAVigation:DATA:PATTern #H3F,8

Manual operation: See "Data Source" on page 65

<subsystem>:NAVigation:SIMulation:TBASis <SystemTime>

Determines the time basis used to enter the simulation start time.

Parameters:
<SystemTime> UTC | GPS | GST | GLO | BDT

*RST: UTC

Example: See example "Selecting Real Navigation Data" on page 175.

Manual operation: See "System Time" on page 67

<subsystem>:NAVigation:SIMulation:DATE <Year>, <Month>, <Day>

Defines the date for the simulation in DD.MM.YYYY format of the Gregorian calendar.

This setting is only available for <subsystem>: NAVigation: DATA set to RNData
and <subsystem>: NAVigation: SIMulation: TBASis  set to UTC.
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Parameters:
<Year> integer

Range: 1980  to  9999
Increment: 1

<Month> integer
Range: 1  to  12
Increment: 1

<Day> integer
Range: 1  to  31
Increment: 1

Example: See example "Selecting Real Navigation Data" on page 175.

Manual operation: See "Date [dd.mm.yyyy]" on page 67

<subsystem>:NAVigation:SIMulation:TIME <Hour>, <Minute>, <Second>

Defines the exact simulation start time in UTC time format.

This setting is only available for <subsystem>: NAVigation: DATA  set to RNData
and <subsystem>: NAVigation: SIMulation: TBASis  set to UTC.

Parameters:
<Hour> integer

Range: 0  to  23
Increment: 1

<Minute> integer
Range: 0  to  59
Increment: 1

<Second> float
Range: 0  to  59.999
Increment: 0.001

Example: See example "Selecting Real Navigation Data" on page 175.

Manual operation: See "Time [hh:mm:ss:xxx]" on page 67

<subsystem>:NAVigation:SIMulation:WNUMber <Week>

Enters the week number (WN) the navigation signal is generated for.

This setting is only available for <subsystem>: NAVigation: SIMulation: TBASis
set to GPS or GST and <subsystem>: NAVigation: DATA set to RNData.

Navigation Data



Remote-Control CommandsSatellite Navigation

178Operating Manual 1173.1427.12 ─ 08

Parameters:
<Week> integer

The weeks are numbered starting from a reference point of time
(WN_REF=0), that depends on the navigation standard.
Range: 0  to  9999.0*53
Increment: 1
*RST: 0

Example: See example "Selecting Real Navigation Data" on page 175.

Manual operation: See "Week Number" on page 67

<subsystem>:NAVigation:SIMulation:TOWeek <TOW>

Defines the simulation start time within the defined week (see <subsystem>: 
NAVigation: SIMulation: WNUMber).

This setting is only available for <subsystem>: NAVigation: SIMulation: TBASis 
set to GPS or GST.

Parameters:
<TOW> float

number of seconds since the beginning of the week
Range: 0  to  604799.999
Increment: 0.001
*RST: 0

Example: See example "Selecting Real Navigation Data" on page 175.

Manual operation: See "Time of Week (TOW)" on page 68

4.6 Obscuration and Auto Multipath

Example: Defining a full obscuration environment
The following example uses GPS entry standard.

// Selecting and enabling a full obscuration user defined environment
SOURce1:BB:GPS:OBSCuration:ENVironment FULL
SOURce1:BB:GPS:OBSCuration:TYPE USER
SOURce1:BB:GPS:OBSCuration:OBSCuration

// Defining a full obscuration area as a sequence of obscured zones
SOURce1:BB:GPS:OBSCuration:FULL:SCALe DISTance
SOURce1:BB:GPS:OBSCuration:FULL:AREA:COUNt 2
SOURce1:BB:GPS:OBSCuration:FULL:AREA1:REFerence 0.5
SOURce1:BB:GPS:OBSCuration:FULL:AREA1:LENGth 0.1
SOURce1:BB:GPS:OBSCuration:FULL:AREA2:REFerence 2.5
SOURce1:BB:GPS:OBSCuration:FULL:AREA2:LENGth 1
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SOURce1:BB:GPS:OBSCuration:FULL:AREA:APPend
SOURce1:BB:GPS:OBSCuration:FULL:AREA:COUNt?
// Response: 3
SOURce1:BB:GPS:OBSCuration:FULL:AREA3:DELete
SOURce1:BB:GPS:OBSCuration:FULL:AREA:COUNt?
// Response: 2
SOURce1:BB:GPS:OBSCuration:FULL:AREA1:INSert
SOURce1:BB:GPS:OBSCuration:FULL:AREA2:REFerence 1.5
SOURce1:BB:GPS:OBSCuration:FULL:AREA2:LENGth 0.5
SOURce1:BB:GPS:OBSCuration:FULL:AREA:COUNt?
Response: 3

// Defining a full obscuration area as a zone pattern
SOURce1:BB:GPS:OBSCuration:FULL:SCALe TIME
SOURce1:BB:GPS:OBSCuration:FULL:RWINdow 1000
SOURce1:BB:GPS:OBSCuration:FULL:RWINdow:STATe ON
// the defined objects are repeated eacht 1000 s

Example: Selectng a vertical obscuration environment
The following example uses GPS entry standard.

SOURce1:BB:GPS:SMODe AUTO
// Selecting and enabling a vertical obscuration environment
SOURce1:BB:GPS:OBSCuration:ENVironment VOBS
SOURce1:BB:GPS:OBSCuration:TYPE URB1
SOURce1:BB:GPS:OBSCuration:OMPath
// Query the available obstacles files and loads one of them
SOURce1:BB:GPS:OBSCuration:VOBS:CATalog:PREDefined?
// Response: Urban_Canyon_1
MMEM:CDIR "/var/user/my_vobs"
SOURce1:BB:GPS:OBSCuration:VOBS:CATalog:USER?
// Response: canyon_2
SOURce1:BB:GPS:OBSCuration:VOBS:FILE "/var/user/my_vobs/canyon_2"
// defining the receiver position
SOURce1:BB:GPS:OBSCuration:VOBS:ROFFset:X 15
SOURce1:BB:GPS:OBSCuration:VOBS:ROFFset:Y 2
SOURce1:BB:GPS:OBSCuration:VOBS:ROFFset:HEIGht 0

Example: Defining a user defined ground and sea reflection
The following example uses GPS entry standard.

SOURce1:BB:GPS:SMODe AUTO
SOURce1:BB:GPS:VEHicle:TYPE AIRCraft
// Selecting and enabling a ground and sea reflection environment
SOURce1:BB:GPS:OBSCuration:ENVironment GSR
SOURce1:BB:GPS:OBSCuration:TYPE USER
SOURce1:BB:GPS:OBSCuration:OMPath
// Defining the material property parameters
SOURce1:BB:GPS:OBSCuration:GSP:STYPe USER
SOURce1:BB:GPS:OBSCuration:GSP:MPRoperty PERM
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SOURce1:BB:GPS:OBSCuration:GSP:PERMittivity 10
SOURce1:BB:GPS:OBSCuration:GSP:CONDuctivity 1
// Defining the obstacles and the distance to them and to ground
SOURce1:BB:GPS:OBSCuration:GSP:GALTitude 0
SOURce1:BB:GPS:OBSCuration:GSP:O1Height 500
SOURce1:BB:GPS:OBSCuration:GSP:O2Height 1000
SOURce1:BB:GPS:OBSCuration:GSP:O1Distance 1000
SOURce1:BB:GPS:OBSCuration:GSP:O2Distance 1000
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<subsystem>:OBSCuration:TYPE <Type>

Selects a predefined obscuration model or enables the configuration of the near envi-
ronment and physical model.

Parameters:
<Type> USER | CITY | SUB1 | URB1 | LTUNnel | MTUNnel | BR1 |

BR2 | P1M | P10M | P1H | HIGHway | CUTTing
USER = User defined
CITY = City block
SUB1 = Suburban area
URB1 = Urban canyon
LTUNnel|MTUNnel = Long tunnel | Multiple tunnel
BR1|BR2 = Bridge 1/2
P1M|P10M|P1H = Parking 1min/10min/1h
HIGHway = Highway
CUTTing = Cutting

*RST: USER

Example: see example "Defining a full obscuration environment"
on page 178

Options: R&S SMBV-K101

Manual operation: See "Type" on page 73

<subsystem>:OBSCuration:ENVironment <Environment>

Selects a near environment model for obscuration & auto multipath.

Parameters:
<Environment> LOS | VOBS | RPL | FULL | GSR

LOS = Line of Sight (LOS)
VOBS = Vertical Obstacles
RPL = Roadside Planes
FULL = Full Obscuration
GSR = Ground/Sea Reflection

*RST: LOS

Example: see example "Defining a full obscuration environment"
on page 178

Options: R&S SMBV-K101

Manual operation: See "Near Environment" on page 74

<subsystem>:OBSCuration:PMODel <PhysicalModel>

Selects the physical effects to be simulated on the GNSS signal, i.e. obscuration only
(OBSCuration) or obscuration and multipath propagation (OMPath).
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Parameters:
<PhysicalModel> OBSCuration | OMPath

*RST: OMP

Example: see example "Defining a full obscuration environment"
on page 178

Options: R&S SMBV-K101, OMPath requires R&S SMBV-K92

Manual operation: See "Physical Model" on page 75

<subsystem>:OBSCuration:VOBS:ROFFset:X <XOffset>
<subsystem>:OBSCuration:VOBS:ROFFset:Y <YOffset>
<subsystem>:OBSCuration:VOBS:ROFFset:HEIGht <HeightOffset>

Determines the start position of a receiver in terms of height and X/Y offset.

Parameters:
<XOffset> float

Range: -1500  to  1500
Increment: 0.1
*RST: 0

<YOffset> float
Range: -1500  to  1500
Increment: 0.1
*RST: 0

<HeightOffset> float
Range: 0  to  500
Increment: 0.1
*RST: 0

Example: see example "Selectng a vertical obscuration environment"
on page 179

Options: R&S SMBV-K101

Manual operation: See "Receiver Offset" on page 77

<subsystem>:OBSCuration:VOBS:ROFFset:MORientation <MapOrientation>

Represents the map orientation.

Parameters:
<MapOrientation> float

Range: 0  to  359.99
Increment: 0.01
*RST: 0

Example: SOURce1:BB:GPS:OBSCuration:VOBS:ROFFset:
MORientation 90
OX orientation to the north
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Options: R&S SMBV-K101

Manual operation: See "Map Orientation" on page 78

<subsystem>:OBSCuration:VOBS:CATalog:PREDefined?
<subsystem>:OBSCuration:RPL:CATalog:PREDefined?
Queries the names of the predefined files in the system directory.

Listed are only predefined obstacles description files (*.rs_obst) respectively road-
side buildings description files (*.rs_buil).

Example: see example "Selectng a vertical obscuration environment"
on page 179

Usage: Query only

Options: R&S SMBV-K101

Manual operation: See "Planes File" on page 81

<subsystem>:OBSCuration:VOBS:CATalog:USER?
<subsystem>:OBSCuration:RPL:CATalog:USER?
Queries the names of the user-defined files in the default directory. The default direc-
tory is set using command MMEM:CDIRectory
Listed are only obstacles description files (*.rs_obst) respectively roadside buildings
description files (*.rs_buil).

Example: see example "Selectng a vertical obscuration environment"
on page 179

Usage: Query only

Options: R&S SMBV-K101

Manual operation: See "Planes File" on page 81

<subsystem>:OBSCuration:VOBS:FILE <Filename>
<subsystem>:OBSCuration:RPL:FILE <Filename>

Loads the selected file.

Loaded are only obstacles description files (*.rs_obst) respectively roadside build-
ings description files (*.rs_buil).

Parameters:
<Filename> string

Example: see example "Selectng a vertical obscuration environment"
on page 179

Options: R&S SMBV-K101

Manual operation: See "Planes File" on page 81
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<subsystem>:OBSCuration:RPL:ROFFset:HEIGht <Heigth>

Sets the receiver height offset, i.e. the antenna altitude relative to the ground.

Parameters:
<Heigth> float

Range: 0  to  500
Increment: 0.1
*RST: 0

Example: SOURce1:BB:GPS:OBSCuration:RPL:ROFFset:HEIGht
20
SOURce1:BB:GPS:OBSCuration:RPL:ILENgth ON

Options: R&S SMBV-K101

Manual operation: See "Receiver Height Offset" on page 80

<subsystem>:OBSCuration:RPL:RWINdow <RepWindow>

Sets the repeating period (in km) of repeating objects.

Parameters:
<RepWindow> float

Range: 1E  to  1E6
Increment: 1E
*RST: 10E3

Options: R&S SMBV-K101

Manual operation: See "Repetition Window" on page 80

<subsystem>:OBSCuration:RPL:RWINdow:STATe <State>

Enables the repetition of the defined objects.

Parameters:
<State> 0 | 1 | OFF | ON

*RST: OFF

Example: SOURce1:BB:GPS:OBSCuration:RPL:RWINdow 10E3
SOURce1:BB:GPS:OBSCuration:RPL:RWINdow:STATe ON
The defined objects are repeated eacht 10km

Options: R&S SMBV-K101

Manual operation: See "Repetition Window" on page 80

<subsystem>:OBSCuration:RPL:ILENgth <State>

If enabled, assumes roadside planes with infinite width.
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Parameters:
<State> 0 | 1 | OFF | ON

*RST: ON

Options: R&S SMBV-K101

Manual operation: See "Set Length to Infinite" on page 80

<subsystem>:OBSCuration:FULL:SCALe <ReferenceScale>

Defines whether the obstacles' positions are defined as distance (in km) or as time (in
s).

Parameters:
<ReferenceScale> TIME | DISTance

*RST: DIST

Example: see example "Defining a full obscuration environment"
on page 178

Options: R&S SMBV-K101

Manual operation: See "Reference Scale" on page 83

<subsystem>:OBSCuration:FULL:RWINdow <RepWindow>

Sets the repeating period (in km or s) of repeating objects.

Parameters:
<RepWindow> integer

Range: 0  to  1000
*RST: 10

Example: see example "Defining a full obscuration environment"
on page 178

Options: R&S SMBV-K101

Manual operation: See "Repetition Window" on page 83

<subsystem>:OBSCuration:FULL:RWINdow:STATe <State>

Enables the repetition of the defined objects.

Parameters:
<State> 0 | 1 | OFF | ON

*RST: OFF

Example: see example "Defining a full obscuration environment"
on page 178

Options: R&S SMBV-K101

Manual operation: See "Repetition Window" on page 83
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<subsystem>:OBSCuration:FULL:AREA:COUNt?

Sets the number of the obscured area/zones.

Return values: 
<AreasCount> integer

Range: 0  to  50
Increment: 1
*RST: 0

Example: see example "Defining a full obscuration environment"
on page 178

Usage: Query only

Options: R&S SMBV-K101

Manual operation: See "Full Obscuration Configuration Table" on page 83

<subsystem>:OBSCuration:FULL:AREA:APPend
<subsystem>:OBSCuration:FULL:AREA<ch>:INSert
<subsystem>:OBSCuration:FULL:AREA<ch>:DELete
Appends/inserts or deletes an obscured zone.

Example: see example "Defining a full obscuration environment"
on page 178

Usage: Event

Options: R&S SMBV-K101

Manual operation: See "Full Obscuration Configuration Table" on page 83

<subsystem>:OBSCuration:FULL:AREA<ch>:REFerence <Reference>

Defines the reference starting position (in km) or time stamp (in s) of a specific
obscured zone.

Suffix: 
<ch>

.
1 to 50
Use the command <subsystem>: OBSCuration: FULL:
AREA: COUNt?  to define the number of the obsured zones.

Parameters:
<Reference> float

Range: 0  to  1E4
Increment: 1E-3
*RST: 0

Example: see example "Defining a full obscuration environment"
on page 178

Options: R&S SMBV-K101
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Manual operation: See "Full Obscuration Configuration Table" on page 83

<subsystem>:OBSCuration:FULL:AREA<ch>:LENGth <Length>

Length of the obscuring zone, defined in km or sec.

Parameters:
<Length> float

Range: 1E-3  to  50
Increment: 1E-3
*RST: 0.1

Example: see example "Defining a full obscuration environment"
on page 178

Options: R&S SMBV-K101

Manual operation: See "Full Obscuration Configuration Table" on page 83

<subsystem>:OBSCuration:GSR:MPRoperty <MaterialPropert>

Define whether the material is defined by its permittivity or power loss characteristic.

Parameters:
<MaterialPropert> PLOSS | PERM

*RST: PERM

Example: see example "Defining a user defined ground and sea reflection"
on page 179

Options: R&S SMBV-K101

Manual operation: See "Material Property" on page 84

<subsystem>:OBSCuration:GSR:STYPe <SurfaceType>

Describes the surface.

Parameters:
<SurfaceType> SEA | WATER | WET | MDRY | DRY | USER

*RST: USER

Example: see example "Defining a user defined ground and sea reflection"
on page 179

Options: R&S SMBV-K101

Manual operation: See "Surface Type" on page 85

<subsystem>:OBSCuration:GSR:PERMittivity <Permittyvity>

Sets the surface permittivity.
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Parameters:
<Permittyvity> float

Range: 1  to  100
Increment: 0.1
*RST: 10

Example: see example "Defining a user defined ground and sea reflection"
on page 179

Options: R&S SMBV-K101

Manual operation: See "Ground Permittivity/Conductivity, Power Loss" on page 85

<subsystem>:OBSCuration:GSR:CONDuctivity <Conductivity>

Sets the surface conductivity.

Parameters:
<Conductivity> float

Range: 1E-6  to  20
Increment: 1E-6
*RST: 1

Example: see example "Defining a user defined ground and sea reflection"
on page 179

Options: R&S SMBV-K101

Manual operation: See "Ground Permittivity/Conductivity, Power Loss" on page 85

<subsystem>:OBSCuration:GSR:PLOSs <PowerLoss>

Sets the surface power loss.

Parameters:
<PowerLoss> integer

Range: 0  to  20
*RST: 5

Example: see example "Defining a user defined ground and sea reflection"
on page 179

Options: R&S SMBV-K101

Manual operation: See "Ground Permittivity/Conductivity, Power Loss" on page 85

<subsystem>:OBSCuration:GSR:O1Distance <Distance>
<subsystem>:OBSCuration:GSR:O2Distance <Distance>

Sets the distance between the receiver and the obstacles.
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Parameters:
<Distance> float

Range: 0  to  1000
Increment: 0.1
*RST: 150

Example: see example "Defining a user defined ground and sea reflection"
on page 179

Options: R&S SMBV-K101

Manual operation: See "h1/h2, d1/d2" on page 85

<subsystem>:OBSCuration:GSR:O1Height <Height>
<subsystem>:OBSCuration:GSR:O2Height <Height>

Determines the height of the left/right obstacle.

Parameters:
<Height> float

Range: 0  to  10000
Increment: 0.1
*RST: 100

Example: see example "Defining a user defined ground and sea reflection"
on page 179

Options: R&S SMBV-K101

Manual operation: See "h1/h2, d1/d2" on page 85

<subsystem>:OBSCuration:GSR:GALTitude <GroundAltitude>

Sets the altitude of the receiver according to the WGS84 geodetic system.

Parameters:
<GroundAltitude> float

Range: 0  to  10000
Increment: 0.1
*RST: 0

Example: see example "Defining a user defined ground and sea reflection"
on page 179

Options: R&S SMBV-K101

Manual operation: See "Ground Altitude" on page 85

<subsystem>:OBSCuration:GSR:OORientation <Orientation>

Sets the obstacle orientation.
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Parameters:
<Orientation> float

Range: 0  to  359.99
Increment: 0.01
*RST: 0

Options: R&S SMBV-K101

Manual operation: See "Obstacle Orientation" on page 85

4.7 Hardware in the Loop (HIL)

<subsystem>:RT:HILPosition:MODE:A.............................................................................190
<subsystem>:RT:HILPosition:MODE:B.............................................................................191
<subsystem>:RT:HILPosition:LATency?...........................................................................192

<subsystem>:RT:HILPosition:MODE:A <ElapsedTime>, <X>, <Y>, <Z>, <XDot>,
<YDot>, <ZDot>, <XDotDot>, <YDotDot>, <ZDotDot>, <XDotDotDot>,
<YDotDotDot>, <ZDotDotDot>, <Yaw>, <Pitch>, <Roll>, <YawDot>, <PitchDot>,
<RollDot>, <YawDotDot>, <PitchDotDot>, <RollDotDot>, <YawDotDotDot>,
<PitchDotDotDot>, <RollDotDotDot>

Sets hardware in loop position of third order ECEF dynamics and attitude.

The yaw/heading, pitch/elevation, roll/bank rotation angles and their derivatives are
obtained by rotating the body (XYZ) frame starting from an aligned state with the local
NED frame by a sequence of three consecutive Euler rotations about z axis then y axis
and then x axis.

The attitude parameters Yaw, Pitch, Roll, RDot etc. are optional

Table 4-5: Parameter description

Parameter Description Default unit

<X>,<Y>,<Z> coordinate in the Earth Fixed Earth Centered (ECEF) coor-
dinate system

m

<XDot>,<YDot>,<ZDot> (equivalently Vx, Vy,Vz ) Velocity vector in ECEF meter/
second

<XDotDot>,<YDotDot>,
<ZDotDot>

(equivalently Ax, Ay,Az ) Acceleration vector in ECEF meter/
second^2

<XDotDotDot>,
<YDotDotDot>,
<ZDotDotDot>

(equivalently Jx, Jy,Jz ) Jerk vector in ECEF meters/
second^3

[<Roll>,<Pitch>,
<Yaw>]

attitude angles (yaw/heading, pitch/elevation, roll/bank)

unlimited value range to simulate more that one cycle rota-
tion between two updates

radians

[<RDot>,<PDot>,
<YDot>]

attitude angular rate of change rad/sec
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Parameter Description Default unit

[<RDotDot>,<PDotDot>,
<YDotDot>]

attitude angular second order derivative rad/sec^2

[<RDotDotDot>,
<PDotDotDot>,
<YDotDotDot>]

attitude angular third order derivative rad/sec^3

See also chapter 2.5.8, "Hardware in the Loop (HIL)", on page 29.

Parameters:
<ElapsedTime> float

Elapsed time from the simulation start
For description of the other parameters, see table 4-5.
Range: 0  to  99999999

Usage: Setting only

Options: R&S SMBV-K92 (motion only), R&S SMBV-K92/-K103 (motion
+attitude)

<subsystem>:RT:HILPosition:MODE:B <ElapsedTime>, <Latitude>, <Longitude>,
<Altitude>, <NDot>, <EDot>, <DDot>, <NDotDot>, <EDotDot>, <DDotDot>,
<NDotDotDot>, <EDotDotDot>, <DDotDotDot>, <Yaw>, <Pitch>, <Roll>,
<YawDot>, <PitchDot>, <RollDot>, <YawDotDot>, <PitchDotDot>,
<RollDotDot>, <YawDotDotDot>, <PitchDotDotDot>, <RollDotDotDot>

Sets hardware in loop position of third order GEOD/NED dynamics and attitude.

The yaw/heading, pitch/elevation, roll/bank rotation angles and their derivatives are
obtained by rotating the body (XYZ) frame starting from an aligned state with the local
NED frame by a sequence of three consecutive Euler rotations about z axis then y axis
and then x axis.

The attitude parameters Yaw, Pitch, Roll, RDot etc. are optional.

Table 4-6: Parameter description

Parameter Description Default unit

<Latitude>,
<Longitude>,
<Altitude>

Geodetic location degrees

<NDot>,<EDot>,<DDot> (equivalently Vn, Ve,Vd ) Velocity vector in the North East
Down (NED) coordinate system

meters/
second

<NDotDot>,<EDotDot>,
<DDotDot>

(equivalently An, Ae,Ad ) Acceleration vector in NED meters/
second^2

<NDotDotDot>,
<EDotDotDot>,
<DDotDotDot>

(equivalently Jn, Je,Jd ) Jerk vector in NED meters/
second^3

[<Roll>,<Pitch>,
<Yaw>]

attitude angles (yaw/heading, pitch/elevation, roll/bank)

unlimited value range to simulate more that one cycle rota-
tion between two updates

radians
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Parameter Description Default unit

[<RDot>,<PDot>,
<YDot>]

attitude angular rate of change rad/sec

[<RDotDot>,<PDotDot>,
<YDotDot>]

attitude angular second order derivative rad/sec^2

[<RDotDotDot>,
<PDotDotDot>,
<YDotDotDot>]

attitude angular third order derivative rad/sec^3

See also chapter 2.5.8, "Hardware in the Loop (HIL)", on page 29.

Parameters:
<ElapsedTime> float

Elapsed time from the simulation start
For description of the other parameters, see table 4-6.
Range: 0  to  99999999

Usage: Setting only

Options: R&S SMBV-K92 (motion only), R&S SMBV-K92/-K103 (motion
+attitude)

<subsystem>:RT:HILPosition:LATency?

Queries the time delay (or prediction latency) between the time specified with the
parameter <ElapsedTime> in a HIL command (<subsystem>: RT:HILPosition: 
MODE: A or <subsystem>: RT:HILPosition: MODE:B) and the time this command is
actually executed in the R&S SMBV.

You can use the determined value for latency calibration.

See also chapter 2.5.8, "Hardware in the Loop (HIL)", on page 29.

Return values: 
<Latency> float

Range: min  to  max
Increment: 0.001
*RST: 0

Example: SOURce1:BB:GPS:RT:HILPosition:LATency?
Usage: Query only

4.8 GNSS System Configuration

<subsystem>:HYBRid:<GNSS>[:STATe]..........................................................................193
<subsystem>:HYBRid:BEIDou[:STATe]............................................................................193
<subsystem>:HYBRid:GALileo[:STATe]........................................................................... 193
<subsystem>:HYBRid:GLONass[:STATe].........................................................................193
<subsystem>:HYBRid:GPS[:STATe]................................................................................ 193
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<subsystem>:UCRF....................................................................................................... 193
<subsystem>:UMGPs.....................................................................................................193
<subsystem>:SATellite:ASPoofing...................................................................................193

<subsystem>:HYBRid:<GNSS>[:STATe]
<subsystem>:HYBRid:BEIDou[:STATe] <State>
<subsystem>:HYBRid:GALileo[:STATe] <State>
<subsystem>:HYBRid:GLONass[:STATe] <State>
<subsystem>:HYBRid:GPS[:STATe] <State>

Defines the navigation standards that will be part of the hybrid configuration. Only the
satellites of an enabled standard are configurable (see chapter 4.12, "Satellites Config-
uration and Satellites Signal Settings", on page 210).

Parameters:
<State> 0 | 1 | OFF | ON

*RST: 0

Options: R&S SMBV-K44/K66/K94/K107

<subsystem>:UCRF <UseCentral_RF>

Use this command if several R&S SMBV instruments are connected to generate GNSS
signal in the same GNSS band.

Parameters:
<UseCentral_RF> 0 | 1 | OFF | ON

*RST: 0

Manual operation: See "Use Common RF Frequency" on page 86

<subsystem>:UMGPs <State>

Enables the configuration of GPS signals modulates with P code, see <subsystem>: 
SATellite<st>: SIGNal.

Parameters:
<State> 0 | 1 | OFF | ON

*RST: 0

Options: R&S SMBV-K93

Manual operation: See "Use Position Accuracy (P-Code) GPS" on page 87

<subsystem>:SATellite:ASPoofing <State>

Activates anti spoofing flag in the GPS navigation message.

Parameters:
<State> 0 | 1 | OFF | ON

*RST: 0
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Example: SOURce1:BB:GPS:SATellite:ASPoofing ON
Manual operation: See "GPS Anti-Spoofing" on page 87

4.9 Almanac/RINEX Configuration

Example: Selecting an Almanac file
The following examples use GPS entry standard. It is assumed, that a RF Band com-
mon for the GNSS standards is selected.

SOURce1:BB:GPS:HYBRid:GALileo:STATe ON
SOURce1:BB:GPS:NAVigation:ALManac:GPS:FILE 'GPS_SEM585.txt'
SOURce1:BB:GPS:NAVigation:ALManac:GALileo:FILE 'GAL_Yuma585.txt'
SOURce1:BB:GPS:NAVigation:ALManac:GLONass:FILE 'GLO_585.agl'
SOURce1:BB:GPS:SVID:GPS:LIST?
//Response:2,3,4,5,6,7,8,9,10,11,12,13,14,15,16,17,18,19,20,21,22,23,24,25,26,27,
// 28,29,30,31,32
SOURce1:BB:GPS:SVID:GALileo:LIST?
//Response:1,2,3,4,5,6,7,8,9,10,11,12,13,14,15,16,17,18,19,20,21,22,23,24,25,26,27,
// 28,29,30
SOURce1:BB:GPS:SVID:GLONass:LIST?
//Response:1,2,5,8,9,10,11,12,13,15,16,17,18,19,20,21,22,23,24
 

Example: Configuring a RINEX file
The following examples use GPS entry standard.

SOURce1:BB:GPS:NAVigation:RINex:GPS:FILE 
'/var/user/Lists/GNSS/GPS/Rinex/GPS_Week585_Day0.10n'
SOURce1:BB:GPS:NAVigation:RINex:GPS:IMPort
SOURce1:BB:GPS:NAVigation:RINex:GPS:UUAState
SOURce1:BB:GPS:NAVigation:RINex:GPS:STATe ON

Some commands of the following description do not apply to the GLONASS satellites.
If so, it is explicitly pointed out.

<subsystem>:NAVigation:ALManac:<GNSS>:FILE............................................................195
<subsystem>:NAVigation:ALManac:BEIDou:FILE............................................................. 195
<subsystem>:NAVigation:ALManac:GALileo:FILE............................................................. 195
<subsystem>:NAVigation:ALManac:GLONass:FILE.......................................................... 195
<subsystem>:NAVigation:ALManac:GPS:FILE..................................................................195
<subsystem>:NAVigation:ALManac:<GNSS>:DATE:BEGIn............................................... 196
<subsystem>:NAVigation:ALManac:BEIDou:DATE:BEGin?................................................196
<subsystem>:NAVigation:ALManac:GALileo:DATE:BEGin?............................................... 196
<subsystem>:NAVigation:ALManac:GPS:DATE:BEGin?....................................................196
<subsystem>:NAVigation:ALManac:<GNSS>:DATE:END.................................................. 196
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<subsystem>:NAVigation:ALManac:BEIDou:DATE:END?.................................................. 196
<subsystem>:NAVigation:ALManac:GALileo:DATE:END?..................................................196
<subsystem>:NAVigation:ALManac:GPS:DATE:END?...................................................... 196
<subsystem>:NAVigation:ALManac:GLONass:TOAPplicability:DATE?................................197
<subsystem>:NAVigation:ALManac:GLONass:TOAPplicability:TIME?.................................197
<subsystem>:NAVigation:ALManac:<GNSS>:TOAPplicability:TOWeek...............................198
<subsystem>:NAVigation:ALManac:BEIDou:TOAPplicability:TOWeek?...............................198
<subsystem>:NAVigation:ALManac:GALileo:TOAPplicability:TOWeek?...............................198
<subsystem>:NAVigation:ALManac:GPS:TOAPplicability:TOWeek?................................... 198
<subsystem>:NAVigation:ALManac:<GNSS>:TOAPplicability:WNUMber.............................198
<subsystem>:NAVigation:ALManac:BEIDou:TOAPplicability:WNUMber?.............................198
<subsystem>:NAVigation:ALManac:GALileo:TOAPplicability:WNUMber?............................ 198
<subsystem>:NAVigation:ALManac:GPS:TOAPplicability:WNUMber?.................................198
<subsystem>:NAVigation:ALManac:<GNSS>:WNUMber................................................... 199
<subsystem>:NAVigation:ALManac:BEIDou:WNUMber?................................................... 199
<subsystem>:NAVigation:ALManac:GALileo:WNUMber?................................................... 199
<subsystem>:NAVigation:ALManac:GPS:WNUMber?........................................................199
<subsystem>:NAVigation:RINex:<GNSS>:FILE................................................................ 199
<subsystem>:NAVigation:RINex:BEIDou:FILE.................................................................. 199
<subsystem>:NAVigation:RINex:GALileo:FILE..................................................................199
<subsystem>:NAVigation:RINex:GLONass:FILE............................................................... 199
<subsystem>:NAVigation:RINex:GPS:FILE...................................................................... 199
<subsystem>:NAVigation:RINex:<GNSS>:STATe............................................................. 199
<subsystem>:NAVigation:RINex:BEIDou:STATe...............................................................199
<subsystem>:NAVigation:RINex:GALileo:STATe...............................................................199
<subsystem>:NAVigation:RINex:GLONass:STATe............................................................200
<subsystem>:NAVigation:RINex:GPS:STATe................................................................... 200
<subsystem>:NAVigation:RINex:IMPort............................................................................200
<subsystem>:NAVigation:RINex:UUAState.......................................................................200
<subsystem>:NAVigation:RINex:UFNState.......................................................................200
<subsystem>:SVID:<GNSS>:LIST...................................................................................200
<subsystem>:SVID<ch>:BEIDou:LIST?............................................................................200
<subsystem>:SVID<ch>:GALileo:LIST?........................................................................... 201
<subsystem>:SVID<ch>:GLONass:LIST?.........................................................................201
<subsystem>:SVID<ch>:GPS:LIST?................................................................................ 201

<subsystem>:NAVigation:ALManac:<GNSS>:FILE
<subsystem>:NAVigation:ALManac:BEIDou:FILE <Almanac>
<subsystem>:NAVigation:ALManac:GALileo:FILE <Almanac>
<subsystem>:NAVigation:ALManac:GLONass:FILE <Almanac>
<subsystem>:NAVigation:ALManac:GPS:FILE <Almanac>

Defines the almanac file for the navigation standard.

For details see "Almanac Configuration" on page 87.
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Parameters:
<Almanac> string

The file name is sufficient to select a predefined almanac file or
almanacs in the default directory.
The complete file path with file name and extension is required
to select almanac files stored elsewhere

Example: See example "Selecting an Almanac file" on page 194.

<subsystem>:NAVigation:ALManac:<GNSS>:DATE:BEGIn
<subsystem>:NAVigation:ALManac:BEIDou:DATE:BEGin?
<subsystem>:NAVigation:ALManac:GALileo:DATE:BEGin?
<subsystem>:NAVigation:ALManac:GPS:DATE:BEGin?
This setting is ony available for GPS and Galileo satellites.

Queries the start date of the week span of the selected almanac file for the navigation
standard. The file is selected using <subsystem>: NAVigation: ALManac: <GNSS>: 
FILE.

Return values: 
<Year> integer

Range: 1980  to  9999
Increment: 1

<Month> integer
Range: 1  to  12
Increment: 1

<Day> integer
Range: 1  to  31
Increment: 1

Example: BB:GPS:NAV:ALM:GAL:DATE:BEG?
Response: 2010,11,07

Usage: Query only

<subsystem>:NAVigation:ALManac:<GNSS>:DATE:END
<subsystem>:NAVigation:ALManac:BEIDou:DATE:END?
<subsystem>:NAVigation:ALManac:GALileo:DATE:END?
<subsystem>:NAVigation:ALManac:GPS:DATE:END?
This setting is ony available for GPS and Galileo satellites.

Queries the end date of the week span of the selected almanac file for the navigation
standard. The file is selected using <subsystem>: NAVigation: ALManac:<GNSS>: 
FILE.
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Return values: 
<Year> integer

Range: 1980  to  9999
Increment: 1

<Month> integer
Range: 1  to  12
Increment: 1

<Day> integer
Range: 1  to  31
Increment: 1

Example: BB:GPS:NAV:ALM:GAL:DATE:END?
Response: 2010,11,14

Usage: Query only

<subsystem>:NAVigation:ALManac:GLONass:TOAPplicability:DATE?

Queries the date of applicability of the selected almanac file for the navigation stand-
ard.

Note: This setting is available for Glonass. It is no longer supported for GPS and Gali-
leo satellites. To get the applicability data of GPS and Galileo satellites, refer to the
commands <subsystem>: NAVigation: ALManac:<GNSS>: TOAPplicability: 
TOWeek  on page 198 and <subsystem>: NAVigation: ALManac: <GNSS>:
TOAPplicability: WNUMber on page 198.

Return values: 
<Year> integer

Range: 1996  to  9999
Increment: 1

<Month> integer
Range: 1  to  12
Increment: 1

<Day> integer
Range: 1  to  31
Increment: 1

Example: BB:GPS:NAV:ALM:GLON:TOAP:DATE?
Response: 2010,11,07

Usage: Query only

Manual operation: See "Almanac Configuration" on page 87

<subsystem>:NAVigation:ALManac:GLONass:TOAPplicability:TIME?

Queries the start time of applicability of the selected almanac file for the navigation
standard.
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Note: This setting is available for Glonass. It is no longer supported for GPS and Gali-
leo satellites. To get the applicability data of GPS and Galileo satellites, refer to the
commands <subsystem>: NAVigation: ALManac: <GNSS>: TOAPplicability: 
TOWeek  on page 198 and <subsystem>: NAVigation: ALManac: <GNSS>: 
TOAPplicability: WNUMber  on page 198.

Return values: 
<Hour> integer

Range: 0  to  23
Increment: 1

<Minute> integer
Range: 0  to  59
Increment: 1

<Second> float
Range: 0  to  59.999
Increment: 0.001

Example: BB:GPS:NAV:ALM:GLON:TOAP:TIME?
Response: 17,0,0

Usage: Query only

Manual operation: See "Almanac Configuration" on page 87

<subsystem>:NAVigation:ALManac:<GNSS>:TOAPplicability:TOWeek
<subsystem>:NAVigation:ALManac:BEIDou:TOAPplicability:TOWeek?
<subsystem>:NAVigation:ALManac:GALileo:TOAPplicability:TOWeek?
<subsystem>:NAVigation:ALManac:GPS:TOAPplicability:TOWeek?
Determines the Time of Week (TOW) the selected almanac is used for (time of applica-
bility).

Return values: 
<Tow> float

Range: 0  to  604799.999
Increment: 0.001
*RST: 0

Usage: Query only

<subsystem>:NAVigation:ALManac:<GNSS>:TOAPplicability:WNUMber
<subsystem>:NAVigation:ALManac:BEIDou:TOAPplicability:WNUMber?
<subsystem>:NAVigation:ALManac:GALileo:TOAPplicability:WNUMber?
<subsystem>:NAVigation:ALManac:GPS:TOAPplicability:WNUMber?
This setting is only available for Galileo and GPS satellites.

Determines the Week Number for which the selected almanac is used for (time of
applicability).
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Return values: 
<WN> integer

Range: 0  to  9999.0*53
Increment: 1
*RST: 1488

Usage: Query only

<subsystem>:NAVigation:ALManac:<GNSS>:WNUMber
<subsystem>:NAVigation:ALManac:BEIDou:WNUMber?
<subsystem>:NAVigation:ALManac:GALileo:WNUMber?
<subsystem>:NAVigation:ALManac:GPS:WNUMber?
This setting is ony available for GPS and Galileo satellites.

Queries the week number of the selected almanac file for the navigation standard. The
file is selected using <subsystem>: NAVigation: ALManac: <GNSS>: FILE .

Return values: 
<WeekNumber> integer

Range: 0  to  529947
*RST: 1488

Example: BB:GPS:NAV:ALM:GPS:WNUM?
Response: 585

Usage: Query only

<subsystem>:NAVigation:RINex:<GNSS>:FILE
<subsystem>:NAVigation:RINex:BEIDou:FILE <Filename>
<subsystem>:NAVigation:RINex:GALileo:FILE <Filename>
<subsystem>:NAVigation:RINex:GLONass:FILE <Filename>
<subsystem>:NAVigation:RINex:GPS:FILE <Filename>

Selects and activates one RINEX file per navigation standard. Perform
<subsystem>: NAVigation: RINex:IMPort  to upload the selected file.

Parameters:
<Filename> string

Example: See example "Configuring a RINEX file" on page 194.

Manual operation: See "RINEX Configuration" on page 88

<subsystem>:NAVigation:RINex:<GNSS>:STATe
<subsystem>:NAVigation:RINex:BEIDou:STATe <State>
<subsystem>:NAVigation:RINex:GALileo:STATe <State>
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<subsystem>:NAVigation:RINex:GLONass:STATe <State>
<subsystem>:NAVigation:RINex:GPS:STATe <State>

Activates a RINEX configuration file previously selected (see <subsystem>: 
NAVigation: RINex: GPS:FILE ) and imported (see <subsystem>: NAVigation: 
RINex: IMPort).

Parameters:
<State> 0 | 1 | OFF | ON

*RST: 0

Example: See example "Configuring a RINEX file" on page 194.

Manual operation: See "RINEX Configuration" on page 88

<subsystem>:NAVigation:RINex:IMPort

Uploads the RINEX file selected by <subsystem>: NAVigation: RINex: GPS:FILE.

Example: See example "Configuring a RINEX file" on page 194.

Usage: Event

Manual operation: See "RINEX Configuration" on page 88

<subsystem>:NAVigation:RINex:UUAState <State>

Synchronizes the time conversion and the atmospheric parameters to the correspond-
ing values retrieved from the RINEX file.

Parameters:
<State> 0 | 1 | OFF | ON

*RST: 0

Example: See example "Configuring a RINEX file" on page 194.

Manual operation: See "RINEX Configuration" on page 88

<subsystem>:NAVigation:RINex:UFNState <State>

Updates the frequency number for Glonass satellites automatically at import of a
RINEX File.

Parameters:
<State> 0 | 1 | OFF | ON

*RST: 0

Example: BB:GPS:NAV:RIN:UFNS 1
Manual operation: See "RINEX Configuration" on page 88

<subsystem>:SVID:<GNSS>:LIST
<subsystem>:SVID<ch>:BEIDou:LIST?
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<subsystem>:SVID<ch>:GALileo:LIST?
<subsystem>:SVID<ch>:GLONass:LIST?
<subsystem>:SVID<ch>:GPS:LIST?
Queries the list of valid satellites (SV IDs) of the selected almanac file for the naviga-
tion standard.

To select the file, use the command <subsystem>: NAVigation: ALManac: 
<GNSS>: FILE.

Example: See example "Selecting an Almanac file" on page 194.

Usage: Query only

4.10 Time Conversion Configuration

Example: Configuring the time conversion and leap seconds settings
The following example uses GPS entry standard.

SOURce1:BB:GPS:PRESet
SOURce1:BB:GPS:SMOD USER
SOURce1:BB:GPS:NAVigation:TCONversion:GPS:AZERo?
//Response: 0
SOURce1:BB:GPS:NAVigation:TCONversion:GPS:AONE?
//Response: 0
SOURce1:BB:GPS:NAVigation:TCONversion:GPS:TOT?
//Response: 0
SOURce1:BB:GPS:NAVigation:TCONversion:GPS:WNOT?
//Response: 0
SOURce1:BB:GPS:NAVigation:TCONversion:LEAP:SYNC
SOURce1:BB:GPS:NAVigation:TCONversion:LEAP:SLSTransition:STATe ON
SOURce1:BB:GPS:NAVigation:TCONversion:LEAP:SEConds?
//Response:15
SOURce1:BB:GPS:NAVigation:TCONversion:LEAP:DATE?
//Response: 2010,11,8
SOURce1:BB:GPS:NAVigation:TCONversion:LEAP:SIGN?
//Response: PLUS 

<subsystem>:NAVigation:TCONversion:<GNSS>:AONE................................................... 202
<subsystem>:NAVigation:TCONversion:BEIDou:AONE..................................................... 202
<subsystem>:NAVigation:TCONversion:GALileo:AONE.....................................................202
<subsystem>:NAVigation:TCONversion:GLONass:AONE.................................................. 202
<subsystem>:NAVigation:TCONversion:GPS:AONE..........................................................202
<subsystem>:NAVigation:TCONversion:<GNSS>:AZERo.................................................. 202
<subsystem>:NAVigation:TCONversion:BEIDou:AZERo....................................................202
<subsystem>:NAVigation:TCONversion:GALileo:AZERo....................................................202
<subsystem>:NAVigation:TCONversion:GLONass:AZERo.................................................202
<subsystem>:NAVigation:TCONversion:GPS:AZERo........................................................ 202
<subsystem>:NAVigation:TCONversion:<GNSS>:TOT...................................................... 203
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<subsystem>:NAVigation:TCONversion:BEIDou:TOT........................................................203
<subsystem>:NAVigation:TCONversion:GALileo:TOT........................................................203
<subsystem>:NAVigation:TCONversion:GLONass:TOT.....................................................203
<subsystem>:NAVigation:TCONversion:GPS:TOT............................................................ 203
<subsystem>:NAVigation:TCONversion:<GNSS>:WNOT...................................................203
<subsystem>:NAVigation:TCONversion:BEIDou:WNOT.....................................................203
<subsystem>:NAVigation:TCONversion:GALileo:WNOT.................................................... 203
<subsystem>:NAVigation:TCONversion:GLONass:WNOT................................................. 203
<subsystem>:NAVigation:TCONversion:GPS:WNOT.........................................................203
<subsystem>:NAVigation:TCONversion:UTCSu:AONE......................................................204
<subsystem>:NAVigation:TCONversion:UTCSu:AZERo.................................................... 204
<subsystem>:NAVigation:TCONversion:UTCSu:DATE?.................................................... 204
<subsystem>:NAVigation:TCONversion:LEAP:SLSTransition[:STATe]................................ 205
<subsystem>:NAVigation:TCONversion:LEAP:DATE.........................................................205
<subsystem>:NAVigation:TCONversion:LEAP:SEConds....................................................205
<subsystem>:NAVigation:TCONversion:LEAP:SIGN......................................................... 205
<subsystem>:NAVigation:TCONversion:LEAP:SYNC........................................................ 206

<subsystem>:NAVigation:TCONversion:<GNSS>:AONE
<subsystem>:NAVigation:TCONversion:BEIDou:AONE <AOne>
<subsystem>:NAVigation:TCONversion:GALileo:AONE <AOne>
<subsystem>:NAVigation:TCONversion:GLONass:AONE <AOne>
<subsystem>:NAVigation:TCONversion:GPS:AONE <AOne>

For <subsystem>: SMODe  STATic or USER, defines the 1st order term of polynomial,
A1.

Parameters:
<AOne> integer

Range: -8388608  to  8388607
Increment: 1
*RST: 0

Example: See example "Configuring the time conversion and leap sec-
onds settings" on page 201.

Manual operation: See "Time Conversion Parameters" on page 90

<subsystem>:NAVigation:TCONversion:<GNSS>:AZERo
<subsystem>:NAVigation:TCONversion:BEIDou:AZERo <AZero>
<subsystem>:NAVigation:TCONversion:GALileo:AZERo <AZero>
<subsystem>:NAVigation:TCONversion:GLONass:AZERo <AZero>
<subsystem>:NAVigation:TCONversion:GPS:AZERo <AZero>

For <subsystem>: SMODe STATic or USER, defines the constant term of polynomial,
A0.
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Parameters:
<AZero> integer

Range: -2147483648  to  2147483647
Increment: 1
*RST: 0

Example: See example "Configuring the time conversion and leap sec-
onds settings" on page 201.

Manual operation: See "Time Conversion Parameters" on page 90

<subsystem>:NAVigation:TCONversion:<GNSS>:TOT
<subsystem>:NAVigation:TCONversion:BEIDou:TOT <Tot>
<subsystem>:NAVigation:TCONversion:GALileo:TOT <Tot>
<subsystem>:NAVigation:TCONversion:GLONass:TOT <Tot>
<subsystem>:NAVigation:TCONversion:GPS:TOT <Tot>

For <subsystem>: SMODe  STATic or USER, defines the UTC data reference time of
week, tot.

Parameters:
<Tot> integer

Range: 0  to  255
Increment: 1
*RST: 0

Example: See example "Configuring the time conversion and leap sec-
onds settings" on page 201.

Manual operation: See "Time Conversion Parameters" on page 90

<subsystem>:NAVigation:TCONversion:<GNSS>:WNOT
<subsystem>:NAVigation:TCONversion:BEIDou:WNOT <Wnot>
<subsystem>:NAVigation:TCONversion:GALileo:WNOT <Wnot>
<subsystem>:NAVigation:TCONversion:GLONass:WNOT <Wnot>
<subsystem>:NAVigation:TCONversion:GPS:WNOT <Wnot>

For <subsystem>: SMODe  STATic or USER, defines the UTC data reference week
number, WNt.

Parameters:
<Wnot> integer

Range: 0  to  255
Increment: 1
*RST: 0

Example: See example "Configuring the time conversion and leap sec-
onds settings" on page 201.

Manual operation: See "Time Conversion Parameters" on page 90
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<subsystem>:NAVigation:TCONversion:UTCSu:AONE <A_1>

Defines the 1st order term of polynomial, A1.

Parameters:
<A_1> integer

Range: -512  to  511
Increment: 1
*RST: 0

Options: R&S SMx/AMU-K294
R&S SMBV-K94

Manual operation: See "UTC-UTC(SU)" on page 91

<subsystem>:NAVigation:TCONversion:UTCSu:AZERo <A_0>

Defines the constant term of polynomial, A0.

Parameters:
<A_0> integer

Range: -1024  to  1023
Increment: 1
*RST: 0

Options: R&S SMx/AMU-K294
R&S SMBV-K94

Manual operation: See "UTC-UTC(SU)" on page 91

<subsystem>:NAVigation:TCONversion:UTCSu:DATE?

Enters the date for the UTC-UTC(SU) data in DMS format.

Return values: 
<Year> integer

Range: 1996  to  9999
Increment: 1

<Month> integer
Range: 1  to  12
Increment: 1

<Day> integer
Range: 1  to  31
Increment: 1

Usage: Query only

Options: R&S SMx/AMU-K294
R&S SMBV-K94

Manual operation: See "UTC-UTC(SU)" on page 91
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<subsystem>:NAVigation:TCONversion:LEAP:SLSTransition[:STATe] <State>

Enables/disables the simulation of the leap second transition.

Parameters:
<State> 0 | 1 | OFF | ON

*RST: Off

Manual operation: See "Leap Second Configuration" on page 90

<subsystem>:NAVigation:TCONversion:LEAP:DATE <Year>, <Month>, <Day>

Defines the date of the next UTC time correction.

Parameters:
<Year> integer

Range: 1980  to  9999
Increment: 1

<Month> integer
Range: 1  to  12
Increment: 1

<Day> integer
Range: 1  to  31
Increment: 1

Example: See example "Configuring the time conversion and leap sec-
onds settings" on page 201.

Options: R&S SMBV-K92

Manual operation: See "Leap Second Configuration" on page 90

<subsystem>:NAVigation:TCONversion:LEAP:SEConds <Seconds>

Defines the currently used leap second.

Parameters:
<Seconds> float

Range: 0  to  50
Increment: 1
*RST: 15

Example: See example "Configuring the time conversion and leap sec-
onds settings" on page 201.

Manual operation: See "Leap Second Configuration" on page 90

<subsystem>:NAVigation:TCONversion:LEAP:SIGN <Sign>

Defines whether one second is added to or subtracted from the current leap second
value during synchronization.
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Parameters:
<Sign> PLUS | MINus

*RST: PLUS

Example: See example "Configuring the time conversion and leap sec-
onds settings" on page 201.

Options: R&S SMBV-K92

Manual operation: See "Leap Second Configuration" on page 90

<subsystem>:NAVigation:TCONversion:LEAP:SYNC

Synchronizes the leap second according to the simulation time.

Example: See example "Configuring the time conversion and leap sec-
onds settings" on page 201.

Usage: Event

Manual operation: See "Leap Second Configuration" on page 90

4.11 Static Multipath Configuration

The multipath settings are enabled for instrument equipped with option GNSS
Enhanced (R&S SMBV-K92).

Example: Configuring the multipath settings for SV ID#20
The following example uses GPS entry standard.

SOURce1:BB:GPS:PRESet
SOURce1:BB:GPS:SMOD USER
SOURce1:BB:GPS:SATellite:COUNt?
//Response: 8
SOURce1:BB:GPS:SATellite2:SVID?
//Response: 20
SOURce1:BB:GPS:SAT2:STAN?
//Response: GALileo
SOURce1:BB:GPS:SVID20:GALileoMPATh:TAP:COUNt 2
SOURce1:BB:GPS:SVID20:GALileoMPATh:TAP1:POWer -3
SOURce1:BB:GPS:SVID20:GALileoMPATh:TAP1:DSHift  100
SOURce1:BB:GPS:SVID20:GALileoMPATh:TAP1:CPHase 3.14
SOURce1:BB:GPS:SVID20:GALileoMPATh:TAP2:TSHift 1
SOURce1:BB:GPS:SVID20:GALileo:MPATh:TAP2:POWer -5
SOURce1:BB:GPS:SVID20:GALileo:MPATh:STATe ON
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<subsystem>:SVID<ch>:<GNSS>:MPATh:STATe.............................................................207
<subsystem>:SVID<ch>:BEIDou:MPATh:STATe...............................................................207
<subsystem>:SVID<ch>:GALileo:MPATh:STATe.............................................................. 207
<subsystem>:SVID<ch>:GLONass:MPATh:STATe............................................................207
<subsystem>:SVID<ch>:GPS:MPATh:STATe...................................................................207
<subsystem>:SVID<ch>:<GNSS>:MPATh:TAP:COUNt..................................................... 208
<subsystem>:SVID<ch>:BEIDou:MPATh:TAP:COUNt....................................................... 208
<subsystem>:SVID<ch>:GALileo:MPATh:TAP:COUNt.......................................................208
<subsystem>:SVID<ch>:GLONass:MPATh:TAP:COUNt....................................................208
<subsystem>:SVID<ch>:GPS:MPATh:TAP:COUNt........................................................... 208
<subsystem>:SVID<ch>:<GNSS>:MPATh:TAP<us>:CPHase............................................ 208
<subsystem>:SVID<ch>:BEIDou:MPATh:TAP<us>:CPHase.............................................. 208
<subsystem>:SVID<ch>:GALileo:MPATh:TAP<us>:CPHase..............................................208
<subsystem>:SVID<ch>:GLONass:MPATh:TAP<us>:CPHase........................................... 208
<subsystem>:SVID<ch>:GPS:MPATh:TAP<us>:CPHase...................................................208
<subsystem>:SVID<ch>:<GNSS>:MPATh:TAP<us>:DSHift............................................... 208
<subsystem>:SVID<ch>:BEIDou:MPATh:TAP<us>:DSHift.................................................208
<subsystem>:SVID<ch>:GALileo:MPATh:TAP<us>:DSHift.................................................208
<subsystem>:SVID<ch>:GLONass:MPATh:TAP<us>:DSHift..............................................208
<subsystem>:SVID<ch>:GPS:MPATh:TAP<us>:DSHift..................................................... 208
<subsystem>:SVID<ch>:<GNSS>:MPATh:TAP<us>:POWer..............................................209
<subsystem>:SVID<ch>:BEIDou:MPATh:TAP<us>:POWer................................................209
<subsystem>:SVID<ch>:GALileo:MPATh:TAP<us>:POWer............................................... 209
<subsystem>:SVID<ch>:GLONass:MPATh:TAP<us>:POWer.............................................209
<subsystem>:SVID<ch>:GPS:MPATh:TAP<us>:POWer....................................................209
<subsystem>:SVID<ch>:<GNSS>:MPATh:TAP<us>:TSHift............................................... 209
<subsystem>:SVID<ch>:BEIDou:MPATh:TAP<us>:TSHift................................................. 209
<subsystem>:SVID<ch>:GALileo:MPATh:TAP<us>:TSHift.................................................209
<subsystem>:SVID<ch>:GLONass:MPATh:TAP<us>:TSHift.............................................. 209
<subsystem>:SVID<ch>:GPS:MPATh:TAP<us>:TSHift......................................................209

<subsystem>:SVID<ch>:<GNSS>:MPATh:STATe
<subsystem>:SVID<ch>:BEIDou:MPATh:STATe <State>
<subsystem>:SVID<ch>:GALileo:MPATh:STATe <State>
<subsystem>:SVID<ch>:GLONass:MPATh:STATe <State>
<subsystem>:SVID<ch>:GPS:MPATh:STATe <State>

Enables/disables the generation of multipath signals for the satellite with the specified
SV ID belonging to the specified GNSS standard. Settings made with the subsequent
<subsystem>:SVID<ch>:<GNSS>:MPATh commands are considered only if the
multipath configuration is enabled.

Parameters:
<State> 0 | 1 | OFF | ON

*RST: 0

Example: See example "Configuring the multipath settings for SV ID#20"
on page 206.

Options: R&S SMBV-K92
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<subsystem>:SVID<ch>:<GNSS>:MPATh:TAP:COUNt
<subsystem>:SVID<ch>:BEIDou:MPATh:TAP:COUNt <Taps>
<subsystem>:SVID<ch>:GALileo:MPATh:TAP:COUNt <Taps>
<subsystem>:SVID<ch>:GLONass:MPATh:TAP:COUNt <Taps>
<subsystem>:SVID<ch>:GPS:MPATh:TAP:COUNt <Taps>

Sets the paths number. The value determines the number of rows available for config-
uration.

For details see "Number of Taps" on page 129.

Parameters:
<Taps> float

Range: 1  to  10
Increment: 1
*RST: 1

Example: See example "Configuring the multipath settings for SV ID#20"
on page 206.

Options: R&S SMBV-K92

<subsystem>:SVID<ch>:<GNSS>:MPATh:TAP<us>:CPHase
<subsystem>:SVID<ch>:BEIDou:MPATh:TAP<us>:CPHase <Phase>
<subsystem>:SVID<ch>:GALileo:MPATh:TAP<us>:CPHase <Phase>
<subsystem>:SVID<ch>:GLONass:MPATh:TAP<us>:CPHase <Phase>
<subsystem>:SVID<ch>:GPS:MPATh:TAP<us>:CPHase <Phase>

Sets the carrier phase, used in case of multipath simulation.

Suffix: 
<us>

.
1..10

Parameters:
<Phase> float

Range: 0  to  6.28
Increment: 0.01
*RST: 0
Default unit: rad

Example: See example "Configuring the multipath settings for SV ID#20"
on page 206.

Options: R&S SMBV-K92

<subsystem>:SVID<ch>:<GNSS>:MPATh:TAP<us>:DSHift
<subsystem>:SVID<ch>:BEIDou:MPATh:TAP<us>:DSHift <DopplerShift>
<subsystem>:SVID<ch>:GALileo:MPATh:TAP<us>:DSHift <DopplerShift>
<subsystem>:SVID<ch>:GLONass:MPATh:TAP<us>:DSHift <DopplerShift>
<subsystem>:SVID<ch>:GPS:MPATh:TAP<us>:DSHift <DopplerShift>

Defines the additional Doppler shift of the simulated signal of the satellite, used to sim-
ulate multipath conditions.
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Suffix: 
<us>

.
1..10

Parameters:
<DopplerShift> float

Range: -10.0E3  to  10.0E3
Increment: 0.01
*RST: 0
Default unit: Hz

Example: See example "Configuring the multipath settings for SV ID#20"
on page 206.

Options: R&S SMBV-K92

<subsystem>:SVID<ch>:<GNSS>:MPATh:TAP<us>:POWer
<subsystem>:SVID<ch>:BEIDou:MPATh:TAP<us>:POWer <Power>
<subsystem>:SVID<ch>:GALileo:MPATh:TAP<us>:POWer <Power>
<subsystem>:SVID<ch>:GLONass:MPATh:TAP<us>:POWer <Power>
<subsystem>:SVID<ch>:GPS:MPATh:TAP<us>:POWer <Power>

Sets the additional power of the satellite in dB, used to simulate multipath conditions.

See chapter 3.6.1, "Power Configuration", on page 92 for information about the power
calculation.

Suffix: 
<us>

.
1..10

Parameters:
<Power> float

Range: -10  to  0
Increment: 0.01
*RST: 0
Default unit: dB

Example: See example "Configuring the multipath settings for SV ID#20"
on page 206 and example "Configuring the power settings "
on page 221.

Options: R&S SMBV-K92

<subsystem>:SVID<ch>:<GNSS>:MPATh:TAP<us>:TSHift
<subsystem>:SVID<ch>:BEIDou:MPATh:TAP<us>:TSHift <TimeShift>
<subsystem>:SVID<ch>:GALileo:MPATh:TAP<us>:TSHift <TimeShift>
<subsystem>:SVID<ch>:GLONass:MPATh:TAP<us>:TSHift <TimeShift>
<subsystem>:SVID<ch>:GPS:MPATh:TAP<us>:TSHift <TimeShift>

Sets an additional delay of the selected satellite, used to simulate multipath conditions.

Suffix: 
<us>

.
1..10
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Parameters:
<TimeShift> float

Range: 0  to  9.99999
Increment: 0.00001
*RST: 0
Default unit: Chips

Example: See example "Configuring the multipath settings for SV ID#20"
on page 206.

Options: R&S SMBV-K92

4.12 Satellites Configuration and Satellites Signal Settings

Configurations with more than 6 satellites require option R&S SMBV-K91, more than
12 satelites require option R&S SMBV-K96.

Example: Configuring the satellite's constellation
The following example uses GPS entry standard.

SOURce1:BB:GPS:PRESet
SOURce1:BB:GPS:SMODe USER

// enable hybrid GNSS configuration
SOURce1:BB:GPS:HYBRid:GPS:STATe ON
SOURce1:BB:GPS:HYBRid:GALileo:STATe ON
SOURce1:BB:GPS:HYBRid:GLONass:STATe ON
SOURce1:BB:GPS:HYBRid:BEIDou:STATe ON

SOURce1:BB:GPS:PRFL

SOURce1:BB:GPS:SEMask 7.5
SOURce1:BB:GPS:SATellite:COUNt 8

SOURce1:BB:GPS:SATellite:GRTP ON
SOURce1:BB:GPS:SATellite1:STANdard?
//Response: GPS
SOURce1:BB:GPS:SATellite1:SIGNal?
//Response: CAC
SOURce1:BB:GPS:SATellite1:SVID?
//Response: 30
SOURce1:BB:GPS:SATellite1:SCRate?
//Response: 1023000
SOURce1:BB:GPS:SATellite1:MODulation?
//Response: BPSK
SOURce1:BB:GPS:SATellite1:DURation?
//Response: 13329
SOURce1:BB:GPS:SATellite1:PRANge?

 

Satellites Configuration and Satellites Signal Settings



Remote-Control CommandsSatellite Navigation

211Operating Manual 1173.1427.12 ─ 08

//Response: 20531267.5147461
SOURce1:BB:GPS:SATellite1:PRBias 0
SOURce1:BB:GPS:SATellite1:TSHift?
//Response: 70060.0902627953
SOURce1:BB:GPS:SATellite1:DSHift?
//Response: 1146.05037064872
SOURce1:BB:GPS:SATellite1:ICPHase?
//Response: 6.25362425028864
SOURce1:BB:GPS:SATellite1:FREQuency?
//Response: 1575421146.05037
SOURce1:BB:GPS:SATellite1:CACRate?
//Response: 1023000.74418801
SOURce1:BB:GPS:SVID19:GPS:MPAT:STATe?
//Response: 0
SOURce1:BB:GPS:SATellite1:STATe?
//Response: 1

SOURce1:BB:GPS:SATellite5:STANdard?
//Response: BEID
SOURce1:BB:GPS:SATellite5:SIGNal?
//Response: B1C
SOURce1:BB:GPS:SATellite5:SVID?
//Response: 33
SOURce1:BB:GPS:SATellite5:ORBit?
//Response: MEO

SOURce1:BB:GPS:SATellite7:STANdard?
//Response: GLON
SOURce1:BB:GPS:SATellite7:SIGNal?
//Response: RCA
SOURce1:BB:GPS:SATellite7:SVID?
//Response: 14
SOURce1:BB:GPS:SATellite7:FNUMber?
//Response: -7
SOURce1:BB:GPS:SATellite7:SCRate?
//Response: 511000

SOURce1:BB:GPS:STATe ON
SOURce1:BB:GPS:HDOP?
//Response: 1.12895407129922
SOURce1:BB:GPS:PDOP?
//Response: 2.15878433755758

<subsystem>:SPReading[:STATe]...................................................................................212
<subsystem>:SEMask.................................................................................................... 212
<subsystem>:HDOP?.....................................................................................................213
<subsystem>:PDOP?..................................................................................................... 213
<subsystem>:GALModulation..........................................................................................213
<subsystem>:GOConstellation........................................................................................ 213
<subsystem>:SATellite:GRTProjection.............................................................................214
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<subsystem>:SATellite:COUNt........................................................................................214
<subsystem>:SATellite<st>:CACRate?............................................................................ 214
<subsystem>:SATellite<st>:DSHift...................................................................................215
<subsystem>:SATellite<st>:DURation?............................................................................ 215
<subsystem>:SATellite<st>:FNUMber..............................................................................215
<subsystem>:SATellite<st>:FREQuency?........................................................................ 216
<subsystem>:SATellite<st>:CPHase................................................................................216
<subsystem>:SATellite<st>:ICPHase...............................................................................216
<subsystem>:SATellite<st>:PCRate?...............................................................................216
<subsystem>:SATellite<st>:MODulation...........................................................................217
<subsystem>:SATellite<st>:ORBit................................................................................... 217
<subsystem>:SATellite<st>:PRANge............................................................................... 217
<subsystem>:SATellite<st>:PRBias................................................................................. 218
<subsystem>:SATellite<st>:SCRate?...............................................................................218
<subsystem>:SATellite<st>:SIGNal................................................................................. 218
<subsystem>:SATellite<st>:STANdard.............................................................................218
<subsystem>:SATellite<st>:STATe..................................................................................219
<subsystem>:SATellite<st>:SVID.................................................................................... 219
<subsystem>:SATellite<st>:TSHift...................................................................................219

<subsystem>:SPReading[:STATe] <State>

Activates/deactivates spreading. When spreading is deactivated the pure navigation
data is modulated onto the RF carrier.

This setting is only available for <subsystem>: SMODe STATic.

Parameters:
<State> 0 | 1 | OFF | ON

*RST: 1

Example: BB:GPS:SMOD STAT
BB:GPS:SPR:STAT ON

Manual operation: See "Use Spreading" on page 100

<subsystem>:SEMask <SEMask>

For <subsystem>: SMODe AUTO or USER, sets the satellite's elevation mask.

Parameters:
<SEMask> float

Range: 2.5  to  10.0
*RST: 5

Example: See example "Configuring the satellite's constellation"
on page 210.

Manual operation: See "Elevation Mask" on page 101
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<subsystem>:HDOP?

For <subsystem>: SMODe AUTO or USER, queries the HDOP (Horizontal Dilution of
Precision) of the selected satellite constellation at the beginning of the simulation.

Return values: 
<Hdop> float

Increment: 0.01

Example: See example "Configuring the satellite's constellation"
on page 210.

Usage: Query only

Manual operation: See "Initial HDOP/PDOP" on page 101

<subsystem>:PDOP?

For <subsystem>: SMODe AUTO or USER, queries the PDOP (Position Dilution of Pre-
cision) of the selected satellite constellation at the beginning of the simulation.

Return values: 
<PDop> float

Increment: 0.01
*RST: 0

Example: See example "Configuring the satellite's constellation"
on page 210.

Usage: Query only

Manual operation: See "Initial HDOP/PDOP" on page 101

<subsystem>:GALModulation <Modulation>

Defines the modulation mode used for modulating the galileo carrier signal.

BOC(1,1) modulation can be set with Galileo instead of CBOC(6,1) to reduce the sam-
ple rate required to simulate a certain period of time.

Parameters:
<Modulation> BOC | CBOC

*RST: CBOC

Manual operation: See "Galileo Sat. Modulation" on page 100

<subsystem>:GOConstellation

Retrieves an optimal satellite constellation for the selected Almanac/RINEX file, eleva-
tion mask and the enabled maximum number of satellites.

Usage: Event

Manual operation: See "Get Optimal Constellation" on page 102
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<subsystem>:SATellite:GRTProjection <Glb_RT_proj>

Forces ephemeris projection for all satellites, i.e. performs the same action as the com-
mand <subsystem>: SVID<ch>: <GNSS>: NMESsage: RTPRojection .

Parameters:
<Glb_RT_proj> 0 | 1 | OFF | ON

*RST: 0

Example: See example "Configuring the satellite's constellation"
on page 210.

Manual operation: See "Global Ephemeris Real-Time Projection" on page 102

<subsystem>:SATellite:COUNt <SatCount>

Defines the maximum number of satellites that can be simulated. The minimum
allowed number depends on the selected simulation mode (see <subsystem>: SMODe 
on page 160) .

Configurations with one satellite are allowed only for <subsystem>: SMODeSTATic.
For <subsystem>: SMODe AUTO or USER, four satellites or more are required.

Note: Generating the navigation signal with more than 6 satellites is enabled only for
instruments equipped with option R&S SMBV-K91; more than 12 satellites require
option R&S SMBV-K96.

The number of satellites determines the value range of the suffix for
<subsystem>:SATellite<st> commands.

Parameters:
<SatCount> integer

Range: 1  to  24
Increment: 1
*RST: 1

Example: See example "Configuring the satellite's constellation"
on page 210.

Options: R&S SMBV-K91 (more than 6 satellites)
R&S SMBV-K96 (more than 12 satellites)

Manual operation: See "Maximum Number of Satellites" on page 103

<subsystem>:SATellite<st>:CACRate?

Queries the currently valid values for the chip rate.

Return values: 
<CACRate> float

Default unit: Hz

Example: See example "Configuring the satellite's constellation"
on page 210.
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Usage: Query only

Manual operation: See "Resulting Start Chip Rate" on page 109

<subsystem>:SATellite<st>:DSHift <DopplerShift>

Defines the Doppler shift of the simulated signal of the satellite.

Parameters:
<DopplerShift> float

Range: -100.0e3  to  100.0e3
Increment: 0.01
*RST: 0
Default unit: Hz

Example: See example "Configuring the satellite's constellation"
on page 210.

Manual operation: See "Doppler Shift" on page 108

<subsystem>:SATellite<st>:DURation?

Queries the time the satellite's elevation is higher than 2.5, 5, 7.5 or 10° starting at the
first simulation moment of the satellite of interest, as selected with the command
<subsystem>: SEMask.

Return values: 
<Duration> float

Default unit: s

Example: See example "Configuring the satellite's constellation"
on page 210.

Usage: Query only

Manual operation: See "Duration (Elev. > 2.5/5/7.5/10°)" on page 106

<subsystem>:SATellite<st>:FNUMber <FrequencyNumber>

The command sets or queries the frequency number, depending on the used data
source. The parameter corresponds to the sub-carrier used to modulate the GLONASS
satellite.

Parameters:
<FrequencyNumber> integer

Range: -7  to  24
Increment: 1
*RST: 0

Manual operation: See "Frequency Number" on page 105
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<subsystem>:SATellite<st>:FREQuency?

Queries the currently valid values for Doppler-shifted carrier frequency.

Return values: 
<Frequency> float

Default unit: Hz

Example: See example "Configuring the satellite's constellation"
on page 210.

Usage: Query only

Manual operation: See "Resulting Start Frequency" on page 108

<subsystem>:SATellite<st>:CPHase <Code>

Sets the initial code phase in chips while working in static simulation mode and using
arbitary navigation data source.

Parameters:
<Code> float

Range: 0  to  20459.99
Increment: 0.01
*RST: 0

Manual operation: See "Initial Code Phase" on page 107

<subsystem>:SATellite<st>:ICPHase <ICPhase>

Sets the initial carrier phase.

This setting is only available for <subsystem>: SMODe STATic. The parameter is
updated automatically for USER and AUTO.

Parameters:
<ICPhase> float

Range: 0  to  6.28
Increment: 0.01
*RST: 0

Example: See example "Configuring the satellite's constellation"
on page 210.

Manual operation: See "Initial Carrier Phase " on page 108

<subsystem>:SATellite<st>:PCRate?

Queries the currently valid values for the chip rate of the P-code.

Return values: 
<PCRate> float

Usage: Query only
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Options: R&S SMBV-K93

Manual operation: See "Resulting P-Code Chip Rate" on page 109

<subsystem>:SATellite<st>:MODulation <Modulation>

Defines the modulation used for modulating the carrier signal.

Parameters:
<Modulation> BPSK | CBOC

*RST: BPSK

Example: See example "Configuring the satellite's constellation"
on page 210.

Manual operation: See "Modulation" on page 106

<subsystem>:SATellite<st>:ORBit <OrbitType>

(enabled for BeiDou satellites only)

For BeiDou satellites, querries the orbit type the corresponding satellite is using.

Parameters:
<OrbitType> MEO | IGSO | GEO

*RST: GEO

Example: See example "Configuring the satellite's constellation"
on page 210.

Manual operation: See "Orbit Type" on page 106

<subsystem>:SATellite<st>:PRANge <Pseudorange>

For <subsystem>: SMODe STATic, defines the propagation delay from satellite to
receiver in meters.

Parameters:
<Pseudorange> float

Range: 0  to  (2.499E6)/1.023E6*SPEED_OF_LIGHT
Increment: 0.001
*RST: 0
Default unit: m

Example: See example "Configuring the satellite's constellation"
on page 210.

Manual operation: See "Pseudorange" on page 107
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<subsystem>:SATellite<st>:PRBias <PseudorangeBias>

Sets a bias to the pseudorange of a satellite (see also <subsystem>: 
SATellite<st>: PRANge on page 217).

This setting is only available for <subsystem>: SMODe AUTO or USER.

Parameters:
<PseudorangeBias> float

Range: -1000  to  1000
Increment: 0.001
*RST: 0
Default unit: m

Example: See example "Configuring the satellite's constellation"
on page 210.

Manual operation: See "Pseudorange Bias" on page 107

<subsystem>:SATellite<st>:SCRate?

Queries the standard chip rate.

Return values: 
<ChipRate> float

Default unit: Hz

Example: See example "Configuring the satellite's constellation"
on page 210.

Usage: Query only

Manual operation: See "Standard Chip Rate" on page 105

<subsystem>:SATellite<st>:SIGNal <Signal>

Selects the type of signal the corresponding satellite is using.

Enabled <subsystem>: UMGPs is prerequisites for using P codes.

Parameters:
<Signal> CACode | PCODe | CAPQ | CAPI | E1Def | RCA | B1CA

*RST: CACode

Example: See example "Configuring the satellite's constellation"
on page 210.

Manual operation: See "Signal(s)" on page 103

<subsystem>:SATellite<st>:STANdard <Standard>

Selects the navigation standard the corresponding satellite belongs to.
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The available GNSS standards depend on the selected hybrid GNSS configuration and
the installed options.

Parameters:
<Standard> GPS | GALileo | GLONass | BEIDou

*RST: GPS

Example: See example "Configuring the satellite's constellation"
on page 210.

Manual operation: See "Standard" on page 103

<subsystem>:SATellite<st>:STATe <State>

Activates/deactivates the satellite.

Parameters:
<State> 0 | 1 | OFF | ON

*RST: 0

Example: See example "Configuring the satellite's constellation"
on page 210.

Manual operation: See "Satellite State" on page 103

<subsystem>:SATellite<st>:SVID <Svid>

Defines the Space Vehicle ID of the satellite to be simulated. This value is used to gen-
erate the corresponding spreading code.

For <subsystem>: NAVigation: DATARNData, only the valid IDs which are listed in
the almanac are selectable; for arbitrary data, any ID can be selected.

SV ID set to -1 corresponds to the manual selection "N.A. (not assigned)". It is not
allowed to assign the same SV ID to more than one satellite of one GNSS standard.
Hence, the selection N.A. can be used to exchange the assigned SV ID to different sat-
ellites belonging to the same standard.

Parameters:
<Svid> integer

Range: 1  to  40
Increment: 1
*RST: 1

Example: See example "Configuring the satellite's constellation"
on page 210.

Manual operation: See "SV-ID" on page 104

<subsystem>:SATellite<st>:TSHift <TimeShift>

Defines the propagation delay from satellite to receiver.
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Parameters:
<TimeShift> float

time shift in chips
Range: 0  to  2499999.999
Increment: 0.001
*RST: 0

Example: See example "Configuring the satellite's constellation"
on page 210.

Manual operation: See "Time Shift/ chips" on page 108

4.13 Global Signal Configuration

<subsystem>:SVID:SIGNal:COUPling <State>

Enables the configuration of all SV IDs simultaneously. Current settings are overwrit-
ten.

Parameters:
<State> 0 | 1 | OFF | ON

*RST: 1

Manual operation: See "SV ID Signal Coupling" on page 110

<subsystem>:SVID<ch>:<GNSS>:SIGNal
<subsystem>:SVID<ch>:BEIDou:SIGNal <Signal>
<subsystem>:SVID<ch>:GALileo:SIGNal <Signal>
<subsystem>:SVID<ch>:GLONass:SIGNal <Signal>
<subsystem>:SVID<ch>:GPS:SIGNal <Signal>

Sets the type of signal a SV ID will use in the moment the corresponding satellite
becomes visible.

Parameters:
<Signal> CACode | PCODe | CAPQ | CAPI | E1Def | RCA | B1CA

GPS signals: CACode|PCODe|CAPQ|CAPI
Galileo signals: E1Def
GLONASS signals: RCA
BeiDou signals: B1CA
*RST: CACode

Options: R&S SMBV-K93

<subsystem>:SVID<ch>:<GNSS>:POWer
<subsystem>:SVID<ch>:BEIDou:POWer <Power>
<subsystem>:SVID<ch>:GALileo:POWer <Power>
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<subsystem>:SVID<ch>:GLONass:POWer <Power>
<subsystem>:SVID<ch>:GPS:POWer <Power>

Sets the power a SV ID will use the moment the corresponding satellite becomes visi-
ble and is simulated.

Parameters:
<Power> float

Range: -21  to  0
Increment: 0.01
*RST: 0

Options: R&S SMBV-K93

4.14 Power Tuning and Power Settings

Example: Configuring the power settings
The following example uses GPS entry standard and specifies a reference satellite.

SOURce1:BB:GPS:PRESet
SOURce1:BB:GPS:SMODe USER
SOURce1:BB:GPS:HYBRid:GALileo:STATe ON
SOURce1:BB:GPS:SATellite:COUNt 8
SOURce1:BB:GPS:GOConstellation
SOURce1:BB:GPS:SATellite2:STANdard?
//Response: GALileo
SOURce1:BB:GPS:SATellite2:SVID?
//Response: 23
SOURce1:BB:GPS:SVID23:GALileo:MPATh:TAP:COUNt 2
SOURce1:BB:GPS:SVID23:GALileo:MPATh:TAP1:POWer -3
SOURce1:BB:GPS:SVID23:GALileo:MPATh:TAP2:POWer -5
SOURce1:BB:GPS:SVID23:GALileo:MPATh:STATe ON
SOURce1:BB:GPS:SATellite2:STATe ON
SOURce1:BB:GPS:POWer:MODE AUTO
SOURce1:BB:GPS:POWer:REFerence:SAT 1
SOURce1:BB:GPS:POWer:REFerence:STANdard?
//Response: GPS
SOURce1:BB:GPS:POWer:REFerence:SIGNal?
//Response: CACode
SOURce1:BB:GPS:POWer:REFerence:DIStance?
//Response: 20720
SOURce1:BB:GPS:POWer:REFerence:POWer -115
SOURce1:BB:GPS:POWer:INTer:PZERo
SOURce1:BB:GPS:STATe ON
SOURce1:BB:GPS:SATellite2:POWer?

SOURce1:BB:GPS:POWer:INTer:PSTandard
SOURce1:BB:GPS:POWer:INTer:CAE1Def?
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//Response: -1.25
SOURce1:BB:GPS:SATellite2:POWer?

SOURce1:BB:GPS:POWer -110
SOURce1:BB:GPS:POWer:TOTal?

<subsystem>:POWer:MODE...........................................................................................222
<subsystem>:POWer:REFerence[:POWer].......................................................................222
<subsystem>:POWer:REFerence:SATellite...................................................................... 223
<subsystem>:POWer:REFerence:STANdard.................................................................... 223
<subsystem>:POWer:REFerence:SIGNal?....................................................................... 223
<subsystem>:POWer:REFerence:DISTance?................................................................... 224
<subsystem>:SATellite<st>:POWer................................................................................. 224
<subsystem>:SATellite<st>:POWer:RSIGnal?.................................................................. 224
<subsystem>:POWer:TOTal?..........................................................................................225
<subsystem>:POWer:INTer:PZERo................................................................................. 225
<subsystem>:POWer:INTer:PSTandard........................................................................... 225
<subsystem>:POWer:INTer:CABCAGeo.......................................................................... 225
<subsystem>:POWer:INTer:CABCAIgso.......................................................................... 225
<subsystem>:POWer:INTer:CABCAMeo.......................................................................... 225
<subsystem>:POWer:INTer:CAE1Def.............................................................................. 225
<subsystem>:POWer:INTer:CARCA................................................................................ 225
<subsystem>:POWer:INTRa:GPS:PZERo........................................................................ 226
<subsystem>:POWer:INTRa:GPS:PSTandard.................................................................. 226
<subsystem>:POWer:INTRa:GPS:CAP............................................................................226

<subsystem>:POWer:MODE <Mode>

Determines whether the power is calculated automatically or is based on user defined
settings.

Parameters:
<Mode> USER | AUTO

USER
Manual power configuration per satellite
AUTO
Automatic power calculation, based on the satellite-to-receiver
distance and relative to the relative power of the reference satel-
lite (<subsystem>: POWer:REFerence: SATellite ).
*RST: USER

Example: See example "Configuring the power settings " on page 221.

Manual operation: See "Power Mode" on page 98

<subsystem>:POWer:REFerence[:POWer] <ReferencePower>

Sets the power level that is used as a reference for the calculation of the power level of
the satellites.
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Parameters:
<ReferencePower> float

Range: -145  to  20
Increment: 0.01
*RST: -30
Default unit: dBm

Example: See example "Configuring the power settings " on page 221.

Manual operation: See "Reference Power" on page 99

<subsystem>:POWer:REFerence:SATellite <Sat>

Sets the satellite used as a reference for the calculation of the power levels of the sat-
ellites in auto power mode.

Value -1 corresponds to N.A.

Parameters:
<Sat> integer

Range: 1  to  24
Increment: 1
*RST: 1

Example: See example "Configuring the power settings " on page 221.

Manual operation: See "Reference Satellite" on page 99

<subsystem>:POWer:REFerence:STANdard <Standard>

Queries/sets the reference standard.

Parameters:
<Standard> GPS | GALileo | GLONass | BEIDou

*RST: GPS

Example: See example "Configuring the power settings " on page 221.

Manual operation: See "Reference Standard" on page 100

<subsystem>:POWer:REFerence:SIGNal?

Queries the signal component of the current reference satellite used as reference for
the power calculation.

Return values: 
<SignalType> CACode | PCODe | CAPQ | CAPI | E1Def | RCA | B1CA

*RST: CACode

Example: See example "Configuring the power settings " on page 221.

Usage: Query only
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Manual operation: See "Reference Signal/ Reference Orbital Distance"
on page 100

<subsystem>:POWer:REFerence:DISTance?

Queries the pseudorange of the reference satellite at the beginning of the simulation
(t=t0).

Return values: 
<Distance> float

Range: 0  to  (0.2*SPEED_OF_LIGHT)
Increment: 1E3
*RST: 0

Example: See example "Configuring the power settings " on page 221.

Usage: Query only

Manual operation: See "Reference Signal/ Reference Orbital Distance"
on page 100

<subsystem>:SATellite<st>:POWer <Power>

Sets/queries the power offset of the satellite in dB. The offset determines the power
ratio of the activated satellites.

This setting command is only available for <subsystem>: SMODe USER.

See chapter 3.6.1, "Power Configuration", on page 92 for information about the power
calculation.

Parameters:
<Power> float

Range: -20  to  20 dB (for the query command) / 0 dB (for
the settings command)

Increment: 0.01
*RST: 0

Example: See example "Configuring the power settings " on page 221.

Manual operation: See "Power" on page 105

<subsystem>:SATellite<st>:POWer:RSIGnal? <RefSignal>

For mixed signals like "C/A+P", queries the signal used as a reference by power calcu-
lation.

The power reference is fixed to "C/A" for mixed signals. For signals modulated only
with the P code, the power reference is "P".

Parameters:
<RefSignal> CA | P

*RST: CA
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Usage: Query only

Options: R&S SMBV-K93

Manual operation: See "Power Reference" on page 106

<subsystem>:POWer:TOTal?

Queries the total power of the GNSS signal.

Return values: 
<Power> float

Range: -145  to  30
Increment: 0.01
*RST: 0
Default unit: dBm

Example: See example "Configuring the power settings " on page 221.

Usage: Query only

Manual operation: See "Total Power" on page 100

<subsystem>:POWer:INTer:PZERo

Sets the Inter-Standard Power relations to 0 dB.

Example: See example "Configuring the power settings " on page 221.

Usage: Event

Manual operation: See "Set to 0" on page 115

<subsystem>:POWer:INTer:PSTandard

Sets the power relation between the signals belonging to the different navigation stand-
ard according to the relation determined in the specifications.

Example: See example "Configuring the power settings " on page 221.

Usage: Event

Manual operation: See "Set to Standard" on page 115

<subsystem>:POWer:INTer:CABCAGeo <CaToGeo>
<subsystem>:POWer:INTer:CABCAIgso <CaToIgso>
<subsystem>:POWer:INTer:CABCAMeo <CaToBdsMeo>
<subsystem>:POWer:INTer:CAE1Def <CaToE1def>
<subsystem>:POWer:INTer:CARCA <CaToRca>

Sets the power relation between the signals belonging to the different navigation stand-
ards. The power level of the GPS signal C/A is used as reference.
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Parameters:
<CaToRca> float

Range: 0  to  6
Increment: 0.01
*RST: 3.03
Default unit: dB

<CaToE1def> float
Range: -6  to  0
Increment: 0.01
*RST: -1.5
Default unit: dB

<CaToGeo>,
<CaToIgso>,
<CaToBdsMeo>

float
Range: 0  to  6
Increment: 0.01
*RST: 4.5
Default unit: dB

Example: See example "Configuring the power settings " on page 221.

Manual operation: See "GPS C/A-GALILEO E1-DEF, GPS C/A-GLONASS R-C/A,
GPS C/A-BeiDou (GEO/MEO/IGSO) B-C/A" on page 115

<subsystem>:POWer:INTRa:GPS:PZERo

Sets the power relations between the signal components to 0 dB.

Usage: Event

Options: R&S SMBV-K93

Manual operation: See "Set to 0" on page 114

<subsystem>:POWer:INTRa:GPS:PSTandard

Sets the power relation between the signals belonging to the same navigation standard
according to the relation determined in the specifications.

Usage: Event

Options: R&S SMBV-K93

Manual operation: See "Set to Standard" on page 114

<subsystem>:POWer:INTRa:GPS:CAP <CA_P>

Sets the power relation between the signals belonging to the same navigation stand-
ard.
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Parameters:
<CA_P> float

Range: 0  to  6
Increment: 0.01
*RST: 3

Manual operation: See "C/A-P" on page 114

4.15 Navigation Message Configuration

<subsystem>:SVID<ch>:<GNSS>:NMESsage:PAGE:COUNt.............................................230
<subsystem>:SVID<ch>:BEIDou:NMESsage:PAGE:COUNt...............................................230
<subsystem>:SVID<ch>:GALileo:NMESsage:PAGE:COUNt.............................................. 230
<subsystem>:SVID<ch>:GLONass:NMESsage:PAGE:COUNt............................................230
<subsystem>:SVID<ch>:GPS:NMESsage:PAGE:COUNt................................................... 230
<subsystem>:SVID<ch>:<GNSS>:NMESsage:PRESet......................................................230
<subsystem>:SVID<ch>:BEIDou:NMESsage:PRESet........................................................230
<subsystem>:SVID<ch>:GALileo:NMESsage:PRESet....................................................... 230
<subsystem>:SVID<ch>:GLONass:NMESsage:PRESet.................................................... 230
<subsystem>:SVID<ch>:GPS:NMESsage:PRESet............................................................230
<subsystem>:SVID<ch>:<GNSS>:NMESsage:PROJect.................................................... 230
<subsystem>:SVID<ch>:BEIDou:NMESsage:PROJect...................................................... 230
<subsystem>:SVID<ch>:GALileo:NMESsage:PROJect......................................................230
<subsystem>:SVID<ch>:GLONass:NMESsage:PROJect................................................... 231
<subsystem>:SVID<ch>:GPS:NMESsage:PROJect.......................................................... 231
<subsystem>:SVID<ch>:<GNSS>:NMESsage:RTPRojection............................................. 231
<subsystem>:SVID<ch>:BEIDou:NMESsage:RTPRojection............................................... 231
<subsystem>:SVID<ch>:GALileo:NMESsage:RTPRojection...............................................231
<subsystem>:SVID<ch>:GLONass:NMESsage:RTPRojection............................................ 231
<subsystem>:SVID<ch>:GPS:NMESsage:RTPRojection................................................... 231
<subsystem>:SVID<ch>:<GNSS>:NMESsage[:PAGE<us>]:CCORection:AF<gr0>...............231
<subsystem>:SVID<ch>:BEIDou:NMESsage[:PAGE<us>]:CCORrection:AF<gr0>............... 231
<subsystem>:SVID<ch>:GPS:NMESsage[:PAGE<us>]:CCORrection:AF<gr0>....................231
<subsystem>:SVID<ch>:<GNSS>:NMESsage[:PAGE<us>]:CCORection:TGD.................... 232
<subsystem>:SVID<ch>:BEIDou:NMESsage[:PAGE<us>]:CCORrection:TGD..................... 232
<subsystem>:SVID<ch>:GPS:NMESsage[:PAGE<us>]:CCORrection:TGD......................... 232
<subsystem>:SVID<ch>:<GNSS>:NMESsage[:PAGE<us>]:CCORection:TOC.................... 232
<subsystem>:SVID<ch>:BEIDou:NMESsage[:PAGE<us>]:CCORrection:TOC..................... 232
<subsystem>:SVID<ch>:GPS:NMESsage[:PAGE<us>]:CCORrection:TOC......................... 232
<subsystem>:SVID<ch>:GPS:NMESsage[:PAGE<us>]:EPHemeris:AODO..........................233
<subsystem>:SVID<ch>:<GNSS>:NMESsage[:PAGE<us>]:EPHemeris:CIC........................233
<subsystem>:SVID<ch>:BEIDou:NMESsage[:PAGE<us>]:EPHemeris:CIC......................... 233
<subsystem>:SVID<ch>:GALileo:NMESsage[:PAGE<us>]:EPHemeris:CIC.........................233
<subsystem>:SVID<ch>:GPS:NMESsage[:PAGE<us>]:EPHemeris:CIC..............................233
<subsystem>:SVID<ch>:<GNSS>:NMESsage[:PAGE<us>]:EPHemeris:CIS........................233
<subsystem>:SVID<ch>:BEIDou:NMESsage[:PAGE<us>]:EPHemeris:CIS......................... 233
<subsystem>:SVID<ch>:GALileo:NMESsage[:PAGE<us>]:EPHemeris:CIS......................... 233
<subsystem>:SVID<ch>:GPS:NMESsage[:PAGE<us>]:EPHemeris:CIS..............................233

 

Navigation Message Configuration



Remote-Control CommandsSatellite Navigation

228Operating Manual 1173.1427.12 ─ 08

<subsystem>:SVID<ch>:GPS:NMESsage[:PAGE<us>]:EPHemeris:CLTMode..................... 233
<subsystem>:SVID<ch>:<GNSS>:NMESsage[:PAGE<us>]:EPHemeris:CRC...................... 234
<subsystem>:SVID<ch>:BEIDou:NMESsage[:PAGE<us>]:EPHemeris:CRC........................234
<subsystem>:SVID<ch>:GALileo:NMESsage[:PAGE<us>]:EPHemeris:CRC........................234
<subsystem>:SVID<ch>:GPS:NMESsage[:PAGE<us>]:EPHemeris:CRC............................ 234
<subsystem>:SVID<ch>:<GNSS>:NMESsage[:PAGE<us>]:EPHemeris:CRS...................... 234
<subsystem>:SVID<ch>:BEIDou:NMESsage[:PAGE<us>]:EPHemeris:CRS........................ 234
<subsystem>:SVID<ch>:GALileo:NMESsage[:PAGE<us>]:EPHemeris:CRS........................234
<subsystem>:SVID<ch>:GPS:NMESsage[:PAGE<us>]:EPHemeris:CRS............................ 234
<subsystem>:SVID<ch>:<GNSS>:NMESsage[:PAGE<us>]:EPHemeris:CUC...................... 234
<subsystem>:SVID<ch>:BEIDou:NMESsage[:PAGE<us>]:EPHemeris:CUC........................234
<subsystem>:SVID<ch>:GALileo:NMESsage[:PAGE<us>]:EPHemeris:CUC........................234
<subsystem>:SVID<ch>:GPS:NMESsage[:PAGE<us>]:EPHemeris:CUC............................ 234
<subsystem>:SVID<ch>:<GNSS>:NMESsage[:PAGE<us>]:EPHemeris:CUS...................... 235
<subsystem>:SVID<ch>:BEIDou:NMESsage[:PAGE<us>]:EPHemeris:CUS........................ 235
<subsystem>:SVID<ch>:GALileo:NMESsage[:PAGE<us>]:EPHemeris:CUS........................235
<subsystem>:SVID<ch>:GPS:NMESsage[:PAGE<us>]:EPHemeris:CUS............................ 235
<subsystem>:SVID<ch>:<GNSS>:NMESsage[:PAGE<us>]:EPHemeris:ECCentricity........... 235
<subsystem>:SVID<ch>:BEIDou:NMESsage[:PAGE<us>]:EPHemeris:ECCentricity.............235
<subsystem>:SVID<ch>:GALileo:NMESsage[:PAGE<us>]:EPHemeris:ECCentricity.............235
<subsystem>:SVID<ch>:GPS:NMESsage[:PAGE<us>]:EPHemeris:ECCentricity................. 235
<subsystem>:SVID<ch>:GPS:NMESsage[:PAGE<us>]:EPHemeris:FIFLag.........................235
<subsystem>:SVID<ch>:<GNSS>:NMESsage[:PAGE<us>]:EPHemeris:HEALth..................236
<subsystem>:SVID<ch>:BEIDou:NMESsage[:PAGE<us>]:EPHemeris:HEALth....................236
<subsystem>:SVID<ch>:GPS:NMESsage[:PAGE<us>]:EPHemeris:HEALth........................ 236
<subsystem>:SVID<ch>:<GNSS>:NMESsage[:PAGE<us>]:EPHemeris:IDOT..................... 236
<subsystem>:SVID<ch>:BEIDou:NMESsage[:PAGE<us>]:EPHemeris:IDOT....................... 236
<subsystem>:SVID<ch>:GALileo:NMESsage[:PAGE<us>]:EPHemeris:IDOT.......................236
<subsystem>:SVID<ch>:GPS:NMESsage[:PAGE<us>]:EPHemeris:IDOT........................... 236
<subsystem>:SVID<ch>:GALileo:NMESsage[:PAGE<us>]:EPHemeris:IODA.......................236
<subsystem>:SVID<ch>:<GNSS>:NMESsage[:PAGE<us>]:EPHemeris:IDOC..................... 236
<subsystem>:SVID<ch>:BEIDou:NMESsage[:PAGE<us>]:EPHemeris:IODC.......................236
<subsystem>:SVID<ch>:GPS:NMESsage[:PAGE<us>]:EPHemeris:IODC........................... 236
<subsystem>:SVID<ch>:<GNSS>:NMESsage[:PAGE<us>]:EPHemeris:IDOE..................... 237
<subsystem>:SVID<ch>:BEIDou:NMESsage[:PAGE<us>]:EPHemeris:IODE....................... 237
<subsystem>:SVID<ch>:GPS:NMESsage[:PAGE<us>]:EPHemeris:IODE........................... 237
<subsystem>:SVID<ch>:GALileo:NMESsage[:PAGE<us>]:EPHemeris:IODNav................... 237
<subsystem>:SVID<ch>:<GNSS>:NMESsage[:PAGE<us>]:EPHemeris:IZERo....................237
<subsystem>:SVID<ch>:BEIDou:NMESsage[:PAGE<us>]:EPHemeris:IZERo......................237
<subsystem>:SVID<ch>:GALileo:NMESsage[:PAGE<us>]:EPHemeris:IZERo..................... 237
<subsystem>:SVID<ch>:GPS:NMESsage[:PAGE<us>]:EPHemeris:IZERo.......................... 237
<subsystem>:SVID<ch>:GPS:NMESsage[:PAGE<us>]:EPHemeris:LTPData...................... 238
<subsystem>:SVID<ch>:<GNSS>:NMESsage[:PAGE<us>]:EPHemeris:MZERo.................. 238
<subsystem>:SVID<ch>:BEIDou:NMESsage[:PAGE<us>]:EPHemeris:MZERo....................238
<subsystem>:SVID<ch>:GALileo:NMESsage[:PAGE<us>]:EPHemeris:MZERo....................238
<subsystem>:SVID<ch>:GPS:NMESsage[:PAGE<us>]:EPHemeris:MZERo........................ 238
<subsystem>:SVID<ch>:<GNSS>:NMESsage[:PAGE<us>]:EPHemeris:NDELta..................238
<subsystem>:SVID<ch>:BEIDou:NMESsage[:PAGE<us>]:EPHemeris:NDELta....................238
<subsystem>:SVID<ch>:GALileo:NMESsage[:PAGE<us>]:EPHemeris:NDELta................... 238
<subsystem>:SVID<ch>:GPS:NMESsage[:PAGE<us>]:EPHemeris:NDELta........................238
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<subsystem>:SVID<ch>:<GNSS>:NMESsage[:PAGE<us>]:EPHemeris:ODOT....................238
<subsystem>:SVID<ch>:BEIDou:NMESsage[:PAGE<us>]:EPHemeris:ODOT......................238
<subsystem>:SVID<ch>:GALileo:NMESsage[:PAGE<us>]:EPHemeris:ODOT..................... 239
<subsystem>:SVID<ch>:GPS:NMESsage[:PAGE<us>]:EPHemeris:ODOT..........................239
<subsystem>:SVID<ch>:<GNSS>:NMESsage[:PAGE<us>]:EPHemeris:OMEGa................. 239
<subsystem>:SVID<ch>:BEIDou:NMESsage[:PAGE<us>]:EPHemeris:OMEGa................... 239
<subsystem>:SVID<ch>:GALileo:NMESsage[:PAGE<us>]:EPHemeris:OMEGa...................239
<subsystem>:SVID<ch>:GPS:NMESsage[:PAGE<us>]:EPHemeris:OMEGa........................239
<subsystem>:SVID<ch>:<GNSS>:NMESsage[:PAGE<us>]:EPHemeris:OZERo.................. 239
<subsystem>:SVID<ch>:BEIDou:NMESsage[:PAGE<us>]:EPHemeris:OZERo.................... 239
<subsystem>:SVID<ch>:GALileo:NMESsage[:PAGE<us>]:EPHemeris:OZERo....................239
<subsystem>:SVID<ch>:GPS:NMESsage[:PAGE<us>]:EPHemeris:OZERo........................ 239
<subsystem>:SVID<ch>:GPS:NMESsage[:PAGE<us>]:EPHemeris:SF1Reserved<gr>.........239
<subsystem>:SVID<ch>:GALileo:NMESsage[:PAGE<us>]:EPHemeris:SISA....................... 240
<subsystem>:SVID<ch>:<GNSS>:NMESsage[:PAGE<us>]:EPHemeris:SQRA....................240
<subsystem>:SVID<ch>:BEIDou:NMESsage[:PAGE<us>]:EPHemeris:SQRA......................240
<subsystem>:SVID<ch>:GALileo:NMESsage[:PAGE<us>]:EPHemeris:SQRA..................... 240
<subsystem>:SVID<ch>:GPS:NMESsage[:PAGE<us>]:EPHemeris:SQRA.......................... 240
<subsystem>:SVID<ch>:GPS:NMESsage[:PAGE<us>]:EPHemeris:SVConfig......................240
<subsystem>:SVID<ch>:<GNSS>:NMESsage[:PAGE<us>]:EPHemeris:TOE...................... 241
<subsystem>:SVID<ch>:BEIDou:NMESsage[:PAGE<us>]:EPHemeris:TOE........................ 241
<subsystem>:SVID<ch>:GALileo:NMESsage[:PAGE<us>]:EPHemeris:TOE........................241
<subsystem>:SVID<ch>:GPS:NMESsage[:PAGE<us>]:EPHemeris:TOE.............................241
<subsystem>:SVID<ch>:<GNSS>:NMESsage[:PAGE<us>]:EPHemeris:URA...................... 241
<subsystem>:SVID<ch>:BEIDou:NMESsage[:PAGE<us>]:EPHemeris:URA........................ 241
<subsystem>:SVID<ch>:GPS:NMESsage[:PAGE<us>]:EPHemeris:URA............................ 241
<subsystem>:SVID<ch>:GALileo:NMESsage[:PAGE<us>]:FNAV:AF<gr0>..........................241
<subsystem>:SVID<ch>:GALileo:NMESsage[:PAGE<us>]:FNAV:BGD............................... 241
<subsystem>:SVID<ch>:GALileo:NMESsage[:PAGE<us>]:FNAV:E5ADVS......................... 242
<subsystem>:SVID<ch>:GALileo:NMESsage[:PAGE<us>]:FNAV:E5AHS............................242
<subsystem>:SVID<ch>:GALileo:NMESsage[:PAGE<us>]:FNAV:K.................................... 242
<subsystem>:SVID<ch>:GALileo:NMESsage[:PAGE<us>]:FNAV:TOC............................... 243
<subsystem>:SVID<ch>:GALileo:NMESsage[:PAGE<us>]:INAV:AF<gr0>...........................243
<subsystem>:SVID<ch>:GALileo:NMESsage[:PAGE<us>]:INAV:BGD................................ 243
<subsystem>:SVID<ch>:GALileo:NMESsage[:PAGE<us>]:INAV:E1BDVS...........................243
<subsystem>:SVID<ch>:GALileo:NMESsage[:PAGE<us>]:INAV:E1BHS.............................244
<subsystem>:SVID<ch>:GALileo:NMESsage[:PAGE<us>]:INAV:E5BDVS...........................244
<subsystem>:SVID<ch>:GALileo:NMESsage[:PAGE<us>]:INAV:E5BHS.............................244
<subsystem>:SVID<ch>:GALileo:NMESsage[:PAGE<us>]:INAV:TOC.................................245
<subsystem>:SVID<ch>:GLONass:NMESsage[:PAGE<us>]:CCORrection:DTAU................ 245
<subsystem>:SVID<ch>:GLONass:NMESsage[:PAGE<us>]:CCORrection:EN.................... 245
<subsystem>:SVID<ch>:GLONass:NMESsage[:PAGE<us>]:CCORrection:GAMN............... 245
<subsystem>:SVID<ch>:GLONass:NMESsage[:PAGE<us>]:CCORrection:TAUN................ 246
<subsystem>:SVID<ch>:GLONass:NMESsage[:PAGE<us>]:EPHemeris:AOEP...................246
<subsystem>:SVID<ch>:GLONass:NMESsage[:PAGE<us>]:EPHemeris:HEALth.................246
<subsystem>:SVID<ch>:GLONass:NMESsage[:PAGE<us>]:EPHemeris:P..........................247
<subsystem>:SVID<ch>:GLONass:NMESsage[:PAGE<us>]:EPHemeris:SEType................ 247
<subsystem>:SVID<ch>:GLONass:NMESsage[:PAGE<us>]:EPHemeris:TALignment.......... 247
<subsystem>:SVID<ch>:GLONass:NMESsage[:PAGE<us>]:EPHemeris:TINDex.................248
<subsystem>:SVID<ch>:GLONass:NMESsage[:PAGE<us>]:EPHemeris:TINTerval?............248
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<subsystem>:SVID<ch>:GLONass:NMESsage[:PAGE<us>]:EPHemeris:TOE?................... 248
<subsystem>:SVID<ch>:GLONass:NMESsage[:PAGE<us>]:EPHemeris:URA..................... 249
<subsystem>:SVID<ch>:GLONass:NMESsage[:PAGE<us>]:EPHemeris:XN....................... 249
<subsystem>:SVID<ch>:GLONass:NMESsage[:PAGE<us>]:EPHemeris:YN....................... 249
<subsystem>:SVID<ch>:GLONass:NMESsage[:PAGE<us>]:EPHemeris:ZN........................249
<subsystem>:SVID<ch>:GLONass:NMESsage[:PAGE<us>]:EPHemeris:XDDN...................249
<subsystem>:SVID<ch>:GLONass:NMESsage[:PAGE<us>]:EPHemeris:YDDN...................249
<subsystem>:SVID<ch>:GLONass:NMESsage[:PAGE<us>]:EPHemeris:ZDDN...................249
<subsystem>:SVID<ch>:GLONass:NMESsage[:PAGE<us>]:EPHemeris:XDN..................... 250
<subsystem>:SVID<ch>:GLONass:NMESsage[:PAGE<us>]:EPHemeris:YDN..................... 250
<subsystem>:SVID<ch>:GLONass:NMESsage[:PAGE<us>]:EPHemeris:ZDN..................... 250

<subsystem>:SVID<ch>:<GNSS>:NMESsage:PAGE:COUNt
<subsystem>:SVID<ch>:BEIDou:NMESsage:PAGE:COUNt <NumberOfPages>
<subsystem>:SVID<ch>:GALileo:NMESsage:PAGE:COUNt <NumberOfPages>
<subsystem>:SVID<ch>:GLONass:NMESsage:PAGE:COUNt <NumberOfPages>
<subsystem>:SVID<ch>:GPS:NMESsage:PAGE:COUNt <NumberOfPages>

Number of navigation pages. Several navigation pages are available per satellite.

If a RINEX file is used, the value of this parameter is retrieved from the file. A RINEX
file may contain ephemeris information for up to 24 hours. Since the ephemeris are
updated every two hours, the RINEX file contains a maximum number of 12 navigation
pages.

This setting is only available for <subsystem>: SMODeUSER.

Parameters:
<NumberOfPages> float

Range: 1  to  12
Increment: 1
*RST: 1

Options: R&S SMBV-K65

<subsystem>:SVID<ch>:<GNSS>:NMESsage:PRESet
<subsystem>:SVID<ch>:BEIDou:NMESsage:PRESet
<subsystem>:SVID<ch>:GALileo:NMESsage:PRESet
<subsystem>:SVID<ch>:GLONass:NMESsage:PRESet
<subsystem>:SVID<ch>:GPS:NMESsage:PRESet
The navigation message's parameters are calculated according to the selected alma-
nac.

This setting is only available for <subsystem>: SMODeUSER.

Usage: Event

<subsystem>:SVID<ch>:<GNSS>:NMESsage:PROJect
<subsystem>:SVID<ch>:BEIDou:NMESsage:PROJect
<subsystem>:SVID<ch>:GALileo:NMESsage:PROJect
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<subsystem>:SVID<ch>:GLONass:NMESsage:PROJect
<subsystem>:SVID<ch>:GPS:NMESsage:PROJect
Triggers the projection of the parameters of the navigation message. The values of the
TOE and TOC are calculated according to the selected current simulation time (for
"System Time > UTC").

For details see "Project Navigation Message" on page 119

This setting is only available for <subsystem>: SMODe USER.

Usage: Event

<subsystem>:SVID<ch>:<GNSS>:NMESsage:RTPRojection
<subsystem>:SVID<ch>:BEIDou:NMESsage:RTPRojection <State>
<subsystem>:SVID<ch>:GALileo:NMESsage:RTPRojection <State>
<subsystem>:SVID<ch>:GLONass:NMESsage:RTPRojection <State>
<subsystem>:SVID<ch>:GPS:NMESsage:RTPRojection <State>

Enables the instrument to internally perform a projection of the navigation message
whenever this message is approaching its validity limit.

For details see "Real-Time Projection" on page 118.

This setting is only available for <subsystem>: SMODe  USER and <subsystem>: 
SATellite: GRTProjection  OFF.

Parameters:
<State> 0 | 1 | OFF | ON

*RST: 0

Options: R&S SMBV-K65

<subsystem>:SVID<ch>:<GNSS>:NMESsage[:PAGE<us>]:CCORection:AF<gr0>
<subsystem>:SVID<ch>:BEIDou:NMESsage[:PAGE<us>]:CCORrection:AF<gr0>

<Af>
<subsystem>:SVID<ch>:GPS:NMESsage[:PAGE<us>]:CCORrection:AF<gr0>

<Af>

Defines the clock correction parameters a_f2, a_f1, a_f0.

Suffix: 
<gr0>

.
0 | 1 | 2

Parameters:
<Af> integer

Value range (GPS parameters):
a_f2 = -27 to 27-1; a_f1 = -215 to 215-1; a_f0 = -221 to 221-1
Value range (BeiDou parameters):
a_f2 = -210 to 210-1; a_f1 = -221 to 221-1; a_f0 = -223 to 223-1
Increment: 1
*RST: 0
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<subsystem>:SVID<ch>:<GNSS>:NMESsage[:PAGE<us>]:CCORection:TGD
<subsystem>:SVID<ch>:BEIDou:NMESsage[:PAGE<us>]:CCORrection:TGD

<Tgd>
<subsystem>:SVID<ch>:GPS:NMESsage[:PAGE<us>]:CCORrection:TGD <Tgd>

Defines the L1-L2 correction term.

Parameters:
<Tgd> integer

GPS parameter
Range: -128  to  127
Increment: 1
*RST: 0

<Tgd> integer
BeiDou parameter
Range: -512  to  511
Increment: 1
*RST: 0

Example: SOURce1:BB:GPS:SVID1:GPS:NMESsage:PAGE1:
CCORrection:TGD 10

<subsystem>:SVID<ch>:<GNSS>:NMESsage[:PAGE<us>]:CCORection:TOC
<subsystem>:SVID<ch>:BEIDou:NMESsage[:PAGE<us>]:CCORrection:TOC

<Toc>
<subsystem>:SVID<ch>:GPS:NMESsage[:PAGE<us>]:CCORrection:TOC <Toc>

Defines the Clock Correction Parameter. As this parameter affects the satellite's orbit,
the value selected here also has an impact on the satellite's parameters "Time Shift",
"Doppler Shift" and "Duration (Elevation>2.5/5/7.5/10°)" (see <subsystem>: 
SATellite<st>: TSHift  on page 219, <subsystem>: SATellite<st>: DSHift 
on page 215, <subsystem>: SATellite<st>: DURation?  on page 215).

This setting is only available for <subsystem>: SMODeUSER.

Parameters:
<Toc> integer

GPS parameter
Range: 0  to  65535
Increment: 1
*RST: 0

<Toc> integer
BeiDou parameter
Range: 0  to  131071
Increment: 1
*RST: 0

Options: R&S SMBV-K65
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<subsystem>:SVID<ch>:GPS:NMESsage[:PAGE<us>]:EPHemeris:AODO <Aodo>

Age of Data Offset

Parameters:
<Aodo> integer

Range: 0  to  31
Increment: 1
*RST: 0

Manual operation: See "GPS Ephemeris Parameters" on page 121

<subsystem>:SVID<ch>:<GNSS>:NMESsage[:PAGE<us>]:EPHemeris:CIC
<subsystem>:SVID<ch>:BEIDou:NMESsage[:PAGE<us>]:EPHemeris:CIC <Cic>
<subsystem>:SVID<ch>:GALileo:NMESsage[:PAGE<us>]:EPHemeris:CIC <Cic>
<subsystem>:SVID<ch>:GPS:NMESsage[:PAGE<us>]:EPHemeris:CIC <Cic>

Amplitude of the Cosine Harmonic Correction Term to the Angle of Inclination

Parameters:
<Cic> integer

Range: -32768  to  32767
Increment: 1
*RST: 0

<subsystem>:SVID<ch>:<GNSS>:NMESsage[:PAGE<us>]:EPHemeris:CIS
<subsystem>:SVID<ch>:BEIDou:NMESsage[:PAGE<us>]:EPHemeris:CIS <Cis>
<subsystem>:SVID<ch>:GALileo:NMESsage[:PAGE<us>]:EPHemeris:CIS <Cis>
<subsystem>:SVID<ch>:GPS:NMESsage[:PAGE<us>]:EPHemeris:CIS <Cis>

Amplitude of the Sine Harmonic Correction Term to the Angle of Inclination

Parameters:
<Cis> integer

Range: -32768  to  32767
Increment: 1
*RST: 0

<subsystem>:SVID<ch>:GPS:NMESsage[:PAGE<us>]:EPHemeris:CLTMode
<CltMode>

Type of code for L2; This value does not have any impact on the actual used ranging
code of the generated satellite.
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Parameters:
<CltMode> REServed | PCODe | CACode

REServed
Reserved for future use.
PCODe
Carrier L2 (f_L2= 1.2276 GHz) is modulated by P-code (BPSK).
CACode
Carrier L2 (f_L2= 1.2276 GHz) is modulated by C/A-code
(BPSK).
*RST: PCODe

Manual operation: See "GPS Ephemeris Parameters" on page 121

<subsystem>:SVID<ch>:<GNSS>:NMESsage[:PAGE<us>]:EPHemeris:CRC
<subsystem>:SVID<ch>:BEIDou:NMESsage[:PAGE<us>]:EPHemeris:CRC <Crc>
<subsystem>:SVID<ch>:GALileo:NMESsage[:PAGE<us>]:EPHemeris:CRC <Crc>
<subsystem>:SVID<ch>:GPS:NMESsage[:PAGE<us>]:EPHemeris:CRC <Crc>

Amplitude of the Cosine Harmonic Correction Term to the Orbit Radius

Parameters:
<Crc> integer

Range: -32768  to  32767
Increment: 1
*RST: 0

<subsystem>:SVID<ch>:<GNSS>:NMESsage[:PAGE<us>]:EPHemeris:CRS
<subsystem>:SVID<ch>:BEIDou:NMESsage[:PAGE<us>]:EPHemeris:CRS <Crs>
<subsystem>:SVID<ch>:GALileo:NMESsage[:PAGE<us>]:EPHemeris:CRS <Crs>
<subsystem>:SVID<ch>:GPS:NMESsage[:PAGE<us>]:EPHemeris:CRS <Crs>

Amplitude of the Sine Harmonic Correction Term to the Orbit Radius

Parameters:
<Crs> integer

Range: -32768  to  32767
Increment: 1
*RST: 0

<subsystem>:SVID<ch>:<GNSS>:NMESsage[:PAGE<us>]:EPHemeris:CUC
<subsystem>:SVID<ch>:BEIDou:NMESsage[:PAGE<us>]:EPHemeris:CUC <Cuc>
<subsystem>:SVID<ch>:GALileo:NMESsage[:PAGE<us>]:EPHemeris:CUC

<Cuc>
<subsystem>:SVID<ch>:GPS:NMESsage[:PAGE<us>]:EPHemeris:CUC <Cuc>

Amplitude of the Cosine Harmonic Correction Term to the Argument of Latitude
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Parameters:
<Cuc> integer

Range: -32768  to  32767
Increment: 1
*RST: 0

<subsystem>:SVID<ch>:<GNSS>:NMESsage[:PAGE<us>]:EPHemeris:CUS
<subsystem>:SVID<ch>:BEIDou:NMESsage[:PAGE<us>]:EPHemeris:CUS <Cus>
<subsystem>:SVID<ch>:GALileo:NMESsage[:PAGE<us>]:EPHemeris:CUS <Cus>
<subsystem>:SVID<ch>:GPS:NMESsage[:PAGE<us>]:EPHemeris:CUS <Cus>

Amplitude of the Sine Harmonic Correction Term to the Argument of Latitude

Parameters:
<Cus> integer

Range: -32768  to  32767
Increment: 1
*RST: 0

<subsystem>:SVID<ch>:<GNSS>:NMESsage[:PAGE<us>]:EPHemeris:
ECCentricity

<subsystem>:SVID<ch>:BEIDou:NMESsage[:PAGE<us>]:EPHemeris:
ECCentricity <Eccentricity>

<subsystem>:SVID<ch>:GALileo:NMESsage[:PAGE<us>]:EPHemeris:
ECCentricity <Eccentricity>

<subsystem>:SVID<ch>:GPS:NMESsage[:PAGE<us>]:EPHemeris:ECCentricity
<Eccentricity>

Eccentricity

Parameters:
<Eccentricity> integer

Range: 0  to  4294967295
Increment: 1
*RST: 0

<subsystem>:SVID<ch>:GPS:NMESsage[:PAGE<us>]:EPHemeris:FIFLag
<FiFlag>

Indicates the curve-fit interval used by the CS (Control Segment) in determining the
ephemeris parameters

Parameters:
<FiFlag> 0 | 1 | OFF | ON

*RST: 0

Manual operation: See "GPS Ephemeris Parameters" on page 121
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<subsystem>:SVID<ch>:<GNSS>:NMESsage[:PAGE<us>]:EPHemeris:HEALth
<subsystem>:SVID<ch>:BEIDou:NMESsage[:PAGE<us>]:EPHemeris:HEALth

<Health>
<subsystem>:SVID<ch>:GPS:NMESsage[:PAGE<us>]:EPHemeris:HEALth

<Health>

This value does not have an impact on the actual health status of the generated satel-
lite.

Parameters:
<Health> integer

Range: 0  to  31 (for GPS), 1 (for BeiDou)
Increment: 1
*RST: 0

<subsystem>:SVID<ch>:<GNSS>:NMESsage[:PAGE<us>]:EPHemeris:IDOT
<subsystem>:SVID<ch>:BEIDou:NMESsage[:PAGE<us>]:EPHemeris:IDOT <Idot>
<subsystem>:SVID<ch>:GALileo:NMESsage[:PAGE<us>]:EPHemeris:IDOT

<Idot>
<subsystem>:SVID<ch>:GPS:NMESsage[:PAGE<us>]:EPHemeris:IDOT <Idot>

Rate of Inclination Angle

Parameters:
<Idot> integer

Range: -8192  to  8191
Increment: 1
*RST: 0

<subsystem>:SVID<ch>:GALileo:NMESsage[:PAGE<us>]:EPHemeris:IODA
<Ioda>

Issue Of Data (Almanacs)

Parameters:
<Ioda> integer

Range: 0  to  15
Increment: 1
*RST: 0

Manual operation: See "Galileo Ephemeris Parameters" on page 122

<subsystem>:SVID<ch>:<GNSS>:NMESsage[:PAGE<us>]:EPHemeris:IDOC
<subsystem>:SVID<ch>:BEIDou:NMESsage[:PAGE<us>]:EPHemeris:IODC

<Iodc>
<subsystem>:SVID<ch>:GPS:NMESsage[:PAGE<us>]:EPHemeris:IODC <Iodc>

Issue of Data, Clock
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Parameters:
<Iodc> integer

Range: 0  to  1023 (for GPS), 31 (for BeiDou)
Increment: 1
*RST: 0

<subsystem>:SVID<ch>:<GNSS>:NMESsage[:PAGE<us>]:EPHemeris:IDOE
<subsystem>:SVID<ch>:BEIDou:NMESsage[:PAGE<us>]:EPHemeris:IODE

<Iode>
<subsystem>:SVID<ch>:GPS:NMESsage[:PAGE<us>]:EPHemeris:IODE <Iode>

Issue of Data, Ephemeris

Parameters:
<Iode> integer

Range: 0  to  255 (for GPS), 31 (for BeiDou)
Increment: 1
*RST: 0

<subsystem>:SVID<ch>:GALileo:NMESsage[:PAGE<us>]:EPHemeris:IODNav
<Iodnav>

Issue Of Data (Ephemeris and Clock correction)

Parameters:
<Iodnav> integer

Range: 0  to  1023
Increment: 1
*RST: 0

Manual operation: See "Galileo Ephemeris Parameters" on page 122

<subsystem>:SVID<ch>:<GNSS>:NMESsage[:PAGE<us>]:EPHemeris:IZERo
<subsystem>:SVID<ch>:BEIDou:NMESsage[:PAGE<us>]:EPHemeris:IZERo

<Izero>
<subsystem>:SVID<ch>:GALileo:NMESsage[:PAGE<us>]:EPHemeris:IZERo

<Izero>
<subsystem>:SVID<ch>:GPS:NMESsage[:PAGE<us>]:EPHemeris:IZERo <Izero>

Inclination Angle at Reference Time

Parameters:
<Izero> integer

Range: -2147483648  to  2147483647
Increment: 1
*RST: 0
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<subsystem>:SVID<ch>:GPS:NMESsage[:PAGE<us>]:EPHemeris:LTPData
<LtpData>

Use of carrier L2 P data flag

This value does not have an impact on whether data is really transmitted on the satel-
lite's carrier L2 or not.

Parameters:
<LtpData> 0 | 1 | OFF | ON

*RST: 0

Manual operation: See "GPS Ephemeris Parameters" on page 121

<subsystem>:SVID<ch>:<GNSS>:NMESsage[:PAGE<us>]:EPHemeris:MZERo
<subsystem>:SVID<ch>:BEIDou:NMESsage[:PAGE<us>]:EPHemeris:MZERo

<MZero>
<subsystem>:SVID<ch>:GALileo:NMESsage[:PAGE<us>]:EPHemeris:MZERo

<MZero>
<subsystem>:SVID<ch>:GPS:NMESsage[:PAGE<us>]:EPHemeris:MZERo

<MZero>

Mean Anomaly at Reference Time

Parameters:
<MZero> integer

Range: -2147483648  to  2147483647
Increment: 1
*RST: 0

<subsystem>:SVID<ch>:<GNSS>:NMESsage[:PAGE<us>]:EPHemeris:NDELta
<subsystem>:SVID<ch>:BEIDou:NMESsage[:PAGE<us>]:EPHemeris:NDELta

<NDelta>
<subsystem>:SVID<ch>:GALileo:NMESsage[:PAGE<us>]:EPHemeris:NDELta

<NDelta>
<subsystem>:SVID<ch>:GPS:NMESsage[:PAGE<us>]:EPHemeris:NDELta

<NDelta>

Mean Motion Difference From Computed Value

Parameters:
<NDelta> integer

Range: -32768  to  32767
Increment: 1
*RST: 0

<subsystem>:SVID<ch>:<GNSS>:NMESsage[:PAGE<us>]:EPHemeris:ODOT
<subsystem>:SVID<ch>:BEIDou:NMESsage[:PAGE<us>]:EPHemeris:ODOT

<ODot>
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<subsystem>:SVID<ch>:GALileo:NMESsage[:PAGE<us>]:EPHemeris:ODOT
<ODot>

<subsystem>:SVID<ch>:GPS:NMESsage[:PAGE<us>]:EPHemeris:ODOT <ODot>

Rate of Right Ascension

Parameters:
<ODot> integer

Range: -8388608  to  8388607
Increment: 1
*RST: 0

<subsystem>:SVID<ch>:<GNSS>:NMESsage[:PAGE<us>]:EPHemeris:OMEGa
<subsystem>:SVID<ch>:BEIDou:NMESsage[:PAGE<us>]:EPHemeris:OMEGa

<Omega>
<subsystem>:SVID<ch>:GALileo:NMESsage[:PAGE<us>]:EPHemeris:OMEGa

<Omega>
<subsystem>:SVID<ch>:GPS:NMESsage[:PAGE<us>]:EPHemeris:OMEGa

<Omega>

Argument of Perigee

Parameters:
<Omega> integer

Range: -2147483648  to  2147483647
Increment: 1
*RST: 0

<subsystem>:SVID<ch>:<GNSS>:NMESsage[:PAGE<us>]:EPHemeris:OZERo
<subsystem>:SVID<ch>:BEIDou:NMESsage[:PAGE<us>]:EPHemeris:OZERo

<OZero>
<subsystem>:SVID<ch>:GALileo:NMESsage[:PAGE<us>]:EPHemeris:OZERo

<OZero>
<subsystem>:SVID<ch>:GPS:NMESsage[:PAGE<us>]:EPHemeris:OZERo

<OZero>

Longitude of Ascending Node of Orbit Plane at Weekly Epoch

Parameters:
<OZero> integer

Range: -2147483648  to  2147483647
Increment: 1
*RST: 0

<subsystem>:SVID<ch>:GPS:NMESsage[:PAGE<us>]:EPHemeris:
SF1Reserved<gr> <Reserved>

SF1 Reserved 1/2/3/4

Suffix: 
<gr>

.
1|2|3|4
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Parameters:
<Reserved> integer

Range: 0  to  67108864
Increment: 1
*RST: 0

Manual operation: See "GPS Ephemeris Parameters" on page 121

<subsystem>:SVID<ch>:GALileo:NMESsage[:PAGE<us>]:EPHemeris:SISA
<Sisa>

Signal In Space Accuracy

Parameters:
<Sisa> integer

Range: 0  to  255
Increment: 1
*RST: 0

Manual operation: See "Galileo Ephemeris Parameters" on page 122

<subsystem>:SVID<ch>:<GNSS>:NMESsage[:PAGE<us>]:EPHemeris:SQRA
<subsystem>:SVID<ch>:BEIDou:NMESsage[:PAGE<us>]:EPHemeris:SQRA

<SqrA>
<subsystem>:SVID<ch>:GALileo:NMESsage[:PAGE<us>]:EPHemeris:SQRA

<SqrA>
<subsystem>:SVID<ch>:GPS:NMESsage[:PAGE<us>]:EPHemeris:SQRA <SqrA>

Square Root of the Semi-Major Axis

Parameters:
<SqrA> integer

Range: 100000  to  4294967295
Increment: 1
*RST: 100000

<subsystem>:SVID<ch>:GPS:NMESsage[:PAGE<us>]:EPHemeris:SVConfig
<SvConfig>

SV Configurations

Parameters:
<SvConfig> integer

Range: 0  to  15
Increment: 1
*RST: 0

Manual operation: See "GPS Ephemeris Parameters" on page 121
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<subsystem>:SVID<ch>:<GNSS>:NMESsage[:PAGE<us>]:EPHemeris:TOE
<subsystem>:SVID<ch>:BEIDou:NMESsage[:PAGE<us>]:EPHemeris:TOE <ToE>
<subsystem>:SVID<ch>:GALileo:NMESsage[:PAGE<us>]:EPHemeris:TOE <ToE>
<subsystem>:SVID<ch>:GPS:NMESsage[:PAGE<us>]:EPHemeris:TOE <ToE>

Time Of Ephemeris

Parameters:
<ToE> integer

Range: 0  to  65535
Increment: 1
*RST: 0

<subsystem>:SVID<ch>:<GNSS>:NMESsage[:PAGE<us>]:EPHemeris:URA
<subsystem>:SVID<ch>:BEIDou:NMESsage[:PAGE<us>]:EPHemeris:URA <Ura>
<subsystem>:SVID<ch>:GPS:NMESsage[:PAGE<us>]:EPHemeris:URA <Ura>

SV accuracy / URA Index

Parameters:
<Ura> integer

Range: 0  to  15
Increment: 1
*RST: 0

<subsystem>:SVID<ch>:GALileo:NMESsage[:PAGE<us>]:FNAV:AF<gr0> <Af>

Defines the SV clock drift rate correction coefficients af0, af1, af2(E1,E5a) of the freely
accessible navigation message F/NAV, provided by the E5a signal for Open Service.

Suffix: 
<gr0>

.
0 | 1 | 2

Parameters:
<Af> integer

Value range:
af2 = -2^5 ... 2^5-1
af1 = -2^20 ... 2^20-1
af0 = -2^30 ... 2^30-1
Increment: 1
*RST: 0

Manual operation: See "Galileo FNAV Parameters" on page 127

<subsystem>:SVID<ch>:GALileo:NMESsage[:PAGE<us>]:FNAV:BGD <B_GD>

Defines the E1-E5a Broadcast Group Delay parameters "BGD(E1,E5a)" of the freely
accessible navigation message F/NAV, provided by the E5a signal for Open Service.
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Parameters:
<B_GD> integer

Range: -512  to  511
Increment: 1
*RST: 0

Manual operation: See "Galileo FNAV Parameters" on page 127

<subsystem>:SVID<ch>:GALileo:NMESsage[:PAGE<us>]:FNAV:E5ADVS <Dvs>

Defines the Data Validity Satellite Status, transmitted on E5a (E5aDVS) of the freely
accessible navigation message F/NAV.

Parameters:
<Dvs> integer

Range: 0  to  1
Increment: 1
*RST: 0

Manual operation: See "Galileo FNAV Parameters" on page 127

<subsystem>:SVID<ch>:GALileo:NMESsage[:PAGE<us>]:FNAV:E5AHS <Hs>

Defines the Signal Health Status for E5a (E5aHS) of the freely accessible navigation
message F/NAV, provided by the E5a signal for Open Service.

Parameters:
<Hs> integer

Range: 0  to  3
Increment: 1
*RST: 0

Manual operation: See "Galileo FNAV Parameters" on page 127

<subsystem>:SVID<ch>:GALileo:NMESsage[:PAGE<us>]:FNAV:K <K>

Defines the F-NAV Almanac Scheduling start index of the freely accessible navigation
message F/NAV, provided by the E5a signal for Open Service.

Parameters:
<K> integer

Range: 0  to  3
Increment: 1
*RST: 0

Manual operation: See "Galileo FNAV Parameters" on page 127
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<subsystem>:SVID<ch>:GALileo:NMESsage[:PAGE<us>]:FNAV:TOC <Toc>

Defines the Clock correction data reference Time of Week "toC(E1,E5a)" of the freely
accessible navigation message F/NAV, provided by the E5a signal for Open Service.

Parameters:
<Toc> integer

Range: 0  to  16383
Increment: 1
*RST: 0

Manual operation: See "Galileo FNAV Parameters" on page 127

<subsystem>:SVID<ch>:GALileo:NMESsage[:PAGE<us>]:INAV:AF<gr0> <Af>

Defines the SV clock drift rate correction coefficients af0, af1, af2(E1,E5b) of the Integrity
navigation message INAV.

Suffix: 
<gr0>

.
0 | 1 | 2

Parameters:
<Af> integer

Value range:
af2 = -2^5 ... 2^5-1
af1 = -2^20 ... 2^20-1
af0 = -2^30 ... 2^30-1
Increment: 1
*RST: 0

Manual operation: See "Galileo INAV Parameters" on page 126

<subsystem>:SVID<ch>:GALileo:NMESsage[:PAGE<us>]:INAV:BGD <B_GD>

Defines the E1-E5b Broadcast Group Delay "BGD (E1,E5b)" parameter of the Integrity
navigation message INAV.

Parameters:
<B_GD> integer

Range: -512  to  511
Increment: 1
*RST: 0

Manual operation: See "Galileo INAV Parameters" on page 126

<subsystem>:SVID<ch>:GALileo:NMESsage[:PAGE<us>]:INAV:E1BDVS <Dvs>

Defines the Data Validity Satellite Status, transmitted on E1-B ("E1-BDVS") of the Integ-
rity navigation message I/NAV provided by E5b and E1-B signals.
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Parameters:
<Dvs> integer

Range: 0  to  1
Increment: 1
*RST: 0

Manual operation: See "Galileo INAV Parameters" on page 126

<subsystem>:SVID<ch>:GALileo:NMESsage[:PAGE<us>]:INAV:E1BHS <HS>

Defines the Signal Health Status for E1 ("E1-BHS") of the Integrity navigation message
I/NAV provided by E5b and E1-B signals.

Parameters:
<HS> integer

Range: 0  to  3
Increment: 1
*RST: 0

Manual operation: See "Galileo INAV Parameters" on page 126

<subsystem>:SVID<ch>:GALileo:NMESsage[:PAGE<us>]:INAV:E5BDVS <Dvs>

Defines the Data Validity Satellite Status, transmitted on E5b ("E5bDVS") of the Integrity
navigation message I/NAV.

Parameters:
<Dvs> integer

Range: 0  to  1
Increment: 1
*RST: 0

Manual operation: See "Galileo INAV Parameters" on page 126

<subsystem>:SVID<ch>:GALileo:NMESsage[:PAGE<us>]:INAV:E5BHS <Hs>

Defines the Signal Health Status for E5b ("E5bHS") of the Integrity navigation message
I/NAV provided by E5b and E1-B signals.

Parameters:
<Hs> integer

Range: 0  to  3
Increment: 1
*RST: 0

Manual operation: See "Galileo INAV Parameters" on page 126
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<subsystem>:SVID<ch>:GALileo:NMESsage[:PAGE<us>]:INAV:TOC <Toc>

Defines the Clock correction data reference Time of Week "toC(E1,E5b)" parameter of
the Integrity navigation message INAV.

Parameters:
<Toc> integer

Range: 0  to  16383
Increment: 1
*RST: 0

Manual operation: See "Galileo INAV Parameters" on page 126

<subsystem>:SVID<ch>:GLONass:NMESsage[:PAGE<us>]:CCORrection:DTAU
<Delta_TAU_n>

Defines the time difference between navigation RF signal transmitted in L2 and naviga-
tion RF signal transmitted in L1 band.

Parameters:
<Delta_TAU_n> integer

Range: -16  to  15
Increment: 1
*RST: 0

Manual operation: See "GLONASS Clock Correction Parameters" on page 126

<subsystem>:SVID<ch>:GLONass:NMESsage[:PAGE<us>]:CCORrection:EN
<E_n>

Sets the age of operation information.

Parameters:
<E_n> integer

Range: 0  to  31
Increment: 1
*RST: 0

Manual operation: See "GLONASS Clock Correction Parameters" on page 126

<subsystem>:SVID<ch>:GLONass:NMESsage[:PAGE<us>]:CCORrection:GAMN
<GAMMA_n>

Defines the SV Clock drift correction coefficient.

Parameters:
<GAMMA_n> integer

Range: -1024  to  1023
Increment: 1
*RST: 0
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Manual operation: See "GLONASS Clock Correction Parameters" on page 126

<subsystem>:SVID<ch>:GLONass:NMESsage[:PAGE<us>]:CCORrection:TAUN
<TAU_n>

Defines the SV Clock bias correction coefficient.

Parameters:
<TAU_n> integer

Range: -2097152  to  2097151
Increment: 1
*RST: 0

Manual operation: See "GLONASS Clock Correction Parameters" on page 126

<subsystem>:SVID<ch>:GLONass:NMESsage[:PAGE<us>]:EPHemeris:AOEP
<AgeOfEph>

Sets the time interval between 2 adjacent values of TOE. It defines hence the age of
the current GLONASS Ephemeris page.

Parameters:
<AgeOfEph> A30M | A45M | A60M

A30M
age of Ephemeris = 30 min
A45M
age of Ephemeris = 45 min
A60M
age of Ephemeris = 60 min
*RST: A30M

Manual operation: See "GLONASS Ephemeris Parameters" on page 123

<subsystem>:SVID<ch>:GLONass:NMESsage[:PAGE<us>]:EPHemeris:HEALth
<Health>

A health value. The user navigation equipment analyzes only the MSB of this word.

Parameters:
<Health> integer

B_n[3] = 1_n = 1
Satellite is not healthy
B_n[3] = 1_n = 0
Satellite is healthy
Range: 0  to  7
Increment: 1
*RST: 0

Manual operation: See "GLONASS Ephemeris Parameters" on page 123
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<subsystem>:SVID<ch>:GLONass:NMESsage[:PAGE<us>]:EPHemeris:P <P>

Reliability measure of system time conversion parameters.

Parameters:
<P> integer

00
TAU_C and TAU_GPS relayed from control segment.
01
TAU_C from control segment; TAU_GPS calculated on board
GLONASS-M satellite.
10
TAU_C on board Glonass-M satellite and TAU_GPS relayed
from CS.
11
TAU_C and TAU_GPS calculated on board Glonass-M satel-
lites.
Range: 0  to  3
Increment: 1
*RST: 0

Manual operation: See "GLONASS Ephemeris Parameters" on page 123

<subsystem>:SVID<ch>:GLONass:NMESsage[:PAGE<us>]:EPHemeris:SEType
<Type>

Selects the satellite ephemeris type.

Parameters:
<Type> GLO | GLOM

*RST: GLOM

Manual operation: See "GLONASS Ephemeris Parameters" on page 123

<subsystem>:SVID<ch>:GLONass:NMESsage[:PAGE<us>]:EPHemeris:
TALignment <TbAlign>

Sets TOE to be aligned to an even or odd scale of 15 min for Age of Ephemeris = 30 or
60 min.

The parameters Tb-Interval (<subsystem>: SVID<ch>: GLONass: NMESsage[: 
PAGE<us>]: EPHemeris: TINTerval? ) and TOE (<subsystem>: SVID<ch>: 
GLONass: NMESsage[: PAGE<us>]: EPHemeris: TOE?) depend on this value.

Note: All Ephemeris pages of an SVID have the same Tb alignment (P2).

Parameters:
<TbAlign> EVEN | ODD

*RST: ODD

Example: SUR:BB:GLON:SVID:GLON:NMES:EPH:TAL EVEN
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Manual operation: See "GLONASS Ephemeris Parameters" on page 123

<subsystem>:SVID<ch>:GLONass:NMESsage[:PAGE<us>]:EPHemeris:TINDex
<TbIndex>

Defines the index of the Tb-time interval.

To define the duration of the Tb-time interval, use the command <subsystem>: 
SVID<ch>: GLONass:NMESsage[: PAGE<us>]: EPHemeris: AOEP .

Parameters:
<TbIndex> integer

Range: 1  to  95
Increment: 1
*RST: 1

Manual operation: See "GLONASS Ephemeris Parameters" on page 123

<subsystem>:SVID<ch>:GLONass:NMESsage[:PAGE<us>]:EPHemeris:
TINTerval?

Queries the Tb-Interval in the current day where the Ephemeris set page is valid.

Return values: 
<TbInterval> string

Example: SUR:BB:GLON:SVID:GLON:NMES:EPH:TIND 0
set Tb_index to 0.
SOUR:BB:GLON:SVID:GLON:NMES:EPH:AOEP 30
set age of Ephemeris to 30 min.
SOUR:BB:GLON:SVID:GLON:NMES:EPH:TINT?
Response: Tb-Interval is the interval between 00:00:00 and
00:30:00 in the current day.

Usage: Query only

Manual operation: See "GLONASS Ephemeris Parameters" on page 123

<subsystem>:SVID<ch>:GLONass:NMESsage[:PAGE<us>]:EPHemeris:TOE?

Queries the time of Ephemeris in the current day.

Return values: 
<Hour> integer

Range: 0  to  23
Increment: 1

<Minute> integer
Range: 0  to  59
Increment: 1
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<Second> float
Range: 0  to  59
Increment: 1

Usage: Query only

Manual operation: See "GLONASS Ephemeris Parameters" on page 123

<subsystem>:SVID<ch>:GLONass:NMESsage[:PAGE<us>]:EPHemeris:URA
<SvAcc>

Provides the predicted satellite user range accuracy (URA).

Parameters:
<SvAcc> integer

Range: 0  to  15
Increment: 1
*RST: 0

Manual operation: See "GLONASS Ephemeris Parameters" on page 123

<subsystem>:SVID<ch>:GLONass:NMESsage[:PAGE<us>]:EPHemeris:XN <X_n>
<subsystem>:SVID<ch>:GLONass:NMESsage[:PAGE<us>]:EPHemeris:YN <Y_n>
<subsystem>:SVID<ch>:GLONass:NMESsage[:PAGE<us>]:EPHemeris:ZN <Z_n>

Sets the OX | OY | OZ position coordinates of the current satellite at TOE(tb), i.e. the
middle of Tb-Interval.

The coordinates correspond to the PZ-90 coordinate system.

Parameters:
<Z_n> integer

Range: -67108864  to  67108863
Increment: 1
*RST: 0

Manual operation: See "GLONASS Ephemeris Parameters" on page 123

<subsystem>:SVID<ch>:GLONass:NMESsage[:PAGE<us>]:EPHemeris:XDDN
<XDDOT_n>

<subsystem>:SVID<ch>:GLONass:NMESsage[:PAGE<us>]:EPHemeris:YDDN
<YDDOT_N>

<subsystem>:SVID<ch>:GLONass:NMESsage[:PAGE<us>]:EPHemeris:ZDDN
<ZDDOT_n>

The OZ acceleration coordinate of the current satellite due to solar and lunar gravita-
tional effects at TOE(tb), i.e. the middle of Tb-Interval.

The coordinates correspond to the PZ-90 coordinate system.
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Parameters:
<ZDDOT_n> integer

Range: -16  to  15
Increment: 1
*RST: 0

Manual operation: See "GLONASS Ephemeris Parameters" on page 123

<subsystem>:SVID<ch>:GLONass:NMESsage[:PAGE<us>]:EPHemeris:XDN
<XDOT_n>

<subsystem>:SVID<ch>:GLONass:NMESsage[:PAGE<us>]:EPHemeris:YDN
<YDOT_n>

<subsystem>:SVID<ch>:GLONass:NMESsage[:PAGE<us>]:EPHemeris:ZDN
<ZDOT_n>

Sets the OX | OY | OZ velocity coordinate of the current satellite at TOE(tb), i.e. the
middle of Tb-Interval(1).

The coordinates correspond to the PZ-90 coordinate system.

Parameters:
<ZDOT_n> integer

Range: -8388608  to  8388607
Increment: 1
*RST: 0

Manual operation: See "GLONASS Ephemeris Parameters" on page 123

4.16 Atmospheric Configuration

<subsystem>:ATMospheric:TROPospheric:MODel............................................................250
<subsystem>:ATMospheric:IONospheric:MODel............................................................... 251
<subsystem>:ATMospheric:IONospheric:KLOBuchar:ALPHa<ch0>.................................... 251
<subsystem>:ATMospheric:IONospheric:KLOBuchar:BETA<ch0>...................................... 251
<subsystem>:ATMospheric:GPS:IONospheric:ALPHa<ch0>.............................................. 251
<subsystem>:ATMospheric:GPS:IONospheric:BETA<ch0>................................................ 252
<subsystem>:ATMospheric:BEIDou:IONospheric:ALPHa<ch0>..........................................252
<subsystem>:ATMospheric:BEIDou:IONospheric:BETA<ch0>............................................252
<subsystem>:ATMospheric:GALileo:IONospheric:AI<ch0>.................................................252
<subsystem>:ATMospheric:GALileo:IONospheric:SF<ch>................................................. 253

<subsystem>:ATMospheric:TROPospheric:MODel <Model>

Determines the tropospheric model.

Parameters:
<Model> NONE | STANag

*RST: NONE

Manual operation: See "Tropospheric Model" on page 112
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<subsystem>:ATMospheric:IONospheric:MODel <Model>

Determines the applied ionospheric model.

Parameters:
<Model> NONE | KLOBuchar

*RST: NONE

Manual operation: See "Ionospheric Model" on page 112

<subsystem>:ATMospheric:IONospheric:KLOBuchar:ALPHa<ch0> <Alpha>

Sets the parameter alpha_0 .. alpha_3 of the satellite's navigation message.

Suffix: 
<ch0>

.
0 .. 3

Parameters:
<Alpha> integer

Range: -128  to  127
*RST: 0

Manual operation: See "Klobuchar Parameters" on page 112

<subsystem>:ATMospheric:IONospheric:KLOBuchar:BETA<ch0> <Beta>

Sets the parameter beta_0 .. beta_3 of the satellite's navigation message.

Suffix: 
<ch0>

.
0 .. 3

Parameters:
<Beta> integer

Range: -128  to  127
*RST: 0

Manual operation: See "Klobuchar Parameters" on page 112

<subsystem>:ATMospheric:GPS:IONospheric:ALPHa<ch0> <Alpha>

Sets the parameter alpha_0 .. alpha_3 of the satellite's navigation message.

Suffix: 
<ch0>

.
0 .. 3

Parameters:
<Alpha> float

Range: -128  to  127
Increment: 1
*RST: 0

Manual operation: See "GPS/BeiDou Ionospheric Parameters" on page 112
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<subsystem>:ATMospheric:GPS:IONospheric:BETA<ch0> <Beta>

Sets the parameter beta_0 .. beta_3 of the satellite's navigation message.

Suffix: 
<ch0>

.
0 .. 3

Parameters:
<Beta> float

Range: -128  to  127
Increment: 1
*RST: 0

Manual operation: See "GPS/BeiDou Ionospheric Parameters" on page 112

<subsystem>:ATMospheric:BEIDou:IONospheric:ALPHa<ch0> <Alpha>

Sets the parameter alpha_0 .. alpha_3 of the satellite's navigation message.

Suffix: 
<ch0>

.
0 .. 3

Parameters:
<Alpha> integer

Range: -128  to  127
*RST: 0

Manual operation: See "GPS/BeiDou Ionospheric Parameters" on page 112

<subsystem>:ATMospheric:BEIDou:IONospheric:BETA<ch0> <Beta>

Sets the parameter beta_0 .. beta_3 of the satellite's navigation message.

Suffix: 
<ch0>

.
0 .. 3

Parameters:
<Beta> integer

Range: -128  to  127
*RST: 0

Manual operation: See "GPS/BeiDou Ionospheric Parameters" on page 112

<subsystem>:ATMospheric:GALileo:IONospheric:AI<ch0> <A_i>

Sets the parameters effective Ionization level 1st .. 3rd order of the satellite's navigation
message.
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Parameters:
<A_i> float

Range: a_i0 (0..2047), a_i1 (-1024..1023), a_i2
(-8192..8191)

Increment: 1
*RST: 0

Manual operation: See "GALILEO Ionospheric Parameters" on page 113

<subsystem>:ATMospheric:GALileo:IONospheric:SF<ch> <SF>

Sets the parameters ionospheric disturbance flag for region 1 to 5 of the satellite's nav-
igation message.

Suffix: 
<ch>

.
1 .. 5

Parameters:
<SF> float

Range: 0  to  1
Increment: 1
*RST: 0

Manual operation: See "GALILEO Ionospheric Parameters" on page 113

4.17 Assistance Data Settings

The Assistance Data Settings are only configurable for instrument equipped with assis-
tance option (R&S SMBV-K65/K67/K95) or the basic option R&S SMBV-K107 and in
"User Localization" mode.

Example: Generating of GPS assistance data
The following example uses GPS entry standard.

SOURce1:BB:GPS:SMODe USER
SOURce1:BB:GPS:ADGeneration:MODE GPS
SOURce1:BB:GPS:ADGeneration:GPS:SYNchronize
SOURce1:BB:GPS:ADGeneration:GPS:SVID15:STATe?
//Response:1
SOURce1:BB:GPS:ADGeneration:GPS:LOCation:COORdinates:DMS?
//Response:144,57,59.97,EAST,37,48,59.987,SOUT,100
SOURce1:BB:GPS:ADGeneration:GPS:LOCation:COORdinates:DECimal?
//Response:144.966658,-37.816663,100
SOURce1:BB:GPS:ADGeneration:GPS:LOCation:URADius 2500
SOURce1:BB:GPS:ADGeneration:GPS:TOAData:TBASis UTC
SOURce1:BB:GPS:ADGeneration:GPS:TOAData:DATE?
//Response:2010,11,7
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SOURce1:BB:GPS:ADGeneration:GPS:TOAData:TIME?
//Response:17,4,0
SOURce1:BB:GPS:ADGeneration:GPS:TOAData:TBASis GPS
SOURce1:BB:GPS:ADGeneration:GPS:TOAData:WNUMber?
//Response:1609
SOURce1:BB:GPS:ADGeneration:GPS:TOAData:TOWeek?
//Response:61455
SOURce1:BB:GPS:ADGeneration:GPS:TOAD:DURation 10
SOURce1:BB:GPS:ADGeneration:GPS:TOAD:RES 0.001
SOURce1:BB:GPS:ADGeneration:ACQuisition:DFORmat GPS
SOURce1:BB:GPS:ADGeneration:ACQ:CREate '/var/user/ADG/acquisition'
SOURce1:BB:GPS:ADGeneration:ALManac:CREate '/var/user/ADG/almanac.rs_al'
SOURce1:BB:GPS:ADGeneration:ALManac:CREate '/var/user/ADG/almanac.rs_yuma'
SOURce1:BB:GPS:ADGeneration:UTC:CREate '/var/user/ADG/UTC'
SOURce1:BB:GPS:ADGeneration:NAVigation:CREate '/var/user/ADG/navigation'
SOURce1:BB:GPS:ADGeneration:NAVigation:CREate '/var/user/ADG/RINEX.110n'
SOURce1:BB:GPS:ADGeneration:IONigation:CREate '/var/user/ADG/ionospheric'
SOURce1:MMEM:CAT? '/var/user/ADG'
//Response: 25301,43275001856,".,DIR,0","..,DIR,0","acquisition.rs_acq,BIN,525",
// "almanac.rs_al,BIN,5518","almanac.rs_yuma,BIN,18344","ion.rs_ion,BIN,70",
// "navigation.rs_nav,BIN,245","RINEX.10n,BIN,525","UTC.rs_utc,BIN,74"

<subsystem>:ADGeneration:BEIDou:SVID<ch>:ACQuisition:BLOCk?.................................256
<subsystem>:ADGeneration:GPS:SVID<ch>:ACQuisition:BLOCk?..................................... 256
<subsystem>:ADGeneration:GALileo:SVID<ch>:ACQuisition:BLOCk?................................ 257
<subsystem>:ADGeneration:GLONass:SVID<ch>:ACQuisition:BLOCk?..............................257
<subsystem>:ADGeneration:BEIDou:SVID<ch>:SAData?..................................................257
<subsystem>:ADGeneration:GALileo:SVID<ch>:SAData?..................................................257
<subsystem>:ADGeneration:GLONass:SVID<ch>:SAData?...............................................258
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<subsystem>:ADGeneration:BEIDou:SVID<ch>:ACQuisition:BLOCk?
<TimeOffset>

<subsystem>:ADGeneration:GPS:SVID<ch>:ACQuisition:BLOCk? <TimeOffset>

Queries part of the current assistance data settings.

Query parameters: 
<TimeOffset> Int

Sets the offset of time to the beginning of the acquisition data
generation set with the command <subsystem>: 
ADGeneration: GPS: TOAData:TIME  or the command
<subsystem>: ADGeneration: GPS: TOAData: TOWeek.

Return values: 
<Block> <Rx Time of Week>,<Satellite ID that corresponds to the

record>,<Zero Order Doppler Term>,<1st order Doppler
Term>,<Uncertainty Doppler>,<Code Phase (or half-Chip index
at epoch Time of Transmission (GPS Sat Time))>,<Integer Code
Phase (or ms unit index at epoch Time of Transmission (GPS
Sat Time))>,<Corresponding Bit number (modulo 4) at epoch
Time of Transmission (GPS Sat Time)>,<Correlator Code phase
Search Radius>,<Azimuth Angle of the Satellite in ENU ortho-
normal coordinate System centered at reference point>,<Eleva-
tion Angle of the Satellite in ENU orthonormal coordinate Sys-
tem centered at reference point>
The returned value is exactly one row of the acquisition assis-
tance data file (2G, 3G) that can be generated by the command
<subsystem>: ADGeneration: ACQuisition: CREate .

Example: SOURce1:BB:GPS:ADGeneration:GPS:TOAData:TBASis
UTC
SOURce1:BB:GPS:ADGeneration:GPS:TOAData:TIME
17,04,00.000
sets the time of assistance data.
SOURce1:BB:GPS:ADGeneration:GPS:SVID2:
ACQuisition:BLOCk? 0.1
queries the acquisition data for SV ID 2 and time offset of 0.1s,
i.e. at UTC Time 17:04:00 + 0.1 s.
Response:
589925,5,3733.3371910282908,0,0,599,18,1,11,
225.32801752395233,11.17712126071662

Usage: Query only

Options: R&S SMBV-K65/K107
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<subsystem>:ADGeneration:GALileo:SVID<ch>:ACQuisition:BLOCk?
<TimeOffset>

<subsystem>:ADGeneration:GLONass:SVID<ch>:ACQuisition:BLOCk?
<TimeOffset>

Queries part of the current assistance data settings.

Query parameters: 
<TimeOffset> Int

Sets the offset of time to the beginning of the acquisition data
generation set with the command <subsystem>: 
ADGeneration: GLONass: TOAData: TIME or the command
<subsystem>: ADGeneration: GLONass: TOAData: TOWeek .

Return values: 
<Block> <Rx Time of Week>,<Satellite ID that corresponds to the

record>,<Zero Order Doppler Term>,<1st order Doppler
Term>,<Uncertainty Doppler (m/s)>,<Code Phase (ms)>,<Inte-
ger Code Phase (ms)>,<Correlator Code phase Search Radius
(ms)>,<Azimuth Angle of the Satellite in ENU orthonormal coor-
dinate System centered at reference point>,<Elevation Angle of
the Satellite in ENU orthonormal coordinate System centered at
reference point>
The returned value is exactly one row of the acquisition assis-
tance data file (2G, 3G) that can be generated by the command
<subsystem>: ADGeneration: ACQuisition: CREate .

Example: SOURce1:BB:GPS:ADGeneration:GLONass:TOAData:
TBASis GLO
SOURce1:BB:GPS:ADGeneration:GLONass:TOAData:
DATE 2012,8,20
SOURce1:BB:GPS:ADGeneration:GLONass:TOAData:
TIME 19,00,00.000
sets the time of assistance data.
SOURce1:BB:GPS:ADGeneration:GLONass:SVID2:
ACQuisition:BLOCk? 0.1
queries the acquisition data for SV ID 2 and time offset of 0.1s,
i.e. at Glonass time 19:00:00 + 0.1 s.
Response:
154800.1,2,431.205775308508,0,0,0.987,68,
0.00764343745397626,151.707854408733,
55.6703598896116,0

Usage: Query only

Options: R&S SMBV-K67/K95

<subsystem>:ADGeneration:BEIDou:SVID<ch>:SAData? <TimeOffset>,
<NumberOfSymbols>

<subsystem>:ADGeneration:GALileo:SVID<ch>:SAData? <TimeOffset>,
<NumberOfSymbols>
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<subsystem>:ADGeneration:GLONass:SVID<ch>:SAData? <TimeOffset>,
<NumberOfSymbols>

<subsystem>:ADGeneration:GPS:SVID<ch>:SAData? <TimeOffset>,
<NumberOfSymbols>

Queries selected number of symbols from the sensitivity assistance message for a
specific satellite (SV ID) and at given specific time.

Query parameters: 
<TimeOffset> float

Sets the offset of time to the beginning of the acquisition data
generation set with the command <subsystem>: 
ADGeneration: GPS:TOAData: TIME or the command
<subsystem>: ADGeneration: GPS:TOAData: TOWeek .

<NumberOfSymbols> Default unit: bits
Determines the length of the sensitivity assistance data to be
generated. The maximum length of the generated sensitivity
assistance data is then 125 subframes, i.e. 25 pages or one
complete navigation message.

Return values: 
<Data> list of floats

The R&S SMBV generates a sensitivity assistance message as
a binary stream.
The returned value of this query for a healthy satellite is a
sequence of integer values. The first integer is the size of the
message in bits to be returned. The remaining, each of which is
a 32 bits long block, represents the expected data bits of the
navigation message.
The query returns 0, in case an unhealthy satellite has been
selected.
An error will only be reported if an out of range value for any of
the arguments has been selected.

Example: SOURce1:BB:GPS:ADGeneration:GPS:TOAData:TBASis
UTC
SOURce1:BB:GPS:ADGeneration:GPS:TOAData:TIME
17,04,00.000
SOURce1:BB:GPS:ADGeneration:GPS:SVID1:SAData?
1,300
queries the sensitivity assistance data for SV ID 1.
Response: 0
The selected satellite is unhealthy.
SOURce1:BB:GPS:ADGeneration:GPS:SVID2:SAData?
2,300
queries the sensitivity assistance data for SV ID 2.
Response:
300,-1962933360,78782016,68160383,-10752,43007,
-172032,681727,-1009778689,-1
The first bits of the sensitivity assistance message are 1000
1011 …
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Usage: Query only

<subsystem>:ADGeneration:<GNSS>:SYNChronize
<subsystem>:ADGeneration:BEIDou:SVID:SYNChronize
<subsystem>:ADGeneration:BEIDou:LOCation:SYNChronize
<subsystem>:ADGeneration:BEIDou:TOAData:SYNChronize
<subsystem>:ADGeneration:BEIDou:SYNChronize
<subsystem>:ADGeneration:GLONass:SVID:SYNChronize
<subsystem>:ADGeneration:GLONass:LOCation:SYNChronize
<subsystem>:ADGeneration:GLONass:TOAData:SYNChronize
<subsystem>:ADGeneration:GLONass:SYNChronize
<subsystem>:ADGeneration:GALileo:SVID:SYNChronize
<subsystem>:ADGeneration:GALileo:LOCation:SYNChronize
<subsystem>:ADGeneration:GALileo:TOAData:SYNChronize
<subsystem>:ADGeneration:GALileo:SYNChronize
<subsystem>:ADGeneration:GPS:SVID:SYNChronize
<subsystem>:ADGeneration:GPS:LOCation:SYNChronize
<subsystem>:ADGeneration:GPS:TOAData:SYNChronize
<subsystem>:ADGeneration:GPS:SYNChronize
Synchronizes the affected parameters.

Example: See example "Generating of GPS assistance data" on page 253.

Usage: Event

Manual operation: See "Synchronize All/Synchronize" on page 132

<subsystem>:ADGeneration:MODE <Mode>

Defines the type of assistance data to be loaded.

Parameters:
<Mode> GPS | GALileo | GLONass | BEIDou

*RST: GPS

Example: See example "Generating of GPS assistance data" on page 253.

Options: R&S SMBV-K65/K67/K95/K107

Manual operation: See "Assistance Mode" on page 132

<subsystem>:ADGeneration:BEIDou:SVID<ch>:STATe <State>
<subsystem>:ADGeneration:GALileo:SVID<ch>:STATe <State>
<subsystem>:ADGeneration:GLONass:SVID<ch>:STATe <State>
<subsystem>:ADGeneration:GPS:SVID<ch>:STATe <State>

Enables/disables a space vehicle with the selected SV ID for generation of assistance
data.
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Parameters:
<State> 0 | 1 | OFF | ON

*RST: OFF

Example: See example "Generating of GPS assistance data" on page 253.

Manual operation: See "Space Vehicle State" on page 132

<subsystem>:ADGeneration:BEIDou:LOCation:COORdinates:DECimal
<Longitude>, <Latitude>, <Altitude>

<subsystem>:ADGeneration:GALileo:LOCation:COORdinates:DECimal
<Longitude>, <Latitude>, <Altitude>

<subsystem>:ADGeneration:GLONass:LOCation:COORdinates:DECimal
<Longitude>, <Latitude>, <Altitude>

<subsystem>:ADGeneration:GPS:LOCation:COORdinates:DECimal <Longitude>,
<Latitude>, <Altitude>

Sets the geographic reference location in decimal format.

Parameters:
<Longitude> float

Range: -180  to  180
Increment: 1E-6
*RST: 0

<Latitude> float
Range: -90  to  90
Increment: 1E-6
*RST: 0

<Altitude> float
Defines the altitude in meters above sea level.
Range: -10000  to  1600000
Increment: 0.1
*RST: 0

Example: See example "Generating of GPS assistance data" on page 253.

Manual operation: See "Reference Location" on page 132

<subsystem>:ADGeneration:BEIDou:LOCation:COORdinates:DMS
<LongitudeDeg>, <LongitudeMin>, <LongitudeSec>, <LongitudeDir>,
<LatitudeDeg>, <LatitudeMin>, <LatitudeSec>, <LatitudeDir>, <Altitude>

<subsystem>:ADGeneration:GALileo:LOCation:COORdinates:DMS
<LongitudeDeg>, <LongitudeMin>, <LongitudeSec>, <LongitudeDir>,
<LatitudeDeg>, <LatitudeMin>, <LatitudeSec>, <LatitudeDir>, <Altitude>
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<subsystem>:ADGeneration:GLONass:LOCation:COORdinates:DMS
<LongitudeDeg>, <LongitudeMin>, <LongitudeSec>, <LongitudeDir>,
<LatitudeDeg>, <LatitudeMin>, <LatitudeSec>, <LatitudeDir>, <Altitude>

<subsystem>:ADGeneration:GPS:LOCation:COORdinates:DMS <LongitudeDeg>,
<LongitudeMin>, <LongitudeSec>, <LongitudeDir>, <LatitudeDeg>,
<LatitudeMin>, <LatitudeSec>, <LatitudeDir>, <Altitude>

Sets the geographic reference location in degrees, minutes and seconds.

Parameters:
<LongitudeDeg> integer

Defines the longitude degrees.
Range: 0  to  180
Increment: 1
*RST: 0

<LongitudeMin> integer
Defines the longitude minutes.
Range: 0  to  59
Increment: 1
*RST: 0

<LongitudeSec> float
Defines the longitude seconds.
Range: 0  to  59.999
Increment: 0.001
*RST: 0

<LongitudeDir> EAST | WEST
Defines the longitude direction.
*RST: EAST

<LatitudeDeg> integer
Defines the latitude degrees.
Range: 0  to  90
Increment: 1
*RST: 0

<LatitudeMin> integer
Defines the latitude minutes.
Range: 0  to  59
Increment: 1
*RST: 0

<LatitudeSec> float
Defines the latitude seconds.
Range: 0  to  59.999
Increment: 0.001
*RST: 0
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<LatitudeDir> NORTh | SOUTh
Defines the latitude direction.
*RST: NORT

<Altitude> float
Defines the altitude in meters above sea level.
Range: -10000  to  1600000
Increment: 0.1
*RST: 0

Example: See example "Generating of GPS assistance data" on page 253.

Manual operation: See "Reference Location" on page 132

<subsystem>:ADGeneration:BEIDou:LOCation:URADius <Radius>
<subsystem>:ADGeneration:GALileo:LOCation:URADius <Radius>
<subsystem>:ADGeneration:GLONass:LOCation:URADius <Radius>
<subsystem>:ADGeneration:GPS:LOCation:URADius <Radius>

Sets the Uncertainty Radius, i.e. sets the maximum radius of the area within which the
two dimensional location of the UE is bounded.

Parameters:
<Radius> integer

Range: 0  to  1.E6
Increment: 1
*RST: 3.E3

Example: See example "Generating of GPS assistance data" on page 253.

Manual operation: See "Reference Location" on page 132

<subsystem>:ADGeneration:BEIDou:TOAData:TBASis <TimeBasis>
<subsystem>:ADGeneration:GALileo:TOAData:TBASis <TimeBasis>
<subsystem>:ADGeneration:GLONass:TOAData:TBASis <TimeBasis>
<subsystem>:ADGeneration:GPS:TOAData:TBASis <TimeBasis>

Determines the time basis used to enter the time of assistance data parameters.

Parameters:
<TimeBasis> UTC | GPS | GST | GLO | BDT

*RST: UTC

Example: See example "Generating of GPS assistance data" on page 253.

Manual operation: See "Time Basis" on page 133

<subsystem>:ADGeneration:BEIDou:TOAData:DATE <Year>, <Month>, <Day>
<subsystem>:ADGeneration:GALileo:TOAData:DATE <Year>, <Month>, <Day>

Assistance Data Settings



Remote-Control CommandsSatellite Navigation

263Operating Manual 1173.1427.12 ─ 08

<subsystem>:ADGeneration:GLONass:TOAData:DATE <Year>, <Month>, <Day>
<subsystem>:ADGeneration:GPS:TOAData:DATE <Year>, <Month>, <Day>

Enabled for UTC or GLONASS time basis (<subsystem>: ADGeneration: GPS: 
TOAData: TBASis).

Enters the date for the assistance data in DMS format of the Gregorian calendar.

Parameters:
<Year> integer

Range: 1980  to  9999
Increment: 1

<Month> integer
Range: 1  to  12
Increment: 1

<Day> integer
Range: 1  to  31
Increment: 1

Example: See example "Generating of GPS assistance data" on page 253.

Manual operation: See "Date [dd.mm.yyyy]" on page 133

<subsystem>:ADGeneration:BEIDou:TOAData:TIME <Hour>, <Minute>, <Second>
<subsystem>:ADGeneration:GALileo:TOAData:TIME <Hour>, <Minute>, <Second>
<subsystem>:ADGeneration:GLONass:TOAData:TIME <Hour>, <Minute>,

<Second>
<subsystem>:ADGeneration:GPS:TOAData:TIME <Hour>, <Minute>, <Second>

Enabled for UTC or GLONASS time basis (<subsystem>: ADGeneration: GPS:
TOAData: TBASis).

Enters the exact start time for the assistance data in UTC time format.

Parameters:
<Hour> integer

Range: 0  to  23
Increment: 1

<Minute> integer
Range: 0  to  59
Increment: 1

<Second> float
Range: 0  to  59.999
Increment: 0.001

Example: See example "Generating of GPS assistance data" on page 253.

Manual operation: See "Time [hh:mm:ss]" on page 133
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<subsystem>:ADGeneration:BEIDou:TOAData:DURation <Duration>
<subsystem>:ADGeneration:GALileo:TOAData:DURation <Duration>
<subsystem>:ADGeneration:GLONass:TOAData:DURation <Duration>
<subsystem>:ADGeneration:GPS:TOAData:DURation <Duration>

Sets the duration of the assistance data.

Parameters:
<Duration> float

Range: 1E-3  to  5E3
Increment: 1E-3
*RST: 1E-3
Default unit: s

Example: See example "Generating of GPS assistance data" on page 253.

Manual operation: See "Duration" on page 134

<subsystem>:ADGeneration:BEIDou:TOAData:RESolution <Resolution>
<subsystem>:ADGeneration:GALileo:TOAData:RESolution <Resolution>
<subsystem>:ADGeneration:GLONass:TOAData:RESolution <Resolution>
<subsystem>:ADGeneration:GPS:TOAData:RESolution <Resolution>

Sets the resolution of the assistance data.

Parameters:
<Resolution> float

Range: 1.0E-3  to  5
Increment: 1.0E-3
*RST: 1.0E-3
Default unit: s

Example: See example "Generating of GPS assistance data" on page 253.

Manual operation: See "Resolution" on page 134

<subsystem>:ADGeneration:BEIDou:TOAData:TOWeek <TOW>
<subsystem>:ADGeneration:GALileo:TOAData:TOWeek <TOW>
<subsystem>:ADGeneration:GLONass:TOAData:TOWeek <TOW>
<subsystem>:ADGeneration:GPS:TOAData:TOWeek <TOW>

Enabled for GPS time basis (<subsystem>: ADGeneration: GPS: TOAData: 
TBASis).

Determines the Time of Week (TOW) the assistance data is generated for.

Parameters:
<TOW> integer

Range: -604800  to  604800
Increment: 1
*RST: 0

Example: See example "Generating of GPS assistance data" on page 253.
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Manual operation: See "Time of Week" on page 134

<subsystem>:ADGeneration:BEIDou:TOAData:WNUMber <WeekNumber>
<subsystem>:ADGeneration:GALileo:TOAData:WNUMber <WeekNumber>
<subsystem>:ADGeneration:GLONass:TOAData:WNUMber <WeekNumber>
<subsystem>:ADGeneration:GPS:TOAData:WNUMber <WeekNumber>

Enabled for GPS time basis (<subsystem>: ADGeneration: GPS:TOAData: 
TBASis ).

Sets the week number (WN) the assistance data is generated for.

Parameters:
<WeekNumber> integer

Range: 0  to  9999.0*53
Increment: 1
*RST: 0

Example: See example "Generating of GPS assistance data" on page 253.

Manual operation: See "Week Number" on page 134

<subsystem>:ADGeneration[:ACQuisition]:DFORmat <DataFormat>

Sets the format, GPS or GNSS, of the generated acquisition files.

Parameters:
<DataFormat> GNSS | GPS

*RST: GNSS

Example: See example "Generating of GPS assistance data" on page 253.

Manual operation: See "Data Format" on page 134

<subsystem>:ADGeneration:ACQuisition:CREate <Create>

Stores the current assistance data settings into the selected acquisition file. The direc-
tory is set using command MMEM:CDIRectory. A path can also be specified, in which
case the files in the specified directory are read. Only the file name has to be entered.
Assistance data settings are stored as acquisition file with the specific file extensions
*.rs_acq.

Parameters:
<Create> string

Example: See example "Generating of GPS assistance data" on page 253.

Options: R&S SMBV-K65/K67/K95/K107

Manual operation: See "Generate Acquisition File …" on page 138
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<subsystem>:ADGeneration:ALManac:CREate <Filename>

Stores the current assistance data settings into the selected almanac file. The directory
is set using command MMEM:CDIRectory. A path can also be specified, in which
case the files in the specified directory are read. Only the file name has to be entered.
Assistance data settings are stored as almanac file with the specific file extensions
*.rs_al or *.rs_yuma.

The default extension is *.rs_al and can be omitted in the file name.

To save an almanac file as file with extension *.rs_yuma, however, this extension
has to be specified in the file name.

Parameters:
<Filename> string

Example: See example "Generating of GPS assistance data" on page 253.

Options: R&S SMBV-K65/K67/K95

Manual operation: See "Generate Almanac File …" on page 134

<subsystem>:ADGeneration:UTC:CREate <Filename>

Stores the current assistance data settings into the selected UTC file. The directory is
set using command MMEM:CDIRectory. A path can also be specified, in which case
the files in the specified directory are read. Only the file name has to be entered. Assis-
tance data settings are stored as UTC file with the specific file extensions *.rs_utc.

Parameters:
<Filename> string

Example: See example "Generating of GPS assistance data" on page 253.

Manual operation: See "Generate UTC File …" on page 137

<subsystem>:ADGeneration:NAVigation:CREate <Filename>

Stores the current assistance data settings into the selected navigation file. The direc-
tory is set using command MMEM:CDIRectory. A path can also be specified, in which
case the files in the specified directory are read. Only the file name has to be entered.
Assistance data settings are stored as navigation file with the specific file extensions
*.rs_nav or into RINEX files with extension .10n.

Parameters:
<Filename> string

Example: See example "Generating of GPS assistance data" on page 253.

Manual operation: See "Generate Navigation File …" on page 136
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<subsystem>:ADGeneration:IONospheric:CREate <Filename>

Stores the current assistance data settings into the selected ionospheric file. The direc-
tory is set using command MMEM:CDIRectory. A path can also be specified, in which
case the files in the specified directory are read. Only the file name has to be entered.
Assistance data settings are stored as ionospheric file with the specific file extensions
*.rs_ion.

Parameters:
<Filename> string

Example: See example "Generating of GPS assistance data" on page 253.

Manual operation: See "Generate Ionospheric File …" on page 135

4.18 S.P.O.T Configuration and Real-Time Commands

Example: Retrieving real-time settings
The following example uses GPS entry standard.

*RST

SOURce1:BB:GPS:SMODe AUTO
SOURce1:BB:GPS:HYBRid:GALileo:STATe 1
SOURce1:BB:GPS:HYBRid:GLONass:STATe 1
SOURce1:BB:GPS:HYBRid:BEIDou:STATe 1
SOURce1:BB:GPS:SATellite:COUNt?
// Response: 12
// constalation with 12 satellites

SOURce1:BB:GPS:VEHicle:TYPE?
// LVEH
SOURce1:BB:GPS:LOCation:SELect "Waypoints"
SOURce1:BB:GPS:LOCation:WAYPoints:FILE "Melbourne_Car_Motion.xtd"

SOURce1:BB:GPS:NAVigation:ALManac:GPS:FILE?
// ".../Lists/Gnss/Gps/Almanac/GPS_SEM678.txt"
SOURce1:BB:GPS:NAVigation:SIMulation:WNUMber?
// 1702
SOURce1:BB:GPS:NAVigation:SIMulation:TOWeek?
// 144016
SOURce1:BB:GPS:NAVigation:SIMulation:TBASis UTC
SOURce1:BB:GPS:NAVigation:SIMulation:DATE?
// 2012,8,20
SOURce1:BB:GPS:NAVigation:SIMulation:TIME?
// 16,0,0

SOURce1:BB:GPS:STATe 1

 

S.P.O.T Configuration and Real-Time Commands



Remote-Control CommandsSatellite Navigation

268Operating Manual 1173.1427.12 ─ 08

SOURce1:BB:GPS:SPOT:UPDate OFF

SOURce1:BB:GPS:RT:HWTime?
// Response: 36.16 sec
// elapsed time since simulation start

SOURce1:BB:GPS:SPOT:NHOTime?
// Response: 750 s
// 750 sec = 12 min 30 sec
// hence the next handover is expected at 12:30 min after 16:00:00 on 20.08.2012, 
// that is, the Next Handover Time is 16:12:30

SOURce1:BB:GPS:RT:SCONstellation? GPS,1702,144050
//Response: 12,G2,G4,G9,G27,E15,E16,E26,E27,R12,R22,B25,B34,716
// constalation with 12 satellites
SOURce1:BB:GPS:RT:OCONstellation? GPS,1609,65455
//Response: 12,G9,E16,R12,E27,B25,R22,G2,G4,E26,G27,B34,E15
SOURce1:BB:GPS:RT:RLOCation:COORdinates:DMS? GPS,1702,144050
//Response: 144,57,59.195,EAST,37,48,37.615,SOUT,100.037
SOURce1:BB:GPS:RT:RLOCation:COORdinates:DECimal? GPS,1702,144050
//Response: 144.966443,-37.810449,100.037
SOURce1:BB:GPS:RT:RATTitude?
// Response: 0,0,-1.54474
SOURce1:BB:GPS:RT:GALileo:SVID27:TAP1:POWer:ABSolute? GST,1702,144100
//Response: -118.836975193809
SOURce1:BB:GPS:RT:GALileo:SVID27:AZIMuth? GST,1702,144100
//Response: 37.5699690788219
SOURce1:BB:GPS:RT:GALileo:SVID10:ELEVation? GST,1702,144100
//Response: 72.6122965557601

<subsystem>:SPOT:NHOTime?...................................................................................... 269
<subsystem>:RT:HWTime?............................................................................................ 269
<subsystem>:RT:<GNSS>:SVID<ch>:AZIMuth................................................................. 269
<subsystem>:RT:BEIDou:SVID<ch>:AZIMuth?................................................................. 269
<subsystem>:RT:GALileo:SVID<ch>:AZIMuth?.................................................................269
<subsystem>:RT:GLONass:SVID<ch>:AZIMuth?.............................................................. 270
<subsystem>:RT:GPS:SVID<ch>:AZIMuth?..................................................................... 270
<subsystem>:RT:<GNSS>:SVID<ch>:ELEVation.............................................................. 271
<subsystem>:RT:BEIDou:SVID<ch>:ELEVation?.............................................................. 271
<subsystem>:RT:GALileo:SVID<ch>:ELEVation?..............................................................271
<subsystem>:RT:GLONass:SVID<ch>:ELEVation?...........................................................271
<subsystem>:RT:GPS:SVID<ch>:ELEVation?.................................................................. 271
<subsystem>:RT:<GNSS>:SVID<ch>:TAP<us>:POWer:ABSolute......................................272
<subsystem>:RT:BEIDou:SVID<ch>:TAP<us>:POWer:ABSolute?......................................272
<subsystem>:RT:GALileo:SVID<ch>:TAP<us>:POWer:ABSolute?......................................272
<subsystem>:RT:GLONass:SVID<ch>:TAP<us>:POWer:ABSolute?...................................272
<subsystem>:RT:GPS:SVID<ch>:TAP<us>:POWer:ABSolute?.......................................... 272
<subsystem>:RT:RLOCation:COORdinates:DECimal?...................................................... 274
<subsystem>:RT:RLOCation:COORdinates:DMS?............................................................275
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<subsystem>:RT:SCONstellation?...................................................................................277
<subsystem>:RT:OCONstellation?...................................................................................279
<subsystem>:RT:RATTitude?..........................................................................................280

<subsystem>:SPOT:NHOTime?

In <subsystem>:SMOD AUTO, queries the time period that will pass from the simula-
tion start before the next handover will be executed.

The time of the upcoming handover is calculated as: "Next Handover Time" = simula-
tion start "Time" + <NHoTime>.

Return values: 
<NHoTime> integer

Default unit: seconds

Example: See example "Retrieving real-time settings" on page 267.

Example: SOURce1:BB:GPS:NAVigation:SIMulation:DATE?
Response: 2012,8,20
SOURce1:BB:GPS:NAVigation:SIMulation:TIME?
Response: 16,0,0
SOURce1:BB:GPS:SPOT:NHOTime?
Response: 750 s
750 sec = 12 min 30 sec. Hence the next handover is expected
at 12:30 min after 16:00:00 on 20.08.2012, that is, the Next
Handover Time is 16:12:30

Usage: Query only

Manual operation: See "Next Constellation Change" on page 143

<subsystem>:RT:HWTime?

Queries the time elapsed since the simulation start.

Return values: 
<ElapsedTime> float

Range: 0  to  INT_MAX
Increment: 0.001
*RST: 0

Example: See example "Retrieving real-time settings" on page 267

Usage: Query only

<subsystem>:RT:<GNSS>:SVID<ch>:AZIMuth
<subsystem>:RT:BEIDou:SVID<ch>:AZIMuth? <TimeBasis>, <Year>, <Month>,

<Day>, <Hour>, <Minutes>, <Seconds>, <WeekNumber>, <TimeOfWeek>
<subsystem>:RT:GALileo:SVID<ch>:AZIMuth? <TimeBasis>, <Year>, <Month>,

<Day>, <Hour>, <Minutes>, <Seconds>, <WeekNumber>, <TimeOfWeek>
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<subsystem>:RT:GLONass:SVID<ch>:AZIMuth? <TimeBasis>, <Year>, <Month>,
<Day>, <Hour>, <Minutes>, <Seconds>, <WeekNumber>, <TimeOfWeek>

<subsystem>:RT:GPS:SVID<ch>:AZIMuth? <TimeBasis>, <Year>, <Month>,
<Day>, <Hour>, <Minutes>, <Seconds>, <WeekNumber>, <TimeOfWeek>

Queries the satellite azimuth in the selected moment of time. The required query
parameters, depend on the selected time basis.

Query parameters: 
<TimeBasis> UTC | GPS | GST | GLO | BDT

*RST: UTC

<Year> integer
required for TimeBasis = UTC
Range: 1980  to  9999
Increment: 1

<Month> integer
required for TimeBasis = UTC
Range: 1  to  12
Increment: 1

<Day> integer
required for TimeBasis = UTC
Range: 1  to  31
Increment: 1

<Hour> integer
required for TimeBasis = UTC
Range: 0  to  23
Increment: 1

<Minutes> integer
required for TimeBasis = UTC
Range: 0  to  59
Increment: 1

<Seconds> float
required for TimeBasis = UTC
Range: 0  to  59.999
Increment: 0.001

<WeekNumber> integer
required for TimeBasis = GPS|GST|BDT
Range: 0  to  529947
Increment: 1
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<TimeOfWeek> float
required for TimeBasis = GPS|GST|BDT
Range: 0  to  604799.999
Increment: 0.001

Return values: 
<Azimuth> float

Example: See example "Retrieving real-time settings" on page 267.

Usage: Query only

<subsystem>:RT:<GNSS>:SVID<ch>:ELEVation
<subsystem>:RT:BEIDou:SVID<ch>:ELEVation? <TimeBasis>, <Year>, <Month>,

<Day>, <Hour>, <Minutes>, <Seconds>, <WeekNumber>, <TimeOfWeek>
<subsystem>:RT:GALileo:SVID<ch>:ELEVation? <TimeBasis>, <Year>, <Month>,

<Day>, <Hour>, <Minutes>, <Seconds>, <WeekNumber>, <TimeOfWeek>
<subsystem>:RT:GLONass:SVID<ch>:ELEVation? <TimeBasis>, <Year>,

<Month>, <Day>, <Hour>, <Minutes>, <Seconds>, <WeekNumber>,
<TimeOfWeek>

<subsystem>:RT:GPS:SVID<ch>:ELEVation? <TimeBasis>, <Year>, <Month>,
<Day>, <Hour>, <Minutes>, <Seconds>, <WeekNumber>, <TimeOfWeek>

Queries the satellite's elevation in the selected moment of time. The required query
parameters, depend on the selected time basis.

Query parameters: 
<TimeBasis> UTC | GPS | GST | GLO | BDT

*RST: UTC

<Year> integer
required for TimeBasis = UTC
Range: 1980  to  9999
Increment: 1

<Month> integer
required for TimeBasis = UTC
Range: 1  to  12
Increment: 1

<Day> integer
required for TimeBasis = UTC
Range: 1  to  31
Increment: 1

<Hour> integer
required for TimeBasis = UTC
Range: 0  to  23
Increment: 1
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<Minutes> integer
required for TimeBasis = UTC
Range: 0  to  59
Increment: 1

<Seconds> float
required for TimeBasis = UTC
Range: 0  to  59.999
Increment: 0.001

<WeekNumber> integer
required for TimeBasis = GPS|GST|BDT
Range: 0  to  529947
Increment: 1

<TimeOfWeek> float
required for TimeBasis = GPS|GST|BDT
Range: 0  to  604799.999
Increment: 0.001

Return values: 
<Elevation> float

Example: See example "Retrieving real-time settings" on page 267.

Usage: Query only

<subsystem>:RT:<GNSS>:SVID<ch>:TAP<us>:POWer:ABSolute
<subsystem>:RT:BEIDou:SVID<ch>:TAP<us>:POWer:ABSolute? <TimeBasis>,

<Year>, <Month>, <Day>, <Hour>, <Minutes>, <Seconds>, <WeekNumber>,
<TimeOfWeek>

<subsystem>:RT:GALileo:SVID<ch>:TAP<us>:POWer:ABSolute? <TimeBasis>,
<Year>, <Month>, <Day>, <Hour>, <Minutes>, <Seconds>, <WeekNumber>,
<TimeOfWeek>

<subsystem>:RT:GLONass:SVID<ch>:TAP<us>:POWer:ABSolute? <TimeBasis>,
<Year>, <Month>, <Day>, <Hour>, <Minutes>, <Seconds>, <WeekNumber>,
<TimeOfWeek>

<subsystem>:RT:GPS:SVID<ch>:TAP<us>:POWer:ABSolute? <TimeBasis>,
<Year>, <Month>, <Day>, <Hour>, <Minutes>, <Seconds>, <WeekNumber>,
<TimeOfWeek>

Queries the absolute power of a specified Tap of a specific satellite at a selected
moment of time.

Note: The power refers to the reference signal component in case of many signals
simulated with this specific satellite e.g. C/A when simulating a satellite with signals
(C/A + P)Q.
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Suffix: 
<us>

.
1..10
Determines the tap number. The number of taps is set with the
command <subsystem>: SVID<ch>: GALileo:MPATh: TAP:
COUNt.

Query parameters: 
<TimeBasis> UTC | GPS | GST | GLO | BDT

*RST: UTC

<Year> integer
required for UTC time basis only
Range: 1980  to  9999
Increment: 1

<Month> integer
required for TimeBasis = UTC
Range: 1  to  12
Increment: 1

<Day> integer
required for TimeBasis = UTC
Range: 1  to  31
Increment: 1

<Hour> integer
required for TimeBasis = UTC
Range: 0  to  23
Increment: 1

<Minutes> integer
required for TimeBasis = UTC
Range: 0  to  59
Increment: 1

<Seconds> float
required for TimeBasis = UTC
Range: 0  to  59.999
Increment: 0.001

<WeekNumber> integer
required for TimeBasis = GPS|GST|BDT
Range: 0  to  529947
Increment: 1

<TimeOfWeek> float
required for TimeBasis = GPS|GST|BDT
Range: 0  to  604799.999
Increment: 0.001
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Return values: 
<Power> float

Example: See example "Retrieving real-time settings" on page 267.

Usage: Query only

<subsystem>:RT:RLOCation:COORdinates:DECimal? <TimeBasis>, <Year>,
<Month>, <Day>, <Hour>, <Minutes>, <Seconds>, <WeekNumber>,
<TimeOfWeek>

Queries the coordinates of the receiver location in decimal format for the selected
moment of time. The required query parameters depend on the selected time basis.

Query parameters: 
<TimeBasis> UTC | GPS | GST | GLO | BDT

*RST: UTC

<Year> integer
required for TimeBasis = UTC
Range: 1980  to  9999
Increment: 1

<Month> integer
required for TimeBasis = UTC
Range: 1  to  12
Increment: 1

<Day> integer
required for TimeBasis = UTC
Range: 1  to  31
Increment: 1

<Hour> integer
required for TimeBasis = UTC
Range: 0  to  23
Increment: 1

<Minutes> integer
required for TimeBasis = UTC
Range: 0  to  59
Increment: 1

<Seconds> float
required for TimeBasis = UTC
Range: 0  to  59.999
Increment: 0.001
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<WeekNumber> integer
required for TimeBasis = GPS|GST|BDT
Range: 0  to  529947
Increment: 1

<TimeOfWeek> float
required for TimeBasis = GPS|GST|BDT
Range: 0  to  604799.999
Increment: 0.001

Return values: 
<Longitude> float

Range: -180  to  180
Increment: 1E-6
*RST: 0

<Latitude> float
Range: -90  to  90
Increment: 1E-6
*RST: 0

<Altitude> float
Range: -10000  to  1600000
Increment: 0.1
*RST: 0

Example: See example "Retrieving real-time settings" on page 267.

Usage: Query only

<subsystem>:RT:RLOCation:COORdinates:DMS? <TimeBasis>, <Year>, <Month>,
<Day>, <Hour>, <Minutes>, <Seconds>, <WeekNumber>, <TimeOfWeek>

Queries the coordinates of the receiver location in DMS format for the selected
moment of time. The required query parameters depend on the selected time basis.

Query parameters: 
<TimeBasis> UTC | GPS | GST | GLO | BDT

*RST: UTC

<Year> integer
required for TimeBasis = UTC
Range: 1980  to  9999
Increment: 1

<Month> integer
required for TimeBasis = UTC
Range: 1  to  12
Increment: 1
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<Day> integer
required for TimeBasis = UTC
Range: 1  to  31
Increment: 1

<Hour> integer
required for TimeBasis = UTC
Range: 0  to  23
Increment: 1

<Minutes> integer
required for TimeBasis = UTC
Range: 0  to  59
Increment: 1

<Seconds> float
required for TimeBasis = UTC
Range: 0  to  59.999
Increment: 0.001

<WeekNumber> integer
required for TimeBasis = GPS|GST|BDT
Range: 0  to  529947
Increment: 1

<TimeOfWeek> float
required for TimeBasis = GPS|GST|BDT
Range: 0  to  604799.999
Increment: 0.001

Return values: 
<LongitudeDeg> integer

Range: 0  to  180
Increment: 1
*RST: 0

<LongitudeMin> integer
Range: 0  to  59
Increment: 1
*RST: 0

<LongitudeSec> float
Range: 0  to  59.999
Increment: 0.001
*RST: 0

<LongitudeDir> EAST | WEST
*RST: EAST
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<LatitudeDeg> integer
Range: 0  to  90
Increment: 1
*RST: 0

<LatitudeMin> integer
Range: 0  to  59
Increment: 1
*RST: 0

<LatitudeSec> float
Range: 0  to  59.999
Increment: 0.001
*RST: 0

<LatitudeDir> NORT | SOUT
*RST: NORT

<Altitude> float
Range: -10000  to  1600000
Increment: 0.1
*RST: 0

Example: See example "Retrieving real-time settings" on page 267.

Usage: Query only

<subsystem>:RT:SCONstellation? <TimeBasis>, <Year>, <Month>, <Day>, <Hour>,
<Minutes>, <Seconds>, <WeekNumber>, <TimeOfWeek>

Queries the constellation of the active satellites for the selected moment of time.

Query parameters: 
<TimeBasis> UTC | GPS | GST | GLO | BDT

*RST: UTC

<Year> integer
required for TimeBasis = UTC
Range: 1980  to  9999
Increment: 1

<Month> integer
required for TimeBasis = UTC
Range: 1  to  12
Increment: 1

<Day> integer
required for TimeBasis = UTC
Range: 1  to  31
Increment: 1

S.P.O.T Configuration and Real-Time Commands



Remote-Control CommandsSatellite Navigation

278Operating Manual 1173.1427.12 ─ 08

<Hour> integer
required for TimeBasis = UTC
Range: 0  to  23
Increment: 1

<Minutes> integer
required for TimeBasis = UTC
Range: 0  to  59
Increment: 1

<Seconds> float
required for TimeBasis = UTC
Range: 0  to  59.999
Increment: 0.001

<WeekNumber> integer
required for TimeBasis = GPS|GST|BDT
Range: 0  to  529947
Increment: 1

<TimeOfWeek> float
required for TimeBasis = GPS|GST|BDT
Range: 0  to  604799.999
Increment: 0.001

Return values: 
<Constellation> <Number of Sats>,<STD/SV ID of Sat1>,<STD/SV ID of

Sat2>,...,<Remaining Time>
The query returns a string composed of the number of simulated
satellites at the selected moment of time, standard/SV-ID of all
the satellites in the active constellation and if applicable the
remaining time to the next exchange of satellites in seconds.
The <Remaining Time> is returned as a valid positive integer
in seconds only when working in a mode where exchange of
stellites is predefined or made automatic at the beginning of the
simulation, e.g while working in the auto localization mode
(<subsystem>: SMODe); otherwise -1 is returned.

Example: BB:GPS:SMOD AUTO
BB:GPS:RT:SCON? GPS,1609,61455
Response: 6,G24,G10,G32,E11,E25,E14,1525
The 6 active satellites G24,G10,G32,E11,E25,E14 build the sat-
ellite constellation. An exchange of satellites will be performed in
1525s.

Example: See also example "Retrieving real-time settings" on page 267.

Usage: Query only

S.P.O.T Configuration and Real-Time Commands



Remote-Control CommandsSatellite Navigation

279Operating Manual 1173.1427.12 ─ 08

<subsystem>:RT:OCONstellation? <TimeBasis>, <Year>, <Month>, <Day>, <Hour>,
<Minutes>, <Seconds>, <WeekNumber>, <TimeOfWeek>

Queries the optimal constellation for the selected moment of time.

Query parameters: 
<TimeBasis> UTC | GPS | GST | GLO | BDT

*RST: UTC

<Year> integer
required for TimeBasis = UTC
Range: 1980  to  9999
Increment: 1

<Month> integer
required for TimeBasis = UTC
Range: 1  to  12
Increment: 1

<Day> integer
required for TimeBasis = UTC
Range: 1  to  31
Increment: 1

<Hour> integer
required for TimeBasis = UTC
Range: 0  to  23
Increment: 1

<Minutes> integer
required for TimeBasis = UTC
Range: 0  to  59
Increment: 1

<Seconds> float
required for TimeBasis = UTC
Range: 0  to  59.999
Increment: 0.001

<WeekNumber> integer
required for TimeBasis = GPS|GST|BDT
Range: 0  to  529947
Increment: 1

<TimeOfWeek> float
required for TimeBasis = GPS|GST|BDT
Range: 0  to  604799.999
Increment: 0.001
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Return values: 
<Constellation> <Number of Sats>,<STD/SV ID of Sat1>,<STD/SV ID of

Sat2>,...
The query returns a string composed of the number of satellites
in the optimal constellation and the standard/SV-ID of the satel-
lites.
Use this information as a basis for manually performed
exchange of satellites.

Example: BB:GPS:SMOD USER
BB:GPS:NAV:SIM:TBAS GPS
BB:GPS:NAV:SIM:WNUM 1609
BB:GPS:NAV:SIM:TOW 61455
BB:GPS:GOC
BB:GPS:RT:SCON? GPS,1609,61455
Response: 6,G11,E11,E19,E28,G19,G14,-1
The 6 active satellites G11,E11,E19,E28,G19,G14 build the sat-
ellite constellation.
BB:GPS:RT:OCON? GPS,1609,65455
Response: 6,G20,E20,E23,G4,G24,E31
The optimal constellation for the selected moment of time con-
sists of 6 satellites G20,E20,E23,G4,G24,E31.

Example: See also example "Retrieving real-time settings" on page 267.

Usage: Query only

Manual operation: See "Get Optimal Constellation" on page 102

<subsystem>:RT:RATTitude? <TimeBasis>, <Year>, <Month>, <Day>, <Hour>,
<Minutes>, <Seconds>, <WeekNumber>, <TimeOfWeek>

Queries the receiver attitude parameters yaw, pitch, roll in degrees for the selected
moment of time.

Query parameters: 
<TimeBasis> UTC | GPS | GST | GLO | BDT

*RST: UTC

<Year> integer
required for TimeBasis = UTC
Range: 1980  to  9999
Increment: 1

<Month> integer
required for TimeBasis = UTC
Range: 1  to  12
Increment: 1
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<Day> integer
required for TimeBasis = UTC
Range: 1  to  31
Increment: 1

<Hour> integer
required for TimeBasis = UTC
Range: 0  to  23
Increment: 1

<Minutes> integer
required for TimeBasis = UTC
Range: 0  to  59
Increment: 1

<Seconds> float
required for TimeBasis = UTC
Range: 0  to  59.999
Increment: 0.001

<WeekNumber> integer
required for TimeBasis = GPS|GST|BDT
Range: 0  to  529947
Increment: 1

<TimeOfWeek> float
required for TimeBasis = GPS|GST|BDT
Range: 0  to  604799.999
Increment: 0.001

Return values: 
<Yaw> float

Range: -3.14  to  3.14
Increment: 0.01
*RST: 0

<Pitch> float
Range: -3.14  to  3.14
Increment: 0.01
*RST: 0

<Roll> float
Range: -3.14  to  3.14
Increment: 0.01
*RST: 0
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Example: SOURce1:BB:GPS:SMODe AUTO
SOURce1:BB:GPS:RATTitude? GPS,1609,61455
Response: 0.10,0.00,1.00
The current receiver attitude parameters yaw (Y) = 0.1, pitch (P)
= 0 and roll (R) = 1.0

Usage: Query only

Manual operation: See "Yaw/Heading, Pitch/Elevation, Roll/Bank" on page 72

4.19 Trigger Settings

<subsystem>[:TRIGger]:SEQuence................................................................................. 282
<subsystem>:TRIGger:SLENgth......................................................................................282
<subsystem>:TRIGger:RMODe?..................................................................................... 283
<subsystem>:TRIGger:ARM:EXECute............................................................................. 283
<subsystem>:TRIGger:EXECute..................................................................................... 284
<subsystem>:TRIGger:SOURce......................................................................................284
<subsystem>:TRIGger:EXTernal:SYNChronize:OUTPut.................................................... 284
<subsystem>:TRIGger:OUTPut<ch>:DELay..................................................................... 285
<subsystem>:TRIGger:OUTPut<ch>:DELay:MINimum?.....................................................285
<subsystem>:TRIGger:OUTPut<ch>:DELay:MAXimum?....................................................285
<subsystem>:TRIGger:OUTPut:DELay:FIXed...................................................................286
<subsystem>:TRIGger[:EXTernal<ch>]:DELay..................................................................286
<subsystem>:TRIGger[:EXTernal<ch>]:INHibit..................................................................286

<subsystem>[:TRIGger]:SEQuence <Sequence>

Selects the trigger mode.

Parameters:
<Sequence> AUTO | RETRigger | AAUTo | ARETrigger | SINGle

*RST: AUTO

Example: BB:GPS:SEQ AAUT
sets the "Armed_auto" trigger mode; the device waits for the first
trigger (e.g. with *TRG) and then generates the signal continu-
ously.

Manual operation: See "Trigger Mode" on page 146

<subsystem>:TRIGger:SLENgth <SLength>

Defines the length of the signal sequence to be output in the "Single" trigger mode
(SOUR:BB:GPS:SEQ SING). The unit of the entry is defined under "Signal Duration
Unit". The maximum value for the sequence length depends on the selected unit.

It is possible to output deliberately just part of the signal, an exact sequence of the sig-
nal, or a defined number of repetitions of the signal.
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Parameters:
<SLength> integer

Range: 1  to  4294967295
Increment: 1
*RST: 1023

Example: BB:GPS:SEQ SING
sets trigger mode Single.
BB:GPS:TRIG:SLEN 200
sets a sequence length of 200 chips. The first 200 chips of the
current frame will be output after the next trigger event.

Manual operation: See "Signal Duration" on page 147

<subsystem>:TRIGger:RMODe?

Queries the current status of signal generation for all trigger modes with GPS modula-
tion on.

Return values: 
<RMode> STOP | RUN

*RST: STOP

Example: BB:GPS:TRIG:MODE ARET
selects the "Armed_Retrigger" mode.
BB:GPS:TRIG:SOUR EXT
sets external triggering via the TRIGGER 1 connector.
BB:GPS:TRIG:RMOD?
queries the current status of signal generation.
Response: RUN
the signal is generated, an external trigger was executed.

Usage: Query only

Manual operation: See "Running/Stopped" on page 147

<subsystem>:TRIGger:ARM:EXECute

Stops signal generation for trigger modes "Armed_Auto" and "Armed_Retrigger". A
subsequent internal or external trigger event restarts signal generation.

Example: BB:GPS:TRIG:SOUR INT
sets internal triggering.
BB:GPS:TRIG:SEQ ARET
sets Armed_Retrigger mode, i.e. every trigger event causes sig-
nal generation to restart.
BB:GPS:TRIG:EXEC
executes a trigger, signal generation is started.
BB:GPS:TRIG:ARM:EXEC
signal generation is stopped.
BB:GPS:TRIG:EXEC
executes a trigger, signal generation is started again.
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Usage: Event

Manual operation: See "Arm" on page 62

<subsystem>:TRIGger:EXECute

Executes a trigger. The internal trigger source must be selected using the command
<subsystem>:TRIG:SOUR INT and a trigger mode other than AUTO must be
selected using the command <subsystem>:TRIG:SEQ.

Example: BB:GPS:TRIG:SOUR INT
sets internal triggering.
BB:GPS:TRIG:SEQ ARET
sets "Armed_Retrigger" mode, i.e. every trigger event causes
signal generation to restart.
BB:GPS:TRIG:EXEC
executes a trigger, signal generation is started.
BB:GPS:TRIG:ARM:EXEC
signal generation is stopped.
BB:GPS:TRIG:EXEC
executes a trigger, signal generation is started again.

Usage: Event

Manual operation: See "Execute Trigger" on page 62

<subsystem>:TRIGger:SOURce <Source>

Selects the trigger source.

Parameters:
<Source> INTernal | EXTernal

Example: BB:GPS:TRIG:SING
selects a trigger mode that requires a trigger.
BB:GPS:TRIG:SOUR EXT
sets external triggering via the TRIGGER connector.

Manual operation: See "Trigger Source" on page 148

<subsystem>:TRIGger:EXTernal:SYNChronize:OUTPut <Output>

(enabled for "Trigger Source" External)

Enables/disables output of the signal synchronous to the external trigger event.

Parameters:
<Output> 0 | 1 | OFF | ON

*RST: 1
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Example: BB:GPS:TRIG:SOUR EXT
sets external triggering.
BB:GPS:TRIG:EXT:SYNC:OUTP ON
enables synchrounous output to external trigger.

Manual operation: See "Sync. Output to External Trigger" on page 148

<subsystem>:TRIGger:OUTPut<ch>:DELay <Delay>

Defines the delay between the signal on the marker outputs and the start of the signal,
expressed in terms of chips. Command :BB:GPS:TRIGger:OUTPut:DELay:FIXed
can be used to restrict the range of values to the dynamic range, i.e. the range within
which a delay of the marker signals can be set without restarting the marker and sig-
nal.

Parameters:
<Delay> float

Range: 0  to  2^32 - 1 chips
Increment: 1 chip
*RST: 0

Example: BB:GPS:TRIG:OUTP2:DEL 1600
sets a delay of 1600 chips for the signal on connector MARKER
2.

Manual operation: See "Marker x Delay" on page 151

<subsystem>:TRIGger:OUTPut<ch>:DELay:MINimum?
<subsystem>:TRIGger:OUTPut<ch>:DELay:MAXimum?
Queries the maximum marker delay for setting <subsystem>:TRIG:OUTP:DEL:FIX
ON.

Return values: 
<Maximum> float

Range: 0  to  max

Example: BB:GPS:TRIG:OUTP:DEL:FIX ON
restricts the marker signal delay setting range to the dynamic
range.
BB:GPS:TRIG:OUTP:DEL:MAX?
queries the maximum of the dynamic range.
Response: 2000
the maximum for the marker delay setting is 2000 chips.

Usage: Query only

Manual operation: See "Current Range without Recalculation" on page 151
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<subsystem>:TRIGger:OUTPut:DELay:FIXed <Fixed>

Restricts the marker delay setting range to the dynamic range. In this range the delay
can be set without restarting the marker and signal. If a delay is entered in setting ON
but is outside this range, the maximum possible delay is set and an error message is
generated.

Parameters:
<Fixed> 0 | 1 | OFF | ON

*RST: 0

Example: BB:GPS:TRIG:OUTP:DEL:FIX ON
restricts the marker signal delay setting range to the dynamic
range.

Manual operation: See "Fix marker delay to current range" on page 151

<subsystem>:TRIGger[:EXTernal<ch>]:DELay <Delay>

Specifies the trigger delay (expressed as a number of chips) for external triggering.

Parameters:
<Delay> float

Range: 0  to  65535
Increment: 0.01 chip
*RST: 0.0 chips

Example: BB:GPS:TRIG:SOUR EXT
sets an external trigger via the TRIGGER 1 connector.
BB:GPS:TRIG:DEL 50
sets a delay of 50 chips for the trigger.

Manual operation: See "External Delay" on page 149

<subsystem>:TRIGger[:EXTernal<ch>]:INHibit <Inhibit>

Specifies the number of chips by which a restart is to be inhibited following a trigger
event. Applies only in the case of external triggering.

Parameters:
<Inhibit> integer

Range: 0  to  67108863
Increment: 1 chip
*RST: 0

Example: BB:GPS:TRIG:SOUR EXT
selects an external trigger via the TRIGGER 1 connector.
BB:GPS:TRIG:INH 200
sets a restart inhibit for 200 chips following a trigger event.

Manual operation: See "External Inhibit" on page 149
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4.20 Marker Settings

<subsystem>:TRIGger:OUTPut<ch>:MODE..................................................................... 287
<subsystem>:TRIGger:OUTPut<ch>:ONTime...................................................................288
<subsystem>:TRIGger:OUTPut<ch>:OFFTime................................................................. 288
<subsystem>:TRIGger:OUTPut<ch>:PATTern.................................................................. 288
<subsystem>:TRIGger:OUTPut<ch>:PULSe:DIVider......................................................... 288
<subsystem>:TRIGger:OUTPut<ch>:PULSe:FREQuency?................................................ 289
<subsystem>:TRIGger:OUTPut<ch>:PULSe:WIDTh..........................................................289

<subsystem>:TRIGger:OUTPut<ch>:MODE <Mode>

Defines the signal for the selected marker output.

Note: In instruments equipped with option R&S SMBV-K96, disabled <subsystem>: 
UMGPs and enabled satellites constellation with more than 12 satellites, only one
marker signal is available.

Parameters:
<Mode> PULSe | PATTern | RATio | PPS | PP2S | TRIGger | DISabled |

PPS10 | | RESTart
PULSe|PATTern|RATio
Reqular marker signals
PPS | PP2S | PPS10
A marker signal is generated for every start of second, every
second second or respectivelly every tenth second (GPS time).
The pulse width is defined with the
<subsystem>:TRIG:OUTP:PULSe:WIDTh command

TRIGger
A marker signal is generated only when a trigger event occurs.
DISabled
Generation of a marker signal is deactivated.
Restart
(R&S WinIQSIM2 only)
The signal is generated continuously. A trigger event causes a
restart.
*RST: PPS

Example: BB:GPS:TRIG:OUTP2:PATT #B000000011111111,15
sets a bit pattern.
BB:GPS:TRIG:OUTP1:MODE PATT
activates the marker signal according to a bit pattern on output
MARKER 1.

Manual operation: See "Marker Mode" on page 150
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<subsystem>:TRIGger:OUTPut<ch>:ONTime <OnTime>
<subsystem>:TRIGger:OUTPut<ch>:OFFTime <OffTime>

Sets the number of chips in a period (ON time + OFF time) during which the marker
signal in setting <subsystem>:TRIGger:OUTPut:MODE RATio on the marker out-
puts is OFF.

Parameters:
<OffTime> integer

Range: 1  to  2^24 - 1 chips
Increment: 1 chip
*RST: 1

Example: BB:GPS:TRIG:OUTP2:OFFT 200
sets an OFF time of 200 chips for marker signal 2.

Manual operation: See "Marker Mode" on page 150

<subsystem>:TRIGger:OUTPut<ch>:PATTern <Pattern>

Defines the bit pattern used to generate the marker signal in the setting
<subsystem>:TRIGger:OUTPut:MODE PATTern. 0 is marker off, 1 is marker on.

Parameters:
<Pattern> 64 bit pattern

Range: #B0,1  to  #B111...1,64
*RST: #B0,1

Example: BB:GPS:TRIG:OUTP2:PATT #B000000011111111,15
sets a bit pattern.
BB:GPS:TRIG:OUTP2:MODE PATT
activates the marker signal according to a bit pattern on output
MARKER 2.

Manual operation: See "Marker Mode" on page 150

<subsystem>:TRIGger:OUTPut<ch>:PULSe:DIVider <Divider>

Sets the divider for Pulse marker mode (<subsystem>:TRIG:OUTP:MODE PULSe).
The resulting pulse frequency is derived by dividing the chip rate (1.023 MHz) by the
divider.

Parameters:
<Divider> integer

Range: 2  to  1024
Increment: 1
*RST: 2
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Example: BB:GPS:TRIG:OUTP2:PULS:DIV 2
sets the divider to 2 for the marker signal on output MARKER 2.
BB:GPS:TRIG:OUTP2:FREQ?
queries the resulting pulse frequency of the marker signal.
Response: 511511.038
the resulting pulse frequency is 511.511 kHz.

Manual operation: See "Marker Mode" on page 150

<subsystem>:TRIGger:OUTPut<ch>:PULSe:FREQuency?

Queries the pulse frequency of the pulsed marker signal in the setting
<subsystem>:TRIGger:OUTPut:MODE PULSe. The pulse frequency is derived by
dividing the symbol rate by the divider.

Return values: 
<Frequency> float

Example: BB:GPS:TRIG:OUTP2:PULS:DIV 2
sets the divider for the marker signal on output MARKER 2 to
the value 2.
BB:GPS:TRIG:OUTP2:MODE PULS
enables the pulsed marker signal.
BB:GPS:TRIG:OUTP2:PULS:FREQ?
queries the pulse frequency of the marker signal.
Response: 511511.038
the resulting pulse frequency is 511.511 kHz.

Usage: Query only

Manual operation: See "Marker Mode" on page 150

<subsystem>:TRIGger:OUTPut<ch>:PULSe:WIDTh <Width>

Sets the Pulse Width for 1PPS and 1PP2S marker mode
(<subsystem>:TRIG:OUTP:MODE PPS | PP2S).

Parameters:
<Width> integer

Range: 1  to  800
*RST: 1

Example: BB:GPS:TRIG:OUTP2:MODE PPS
enables the 1PPS marker signal.
BB:GPS:TRIG:OUTP1:PULS:WIDT 2
sets the pulse width for the marker signal on output MARKER 2
to the value 2.

Manual operation: See "Marker Mode" on page 150
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4.21 Clock Settings

<subsystem>:CLOCk:MODE...........................................................................................290
<subsystem>:CLOCk:MULTiplier.....................................................................................290
<subsystem>:CLOCk:SOURce........................................................................................290
<subsystem>:CLOCk:SYNChronization:EXECute............................................................. 291
<subsystem>:CLOCk:SYNChronization:MODE................................................................. 291

<subsystem>:CLOCk:MODE <Mode>

Enters the type of externally supplied clock (<subsystem>:CLOCk:SOURce
EXTernal).

When MCHip is used, a multiple of the chip clock is supplied via the CLOCK connector
and the chip clock is derived internally from this. The multiplier is entered with the com-
mand <subsystem>:CLOCk:MULTiplier.

Parameters:
<Mode> CHIP | MCHip

*RST: CHIP

Example: BB:GPS:CLOC:MODE CHIP
selects clock type "Chip", i.e. the supplied clock is a chip clock.

Manual operation: See "Clock Mode" on page 152

<subsystem>:CLOCk:MULTiplier <Multiplier>

Specifies the multiplier for clock type "Multiplied" (<subsystem>:CLOCk:MODE
MCHip) in the case of an external clock source.

Parameters:
<Multiplier> integer

Range: 1  to  64
Increment: 1
*RST: 4

Example: BB:GPS:CLOC:SOUR EXT
selects the external clock source. The clock is supplied via the
CLOCK connector.
BB:GPS:CLOC:MODE MCH
selects clock type "Multiplied", i.e. the supplied clock has a rate
which is a multiple of the chip rate.
BB:GPS:CLOC:MULT 12
the multiplier for the external clock rate is 12.

Manual operation: See "Clock Multiplier" on page 153

<subsystem>:CLOCk:SOURce <Source>

Selects the clock source.
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For two-path instruments, selecting EXTernal is only possible for path A, since the
external clock source is permanently allocated to path A.

Parameters:
<Source> INTernal | EXTernal | AINTernal

INTernal
The internal clock reference is used to generate the chip clock
(1.023 MHz).
EXTernal
The external clock reference is supplied to the CLOCK connec-
tor.
*RST: INTernal

Example: BB:GPS:CLOC:SOUR EXT
selects an external clock reference. The clock is supplied via the
CLOCK connector.
BB:GPS:CLOC:MODE CHIP
specifies that a chip clock is supplied via the CLOCK connector.

Manual operation: See "Clock Source" on page 152

<subsystem>:CLOCk:SYNChronization:EXECute

Performs automatically adjustment of the instrument's settings required for the selected
synchronization mode.

Usage: Event

Manual operation: See "Set Synchronization Settings" on page 152

<subsystem>:CLOCk:SYNChronization:MODE <Mode>

Selects the synchronization mode.

This parameter is used to enable generation of very precise synchronous signals from
several connected R&S SMBVs.

Note: If several instruments are connected, the connecting cables from the master
instrument to the slave and between each two consecutive slave instruments must
have the same length and type. Avoid unnecessary cable length and branching points.
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Parameters:
<Mode> NONE | MASTer | SLAVe

NONE
The instrument is working in stand-alone mode.
MASTer
The instrument synchronizes all connected instruments, includ-
ing the trigger and reference clock signals.
SLAVe
The instrument receives the synchronisation and reference clock
signal from another instrument working in a master mode.
*RST: NONE

Example: BB:GPS:CLOC:SYNC:MODE MAST
Defines the current instrument as the master for synchronization
of the connected instruments

Manual operation: See "Sync. Mode" on page 152
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A Annex

A.1 User Environment Files

The R&S SMBV supports different file formats that describe a moving receiver. This
section focus on:

● Movement or Motion Files.....................................................................................293
● Vehicle Description Files (Used for Smoothening)................................................300
● Antenna Pattern / Body Mask Files.......................................................................301

A.1.1 Movement or Motion Files

A.1.1.1 Waypoint File Format

This file format is a list of coordinates (longitude, latitude, altitude) and a respective
resolution in milliseconds (see example "3GPP Performance Test Scenario#3 "Mel-
bourne" (WGS84 geodetic coordinates)" on page 293).

Example: 3GPP Performance Test Scenario#3 "Melbourne" (WGS84 geodetic
coordinates)
The resolution command at the beginning of the format specifies the sampling interval
to be used for the WGS84 geodetic coordinates list. The resolution gives the time (in
ms) between two consecutive waypoints.

RESOLUTION: 50
144.966666334601,-37.8166633061788,100.000000009313
144.966662392613,-37.8166632247233,100.000000039116
144.966658453002,-37.8166630889914,100.00000008475
144.966654516955,-37.8166628990241,100.000000149943
144.966650585658,-37.8166626548785,100.000000235625
144.966646660296,-37.8166623566284,100.000000339001
144.966642742053,-37.8166620043635,100.000000461936
144.966638832109,-37.81666159819,100.000000603497
144.966634931642,-37.8166611382304,100.000000762753
144.96663104183,-37.8166606246233,100.000000941567
144.966627163843,-37.8166600575235,100.000001138076
144.96662329885,-37.8166594371019,100.000001354143
144.966619448018,-37.8166587635456,100.000001588836
144.966615612505,-37.8166580370574,100.000001840293
144.966611793469,-37.8166572578565,100.00000211224
144.96660799206,-37.8166564261776,100.00000240095
144.966574759635,-37.8166466260761,100.00000580959
etc.
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A.1.1.2 Vector Trajectory File Format

This file format uses a script containing the commands defined in the following table:

Command Description

REFERENCE: lon, Lat, alt Specifies the Cartesian Reference of the ENU coordinates system.
Given as a geodetic WGS84 point (longitude, Latitude, Altitude).

START: E ,N, U, Velocity Start location i.e., initial "current location" in the ENU Cartesian coordi-
nate of center "REFERENCE". East, North and UP (ENU) coordinates
are then provided (m). The last argument is the start velocity in (m/s).

ARC: E, N, Angle Specifies a 2-Dimensional ARC (East, North) with the first two argu-
ments representing the center of the ARC (m) in the Cartesian basis.
The last argument specifies the angle in degrees (°) of the Arc Starting
the "current location". Angle sign is significant since it indicates positive
direction (against clock movement) or negative direction (same as
clock movement). The end edge of the arc represents the new "current
location". Velocity doesn't change when using an ARC command.

LINE: ∆E, ∆N, Acceleration Specifies a 2-Dimensional Line starting the "current location" as the
first edge and (Current loc E + ∆E, Current loc N + ∆N) as the second
edge (m). Constant acceleration/deceleration can be specified in the
last argument e.g., (0 means constant velocity). Unit for acceleration is
(m/s2). The second edge is again used as the "current location" for the
next command. The speed at this second edge is also used as the
start speed for the next command.

STAY: Time Stay at the current location for Time period (ms).

Example: Example of Waypoint File
This example explains a waypoint file in the second format for the case of 3GPP Per-
formance Test Scenario#3 "Melbourne", as described in 3GPP 34.108 v.8.0.0, 3GPP
34.171 v.7.0.1.
The GPS signals simulate the GPS-receiver moving on a rectangular trajectory of
940m by 1 440m with rounded corners defined in table 1-1 and figure 1-1.
The initial reference is first defined followed by acceleration to final speed of 100 km/h
in 250 m.
The UE then maintains the speed for 400 m. This is followed by deceleration to final
speed of 25 km/h in 250 m. The UE then turn 90 degrees with turning radius of 20 m at
25 km/h. This is followed by acceleration to final speed of 100 km/h in 250 m.
The sequence is repeated to complete the rectangle.

Table 1-1: Trajectory Parameters for Moving Scenario and Periodic Update Performance test case

Parameter Distance (m) Speed (km/h)

l11, l15, l21, l25 20 25

l12, l14, l22, l24 250 25 to 100 and 100 to 25

l13 400 100

l23 900 100
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Fig. 1-1: Moving Scenario

The following is the content of the waypoint file.

The start tag MOVEMENT FILE is a mandatory element for each movement descrip-
tion. If this tag is omitted, the instrument interprets the coordinates described in the
waypoint file as static one.

****************************** MOVEMENT FILE ******************************
%%!! All empty lines or statements starting with %% will be ignored
%% This file format is used to load a continuous movement File into the signal generator
%% Enter the WGS-84 Reference Point's Coordinates S
REFERENCE: 144.96667027777777777777777777777777,-7.81666333333333333333333333333,100
%%From here on, we work in an ENU (EAST-NORTH-UPPER) 
basis centered around the ENU reference point S.
%%And more specifically the movement description will start from "START"
%%"START", "EAST COORDINATE E0 relative to S", "NORTH COORDINATE N0 relative to S",
"UPPER COORDINATE N0 relative to S", "SPEED in (m/s)" 
START: 0, 0, 0, 6.94444444444444444
%%Each movement segment is described in one line command in the file and the segments
%% are to be read sequentially.
%%It can be either a line description or an arc description... for a line, 
%% we start by the syntax: "LINE" and for an arc
%%we start with the syntax "ARC"  
%%In the current version, we will provide only EAST-NORTH Movement segments
%%"ARC", "Center EAST Coordinate", "Center NORTH Coordinate", 
"ARC in degrees (pos or neg is necessary for orientation)"
ARC: 0, 20, -90
%%"LINE", "Second Edge EAST Coordinate, first edge is the current point 
%% or last point of previous segment", "Second Edge NORTH Coordinate", 
"Acceleration/Deceleration"
%%Acceleration is to be taken as the projection following the movement segment
LINE: 0, 250, 1.44675925925925925926
LINE: 0, 400, 0
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LINE: 0, 250, -1.44675925925925925926
ARC: 0, 920, -90
LINE: 250, 0, 1.44675925925925925926
LINE: 900, 0, 0
LINE: 250, 0, -1.44675925925925925926
ARC: 1400, 920, -90
LINE: 0, -250, 1.44675925925925925926
LINE: 0, -400, 0
LINE: 0, -250, -1.44675925925925925926
ARC: 1400, 20, -90
LINE: -250, 0, 1.44675925925925925926
LINE: -900, 0, 0
LINE: -250, 0, -1.44675925925925925926
%%End of Trajectory description

A.1.1.3 NMEA Files as Source for Movement Information

The NMEA movement information (receiver-fix location) extracted from a standard
NMEA file can be used as a source for the generation of the movement file of interest.

Refer to chapter A.3, "NMEA Scenarios", on page 306 for detailed description of the
NMEA file format.

A.1.1.4 Trajectory Description Files

The trajectory description files are supported by instruments equipped with option
R&S SMBV-K92. For some of the file contents (including attitude information), the
option R&S SMBV-K103 is additionally required.

The trajectory description files use the file extension *.xtd. See example "Trajectory
description files in <positiononly> waypoint format" on page 298 for a simple example
of the file format.

The table 1-2 describes the used tags and parameters.

Table 1-2: Format of *.xtd file

Container Tag name Parameter Description

<general>    

 <info> <name> Name of the trajectory
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Container Tag name Parameter Description

 <property> <waypointfor-
mat>

Defines the format of the waypoint data.
The possible values are:
● "positiononly"

only waypoint data
● "position_attitude"

waypoint and attitude data
● "position_velocitymagnitude"

waypoints and velocity magnitude information per point
● "position_velocitymagnitude_attitude"

waypoints, velocity magnitude and attitude data
● "position_velocityvector"

waypoints and velocity vector per location
● "position_velocityvector_attitude"

waypoints, velocity vector and attitude per point

The three <property waypointformat="*_attitude"> formats
require the option R&S SMBV-K103. An instrument not equipped with this
option discards files containing these formats and displays an error mes-
sage.

Smoothening is only possible with <property
waypointformat="positiononly"> as well as NMEA, waypoints
and *.kml.

The description of the waypoints has to follow the selected format, e.g.
<waypointvector
data="0.05,144.966662392613,-37.8166632247233,
100.000000039116"/> with <property
waypointformat="positiononly"/> and
<datavectorhastimestamp="yes">.

  <datavectorhas-
timestamp>

Determines the way the time stamp (elapsed time starting start simulation
time) is defined.
● With <datavectorhastimestamp="yes">

the time stamp of a waypoint is retrieved from the
<waypointvector data>, as the first data vector parameter.

● With <datavectorhastimestamp="no">
the time stamp is internally calculated based on the follwoing rule:
– The time stamp of first waypoint is T1 = 0

the time stamp of the waypointN is TN = (N–
1)*<timeresolution>

  <coordsystem> Defines the coordinate system ("enu", "cart ecef" or "geod wgs84") used
by the definition of the <waypointvector data>.

  <timeresolution> If <datavectorhastimestamp="no">, applies implicitly time stamps
to waypoints. Otherwise, the time stamp is retrieved automatically, see
<datavectorhastimestamp>.

  <enurefpoint> Coordinates of the reference waypoint in ENU format

  <endbehaviour> Determines the behavior of the moving object at the end of the trajectory.

The possible values are: "jump", "return", "stop"

  <attitudeunit> Defines the unit ("rad" or "deg") the attitude is expressed in

  <noofway-
points>

Number of the used waypoints vectors.

Use the parameter to minimize the size of the waypoint without actually
deleting the waypoints
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Container Tag name Parameter Description

  <attitudecontinu-
ous>

If <attitudecontinuous="no">, the attitude angles to be read are
bounded by 2*PI.

The <attitudecontinuous="yes"> means that they are not boun-
ded.

<waypoints>   Description of the trajectory as a list of waypoint vectors.

 <waypointvec-
tor>

<data> Coordinates of the waypoint in the format selected by <coordsystem>
● [time,]longitude,latitude,altitude (geod wgs84)
● [time,]X,Y,Z (cart ecef)
● [time,]EAST,NORTH,UPPER (enu)

Depending on the <datavectorhastimestamp>, 3 or 4 values are
evaluated with <property waypointformat="positiononly"/>
Depending on the <property waypointformat>, more information
can be provided. The following is a list of the information appended to the
coordinates of the waypoint mentioned above.
● <property waypointformat="positiononly">

no additional information
● <property waypointformat="position_attitude">

yaw/heading,pitch/elevation,roll/bank, e.g.
[time,]longitude,latitude,altitude,yaw,pitch,roll
The vehicle attitude (yaw, pitch and roll) parameters are configured
relative to the local horizon

● <property
waypointformat="position_velocitymagnitude">
vel, e.g. [time,]X,Y,Z,vel

● <property
waypointformat="position_velocitymagnitude_attitude">
vel,yaw/heading,pitch/elevation,roll/bank, e.g.
[time,]EAST,NORTH,UPPER,vel,yaw,pitch,roll

● <property waypointformat="position_velocityvector">
velocity vector Vx,Vy,Vz, e.g. [time,]X,Y,Z,Vx,Vy,Vz

● <property
waypointformat="position_velocityvector_attitude">
yaw/heading,pitch/elevation,roll/bank,Vx,Vy,Vz, e.g.
[time,]longitude,latitude,altitude,yaw,pitch,roll,
Vx,Vy,Vz.

Note: If the waypoints are in geod wgs84, velocity vector is assumed in
Cartesian ECEF coordinate system.

Example: Trajectory description files in <positiononly> waypoint format
The following are two examples in <property
waypointformat="positiononly"> format. The examples emphasize on the dif-
ferent formats and explain the used time stamp principle.

● The <waypointvector data> parameters in the following example are vectors
with size of 3, because of the tag <property
datavectorhastimestamp="no">. Even if a fourth value have been defined, it
would have been ignored.
The time stamp is defined with the tag <property timeresolution="0.05">:
T1 = 0, T2 = (2-1)*0.05 = 0.05, etc. T12 = (12-1)*0.05 = 0.55

<trajectory>
    <general>
        <info name=”position only and user defined time stamp”/>
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        <property waypointformat="positiononly"/>
        <property datavectorhastimestamp="no" />
        <property coordsystem="enu" />
        <property timeresolution="0.05" />
        <property enurefpoint="54.0,10.0,12"/>
        <property endbehaviour="return"/>
        <property noofwaypoints="12"/>
    </general>
    <waypoints>
        <waypointvector data="0,0,0"/>
        <waypointvector data="0,1,0"/>
        <waypointvector data="0,2,0"/>
        <waypointvector data="0,3,0"/>
        <waypointvector data="0,4,0"/>
        <waypointvector data="0,5,0"/>
        <waypointvector data="0,6,0"/>
        <waypointvector data="0,7,0"/>
        <waypointvector data="0,8,0"/>
        <waypointvector data="0,9,0"/>
        <waypointvector data="0,10,0"/>
        <waypointvector data="0,11,0"/>
</waypoints>
</trajectory>

● In the following example the tag <property
datavectorhastimestamp="yes"> and all four value in the
<waypointvector data> parameters are evaluated. The time stamp is
retrieved automatically; the time stamp of a waypoint is the first value in the corre-
sponding <waypointvector data> parameter:
T1 = 0, T2 = 0.05, etc. T12 = 0.55.

<trajectory>
    <general>
        <info name=”position only with time stamp”/>
        <property waypointformat="positiononly"/>
        <property datavectorhastimestamp="yes"/>
        <property coordsystem="geod wgs84" />
        <property endbehaviour="return"/>
        <property duration="2.0"/>
    </general>
    <waypoints>
        <waypointvector data="0,144.966666334601,-37.8166633061788,100.000000009313"/>
        <waypointvector data="0.05,144.966662392613,-37.8166632247233,100.000000039116"/>
        <waypointvector data="0.10,144.966658453002,-37.8166630889914,100.00000008475"/>
        <waypointvector data="0.15,144.966654516955,-37.8166628990241,100.000000149943"/>
        <waypointvector data="0.20,144.966650585658,-37.8166626548785,100.000000235625"/>
        <waypointvector data="0.25,144.966646660296,-37.8166623566284,100.000000339001"/>
        <waypointvector data="0.30,144.966642742053,-37.8166620043635,100.000000461936"/>
        <waypointvector data="0.35,144.966638832109,-37.81666159819,100.000000603497"/>
        <waypointvector data="0.40,144.966634931642,-37.8166611382304,100.000000762753"/>
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        <waypointvector data="0.45,144.96663104183,-37.8166606246233,100.000000941567"/>
        <waypointvector data="0.50,144.966627163843,-37.8166600575235,100.000001138076"/>
        <waypointvector data="0.55,144.96662329885,-37.8166594371019,100.000001354143"/>
</waypoints>
</trajectory>

A.1.2 Vehicle Description Files (Used for Smoothening)

The vehicle description files use the file extension *.xvd. The following is a simple
example of the file format.

<vehicle>
    <info name="Car"/>
    <limits>
        <property maxspeed="100.0"/>
        <property maxg="0.6"/>
        <property maxg_lateral="0.6"/>
        <property maxjerk="15"/>
        <property maxjerk_lateral="15"/>
        <property maxyawrate="0"/>
        <property maxyawacceleration="0"/>
        <property maxyawjerk="0"/>
        <property maxpitchangle="0"/>
        <property maxpitchrate="0"/>
        <property maxpitchacceleration="0"/>
        <property maxpitchjerk="0"/>
        <property maxrollangle="0"/>
        <property maxrollrate="0"/>
        <property maxrollacceleration="0"/>
        <property maxrolljerk="0"/>
        <property proximity="0"/>
    </limits>
</vehicle>

The table 1-3 describes the used tags and parameters.

Table 1-3: Format of *.xvd file

Container Tag name Parameter Description

<info>    

 <name>  Vehicle name

<limits>    

 <property> <maxspeed> Maximal Speed (m/s)

  <maxg> Maximum tangential acceleration in g unit

  <maxg_lateral> Maximum radial acceleration (due to centrifugal force) in g unit

  <maxjerk> Maximum tangential Jerk in m/s2

  <maxjerk_lateral> Maximum radial Jerk in m/s2
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Container Tag name Parameter Description

  <maxyawrate> Maximum rate of change of the yaw/heading (rad/s)

  <maxyawaccelera-
tion>

Maximum second rate of change (acceleration) of the yaw/head-
ing (rad/s2)

  <maxyawjerk> Maximum third rate of change (jerk) of the yaw/heading (rad/s3)

  <maxpitchangle> Maximum pitch/elevation angle (rad)

  <maxpitchrate> Maximum rate of change of the pitch/elevation (rad/s)

  <maxpitchaccelera-
tion>

Maximum second rate of change (acceleration) of the pitch/
elevation (rad/s2)

  <maxpitchjerk> Maximum third rate of change (jerk) of the pitch/elevation
(rad/s3)

  <maxrollangle> Maximum roll/bank angle (rad)

  <maxrollrate> Maximum rate of change of the roll/bank (rad/s)

  <maxrollaccelera-
tion>

Maximum second rate of change (acceleration) of the roll/bank
(rad/s2)

  <maxrolljerk> Maximum third rate of change (jerk) of the roll/bank (rad/s3)

  <proximity> Specifies the maximum allowed deviation from the waypoints
specified by the user (m)

A.1.3 Antenna Pattern / Body Mask Files

The antenna patterns files are supported by instruments equipped with option
R&S SMBV-K102/103. Some parameters additionally require option R&S SMBV-K92.

Two files describe an antenna, the antenna pattern *.ant_pat file and the phase
response *.phase file.

Both files must have the same file name and must be stored in the same directory. The
*.ant_pat file describes the power response matrix of each antenna. The instrument
retrieves the phase response matrix from the *.phase file.

If the required *.phase file does not exist, a zero phase response is assumed.

Both file *.ant_pat and *.phase should have the same content but different data
section <data> (see table 1-4)

The following are two examples of the file format: an extract of the description of an
antenna pattern with three antennas and description of an antenna with four sectors.

Example: Anntena pattern with three antennas
The follwoing is an extract of the description.

<?xml version="1.0" encoding="ISO-8859-1"?>
<antenna_pattern>
  <antenna_descr count="3" use_same_pattern="no">
    <antenna id="1" YawAxis_Z_offset="-5.5" PitchAxis_Y_offset="0"  
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                    RollAxis_X_offset="-11.0" Yaw_offset="0" Pitch_offset="0"
                    Roll_offset="0" />
    <antenna id="2" YawAxis_Z_offset="5.5" PitchAxis_Y_offset="-4" 
                    RollAxis_X_offset="-11.0" Yaw_offset="0" Pitch_offset="0"
                    Roll_offset="120" />
    <antenna id="3" YawAxis_Z_offset="5.0" PitchAxis_Y_offset="4"
                    RollAxis_X_offset="-11.0" Yaw_offset="0" Pitch_offset="0"
                    Roll_offset="240" />
  </antenna_descr>
  <az_res> 1.00000000e+000 </az_res>
  <elev_res> 1.00000000e+000 </elev_res>
  <data>
     -179.5,-178.5,-177.5,-176.5,-175.5,-174.5,-173.5,-172.5,-171.5,-170.5,-169.5,-168.5,
     -167.5,-166.5,-165.5,-164.5,-163.5,-162.5,-161.5,-160.5,-159.5,-158.5,-157.5,-156.5,
     -155.5,-154.5,-153.5,-152.5,-151.5,-150.5,-149.5,-148.5,-147.5,-146.5,-145.5,-144.5,
     -143.5,-142.5,-141.5,-140.5,-139.5,-138.5,-137.5,-136.5,-135.5,-134.5,-133.5,-132.5,
     ...
  </data>
</antenna_pattern>

Example: Antenna with four sectors
The follwoing is a file decribing an antenna with four sectors.

<?xml version="1.0" encoding="ISO-8859-1"?>
<antenna_pattern>
 <antenna_descr count="1" use_same_pattern="no">
    <antenna id="1" YawAxis_Z_offset="0" PitchAxis_Y_offset="0"  
                    RollAxis_X_offset="0" Yaw_offset="0" Pitch_offset="90"
                    Roll_offset="0" />
 </antenna_descr>
 <az_res> 90.00000000e+000 </az_res>
 <elev_res> 90.00000000e+000 </elev_res>
  <data>
                -135.0,-45.0,45.0,135,45.0,0.0,3.0,6.0,9.0,-45.0,0.0,3.0,6.0,9.0
  </data>
</antenna_pattern>

The table 1-4 describes the used tags and parameters.

Table 1-4: Format of *.ant_pat and *.phase file

Container Tag name Parameter Description

<antenna_pattern>   Defines antenna pattern File

<antenna_descr>   Contains the descriptions of the antennas

  <count> Number of antenna patterns. Value range = 1 to 4.

  <use_same_pat-
tern>

Specify whether the same data section is used for all the anten-
nas or not.
● "yes": the data section will be used for all antennas
● "no": the data section has to be augmented with the data of

all antennas consecutively

User Environment Files



AnnexSatellite Navigation

303Operating Manual 1173.1427.12 ─ 08

Container Tag name Parameter Description

 <antenna>  Descriptions of the individual antenna

  <id> Antenna identification number

  <YawAxis_Z_off-
set>

<PitchAxis_Y_off-
set>

<RollAxis_X_off-
set>

Position shift of the antenna along the X/Y/Z axis with respect to
the center of gravity of the body

Value in meters

  <Yaw_offset>

<Pitch_offset>

<Roll_offset>

Angular shift of the antenna along the X/Y/Z axis of the to the
body

Value in degrees

<az_res>   Resolution of the columns in the data section

value in degrees integer divider of 360

<elev_res>   Resolution of the raws in the data section

value in degrees integer divider of 180

<data>   The file has to contain for every pattern:
● [1 + 360/<az_res>] columns
● [1 + 180/<elev_res>] rows

Title column and row are disregarded

If the <use_same_pattern=”yes”> only one pattern is suffi-
cient, otherwise the other patterns must be appended after each
others inside this section

If the data represents the power response of the antenna
(*.ant_pat file), the power loss values are in dB (between 0
and 40)

If the data represents the phase response of the antenna
(*.phase file), the phase values are in degrees

A.2 RINEX Files

The RINEX file format consists of three ASCII file types: observation data file, naviga-
tion message file and meteorological data file. The navigation RINEX files comprises
the Ephemeris information of all visible satellites at a control station or a commercial
receiver.

Each file type consists of a header section and a data section. The header section con-
tains global information for the entire file and is placed at the beginning of the file. The
format of the data records of the RINEX navigation message files may contain naviga-
tion messages of more than one satellite system (GPS, GLONASS, Galileo, etc.). See
RINEX Format Description for description of the RINEX file format.

RINEX Navigation Files can be downloaded from http://cddis.gsfc.nasa.gov/gnss_data-
sum.html#brdc.
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A.2.1 RINEX Format Description

Records marked with * are optional

Table 1-5: Navigation message file - header section description

 HEADER LABEL (Col-
umns 61-80)

DESCRIPTION FORMAT

 RINEX VERSION / TYPE ● Format version (2)
● File type ('N' for Navigation data)

I6,14X, A1,19X

 PGM / RUN BY / DATE ● Name of program creating current
file

● Name of agency creating current file
● Date of file creation

A20, A20 A20

* COMMENT Comment line(s) A60

* ION ALPHA Ionosphere parameters A0-A3 of alma-
nac (page 18 of subframe 4)

2X,4D12.4

* ION BETA Ionosphere parameters B0-B3 of alma-
nac

2X,4D12.4

* DELTA-UTC: A0,A1,T,W Almanac parameters to compute time in
UTC (page 18 of subframe 4)

A0,A1: terms of polynomial

T : reference time for UTC data

W : UTC reference week number. Contin-
uous number, not mod(1024)!

3X,2D19.12, 2I9

* LEAP SECONDS Delta time due to leap seconds I6

 END OF HEADER Last record in the header section. 60X

Table 1-6: Navigation message file - data record description

 HEADER LABEL (Columns
61-80 )

DESCRIPTION FORMAT

 PRN / EPOCH / SV CLK ● Satellite PRN number
● Epoch: Toc - Time of Clock

– year (2 digits)
– month
– day
– hour
– minute
– second

● SV clock bias (seconds)
● SV clock drift (sec/sec)
● SV clock drift rate (sec/sec2)

I2, 5I3, F5.1,

3D19.12

 BROADCAST ORBIT - 1 ● IODE Issue of Data, Ephemeris
● Crs (meters)
● Delta n (radians/sec)
● M0 (radians)

3X,4D19.12

 BROADCAST ORBIT - 2 ● Cuc (radians)
e Eccentricity
Cus (radians)
sqrt(A) (sqrt(m))

3X,4D19.12
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 HEADER LABEL (Columns
61-80 )

DESCRIPTION FORMAT

 BROADCAST ORBIT - 3 ● Toe Time of Ephemeris (sec of GPS
week)

● Cic (radians)
● OMEGA (radians)
● CIS (radians)

3X,4D19.12

 BROADCAST ORBIT - 4 ● i0 (radians)
● Crc (meters)
● omega (radians)
● OMEGA DOT (radians/sec)

3X,4D19.12

 BROADCAST ORBIT - 5 ● IDOT (radians/sec)
● Codes on L2 channel
● GPS Week # (to go with TOE)

Continuous number, not mod(1024)!
● L2 P data flag

3X,4D19.12

 BROADCAST ORBIT - 6 ● SV accuracy (meters)
● SV health (MSB only)
● TGD (seconds)
● IODC Issue of Data, Clock

3X,4D19.12

 BROADCAST ORBIT - 7 ● Transmission time of message (sec
of GPS week, derived e.g. from Z-
count in Hand Over Word (HOW)

● spare
● spare
● spare

3X,4D19.12

A.2.2 Example of a RINEX File

The following part of a script has the ephemeris info of satellites 4 and 9 at toc = toe =
352800.

2.10           N: GPS NAV DATA                         RINEX VERSION / TYPE
teqc  2002Mar14     Lisa McCormick      20090501 01:40:41UTCPGM / RUN BY / DATE
Solaris 2.7|Ultra 2|cc SC5.0|=+-|*Sparc                     COMMENT
rnw                 Dataflow Processing 04/30/2009 00:00:21 COMMENT
                                                            END OF HEADER

 4 09  4 30  2  0  0.0-7.157493382690D-05-1.523403625470D-11 0.000000000000D+00
    5.100000000000D+01 9.125000000000D+00 5.024495004670D-09-3.085066632770D+00
    3.930181264880D-07 8.587007410820D-03 7.828697562220D-06 5.153723627090D+03
    3.528000000000D+05 3.725290298460D-09 1.098217239560D-01-1.024454832080D-07
    9.410577584670D-01 2.186875000000D+02 4.847291251310D-01-8.071407635100D-09
   -3.571577341960D-10 1.000000000000D+00 1.529000000000D+03 0.000000000000D+00
    2.400000000000D+00 0.000000000000D+00-6.053596735000D-09 5.100000000000D+01
    3.456060000000D+05 4.000000000000D+00

 9 09  4 30  2  0  0.0 5.332380533220D-05 1.932676241270D-12 0.000000000000D+00
    1.070000000000D+02-7.959375000000D+01 4.243748197720D-09-2.353512095310D+00
   -4.012137651440D-06 2.042865683320D-02 3.149732947350D-06 5.153640602110D+03
    3.528000000000D+05 2.738088369370D-07-3.071164751940D+00 9.499490261080D-08
    9.762633443270D-01 3.201250000000D+02 1.469759572200D+00-7.773895242510D-09
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    1.046472161190D-10 1.000000000000D+00 1.529000000000D+03 0.000000000000D+00
    2.400000000000D+00 0.000000000000D+00-5.587935447690D-09 1.070000000000D+02
    3.456060000000D+05 4.000000000000D+00

A.3 NMEA Scenarios

The National Marine Electronic Association (NMEA) is a broadcasting standard sup-
ported by all navigation receivers. The NMEA files comprise information about com-
mon parameters related to the satellite constellation, navigation parameters, time,
receiver location and dynamics. The table 1-7 defines the starting acronym for a NMEA
command of a specific navigation standard. In the moment this firmware is released,
the Galileo NMEA acronym has not been defined yet.

Table 1-7: Overview of the starting acronyms for the NMEA command

ID Meaning

AG Autopilot - General

AP Autopilot - Magnetic

CC Computer - Programmed Calculator (outdated)

CD Communications - Digital Selective Calling (DSC)

CM Computer - Memory Data (outdated)

CS Communications - Satellite

CT Communications - Radio-Telephone (MF/HF)

CV Communications - Radio-Telephone (VHF)

CX Communications - Scanning Receiver

DE DECCA Navigation

DF Direction Finder

EP Emergency Position Indicating Beacon (EPIRB)

ER Engine Room Monitoring Systems

GP Global Positioning System (GPS)

GL GLONASS

HC Heading - Magnetic Compass

HE Heading - North Seeking Gyro

HN Heading - Non North Seeking Gyro

II Integrated Instrumentation

IN Integrated Navigation

LA Loran A

LC Loran C
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ID Meaning

MP Microwave Positioning System (outdated)

OM OMEGA Navigation System

Example of NMEA File

$GPVTG,,T,,M,0.000,N,0.000,K,A*23
$GPGGA,215810.00,3540.00066,N,13944.99611,E,1,04,1.61,6.8,M,39.4,M,,*5E
$GPGSA,A,3,06,09,04,10,,,,,,,,,2.47,1.61,1.87*01
$GPGSV,4,1,14,29,48,312,,26,47,312,,06,35,302,47,09,18,238,47*71
$GPGSV,4,2,14,27,47,312,,13,50,118,,04,72,181,47,30,48,312,*76
$GPGSV,4,3,14,14,39,070,,10,12,050,47,31,48,312,,07,64,349,*72
$GPGSV,4,4,14,25,47,312,,28,48,312,*7E
$GPGLL,3540.00066,N,13944.99611,E,215810.00,A,A*69
$GPZDA,215810.00,28,04,2023,00,00*64
$GPRMC,215811.00,A,3540.00066,N,13944.99611,E,0.000,,280423,,,A*7E

A.4 Used Algorithms

This section provides reference information on the algorithms applied by the genera-
tion of the GNSS signal.

A.4.1 Detailes on the Smoothening Algorithm

An important parameter in the smoothening application is the proximity parameter
which specifies the maximum deviation from the user’s input waypoints. This parame-
ter also specifies the number of inserted waypoints along the great circle in case the
user’s input waypoints are far away from each other. This is done to ensure that the
smoothened trajectory will not transverse the earth’s surface.

The smoothening is based on a modified version of linear segment parabolic blend
algorithm (LSPB) to specify the motion dynamics between two waypoints and geomet-
ric blend to change the direction of motion.

LSPB provides continuity in velocity (limited acceleration) but suffers from infinite Jerk.

The modified LSPB guarantees the continuity in acceleration (limited Jerk) between
waypoints. Control points are inserted between each two waypoints and the motion is
planned between these control points using fifth order polynomial regression which
guarantees the continuity of the velocity and acceleration at the control points.

The acceleration at the starting and the reached waypoint is zero; this will guarantee
the continuity when entering a blend to change the direction of motion since the blend
is represented by a sixth order polynomial with zero initial and final acceleration. The
blend is symmetric with respect to the axis bisecting the angle formed by three way-
points.
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The starting and the exit waypoint coordinates of the blend in addition to the blend’s
sixth order polynomial coefficients and velocity are determined by the proximity param-
eter mentioned before. Once the starting and exit waypoints coordinates for the blends
of all the user’s input waypoints are determined, these waypoints can later be connec-
ted using the modified (LSPB) mentioned before to form the entire motion trajectory.

In case the user specifies zero proximity value then the motion is formed entirely of
straight segments with no blends, since the starting and the exit waypoints are the
user’s input waypoints, in such a case the simulated motion will stop at every waypoint
in order to change direction of motion.
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